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Introduction

! aptop owners are special people.

You see, a laptop owner demands everything from a computer that a desktop
owner does: reliability, performance, expandability, and ease of use. Owners
of Mac Pro or iMac desktop computers can draw the line right there because
their computers are designed for a stationary existence. But, you and I are
laptop owners. We also need that same computer to be an inch thick (or
less). We demand that it run for hours on a single battery charge. We require
that it be light as a feather. We want to conquer the coffee shop, the library,
and even a lecture hall or two!

Today’s Apple laptops deliver all that, and more. If you’ve bought one of
these modern masterpieces — or you’re thinking about it right now — I
applaud your good taste, common sense, and discerning eye. Apple laptops
have everything: super performance, a top-shelf LED screen, rugged reli-
ability, and a trouble-free, powerful operating system. Heck, your Intel-based
Apple laptop can even run . . . wait for it . . . Windows XP, Vista, or 7. (If you
absolutely have to, the option is there.)

[ wrote this book for myself — and for every other Apple laptop owner who
desires to become a laptop techno-wizard. In these pages, you find a guide to
both your laptop’s hardware and Mac OS X Snow Leopard, the latest version
of Apple’s superb operating system. After I cover the basics that every laptop
owner should know, you find out how to accomplish all sorts of cutting-edge
audio, visual, and Internet projects. (Oh, and if you already have another of
my books, you know that I don’t skimp on the power-user tips and tricks that
save you time, effort, and money.)

Like my two-dozen-or-so other For Dummies titles, I respect and use the same
English language you mastered in school, avoiding jargon, ridiculous com-
puter acronyms, and confusing techno-babble whenever possible. (Plus, I try
to bring out the humor that’s hidden inside every computer. Finding out how
to use your Mac should be fun and not a chore!)
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What's Really Required

If you're not an engineer with a degree in Advanced Thakamology — imagine
that — you don’t need to worry! Here’s a reasonably complete list of what’s
not required to use this book.

+* I make no assumptions about your previous knowledge of computers —
laptop or otherwise — and software. I start at the beginning, which is
where every book should start.

v~ Still considering buying a MacBook, MacBook Air, or MacBook Pro?
Heck, you don’t even need the computer! If you're evaluating whether a
Mac laptop is right for you, this book is a great choice. I introduce you
to both the hardware and software you’ll get, so you can easily deter-
mine whether a Mac is the machine for you. (It is. Trust me.)

v Upgrading from the monster that is Windows? [ have tips, tricks, and
entire sections devoted to the hardy pioneers called Switchers! You
discover the similarities and differences between the two operating sys-
tems, how you can make the switch as easily and quickly as possible,
and how to run Windows on your new laptop, if you absolutely must.

v If your friends and family have told you that you're going to spend half
your savings on software — or that no decent software is available for
Mac computers — just smile quietly to yourself! These are two persis-
tent myths about Mac computers, and those same folks are going to be
blown away by the images, music, movies, and documents you produce.
(Oh, by the way, Mac laptops come complete with a ton more software
than any other PC desktop or laptop, and the iLife suite of applications
is better than anything available on a PC!) To sum up: You can do virtu-
ally everything in this book with the software that came with your Mac!

So what is required? Only a Mac laptop and the desire to become a power
user — someone who produces the best work in the least amount of time and
has the most fun doing it!

I should note that this book was written by using the latest MacBook Pro

computer, so owners of older Mac laptops who aren’t running Intel proces-
sors might not be able to follow along with everything I cover.

About This Book

Each chapter in this book is written as a reference on a specific hard-
ware or software topic. As fruit of the hard work of my editors, you can
begin reading anywhere you like because each chapter is self-contained.
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However, if you want to get the most out of this tome (and your MacBook
experience), nothing’s wrong with reading this book from front to back. I
warn you, however, that Tom Clancy and Stephen King have nothing to fear
from my “no-frills” prose.

Conventions Used in This Book

<MBER
é"\&

Even with a minimum of techno-speak, this book needs to cover the special
keys you have to press or menu commands you have to choose to make
things work. Hence, this short list of conventions.

Stuff you type

[ may ask you to type a command in Mac OS X. That text usually appears in
boldface, like this:

Type me.

You usually have to press Return before anything happens.

Menu commands
I list menu commands in this format:
Edit=>Copy

This example of a shorthand menu instruction indicates that you should click
the Edit menu and then choose the Copy item.

Web addresses

No up-to-date book on a computer is complete without a bag full of Web
addresses for you to check out. When you see these addresses in the text,
they look like this — www.mlcbooks . com — or like this:

www . mlcbooks.com

(By the way, that Web site does exist. You're always welcome to check out
my little acre of Web space!)
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Your MacBook is an elegant and sophisticated
machine — and as easy to use as a computer
can be —but from time to time, you may be curi-
ous about the technical details that surround
your hardware and software. (You probably

For the technically curious

disassembled alarm clocks as a kid, like | did.)
Techie stuff is formatted as a sidebar, like this
one, and you don’t have to read it unless you
want to know what makes things tick. (Pun by
sheer accident.)

How This Book Is Organized

After careful thought (read that “flipping a coin”), I divided this book into
seven major parts — plus an index, just because you deserve one. For your
convenience, cross-references to additional coverage of many topics are
sprinkled liberally throughout the book.

The Seven Parts Shall Be As Follows.

Part I: Tie Myself Down with
a Desktop? Preposterous!

This part introduces you to the important features of your laptop — like find-
ing out where all the cables connect — and helps you set up your system. |
also introduce Mac OS X Snow Leopard, which is the Apple operating system
that comes preinstalled on your MacBook, MacBook Air, or MacBook Pro.

Part I1: Shaking Hands with Mac 0S X

It’s time to familiarize you with Snow Leopard (you find much more here
behind the spots). In Part II, you find out how to take care of mundane chores
(such as moving your stuff) as well as how to customize and personalize your
system until it fits like the proverbial glove. Switchers from the PC world will
be especially interested in understanding the ins and outs of Mac OS X — and
friends, it ain’t hard. The Mac started out easier to use than a Windows PC,
and nothing has changed.
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Part I11: Connecting and Communicating

In Part III, it’s time to jump into the one application you're likely to use

every day: your Safari Web browser! You also find out more about the Apple
MobileMe Internet subscriber service as well as how to connect your laptop
for printing, sharing information with your PDA or cellphone, and even video-
conferencing. (I told you this thing was powerful, didn’t 1?)

In this part, I also discuss how to share your Mac laptop among a group of
people and how to connect your Mac to a network. (Wired or wireless, it
makes no difference to me!)

Part IU: Living the iLife

Ah, readers, you can begin humming happily to yourself right this second!
Yep, Part IV provides complete coverage of the latest iLife 09 release, with
the names that are the envy of the Windows crowd: iTunes, iPhoto, iMovie,
iDVD, and GarageBand. You find out how to turn your mobile monster com-
puter into the hub for all your digital media. Whether you listen to it, display
it, compose it, or direct it, this part of the book explains it.

Part U: Getting Productive with iWork

Part V is dedicated to the iWork '09 productivity suite. You find out how to
produce works of office art: spreadsheets, presentations, and printed docu-
ments that deliver your message with aplomb.

Part Ul: Necessary Evils: Troubleshooting,
Upgrading, Maintaining

In Part VI, I cover the stuff you need to know to upgrade your MacBook with
more memory or new hardware. If you need to troubleshoot a problem with
your hardware or software, check out my should-be-patented troubleshoot-
ing guide. Finally, I describe what you can do to help keep your laptop run-
ning as fast and as trouble free as the day you took it out of the box!
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Part UII: The Part of Tens

The two chapters here that make up the famous “Part of Tens” section con-
tain a quick reference of tips and advice on a specific laptop or Macintosh
topic. Each list has ten concise tips, and one or two readers have told me
that they make excellent tattoos. (Personally, I'm not that much of a Mac
guru.)

Bonus chapter: “Communicating
with That Bluetooth Guy”

In a free bonus chapter available at my Web site, www.mlcbooks . com, |
cover how to share data among wireless devices by using Bluetooth tech-
nology and iSync, and how to broadcast your music around your house like
Wolfman Jack.

Icons Used in This Book

A\

Like other technology authors, I firmly believe that important nuggets of
wisdom should stand out on the page! With that in mind, this For Dummies
book includes a number of margin icons for certain situations.

The most popular icon in the book, you find it next to suggestions [ make that
save you time and effort — and once or twice, even cash!

These are My Favorite Recommendations — in fact, I'll bet just about any
laptop power user would tell you the same. Follow my maxims, and you’ll
avoid the quicksand and pitfalls that I've encountered with all sorts of Macs
for almost two decades!

You don’t have to know this stuff, but the technologically curious love high-
tech details. (Of course, we're great fun at parties, too.)
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Always read the information for this icon first! I'm discussing something that
could harm your hardware or throw a plumber’s helper into your software.

This is the highlighter stuff — not quite as universally accepted (or as impor-
tant to the author) as a Mark’s Maxim, but a good reminder! I use these icons
to reinforce That Which Should Be Remembered.

Where to Go from Here

My recommendations on how to proceed? I just happen to have three:

v If you're thinking about buying a new MacBook, MacBook Air, or
MacBook Pro, the box is still unopened in your living room, or you’d like
help setting things up, start with Part 1.

v If you're already on the road with your laptop but you’d like guidance
with running Mac OS X — Hey, you Windows Switchers! Take note! —
start with Part II.

v For all other concerns, use the index or check out the table of contents
to jump straight to the chapter you need.

A Final Word

[ thank you for buying my book, and I hope that you find MacBook For
Dummies, 3rd Edition, invaluable! With this fearless guide in hand, I believe
that you and your Mac will bond as I have with mine. (That sounds somewhat
wrong, but it’s really not.)

Time for the first Mark’s Maxim in this book:
Take your time — after all, finding out how to use your computer isn’t a
race — and don’t worry if you’re not a graphic artist, professional photogra-

pher, or video editor. With your Mac laptop and its software, you don’t have
to be!™
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Part |

Tie Myself Down with a
Desktop? Preposterous!

The 5t Wave By Rich Tennant
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“T'm ordering our new MacPBook.
Do you want it left-brain or
right-brain oriented?”
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In this part . . .

our journey as a Mac Road Warrior — pun intended —
begins with a description of your laptop itself as
well as the details you need to know when unpacking and
setting up your newest family member. You'll also find
an introduction to Mac OS X Snow Leopard, the latest
version of Apple’s super-popular operating system.

[ also talk about the differences among the MacBook
models as of this writing: the MacBook, the MacBook Pro,
and the incredibly thin MacBook Air.
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Chapter 1

Hey, It Really Does Have
Everything | Need

In This Chapter
Identifying the important parts of your Mac laptop
Introducing the MacBook Air
Locating the right home for your computer
Unpacking, plugging in stuff, and getting hooked up
Playing with your bundled software
Buying additional stuff that you might need

M ost action films have one scene in common: I call it the “gear up”
scene, where the good guys strap on their equipment in preparation

for battle. (It doesn’t matter what era: You see “gear up” scenes in Gladiator,
Aliens, and virtually every movie Arnold has made.) You're sure to see lots
of clicking straps and equipping of offensive weapons (and sometimes even
a dash of war paint). The process usually takes a minute or so, all told with
whiplash camera work and stirring martial music in the background.

Well, fellow Macintosh Road Warrior, it takes only two seconds and one move
for you to gear up: closing the lid. That’s because your MacBook is a self-
contained world, providing virtually everything you’ll find on a desktop iMac
or Mac Pro. This is indeed the decade of the laptop, meshing nicely with your
cellphone and that wireless connection at your local coffee shop. You have
selected the right companion for the open road.

Unlike some of Apple’s other designs, such as the Mac mini or the iMac, your
MacBook looks similar to a PC laptop running Windows. (In fact, an Intel-based
Mac laptop can run Windows, if you absolutely must.) But your laptop holds a
number of pleasant surprises that no PC laptop can offer — and, in the case of
the MacBook Air, you’ll lose pounds and inches from your chassis! In this chap-
ter, I introduce you to the hardware and all the major parts of the machine —
and you even find out how to unpack and connect your computer. And, as
frosting on the cake, I preview the software that Apple is so proud of, as well as
the accessories that you should buy now rather than later.
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Welcome to your Mac laptop, good reader. Gear up!

An Overview of Vour Mac Laptop

Sure, your MacBook Pro might be less than an inch thin (and a MacBook Air
even more svelte than that — [ get to that later in the chapter), but a lot of
superb design lives inside, and you’ll encounter the same parts that you'd
find in a desktop machine. In the following sections, I discuss those important
parts — both the stuff you can see and the stuff that’s shoehorned within.

The parts you probably recognize

Every laptop requires some of the same gizmos. Figure 1-1 helps you track
them down. Of course, as you’d expect, a computer has a body of sorts in
which all the innards and brains are stored, a display screen, a keyboard, a
trackpad or other pointing device, and ports for powering and exchanging
data with outside toys.

iSight camera

LCD screen

|
Figure 1-1:
The charis-
matic form
of a typical
Mac laptop.
|

Disc slot
(MacBook and
MacBook Pro only)
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Feeling outdated? Never!

Are you using an older MacBook or iBook? It
seems that Apple’s product line changes every
time you tear a page from your 12-month cal-
endar, and every new generation of laptops
includes new whiz-bang features. Sometimes
you can add those features separately to your
older machine — such as an external iSight
camera or an AirPort Extreme card — but you
can't update some things, such as your iBook
motherboard. Sigh.

Here's my take on this situation: If your older
laptop does what you need at a pace you can
accept, there is no needto upgrade it.

Skeptical? Here's the proof: Before my recent
upgrade to a MacBook Pro, yours truly was
lugging a pristine iBook G3, which booted
Mac OS X Tiger and did absolutely everything

that | demanded. (A little more patience was
required, certainly, but technology authors are
simply brimming with patience.) The moral:
Avoid the upgrade fever unless you really need
a new companion!

If your laptop bears the iBook logo, you can still
enjoy this book and discover new tips and tricks
from it! Unless the breed of Intel-based Mac
laptops has a feature that you absolutely can't
use on your iBook (such as booting directly into
Windows), you can sail on with your current
computer, fiercely proud of The Bitten Apple
that appears on the cover. Although this book
was written with the MacBook, MacBook Air,
and MacBook Pro lines in mind, virtually every-
thing you read here still applies to your older
laptop. Unless it's steam driven, of course.

That magnificent screen

13

What a view you have! Today’s Mac laptops feature a 13-, 15-, or 17-inch LED
display. Most displays are available in glossy or standard finish: The former

is a good choice for the brightest colors and deepest blacks, and the latter is
a good choice where reflections might be a problem.

LED screens use far less electricity than their antique CRT ancestors do, and
they emit practically no radiation.

Apple’s laptop screens offer a widescreen aspect ratio (the screen is consid-
erably wider than it is tall), which augurs well for those who enjoy watching
DVD movies. (A favorite editor of mine loves it when I use the antique word
augur, meaning fo predict or foretell)

<P That reminds me: Throw away your printed dictionary! You won’t need it
because Mac OS X Snow Leopard includes the fantastic Dictionary widget,
which uses the Internet to retrieve definitions from the online Oxford
American Dictionary site. More on widgets in general in Chapter 5. . . and yes,
it does contain augur.
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The keyboard and trackpad

Hey, here’s something novel for your laptop. Unlike the external input
devices on a standard desktop computer, your Mac has a built-in keyboard
and trackpad (which does the job of a mouse). The keyboard is a particular
favorite of mine for a few reasons:

»* You can either control the sound volume or mute all that noise
completely.

» You can use illuminated keyboards (at least on high-end Mac laptops),
which are perfect for darkened dorm rooms and airplane flights.

v A handy-dandy Media Eject key lets you eject a CD or DVD.

The disc slot

You'll notice a long groove on the right side of your MacBook or MacBook
Pro. No, it’s not for your credit card. This slot accepts CDs and DVDs into
your optical drive. If the drive is empty, loading a disc is as simple as sliding
it in an inch or so; the drive sucks in the disc automatically. (And we don’t
need a stinkin’ floppy. Macs haven’t had floppy drives for years now, and the
PC types are finally catching up.) Note that this drive only accepts standard-
sized CD and DVD discs — don’t try to load a mini-disc or an odd-shaped
“credit-card” optical disc into your drive.

A MacBook Air doesn’t sport an internal optical drive (more on the MacBook
Air later in this chapter). You use either the CD & DVD Sharing feature in Snow
Leopard to read discs remotely (from another Mac or PC on your network), or
you can pick up an external optical drive from Apple for about $100. (Such is
the price you play for super-thin and super-light.)

“Luke, the printed label side of the disc should always be facing you when you
load a disc. Always.”

Food for your ears

A machine this nice had better have great sound, and the Mac doesn’t disap-
point. You have a couple of options for Mac laptop audio:

v All Mac laptops sport built-in speakers (and a microphone to boot).
The MacBook Air has a single speaker, and MacBook and MacBook Pro
models sport stereo speakers.

v Use built-in audio Line Out jacks to connect your Mac’s audio to a pair
of headphones, or a more powerful (and expensive) external speaker
system, or a home stereo system.
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Hey, where’'s my remote?

If this isn’t your first Mac laptop, you're prob-
ably looking for the Apple Remote among all
the Styrofoam. Unfortunately, the latest crop of
Mac laptops doesn’t come with a remote. This
once-standard device, which looks somewhat
like a first-generation iPod shuffle, allowed you
to control your laptop wireless from across the
room. Think DVD viewings, presentations, and
lazy iTunes listening.

If you've picked up a used MacBook or
MacBook Pro, you might have a remote already.
Otherwise, you can always buy one directly
from Apple for about $20. However, you can't
use an Apple Remote with the MacBook Air,
which doesn’t have an IR (infrared) receiver.

The power cable

Sorry, you can’t get a wireless power system . . . yet. (Apple’s working hard on
that one.) However, the MacBook Pro was the first major release of a laptop
with a magnetic power connector; the MacBook and MacBook Air followed suit
soon after. The MagSafe connector reduces the chances of your pride and joy
being yanked off a desk when someone trips over the power cord, because the
magnetic closure pops off under significant strain. Now that’s sassy.

The power button

Yep, you have one of these, too. It’s on the upper right, next to the keyboard,
bearing the familiar “circle with a vertical line” logo.

The iSight camera

Check out that tiny square lens above your screen. That’s a built-in iSight
camera, which allows you to chat with others in a videoconferencing environ-
ment by using Snow Leopard’s iChat feature. You can even take photos with
it, using the Photo Booth software that comes with your laptop, or set up a
travelin’ Webcam.

The battery compartment

Owners of a MacBook or MacBook Pro can open the cover on the bottom of
the laptop to switch batteries. Many road warriors who constantly use their
laptops for extended periods swear by extra batteries, especially if they’re
on-site in the middle of nowhere and there’s not an AC outlet to be found.

Of course, your laptop automatically charges the battery while it’s plugged

in, so you shouldn’t have to remove the battery unless you're replacing it or
switching it with another battery.
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If you're using a MacBook Air, your battery is sealed inside the case and
can’t be swapped. Only an Apple technician can replace a dead battery in a
MacBook Air laptop.

The holes called ports

The next stop on your tour of Planet Laptop is Port Central — those rows of
holes on the sides of your computer. Each port connects a different type of
cable or device, allowing you to easily add all sorts of functionality to your
computer.

Each of these stellar holes is identified by an icon to help you identify it.
Here’s a list of what you'’ll find and a quick rundown on what these ports do.

Connections for external devices and networking:

v FireWire: These ports are the standard in the Apple universe for con-
necting external hard drives and DVD recorders, but they do double
duty as the connector of choice for peripherals like your digital video
(DV) camcorder. (A peripheral is another silly techno-nerd term that
means a separate device you connect to your computer.) If you have a
current MacBook Pro model, you have a fast FireWire 800 port — older
MacBooks may have one of the older FireWire 400 ports too. (The latest
MacBook Air and MacBook models don’t have a FireWire port.)

v USB: Short for Universal Serial Bus, the familiar USB port is the jack-of-all-
trades in today’s world of computer add-ons. Most external devices that
you want to connect to your laptop (such as portable hard drives, scan-
ners, and digital cameras) use a USB port, including the iPod. Depending
on the model of laptop, you’ll have either two or three USB 2.0 ports
available. USB 2.0 connections are much faster than the old USB 1.1 stan-
dard, but they still accept USB 1.1 devices running at the slower speed.

Get the lowdown on FireWire and USB ports in Chapter 22.

v~ Ethernet: Today’s Mac laptops include a standard 10/100/1000 Ethernet
port, so the laptop is ready to join your existing wired Ethernet network.
(Alternatively, you can go wireless for your network connection; more
on that in the next section and in Chapters 11 and 22.) Because the
MacBook Air is designed to be completely wireless, it doesn’t have a
wired Ethernet port; if necessary, you can add a USB Ethernet adapter to
add a wired network port to your Air.

v SD card: Some MacBook models include an SD (Secure Digital) card slot,
allowing you to plug SD memory cards from digital cameras, cellphones,
and portable devices directly into your laptop.
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1 ExpressCard/34: When you need the absolute fastest performance
possible from an external device, you can connect that device to your
17-inch MacBook Pro by using the ExpressCard slot. These cards are the
descendants of the popular PCMCIA (or PC Card) cards, which many
models of older Mac PowerBooks can use. The 17-inch MacBook Pro is
the only Mac laptop to include the ExpressCard slot.

Connections for external video and audio are

v+ Mini DisplayPort connector: In case that splendid screen isn’t big
enough, you can buy an adapter for this port that allows you to send the
video signal from your laptop to another VGA or DVI monitor, or even
S-Video output for your TV and VCR.

1 Headphone/Optical Output: You can send the high-quality audio from
your rectangular beast to a set of standard headphones or an optical
digital audio device such as a high-end home theater system.

v Audio Line In: Last (but certainly not least) is the Audio Line In jack
on the MacBook Pro, which allows you to pipe the signal from another
audio device into your laptop. This one comes in particularly handy
when you record MP3 files from your old vinyl albums or when you want
to record loops in GarageBand.

Don’t forget the parts you can’t see

When you bought your new digital pride and joy, you probably noticed a
number of subtle differences between the low-end MacBook and the iiber-
expensive, top-end MacBook Pro and MacBook Air models. I call these dif-
ferences the Important Hidden Stuff (or IHS, if you're addicted to acronyms
already), and they’re just as important as the parts and ports that you can see.

Internal storage devices are as follows:

v CPU: Today’s Mac laptops feature — gasp! — Intel processors, which
run faster and cooler than the old G4 processors that powered the iBook
and PowerBook models. Of course, the faster the processor, the better.
(Definitely not rocket science.)

v Hard drive: MacBook and MacBook Pro laptops use the latest in hard
drive technology: namely, serial ATA hard drives, which are significantly
faster than the EIDE hard drives used in previous Mac laptop models.
(You don’t need to worry about what ATA and EIDE mean here. Really.)
As you might expect, the MacBook Pro laptop line has a larger-capacity
hard drive as standard equipment, but you can special-order a MacBook
from Apple with a larger hard drive.
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The MacBook Pro and MacBook Air also have another storage option
besides the mundane hard drive: You can opt for the much more expen-
sive (and much more technically impressive) solid-state drive. Hold on
to your chair — you find no moving parts with a solid-state drive, and it
offers better performance than a standard hard drive. Think of the solid-
state drive as an internal USB flash drive, which uses RAM chips rather
than magnetic platters to hold your data! Pricey, but super-sweet, and
Apple once again introduces the latest in computer hardware.

v Optical drive: Okay, I'm cheating a little here. [ mention the optical
drive in an earlier section, but all you can see is the slot, so it qualifies
as an [HS item. Depending on your Mac, your computer includes one of
the following:

® No built-in optical drive

The MacBook Air can be equipped with an external SuperDrive, or
you can use another computer’s drive remotely over your wireless
network.

e A DVD-R/CD-RW SuperDrive, which can play and record both CDs
and DVDs

If you prefer to burn Blu-ray discs, don’t give up hope of recording!
Thanks to those handy USB ports, it’s child’s play to add an exter-
nal Blu-ray recorder.

Wireless communications devices include the following:

v Wireless Ethernet: “Look, Ma, no wires!” As I mention earlier, you can
connect your laptop to an existing wireless Ethernet network. All cur-
rent Mac laptops have built-in AirPort Extreme hardware (older laptops
can be upgraded with an internal AirPort or AirPort Extreme card). With
wireless connectivity, you can share documents with another computer
in another room, share a single high-speed Internet connection betwixt
several computers, or enjoy wireless printing. Truly sassy!

Although Apple would want you to build your wireless wonderland with
an Apple AirPort Extreme Base Station — go figure — you can use your
Mac with any standard 802.11 wireless network. And yes, PCs and Macs
can intermingle on the same wireless network without a hitch.
(Scandalous, ain’t it?)

+” Bluetooth: Let’s get the old “digital pirate” joke out of the way: “Arrgh,
matey, [ needs me a wireless parrot.” (Engineers again . . . sheesh.)
Although strangely named, Bluetooth is another form of wireless con-
nectivity. This time, however, the standard was designed for accessories
such as your keyboard and mouse, and devices such as a personal digi-
tal assistant (PDA) and a cellphone.

Here’s the video display device:
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Meet

|
Figure 1-2:
Behold the
MacBook
Air.
|

v Video card: If your applications rely heavily on high-speed 3-D graph-
ics, you'll be pleased as punch to discover that today’s MacBook Pro
line of laptops come equipped with muscle-bound cards, such as the
NVIDIA GeForce GT 330M. This card is well suited to 3-D modeling,
video editing, and well, honestly, blasting the enemy into small smok-
ing pieces with aplomb.

the MacBook Air

Here’s a corker of a conundrum: The MacBook Air is unique for both its size
and weight (see Figure 1-2). And yet the Air is just like the MacBook and the
MacBook Pro. Well, mostly.

“Hold on, Mark. How can it be so singular and yet share so much with its road
warrior siblings?” That’s what I show you in the following sections, which
discuss the many similarities and the handful of very striking differences
between the three laptops in the MacBook line. If you're considering buying
an Air, these sections can help you decide whether you’d like to go ultra-thin
or stick with the conventional laptop crowd.

One thing’s for sure — Apple never does things mundane!

Comparing "twixt MacBooks

Do you remember when Apple introduced those first iMacs? Although they
shared the same basic components as any computer — a monitor, keyboard,
ports, speakers, and cables — the iMac was revolutionary because it was
completely self-contained. And it came in colors. And it didn’t have a floppy
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drive. In fact, Apple had redesigned the common computer with the focus
on style and ease of use, and had scrapped the floppy drive (and rightly so,
seeing as how floppies had become practically useless and were unreliable,
to boot).

I consider the MacBook Air to be an extension of the iMac revolution. With
this design, Apple has focused this time on physical dimensions and weight,
and has tossed anything that isn’t absolutely necessary for the lecture hall,
boardroom, or city park. However, 'm happy to note that the Air is no toy,
nor is it a bare-bones subnotebook. You'll find the Air as powerful as the
MacBook, and the Air even shares some of the features of the MacBook Pro.

What are the MacBook similarities?
Consider the similarities between the Air and the other MacBooks:

v Widescreen display: The Air has the same-size display as the other
MacBook models. Same display resolution, same gorgeous graphics.

v Intel Core 2 Duo processor: The Air is powered by the same type of CPU
as its siblings.

v Keyboard and trackpad: The Air has a full-size keyboard, and it’s even
backlit, just like the MacBook Pro. The Air’s trackpad includes support for
Multi-Touch control, too. (Read more about Multi-Touch in Chapter 4.)

v Snow Leopard: The Air runs the latest version of Mac OS X with aplomb.

v~ iSight and microphone: Every MacBook Air is video ready, using the
same iSight camera. You can record audio with the built-in microphone
as well. (Read more about iSight and recording in Chapter 12.)

v Wireless support: Like the other MacBooks, the Air has both built-in
AirPort Extreme hardware (802.11n) and built-in Bluetooth hardware.
(Read more about AirPort Extreme in Chapter 11.)

I think most Apple laptop owners would agree that this list covers the major
features to look for in a MacBook, so we can all agree that the MacBook Air is
no underpowered pushover.

So what's so flippin’ radical?

I'm glad you asked! Here’s the checklist of striking differences that set the Air
apart from the MacBook and MacBook Pro:

+~ Physical dimensions: Apple doesn’t call this machine the Air for noth-
ing! The current Air laptop measures a mere (.76 inches in height (at
its tallest point) when closed, 12.8 inches in width, and 8.94 inches in
depth. Oh, and hold on to your chair for this one: Our champ weighs in
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at a lightweight three pounds! (That’s a couple of pounds you won’t be
carrying around all day at that convention expo. Take it from this trav-
eler: You will feel the refreshing difference in just an hour or two.)

1 Cost: At the time of this writing, two versions of the laptop are available.
An entry-level MacBook Air will set you back $1,499, and the top-of-the-
line Air is a whopping $1,799. The more expensive Air is equipped with a
very pricey, solid-state drive and a faster CPU. (Don’t miss the upcoming
coverage on why solid-state is worth every penny.)

v Ports: The Air offers only three ports: a USB 2.0 port, an Audio Out jack,
and a Mini DisplayPort for connecting an external monitor or video
device. Notice I didn’t mention a FireWire port, which can be a big prob-
lem for Apple old-timers like me. I have a huge collection of FireWire
devices. The Air also doesn’t have an infrared port, so it’s not compat-
ible with the Apple Remote. Rats.

v Sealed battery: You can’t swap batteries with a MacBook Air because
the battery is sealed inside the laptop. (Think iPod.)

1 Sealed case: You can’t add or replace RAM modules. However, a
MacBook Air comes equipped with 2GB of RAM, so you should be good
to go. Comparatively, the MacBook can be upgraded to 4GB of RAM, and
MacBook Pro models can be upgraded to 8GB.

v Speaker(s): The MacBook Air includes but one speaker.

v Solid-state drive: Now we’re talkin’, Buck Rogers! [ discuss the solid-
state drive option in the next section.

+* No built-in optical drive: Whoa, Nellie! This is a big one. Apple decided
that a typical Air owner is likely to use a wireless connection for transfer-
ring files and media. But what if you have to reinstall Snow Leopard or
new applications? If you need to read or burn discs, a separate external
USB SuperDrive is available for about $100, or you can use the Remote
Disc feature and share the drive on another computer. (More on Remote
Disc in the section “Sharing a CD or DVD drive,” later in this chapter.)

As you can see, these striking differences make the choice between a
MacBook Air and a MacBook/MacBook Pro very easy indeed. To wit: The Air
is designed for the traveler who appreciates minimum weight and size, but
who doesn’t want to sacrifice the power, full-size screen, and full-size key-
board of a typical MacBook. These folks see the MacBook Air as a race car:
nimble, with reduced weight and no unnecessary frills. (Think of a typical
NASCAR entry: Who needs an expensive stereo or air conditioning?)

If you prefer the additional versatility of a MacBook or MacBook Pro —
including the standard set of ports, the ability to swap batteries, and a
built-in optical drive — I highly recommend that you stick with the more con-
ventional MacBook or MacBook Pro.
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Look, Ma, no moving parts!

You're probably familiar with the common species of usbius flashimus —
more commonly called the USB flash drive. With one of these tiny devices,
you get the equivalent of a 4-64GB hard drive that plugs into a USB 2.0 port,
allowing you to pack your data with you as you jet across the continents. But
have you ever asked yourself, “Self, why don’t they make internal hard drives
that use this same technology?”

Actually, dear reader, solid-state drives have been around for a number

of years now (think iPod shuffle/nano). Unfortunately, however, the solid-
state memory used in today’s flash drives gets pretty expensive as capacity
increases. In fact, the cost has been the limiting factor, as a solid-state drive
offers a number of advantages that really set it apart from a conventional
magnetic hard drive:

+ No moving parts: Unlike a typical magnetic hard drive, you find no
read-write heads and no magnetic platter — just gobs of happy silicon
memory chips. In effect, a solid-state drive works along the same lines as
your MacBook’s system RAM. Unlike your Mac’s RAM, though, a solid-
state drive doesn’t lose the data it stores when you turn off your laptop.
As you can imagine, no moving parts on a computer in motion is supe-
rior on two levels:

¢ The solid-state drive never wears out or needs replacing.

e If your laptop is accidentally abused (think, getting knocked off
your desk), it’s far less likely that you’ll lose a hard drive’s worth
of priceless data when it hits the ground.

v Speed: Oh, my goodness, is this thing fast! Your MacBook will boot/
restart/awake in far less time, and everything you do on your laptop will
benefit from the speed boost. A solid-state drive can read data far faster
than a conventional magnetic hard drive.

1 Power usage: Forget your hard drive spinning up from sleep mode. The
solid-state drive uses far less power than a conventional hard drive,
resulting in significantly longer battery life.

1+~ Blessed silence: The solid-state drive is completely silent. (No more of
that gargling noise while the disk is accessed. Sweet.)

So do you need the solid-state drive option for your MacBook Pro or Air? The
answer lies in your bank account (as well as your need for elbow room). If
you can afford the extra expense of the solid-state drive and you can fit all
your applications and data into 128GB (or the even more expensive 256GB
and 512GB drives), I heartily recommend that you consider joining Buck
Rogers with the storage device of the future.
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If you’d rather save that coin for something else, or you need a larger internal
hard drive to hold things like digital video and a massive collection of digital
images, stick with the tried-and-true magnetic hard drive.

What if I need that pesky optical drive?

Can a laptop survive in the jungle that is Real Life without a DVD drive? The
terse answer is no. I'll be honest here: Ripping an audio CD or burning an
iDVD slideshow disc without an optical drive is impossible. (Rather like a
cheap tank of gas.) And the wonders of digital media are a big part of the
iWorld. So what was Apple thinking?

First, a bit of explanation. Today’s DVD drives are thin, but not Air thin. To
create the stunning Air design with truly revolutionary dimensions, Apple
engineers had to leave out the drive. However, if you own a MacBook Air, you
have two choices when it comes to reading the contents of a CD or DVD: Go
external, or find how to share.

The external USB route

This is my choice. Personally, I have no problem toting around an external
USB DVD burner with a MacBook Air. Heck, half the time, you're likely to
leave it at home because most of us don’t install software every day. The
folks at Cupertino want you to download your movies from the iTunes Store,
so if you follow the Apple Path, you still don’t need an optical drive!

A USB SuperDrive from Apple costs a mere $100, and it can read and
write DVDs as well as the built-in SuperDrive you find in the MacBook and
MacBook Pro.

You can also use any third-party USB DVD drive that’s compatible with
Apple’s laptops and Mac OS X Snow Leopard.

Sharing a CD or DVD drive

The other option for installing software or reading a DVD on the MacBook
Air is Snow Leopard’s built-in CD/DVD Sharing feature. Sharing is an option
if you have a wired or wireless network (see Chapter 11) with at least one of
the following:

v A Macintosh running Mac OS X Tiger, Leopard, or Snow Leopard

v A PC running Windows XP or Vista or 7

This requires you to install a Windows application supplied by Apple
with your MacBook Air.
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You can only read from a shared optical drive. You can’t write data to the
remote drive, even if that drive is a DVD recorder.

On the Macintosh with the optical drive, open System Preferences, click the
Sharing icon, and then select the DVD or CD Sharing check box. Note that you
can set whether the Mac will request your permission when another com-
puter attempts to share the drive.

On a PC, display the Control Panel, click the DVD or CD Sharing icon, and
then select the Enable DVD or CD Sharing check box. Again, you can specify
that permission is required if security is a concern.

After you set up the shared drive, just load the disc and select the Remote
Disc item in any Finder sidebar. (Remote Disc appears under the Devices
heading in the sidebar.) Now you can access the drive as if it were directly
connected to your MacBook Air. Ah, technology!

Location, Location, Location!

3

If you choose the wrong spot to park your new laptop, I can guarantee that
you'll regret it. Some domiciles and office cubicles don’t offer a choice —
you have one desk at work, for example, and nobody’s going to hand over
another one — but if you can select a home for your Mac, consider the
important placement points in this section:

1 Keep things cool. Your new laptop is silent, but that super-fast Intel
Core 2 Duo (or i5 or i7) processor generates heat. Make sure that the
location you choose is far from heating vents and shielded from direct
sunlight. I also recommend a laptop cooling pad, which elevates the
base of your laptop to allow air to circulate underneath.

v Outlets are key! Your computer needs a minimum of at least one nearby
outlet, and perhaps as many as three:

¢ A standard AC outlet (using a current adapter if you're traveling
abroad, if necessary)

¢ A telephone jack (if you have an Apple modem for connecting to
the Internet or sending and receiving faxes)

¢ A nearby Ethernet jack (if you use the MacBook or MacBook Pro’s
built-in Ethernet port for connecting to a wired Ethernet network)

If you prefer to send your data over the airwaves, consider wire-
less networking for your Mac — I discuss everything you need to
know in Chapter 11.
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1+ Don’t forget the lighting. Let me act as your mom. (I know that’s a

stretch, but bear with me.) She’d say, “You can’t possibly expect to work
without decent lighting! You'll go blind!” She’s right, you know. You need
a desk or floor lamp at a minimum if you need to refer to books or docu-
ments often in your work.

v Plan to expand. If your laptop hangs out on a desk, allow an additional

foot of space on each side. That way, you have room for external periph-
erals, more-powerful speakers, and an external keyboard and mouse if
you need one.

If you want to keep an external keyboard handy, consider using a laptop
shelf. These Plexiglas or metal stands elevate your laptop several inches
above the desk, putting the screen at a better ergonomic position and
allowing you to park your keyboard and external mouse underneath.

Unpacking and Connecting Your Laptop

\\3

You're going to love the following sections. They’re short and sweet because
the configuration of a laptop on your desktop is a piece of cake. (Sorry about
the cliché overload, but this really is easy.)

Unpacking for the road warrior

Follow these guidelines when unpacking your system:

v Check for damage. I've never had a box arrive from Apple with shipping

damage, but I've heard horror stories from others (who claim that King
Kong must have been working for That Shipping Company).

Check all sides of your box before you open it. If you find significant
damage, take a photograph (just in case).

v Search for all the parts. When you’re removing those chunks o’ foam,

make certain that you’'ve checked all sides of each foam block for parts
snuggled therein or taped for shipment.

1 Keep all packing materials. Do not head for the trash can with the box

and packing materials. Keep your box and all packing materials for at
least a year, until the standard Apple warranty runs out. If you have to
ship the laptop to an Apple service center, the box and the original pack-
ing are the only way for your machine to fly.

And now, a dramatic Mark’s Maxim about cardboard containers:
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Smart computer owners keep their boxes far longer than a year. If you
sell your laptop or move across the country, for example, you’ll want
that box. Trust me on this one.™

1 Store the invoice for safekeeping. Your invoice is a valuable piece of
paper, indeed.

Save your original invoice in a plastic bag, along with your computer’s
manuals and original software, and other assorted hoo-hah. Keep the
bag on your shelf or stored safely in your desk, and enjoy a little peace
of mind.

+” Read the Mac’s manual. “Hey, wait a minute, Mark. Why do I have to
read the manual from Apple along with this tome?” Good question, and
here’s the answer: The documentation from Apple might contain new
and updated instructions that override what I tell you here. (For exam-
ple, “Never cut the red wire. Cut the blue wire instead.” Or something to
that effect.) Besides, Apple manuals are rarely thicker than a restaurant
menu.

You can always download the latest updated manuals for Apple comput-
ers in electronic format from Apple’s Web site. (Adobe’s PDF format is
the standard for reading documents on your computer, and Snow
Leopard can open and display any PDF document, using the Preview
application or the QuickLook feature.) I always keep a copy of the PDF
manual for my MacBook Pro on my hard drive, just in case.

Connecting Cables 101

Your laptop makes all its connections simple, but your computer depends on
you to get the outside wires and thingamabobs where they go.

The absolutely essential connection

After your new Mac is resting comfortably in its assigned spot (I assume
that’s a desktop), you need to make just one required connection: the power
cable! Plug the cable into the corresponding MagSafe socket on the Mac first,
and then plug ’er into that handy AC outlet. (After your battery is completely
charged, of course, you can go mobile at a moment’s notice.)

Adding the Internet to the mix

If you have Internet access or a local computer network, you need to make at
least one of the following connections described in this section.

If you get on the Internet by dialing a standard phone number and your
laptop has an external USB modem, just make two more connections:
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1. Plug one of the telephone cable’s connectors into your external
modem.

2. Plug the other telephone cable connector into your telephone line’s
wall jack.

After you get your account information from your ISP, Chapter 11 has the
details on configuring your modem and Internet settings for dialup access.

If you have high-speed Internet service, or if you're in an office or school with
a local computer network, you can probably connect through your MacBook
or MacBook Pro’s built-in Ethernet port. You make two connections:

1. Plug one end of the Ethernet cable into the Ethernet port on the Mac.

2. Plug the other end of the Ethernet cable into the Ethernet port from
your network.

Your network port is probably one of the following: an Ethernet wall
jack, an Ethernet hub or switch, or a cable or DSL Internet router (or
sharing device).
A\
Will you be joining a wireless network? If so, you find the information you need
on configuring Snow Leopard for wireless networking in Chapter 11.

Great, a Lecture about
Handling My Laptop

Proper handling of your laptop is important, so take a moment to cover the
Rules of Proper Laptop Deportment. Okay, perhaps I'm lecturing a bit, but
a little common sense goes a long way when handling any computer equip-
ment, and your laptop is no different. (Scolding mode off.)

Keep these rules in mind while opening and carrying your laptop:
v The cover is your friend. Open your laptop’s cover slowly, without jerk-
ing or bending it.

+* Close it before you move it. By closing your laptop, you put your Mac
OS X operating system into sleep mode, and the hard drive automati-
cally spins down (making it safer to move). The laptop is still on, and
will spring back to life after you open the cover.
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1~ Be nice to your keyboard. Don’t press too hard on those keys! Use the
same amount of pressure that you use with a desktop computer keyboard.

” Keep food and drinks far away. Care to turn your laptop into a very
expensive doorstop? Then go ahead and park your soda next to it.
(Oh, and crumbs are perfect if you're interested in buying replacement
keyboards.)

1 Keep your laptop as level as possible. Using your laptop while it’s tilted
too far in any direction can eventually cause problems with your mag-
netic hard drive. I kid you not. (If you choose a solid-state hard drive, of
course, this rule no longer applies!)

An Overview of Mac Software Goodness

The following sections answer the most common of all novice computer
questions: “What the heck will I do with this thing?” You find additional
details and exciting factoids about the software that you get for free, software
you’ll want to buy, and stuff you can do on the Internet.

What comes with my laptop?

Currently, Apple laptops ship with the following major software applications
installed and ready to use:

v The iLife ’09 suite: You know you want these applications! They turn
your Mac into a digital hub for practically every kind of high-tech device
on the planet, including DV camcorders, digital cameras, portable music
players, PDAs, and even cellphones.

Chapters 13-17 focus on the major iLife applications that will appeal to
MacBook owners: iTunes, iPhoto, iMovie, iDVD, and GarageBand.

v iWork trial version: You can try this productivity suite from Apple, but
expect to buy the full shootin’ match if you want to continue using the
applications. With iWork, you can create documents, spreadsheets, and
presentations within Pages, Numbers, and Keynote. See Part V for more
on working with these applications.

+* Photo Booth and Front Row: You discover more about these applica-
tions in Chapter 12. For now, suffice it to say that Photo Booth works
with your laptop’s iSight camera, and Front Row is the remote-control

software you use with your Apple Remote (if you have one).
Q‘&N\BER
<

< The installed software on your Mac might change as new programs become

available.
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Connecting to the Internet from your lap

What is a modern computer without the Internet? Apple gives you great tools
to take full advantage of every road sign and off-ramp on the Information
Superhighway right out of the box:

1 Web surfing: | use Snow Leopard’s Apple Safari Web browser every
single day. It’s faster and better designed than Internet Explorer, with
features such as tabbed browsing and built-in RSS feeds.

If tabbed browsing and RSS feeds sound like ancient Aztec to you, don’t
worry. Chapter 8 is devoted entirely to Safari.

v Web searches: Dashboard widgets can search the entire Internet for
stocks, movie listings, airline schedules, dictionaries, and foreign lan-
guage translations. I explain the Dashboard in Chapter 5.

v Chat: iChat lets you use your Mac to chat with others around the world
for free on the Internet — by keyboard, voice, or full-color video. This
is awesome stuff straight out of Dick Tracy and Buck Rogers. If you've
never seen a video chat, you'll be surprised by just how good your
friends and family look!

Always wear a shirt when videoconferencing.

v+ E-mail: Soldier, Apple has you covered. The Mail application is a full-
featured e-mail system, complete with defenses against the torrent of
junk mail awaiting you. (Imagine a hungry digital saber-toothed tiger
with an appetite for spam.) Send pictures and attached files to everyone
on the planet, and look doggone good doing it.

Applications that rock

Dozens of small applications are supplied with Mac OS X. [ mention them in
later chapters, but here are three good examples to whet your appetite:

v+ DVD Player: Put all that widescreen beauty to work and watch your
favorite DVD movies with DVD Player! You have all the features of
today’s most expensive stand-alone DVD players, too, including a spiffy
on-screen control that looks like a remote.

v Address Book: Throw away that well-thumbed collection of fading

addresses. Use the Snow Leopard Address Book to store, search, and
recall just about any piece of information on your friends, family, and

acquaintances.
v Chess: Ah, but this isn’t the chessboard your dad used! Play the game of

kings against a tough (and configurable) opponent — your MacBook — on
a beautiful 3-D board. Heck, your Mac even narrates the game by speaking

the moves!
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You can use the data you store in your Address Book in other Apple applica-
tions included with Snow Leopard, such as Apple Mail and iChat.

Boot Camp For Dummies

Mac OS X Snow Leopard includes one particularly exciting feature for
Windows switchers: You can use the Apple Boot Camp utility and your
licensed copy of Windows XP, Vista, or 7 to install and boot Windows on your
Intel-based Mac laptop!

Boot Camp creates a Windows-friendly partition (or section) on your hard
drive, where all your Windows files are stored. Other than the slightly strange
key assignments you'’ll have to remember, Boot Camp is reliable and easy to
use. However, | strongly urge you to back up your laptop on a regular basis;
inviting Windows to your Mac laptop also invites potential viruses as well.

Apple’s Boot Camp Assistant provides step-by-step instructions, making it
easy to configure your laptop for Windows. To run the Boot Camp Assistant,
open your Applications folder and double-click the Utilities folder; then
double-click the Boot Camp Assistant application icon.

Other Stuff That Nearly Everyone Wants

No man is an island, and no computer is either. [ always recommend the
same set of stuff for new PC and Mac owners. These extras help keep your
new computer clean and healthy (and some make sure that you're happy as
well):

v A laptop sleeve or case: Most laptop owners eschew the traditional
bulky laptop bag, because a bag broadcasts the fact that you're carry-
ing a valuable MacBook (and adds yet another item to carry on your
trip). On the other hand, if you pack your MacBook in a briefcase, book
bag, or backpack, you need to provide protection from bumps and
scratches. That’s where a laptop sleeve or thin case comes in. I use the
very cool BookBook hardback leather case from Twelve South (www .
twelvesouth.com), which looks — you guessed it — exactly like an
old-fashioned leather-bound book from the outside! (I think it makes me
appear scholarly, while disguising my MacBook.) The BookBook (shown
in Figure 1-3) is available for all sizes of MacBooks, costs under $100,
and provides long-lasting, cushioned protection for your expensive road
warrior.
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The
BookBook
case
provides
protec-

tion and
camouflage
for your
MacBook.
|

1 Surge suppressor: Even an all-in-one computer like your laptop can fall
prey to a power surge. I recommend using one of these:

® A basic surge suppressor with a fuse can help protect your Mac
from an overload.

e A UPS (uninterruptible power supply) costs a little more, but it does
a better job of filtering your AC line voltage to prevent brownouts
or line interference from reaching your computer.

Of course, your laptop’s battery immediately kicks in if you experi-
ence a blackout, so a UPS is less important for your computer.
However, any computer tech will tell you that filtered AC current is
far better for your laptop, and your UPS can also provide power for
external devices that don’t have a battery.

v Screen wipes: Invest in a box of premoistened screen wipes to keep
your screen pristine. Your Mac’s screen can pick up dirt, fingerprints,
QNING/ and other unmentionables faster than you think.

Make sure that your wipes are especially meant for LED/LCD or laptop
computer screens.
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v+~ Blank CDs and DVDs: Depending on the type of optical drive installed
in your laptop — and the type of media you're recording, such as com-
puter data CDs, DVD movies, or audio CDs — you’ll want blank discs for

e CD-R (record once)
¢ CD-RW (record multiple times)
¢ DVD-R (record once) and DVD+RW (record multiple times)

v Cables: Depending on the external devices and wired network connec-
tivity you’ll be using, these are

¢ A standard Ethernet cable (for wired networks or high-speed
Internet)

¢ FireWire or USB cables for devices you already have

1 Restraining cable: For those who are a little more security conscious or
tend to use their laptops in public places, a standard Kensington laptop
lock slot is provided on the MacBook and MacBook Pro case. (Sorry,
MacBook Air owners, but your case is too thin to sport a lock slot.) The
principle is the same as a bicycle cable lock: If your laptop is secured by
a cable to a sturdy fixture, it’s nearly impossible for it to walk off with
someone else.

v Wrist rest: You might have many reasons to buy a new Mac laptop, but |
know that a bad case of carpal tunnel syndrome is not one of them. Take
care of your wrists by carrying a keyboard wrist rest in your laptop bag.
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Turning On Your
Portable Powerhouse

In This Chapter

Turning on your laptop

Checking your Mac for proper operation
Monitoring your battery and heat level
Setting up Mac OS X Snow Leopard
Registering your MacBook

Using Migration Assistant

Copying information from a Windows PC

n Chapter 1, you got as far as unpacking your Mac laptop and connect-

ing a number of cables to it, but unless you bought this computer solely
as a work of modern art, it’s time to turn on your Mac and begin living The
Good Life. (Plus, you still get to admire that Apple design while using iTunes.)
After you get your new beauty powered on, [ show you how to run an initial
checkup of your laptop’s health, and wax enthusiastic on maintaining (and
even augmenting) your laptop battery.

[ also familiarize you with the initial chores that you need to complete —
such as using the Mac OS X Setup Assistant and moving the data and set-
tings from your existing computer to your MacBook, MacBook Air, or
MacBook Pro — before you settle in with your favorite applications.

In this chapter, I assume that Mac OS X Snow Leopard was preinstalled on

your Mac or that you just completed an upgrade to Snow Leopard from an
earlier version of Mac OS X.
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Tales of the On Button
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Your MacBook’s power switch is located on the right side of the keyboard.
Press it now to turn on your laptop, and you will hear the pleasant start-up
tone that’s been a hallmark of Apple computers for many years. Don’t be
alarmed if you don’t immediately see anything on-screen because it takes a
few seconds for the initial Apple logo to appear.

In my experience, sometimes a simple quick press of the power button on
some Mac laptop models just doesn’t do it. Rather, you actually have to hold
the button down for a count of two or so before the computer turns on.
However, if your Mac laptop ever locks up tight (and you can’t quit an appli-
cation, as I demonstrate in Chapter 4), the power button gives you another
option: Hold it down for a count of five or so (depending on your counting
speed), and your Mac shuts off — even if your laptop is locked up tight.

As the Apple logo appears, you see a twirling, circular high-tech progress
indicator that looks like something from a James Bond movie. That’s the sign
that your Mac is loading Snow Leopard and checking your internal hardware
for problems. Sometimes the twirling circle can take a bit longer to disap-
pear. As long as it’s twirling, though, something good is happening.

Next, Snow Leopard displays the soon-to-be-quite-familiar Aqua Blue (yup,
that’s its name) background while it loads certain file sharing, networking,
and printing components (and so on). This won’t take long.

At last, your patience of a whole ten seconds is rewarded, and after a short
(but neat) video, you see the Snow Leopard Setup Assistant appear.

Mark’s Favorite Signs
of a Healthy Laptop

Before you jump into the fun stuff, don’t forget an important step — a quick
prelim check of the signs that your new mobile Mac survived shipment intact
and happy.

If you can answer “yes” to each of these questions, your Mac likely made the
trip without serious damage:

1. Does the computer’s chassis appear undamaged?

It’s pretty easy to spot damage to your Mac’s svelte design. Look for
scratches and puncture damage.
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2. Does the LCD screen work, and is it undamaged?

Does the cover open smoothly? Are any individual dots (or pixels) on
your LCD monitor obviously malfunctioning? Bad pixels appear black or
in a different color than everything surrounding them. (Techs call these
irritating anarchists dead pixels. A 13-inch MacBook screen has over a
million pixels, and unfortunately, many new LCD screens include one or
two dead ones.

3. Do the keyboard and trackpad work?

Check your Mac’s built-in trackpad by moving your finger across its sur-
face; the cursor should move on your screen. To check the keyboard,
press the Caps Lock key on the left and observe whether the Caps Lock
light turns on and off.

If you do notice a problem with your laptop (and you can use your Safari
browser and reach the Web), you can make the connection to an Apple sup-
port technician at www . apple. com. If your MacBook Pro remains dead —
like an expensive paperweight — and you can’t get to the Internet, you can
check your phone book for a local Apple service center, or call the AppleCare
toll-free number at 1-800-275-2273. Chapter 21 also offers troubleshooting
information.

Vou've Not Going to Lecture
about Batteries, Are You?

3

No, this is not going to be a lecture. In fact, the only lecture I put you
through in this book concerns backing up (ahem, which you should do).
Instead, consider these tips as your rules of the road for monitoring and
charging your battery:

1 Recharge in sleep mode or when powered off. Your battery recharges
faster when your laptop is off or in sleep mode. (I go into more detail on
sleep mode in Chapter 6.)

1 Keep your laptop plugged into an AC socket when possible. I take
every opportunity to top off my laptop’s battery, and so should you.

If you don’t have much time to charge your battery before you're away
from an AC socket — say, half an hour — don’t use your MacBook while
it’s plugged in and charging.

1 Save your juice. For the most juice you can scavenge, here are some
easy tricks:
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e Turn off your laptop or leave it in sleep mode.

e Turn off unnecessary hardware. To conserve battery power as
much as possible, disconnect any USB or FireWire devices, and
turn off your AirPort and Bluetooth wireless hardware if you're not
connected to a network. (I cover AirPort wireless networking in
Chapter 11.)

® Reduce the brightness of your display from your laptop’s keyboard,
using the F1 key.

e Remove CDs and DVDs from the optical drive. (MacBook Air owners,
don’t go hunting for a built-in optical drive, because your laptop
doesn’t have one.)

1 Monitor your battery level from the Finder menu. I love Snow
Leopard’s battery-monitoring system! Your laptop’s battery life can be
displayed in the Finder menu in several different views — my personal
favorite is as a percentage of power remaining (with a fully charged bat-
tery registering at 100%). To display the percentage, click the battery
icon in the Finder menu and choose Show=>Percentage.

Keep in mind that the percentage shown is estimated by using your cur-
rent System Preferences settings and power usage, so if you change your
Energy Saver settings or remove a USB device that draws power from
your laptop, you'll see that change reflected in the battery meter. Figure
2-1 illustrates the battery meter in Percentage view.

|
Figure 2-1:
Monitor
your
MacBook's
juice from
the Finder
menu.
|

v~ Calibrate your battery. You can “train” your battery to provide the max-
imum charge by calibrating it, which Apple recommends doing monthly.
It’s a snap:

a. Charge your battery until the Finder menu battery meter indicates that
the unit is fully charged, at 100%.

b. Keep your laptop connected to an AC socket for another two hours to
ensure a maximum charge.
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HyperMac
external
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laptop
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c. Disconnect the power cord and use your laptop on battery power until
it’s fully discharged and it automatically switches to sleep mode.

Make sure that you close all your applications when you see the
low battery warning dialog box so that you don’t lose anything.

d. Allow your laptop to sleep (or turn it off) for a full five hours.
e. Reconnect the AC cord and fully charge your battery.

+ Invest in an external battery. If you often find yourself running out

of battery power on the road without an AC socket handy, consider
buying an external battery! These handy units are especially designed
to charge your MacBook and other USB-powered devices when no other
power source is available. | use the HyperMac external battery from
Sanho Corporation (www . hypershop . com), as shown in Figure 2-2. The
rechargeable HyperMac battery can power and charge your MacBook,
as well as an iPhone and other USB devices. And to make things easier,
it adjusts automatically to the voltage requirements of any MacBook
model, and displays the remaining power with its own built-in meter.
The HyperMac costs between $200 and $500, depending on the battery’s
capacity.

If your battery is no longer holding a charge — in other words, if you
fully charge it and unplug the AC adapter, only to discover that you have
only a few minutes of battery life — it’s time to invest in a replacement
battery. MacBook and MacBook Pro owners can buy a new battery them-
selves (from Apple or any one of a number of online vendors), but
owners of MacBook Air laptops must bring their computers in for servic-
ing. The Air is a sealed unit, and you can’t replace the battery yourself.
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Hot patootie, is my laptop steam-powered?

Laptops generate heat. And today’s super-fast
multicore processors can work up a head of
steam — pun intended — while you're using
them, and even though most MacBooks have
a fan, some of that heat is simply radiated from
the bottom of the computer.

What you might not realize, however, is just
how much heat your MacBook, MacBook Air,
or MacBook Pro can produce! No, you won't be
scalded if you shift your MacBook from a desk
to your lap (Apple dislikes lawsuits as much as
the next company), but if you've been using that
laptop for hours, it will be uncomfortably hot!

To avoid that burning sensation, buy a laptop
stand or cooling pad for your desk. These nifty
metal or Plexiglas pedestals raise your laptop
off of your desk, allowing air to flow under the
bottom of the computer for better cooling. Also,
a laptop stand elevates the screen to a more
ergonomic position. (The keyboard might sud-
denly be harder to use, naturally, but that’s yet
another reason why | recommend an external
keyboard when you're using your Mac laptop at
a semipermanent desk location; it saves wear
and tear on your laptop keyboard, and you get
a full-size keyboard.)

Setting Up and Registering Your Laptop

After your MacBook is running and you give it the once-over for obvious ship-

ping damage, your next chore is to set up your laptop. Unlike other tasks in
this book, I won’t cover the setup process step by step. Apple contextually
tweaks the questions that you see during setup on a regular basis, and the
questions are very easy to answer. Everything is explained on-screen, com-
plete with on-screen Help if you need it.

However, [ do want you to know what to expect, as well as what information
you need to have at hand. I also want you to know about support opportu-
nities, such as the Apple MobileMe Internet services. Hence, this section:
Consider it a study guide for whatever your MacBook’s setup procedure has

to throw at you.

Setting up Mac 0S X Snow Leopard

After you start your computer for the first time — or if you just upgraded
from an earlier version of Mac OS X — your laptop will likely launch Snow
Leopard Setup automatically. (Note that some custom install options, such

as the Archive and Install option, might not launch the setup procedure.) The

setup process takes care of a number of different tasks:
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1 Setup provides Snow Leopard with your personal information. As I
mention in Chapter 1, your Mac ships with a bathtub full of applications,
and many of those use your personal data (such as your address and
telephone number) to automatically fill out your documents.

If that stored personal information starts you worrying about identity
theft, I congratulate you. If you’re using your common sense, it should.
However, in this case, Apple doesn’t disseminate this information any-
where else, and the applications that use your personal data won’t send
it anywhere, either. And Safari, the Apple Web browser, fills out forms
on a Web page automatically only if you give your permission.

1 Setup creates your user account. You're prompted for a username and
password, which Setup uses to create your administrator-level account.

1 Setup configures your language and keyboard choices. Mac OS X is a
truly international operating system, so you are offered a chance to con-
figure your laptop to use a specific language and keyboard layout.

v Setup configures your e-mail accounts in Apple Mail. If you already
have an e-mail account set up with your ISP, keep handy the e-mail
account information that the ISP provided to answer these questions.
The info should include your e-mail address and your login name and
password. Snow Leopard can even automatically configure many Web-
based e-mail accounts for you (including Google Mail, Yahoo! Mail, and
AOL Mail) if you supply your account ID and password. Sweet.

1 Setup allows you to open a free trial subscription with Apple’s
MobileMe service. A MobileMe subscription provides you with online
file storage, iSync capability across multiple computers (as well as your
iPhone and iPad), backups to your online storage, Apple e-mail accounts
(through both Web mail and most mail applications, both under
Windows and Mac OS X), photo sharing, podcasting, and your own acre
of iWeb site on the Internet. I go into all these in detail in Chapter 9, but
for now, just sign up (or sign in, if you already have an existing account)
and take the opportunity to feel smug about owning an Apple computer.

1 Setup sends your registration information to Apple. As a proud owner
of a Mac laptop, take advantage of the year of hardware warranty sup-
port and the free 90 days of telephone support. All you have to do is reg-
ister to use 'em. Rest assured that all this info is confidential.

1 Setup launches Migration Assistant. This assistant guides you through
the process of migrating (an engineer’s term for moving) your existing
user data from your old Mac or PC to your new laptop. Naturally, if your
MacBook is your first Macintosh computer, you can skip this step with
a song in your heart! (Read more on Migration Assistant in the section
“Importing Stuff from Another Mac,” later in this chapter.)
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Registering your MacBook

I'll be honest here: | know that many of us, myself included, don’t register
every piece of computer hardware we buy. For example, I didn’t register my
wireless Bluetooth adapter that [ bought for my older iBook because the total
expenditure was only around $40, the gizmo has no moving parts, and I'm
never likely to need technical support to use it or get it fixed.

However, your MacBook is a different kettle of fish altogether, and I strongly
recommend that you register your purchase with Apple during the setup pro-
cess. You spent a fair amount on your computer, and it’s an investment with
a significant number of moving parts.

Even the hardiest of techno-wizards would agree with this important Mark’s
Maxim:

If you don’t register your new laptop, you can’t receive support.™

And rest assured that Apple is not one of those companies that constantly
pesters you with e-mail advertisements and near-spam. I've registered every
Apple computer I've owned, and I've never felt pestered. (And I have an
extremely low tolerance for pester.)

Importing Stuff from Another Mac

\\3

If you're upgrading from an older Mac running Mac OS X to your new
MacBook or MacBook Pro, | have great news for you: Apple includes
Migration Assistant, a utility application that can help you copy (whoops, |
mean, migrate) all sorts of data from your old Mac to your new machine, via
your laptop’s FireWire port or Ethernet network connection.

To use Migration Assistant to copy your system from your older Mac, you
need a FireWire cable to connect the computers. If you don’t already have
one, you can pick one up at your local Maze o’ Wires electronics store or at
your computer store. (This cable will probably come in handy in the future
as well, so it’s not a one-use wonder.)

If you’re a MacBook or MacBook Air owner, you might be scratching your
head looking for a FireWire port on your new laptop. Let me save you the trou-
ble: You don’t have one. Therefore, you can’t use the Migration Assistant in
FireWire mode at the time of this writing. However, you can use a wired or
wireless Ethernet network connection between computers. Assuming that
both your MacBook and your older Mac can communicate over your home or
office network, just click the Use Network button on the Connect Your
Computers screen to transfer data!
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As I mention earlier, Setup launches Migration Assistant automatically if you
indicate that you want to transfer stuff during the setup process, but you can
always launch Migration Assistant manually at any time. You find it in the
Utilities folder inside your Applications folder; just double-click the Migration
Assistant icon.

The list of stuff that gets copied includes the following:

v User accounts: If you set up multiple user accounts (so that more than
one person can share the computer), the utility ports them all to your
new Mac.

v Network settings: Boy, howdy, this is a real treat for those with manual
network settings provided by an ISP or a network administrator!
Migration Assistant can re-create the entire network environment of
your old Mac on your new laptop.

v System Preferences settings: If you're a fan of tweaking and customizing
Mac OS X to fit you like a glove, rejoice. Migration Assistant actually
copies all the changes that you've made in System Preferences on your
old Mac! (Insert sound of angelic chorus: Hallelujah!)

v Documents: The files in your Documents folder(s) are copied to your
new Mac.

v~ Applications: Migration Assistant tries its best to copy over the third-
party applications that you’ve installed in your Applications folder on the
older Mac. [ say tries its best because you might have to reinstall some
applications, anyway. Some developers create applications that spread
all sorts of files across your hard drive, and Migration Assistant just can’t
keep track of those nomadic files. And some other applications make the
trek just fine, but you might have to reenter their serial numbers.

Follow these steps to use Migration Assistant:

1. If Migration Assistant isn’t already open, open the Utilities folder
inside your Applications folder and then double-click the Migration
Assistant icon.

2. Click Continue on the opening screen.

Migration Assistant prompts you for the account name and password
that you create during the setup procedure, as shown in Figure 2-3. Your
account is an admin account, meaning that you have a higher security
level that allows you to change things in Snow Leopard. (See Chapter 10
for much more detail on user accounts.)

3. Type your account name and password, and then click OK.

Characters in your password are displayed as bullet characters for secu-
rity. After you successfully enter your admin account name and pass-
word, this dialog disappears, and you get to play in the real Migration
Assistant dialog.
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|
Figure 2-3:
Enter your
admin pass-
word to use
Migration
Assistant.
|
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4. Select the From Another Mac radio button and then click Continue.

In case you've lost the data on your hard drive (or you've upgraded your
hard drive), you can also restore your MacBook’s data from a Time
Machine backup drive by using Migration Assistant. (You find all the
details on Time Machine in Chapter 23.)

. Connect a FireWire cable between the two computers. Then click

Continue.

As I mention earlier, if you’d rather use a wired or wireless Ethernet
connection between the computers, click the Use Network button and
eschew the FireWire cable completely. (MacBook Air owners, as well
as owners of the current generation of MacBook laptops, will also have
to use a network connection because their computers don’t have a
FireWire port.)

If you take this route, skip Steps 6 and 7. Instead, run Migration Assistant
on your older Mac and follow Steps 1 through 4, but click To Another
Mac on your older machine and then click Continue. Follow the on-screen
instructions to enter the passcode, and then continue with Step 8.

. Restart your older Mac while holding down the T key.

This restarts your older computer in FireWire Target Disk mode, in which
your older Mac essentially becomes a huge external FireWire hard drive.
(Neat trick.)

You must hold down the T key until you see the FireWire symbol (which
looks like a stylized Y) appear on your older machine.

7. Click Continue.

8. Select the check boxes next to the user accounts that you want to

transfer from your older machine, and then click Continue.
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Migration Assistant displays how much space is required to hold the
selected accounts on your new laptop’s hard drive.

9. Select the check boxes next to the applications and files that you want
to copy. Then click Continue.

10. Select the check boxes next to the settings that you want to transfer.

Normally, you want to migrate all three of these settings groups:
Network Settings, Time Zone, and Sharing Settings.

11. Click the Migrate button.

[ should note that Migration Assistant may take an hour or more to com-
plete (depending on the amount of data to be moved and the type of
connection you're using).

12. After everything is copied, press the power button on your older Mac
to shut it off. Then disconnect the FireWire cable (if necessary).

Importing Stuff from Windows
(1f You Must)

If you're a Windows-to-Mac Switcher, you made a wise choice, especially if
you're interested in the creative applications in the iLife suite! Although you
could choose to start your Apple computing life anew, you probably want to
migrate some of your existing documents and files from that tired PC to your
bright, shiny, new MacBook.

Switching froma PCto ... an Apple PC?

With the Snow Leopard Boot Camp feature, you
can actually create a full Windows XP, Vista, or
7 system on your Intel-based Mac laptop. Yup,
Windows and Snow Leopard coexist peacefully
on the same computer. However, you'll have to
reboot your computer to use your MacBook as
a Windows system.

This brings a whole new meaning to the term
Switcher because some Mac owners are
moving their stuff from Windows (running on
their old PC) to . . . well, Windows (running

on their new laptop) rather than Snow Leopard.
If you do decide to create a Windows system
on your MacBook with Boot Camp, the files
and folders on your existing PC can be copied
directly by using the Files and Settings Transfer
Wizard (in Windows XP) or the Windows Easy
Transfer utility (in Windows Vista and 7). In
effect, you're copying your settings and data
between your old PC and your new Apple-
based PC! (That sounds a little skewed, but die-
hard Apple apostles will have to forgive me.)
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Unfortunately, Mac OS X has no Windows Migration Assistant. However, if
you’re moving from a Windows PC to a Mac, you can copy your files manu-
ally from a CD or DVD or a USB flash drive, or over a network. To make
this manual move more manageable, Table 2-1 covers a number of typical
Windows file locations and their Snow Leopard counterparts.

Table2-1  Moving Media and Documents betwixt Computers

File Type Windows Mac 0S X Mac Application
Location Location
Music files My Music folder Music folder iTunes
Video and movie My Videos folder Movies folder QuickTime/DVD
files Player/iTunes
Digital photos My Pictures folder Pictures iPhoto
folder
Office documents My Documents Documents Mac Office/
folder folder iWork

\3 . . . Lps .
P The Mac OS X Help system contains an entire subsection on specific tricks

you can use when switching from Windows to Mac, including how to connect
to a Windows network and how to directly connect the two computers.

Even with Boot Camp — Apple’s dual-boot feature that allows you to run both
Snow Leopard and Windows XP/Vista/7 on your MacBook, MacBook Pro,

or MacBook Air — manually moving existing Windows applications (such

as PaintShop Photo Pro) to your laptop’s hard drive usually doesn’t work.
That’s because most Windows software installs all sorts of necessary files in
several folders across your hard drive. Instead, you have to install Windows
XP, Vista, or 7 on your Mac laptop (using Boot Camp) and then reinstall your
Windows applications.
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The Laptop Owner's
Introduction to Mac 0S X

In This Chapter
Introducing Mac OS X Snow Leopard
Appreciating the UNIX core underneath Snow Leopard
Recognizing similarities between Windows and Snow Leopard

Getting help while learning about Snow Leopard

n the other books that I've written about Mac OS X Snow Leopard, I use all

sorts of somewhat understated phrases to describe my operating system
of choice, such as elegantly reliable, purely powerful, and supremely user
friendly.

But why is Snow Leopard such a standout? To be specific, why do creative
professionals and computer techno-wizards across the globe hunger for the
very same Mac OS X that runs your MacBook? Why is Snow Leopard so far
ahead of Windows 7 in features and performance? Good questions, all!

In this chapter, | answer those queries and satisfy your curiosity about your
new big cat. | introduce the main elements of the Snow Leopard Desktop, and
[ show you the fearless UNIX heart that beats underneath Snow Leopard’s
sleek exterior. I also point out the most important similarities between Snow
Leopard and Windows, and I outline the resources available if you need help
with Mac OS X.

Oh, and I promise to use honest-to-goodness English in my explanations, with
a minimum of engineer-speak and indecipherable acronyms. (Hey, you have
to boast about Snow Leopard in turn to your family and friends. Aunt Harriet
might not be as technologically savvy as we are.)
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Vour Own Personal Operating System
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Snow Leopard is a special type of software called an operating system (or
OS, as in Mac OS X). That means that Snow Leopard essentially runs your
MacBook and also allows you to run all your other applications, such as
iTunes or Photoshop. It’s the most important computer application — or
software — that you run.

Think of a pyramid, with Snow Leopard as the foundation and other applica-
tions running on top.

You're using the OS when you aren’t running a specific application, such as
these actions:

v Copying files from a CD to your hard drive

v Choosing a different screen saver

Sometimes, Snow Leopard even peeks through an application while it’s run-
ning. For example, application actions like these are also controlled by Snow
Leopard:

v The Open, Save, and Save As dialogs that you see when working with
files in Photoshop

v The Print dialog that appears when you print a document in Microsoft
Word

In the following sections, I personally escort you around the most important
hotspots in Snow Leopard, and you meet the most interesting on-screen thin-
gamabobs that you use to control your laptop. (I told you [ wasn’t going to
talk like an engineer!)

The Snow Leopard Desktop

This particular desktop isn’t made of wood, and you can’t stick your gum
underneath. However, your Snow Leopard Desktop does indeed work much
like the surface of a traditional desk. You can store things there, organize
things into folders, and take care of important tasks like running other appli-
cations. Heck, you even have a clock and a trash can.

Gaze upon Figure 3-1 and follow along as you venture to your Desktop and
beyond.
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Finder menu

Finder window

|
Figure 3-1:
Everything
Snow
Leopard
starts

here —the
Mac 0S X
Desktop.
|

Dock Icons

Meet me at the Dock

The Dock is the closest thing to the dashboard of a car that you're likely to
find on a Macintosh. It’s a pretty versatile combination: one part organizer,
one part application launcher, and one part system monitor. From here, you
can launch applications, see what’s running, and display or hide the windows
shown by your applications.

Each icon in the Dock represents one of the following (many of which are
proudly displayed in Figure 3-2):

v An application that you can run (or is running)
v An application window that’s minimized (shrunk)
v A Web page URL link
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v A document or folder on your system
»* A network server or shared folder

v Your Trash

I cover the Dock in more detail in Chapter 5.

Minimized window

— Running application Trash
Figure 3-2:
The Dock
can contain
all sorts of
exotic icons.
|

A\
The Dock is highly configurable:

v It can appear at different edges of the screen.

v~ It can disappear until you move your mouse pointer to the edge to call it
forth.

» You can resize it.

Dig those crazy icons
By default, Snow Leopard always displays at least one icon on your Desktop:

your Mac’s internal hard drive. To open a hard drive and view or use the
contents, you double-click the icon. Other icons that might appear on your
Desktop can include

v CDs and DVDs

v An iPod

v External hard drives or USB flash drives

v Applications, folders, and documents

v Files and folders

v Your iDisk (if you have a MobileMe account)

1 Network servers you access

Chapter 4 provides the good stuff on icons and their uses within Snow
Leopard.
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Figure 3-3:
Clicking a
menu group
displays a
list of menu
commands.
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There’s no food on this menu

The Finder menu isn’t found in a restaurant. You find it at the top of the
Desktop, where you can use it to control your applications. Virtually every
application that you run on your laptop has a menu.

To use a menu command, follow these steps:

1. Click the menu title (such as File or Edit).
2. Choose the desired command from the list that appears (see Figure 3-3).

Virtually every Macintosh application has some menus, such as File, Edit, and
Window. You're likely to find similar commands within these menus. However,
only two menus are in every Mac OS X application:

v The Apple menu (which is identified with that jaunty Apple Corporation
icon, ®).

v The Application menu (which always bears the name of the active appli-
cation). For instance, the DVD Player menu group appears when you run
the Snow Leopard DVD Player, and the Word menu appears when you
launch Microsoft Word.

I cover these two common menus in more detail in Chapters 4 and 5.
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You can also display a contextual menu — which regular human beings call a
right-click menu — by right-clicking your Snow Leopard Desktop, an applica-
tion, a folder, or a file icon. I get into the right-click menu in detail in Chapter 4.
(Because your MacBook is equipped with a trackpad, you can right-click by
tapping the trackpad with two fingertips.)

There’s always room for one more window

You're probably already familiar with the ubiquitous window itself. Both
Snow Leopard and the applications that you run use windows to display
things like

v The documents that you create

v The contents of your hard drive

For example, the window in Figure 3-1 is a Finder window, where Snow
Leopard gives you access to the applications, documents, and folders on
your system.

Windows are surprisingly configurable. I cover them at length in Chapter 4.

Why get so excited by Snow Leopard?

How the core of an operating system is designed makes more of a differ-
ence than all the visual bells and whistles, which tend to be similar between
Windows 7/Vista/XP and Mac OS X Snow Leopard (and Linux as well, for that
matter). Time for a Mark’s Maxim:

Sure, Snow Leopard’s elegant exterior is a joy to use, but Mac OS X is a
better OS than Windows because of the unique UNIX muscle that lies
underneath!™

So what should you and I look for in an OS? Keep in mind that today’s com-
puter techno-wizard demands three requirements for a truly high-powered
software wonderland — and Mac OS X Snow Leopard easily meets all three:

v Reliability: Your OS has to stay up and running reliably for as long as
necessary — I'm talking months here — without lockups or error mes-
sages. If an application crashes, the rest of your work should remain
safe, and you should be able to shut down the offending software.

v Performance: If your computer has advanced hardware, your OS must
be able to use those resources to speed things up big-time. The OS has
to be highly configurable, and it has to be updated often to keep up with
the latest in computer hardware.

www.it-ebooks.info


http://www.it-ebooks.info/

Chapter 3: The Laptop Owner’s Introduction to Mac 0S X

“Mark, what do you mean by advanced hardware?” Well, if you're already
knowledgeable about state-of-the-art hardware, examples include

e True 64-bit computing
e Multiple processors (like more than one Intel chip in your computer)

¢ A huge amount of RAM (2-4GB on most MacBooks, or up to 32GB
on today’s Mac Pro desktop computers)

¢ Enough hard drive space to make use of a RAID array

If all that sounds like ancient Sumerian, gleefully ignore this technical
drabble and keep reading.

1~ Ease of use: All the speed and reliability in the world can’t help an OS if
it’s difficult to use.

Like Windows done right

You may have heard of the Windows Switcher: a uniquely intelligent species
that’s becoming more and more common these days. Switchers are former
PC owners who have abandoned Windows and bought a Macintosh, thereby
joining the Apple faithful running Mac OS X. (Apple loves to document this
migration on its Web site.) Because today’s Macintosh computers are signifi-
cantly easier to use than their PC counterparts — and you get neat software,

such as Snow Leopard and the iLife suite when you buy a new Mac —

switching makes perfect sense.

It's Apple to the rescue!

UNIX is the established, super-reliable OS that
powers most of the high-performance serv-
ers that make up the Internet. UNIX has built-
in support for virtually every hardware device
ever wrought by the Hand of Man (including all
the cool stuff that came with your MacBook),
and UNIX is well designed and highly efficient.

Unfortunately, standard UNIX looks as hideous
as DOS, complete with a confusing command
line, so ease of use for normal human beings
like you and me goes out the door. Enter the
genius types at Apple, who understood several
years ago that all UNIX needed was a state-of-
the-art, novice-friendly interface! To wit: Mac
0S X was developed with a UNIX foundation

(or core), so it shares the same reliability and
performance as UNIX. However, the software
engineers at Apple (who know a thing or two
about ease of use) made it good looking and
easy to use.

If you're interested in all the details about what
makes Mac 0S X tick, as well as its settings and
features, | can heartily recommend another of
my books, the bestselling (and extremely
heavy) Mac 0S X Snow Leopard All-in-One For
Dummies (published by Wiley). It comprehen-
sively covers everything Snow Leopard — over
700 pages devoted entirely to Mac 0S X and its
companion applications!
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Switchers aren’t moving to totally unfamiliar waters. Windows XP/Vista/7 and
Snow Leopard share a number of important concepts. Familiarizing yourself
with Snow Leopard takes far less time than you might think.

Here’s an overview of the basic similarities between the two operating
systems:

1 The Desktop: The Snow Leopard Desktop is a neat representation of a
real physical desktop, and Windows uses the same idea:

* You can arrange files, folders, and applications on your Desktop to
help keep things handy.

¢ Application windows appear on the Desktop.

v~ Drives, files, and folders: Data is stored in files on your hard drive(s),
and those files can be organized in folders. Both Snow Leopard and
Windows use the same file/folder concept.

v Specific locations: Both Windows and Snow Leopard provide every
user with a set of folders to help keep various types of files organized.
For example, the My Videos folder that you can use in Windows XP cor-
responds to the Movies folder that you find in your Home folder within
Snow Leopard.

+»* Running programs: Both Snow Leopard and Windows run programs (or
applications) in the same manner:

¢ Double-clicking an application icon launches that application.

* Double-clicking a document runs the corresponding application
and then automatically loads the document.

v Window control: Yep, both operating systems use windows, and those
windows can be resized, hidden (or minimized), and closed in similar
fashions. (Are you starting to see the connections here?)

v Drag and drop: One of the basics behind a GUI (a ridiculous acronym
that stands for graphical user interface) like Windows and Snow Leopard
is the ability to drag documents and folders around to move, delete,
copy, and load them. Drag-and-drop is one of the primary advantages
of both of these operating systems because copying a file by dragging
it from one window to another is intuitive and easy enough for a kid to
accomplish.

v~ Editing: Along the same lines as drag-and-drop, both Snow Leopard and
Windows offer similar cut-and-paste editing features. You've likely used
Cut, Copy, and Paste for years, so this is familiar stuff.
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And Just in Case You Need Help . . .

You can call on these resources if you need additional help while you’re dis-
covering how to tame the Snow Leopard.

3

Some of the help resources are located on the Internet, so your Web browser
will come in handy.

The Snow Leopard built-in Help system

Sometimes the help you need is as close as the Help menu on the Finder
menu bar. You can get help for either of the following:

1 A specific application: Just click Help. Then, click in the Search box and
type a short phrase that sums up your query (such as startup keys).
You see a list of help topics appear on the menu. Just click a topic to dis-
play more information.

v General topics: Click a Finder window and then click Help on the menu
bar. Again, you see the Search box, and you can enter a word or phrase
to find within the Help system. To display the Help viewer window, click
the Mac Help item under the Search box.

The Apple Web-based support center

Apple has online product support areas for every hardware and software
product that it manufactures. Visit www.apple.com and click the Support

" tab at the top of the Web page.
o‘

The Search box works just like the Mac OS Help system, but the Knowledge
Base that Apple provides online has a lof more answers.

Magazines

Many magazines (both in print and online) offer tips and tricks on using and
maintaining Mac OS X Snow Leopard.

My personal online favorites are Macworld (www .macworld.com) and the
Wiley For Dummies Web site (www . dummies . com).
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Mac support Web sites

A number of private individuals and groups offer support forums on the Web,
and you can often find help from other Mac owners on these sites within a
few hours of posting a question.

I'm very fond of MacFixIt (www.macfixit.com)and Mac OS X Hints
(http://forums.macosxhints.com).

Mac newsgroups on Usenet

If you're familiar with Usenet newsgroups, you can find lots of help (typically
dispensed with a healthy dose of opinion) in newsgroups like comp . sys.
mac.systemand comp.sys.mac.applications. Simply post a message
and then check back within a few hours to read the replies.

Local Mac user groups

I'd be remiss if [ didn’t mention your local Mac user group. Often, a user
group maintains its own Web site and discussion forum. If you can wait until
the next meeting, you can even ask your question and receive a reply from a
real-live human being . . . quite a thrill in today’s Web-riffic world!
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Shaking Hands
with Mac 0S X

The 5th Wave By Rich Tennant
@ Rperinganr
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ant, but my channeling

energy through gour body’s chakras isn’t going
to increase your laptop’s battery life.”
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In this part . . .

t’s time to delve deeper into the workings of Mac OS X
Snow Leopard. Here, [ show you how to perform all
sorts of common tasks as well as how to customize your

system, how to change settings in System Preferences,
where your personal files are stored, and how to use the
latest Spotlight search technology to find anything you've
stored on your MacBook, MacBook Pro, or MacBook Air!
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Chapter 4

Opening and Closing and
Clicking and Such

In This Chapter
Introducing the highlights of the Finder
Coping with that missing trackpad button
Launching and quitting applications
Identifying and selecting icons and folders
Using keyboard shortcuts to speed things up
Managing windows in Snow Leopard

A h, the Finder — many admire its scenic beauty, but don’t ignore its
unsurpassed power nor its many moods. And send a postcard while
you're there.

Okay, so Snow Leopard’s Finder might not be quite as majestic as the mighty
Mississippi River, but it’s the basic toolbox that you use every single day
while piloting your MacBook. The Finder includes the most common ele-
ments of Mac OS X: window controls, common menu commands, icon fun
(everything from launching applications to copying files), network connec-
tions, keyboard shortcuts, and even emptying the Trash. In fact, one could
say that if you master the Finder and find how to use it efficiently, you're on
your way to becoming a power user! (My editor calls this the Finder “window
of opportunity.” She’s a hoot.)

That’s what this chapter is designed to do: This is your Finder tour guide,
and we'’re ready to roll.
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Using the All-Powerful Finder

This is a hands-on tour, with none of that, “On your right, you’ll see the historic
Go menu” for you! Time to get off the bus and start the tour with Figure 4-1, in
which I show you around the most important elements of the Finder. (In the
upcoming section, “Performing Tricks with Finder Windows,” I give you a close-
up view of window controls.)

The popular attractions include

»* The Apple menu (®): This is a special menu because it appears both
in the Finder and within every application menu bar that you run. It
doesn’t matter whether you're in iTunes or Photoshop or Word. If you
can see a menu bar, the Apple menu is there. The Apple menu contains
common commands to use no matter where you are in Snow Leopard,
such as Restart, Shut Down, and System Preferences.

Apple menu Finder menu bar Icons

|
Figure 4-1:
Snow
Leopard’s
friendliest
face —

the Finder,
complete
with a win-
dow and
menu bar.
|

Desktop Finder window Dock
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v+ The Finder menu bar: Whenever the Finder itself is ready to use (or, in
Mac-speak, whenever the Finder is the active application, rather than
another application), the Finder menu bar appears at the top of your
screen. You know the Finder is active and ready when the word Finder
appears at the left of the menu bar.

\‘&N\BER If you're brand new to computers, a menu is simply a list of commands.
For example, you click the File menu and then choose Save to save a
document. When you click a menu, it extends down so that you can see
the commands it includes. While the menu is extended, you can choose
any enabled menu item (just click it) to perform that action. You can tell
that an item is enabled if its name appears in black. Conversely, a menu
command is disabled if it is grayed out — clicking it does nothing.

When you see a menu path, like this example — Filer>Save — it’s just a
visual shortcut that tells you to click the File menu and then choose
Save from the drop-down menu that appears.

v The Desktop: Your Desktop serves the same purpose as your physical
desktop: You can store stuff here (files, alias icons, and so on), and it’s
a solid, stable surface where you can work comfortably. Application
windows appear on the Desktop, for example, as do other applications,
such as your Stickies notes and your DVD player. Just double-click an
application there to launch it.

“&N\BEI? Your Desktop is easily customized in many ways. For example, you can
& use your own images to decorate the Desktop, organize it to store new
folders and documents, arrange icons how you like, or put the Dock in
another location. Don’t worry — I cover all this in other areas of the
book — I just want you to know that you don’t have to settle for what
Apple gives you as a default Desktop.

v All sorts of icons: This is a Macintosh computer, after all, replete with
tons of make-your-life-easier tools. Check out the plethora of icons on
your Desktop as well as icons within the Finder window itself. Each icon
is a shortcut of sorts to a file, folder, network connection, or device in
your system, including applications that you run and documents that you
create. Refer to Figure 4-1 to see the icon for my MacBook Pro’s hard drive
icon, labeled Wolfgang. (I'm a huge Mozart fan.) Sometimes you click an
icon to watch it do its thing (like icons in the Dock, which [ cover next),
but usually you double-click an icon to make something happen.

v The Dock: The Dock is a launching pad for your favorite applications,
documents, folders, network connections, and Web sites. You can also
refer to it to see what applications are running. Click an icon there to
open the item. For example, the postage stamp icon represents the
Apple Mail application, and clicking the spiffy compass icon launches
your Safari Web browser.

v The Finder window: Finally! The basic Finder window in Figure 4-1 dis-
plays the contents of my Applications folder. You use Finder windows to
launch applications; perform disk chores, such as copying and moving
files; and navigate your hard drive.
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My, what an attractive Sidebar . . . and so useful!

Have you noticed the Sidebar that typically
occupies the left side of a Finder window? It's a
pane of links to common locations and devices
that you can use to jump like a flash to a spe-
cific spot on your hard drive. For example, you
can click the Applications link under the Places
heading, and you're there in an instant. The
Sidebar also contains a Search For heading
that displays the applications, files, and fold-
ers that you've accessed today, yesterday, and
this past week. (Heck, you can even search for
all the images, movies, and documents on your
system from this same Search For section!)

Here's a great example of Sidebar magic: | like
as few icons on my Desktop as possible, so
each book I'm working on gets its own folder.
All the items for that project that might other-
wise end up on my Desktop are saved to that
folder instead. In fact, | make a point of adding
my current book project folder to my Finder
window Sidebar so that it's available immedi-
ately from any Finder window. To do this, just
drag the folder into the column at the left side of
the Finder window and drop it under the Places
heading in the Sidebar's list.

Wait a Second: Where the Heck

Is the Mouse Button?

vq‘

NNG/

Snow Leopard takes a visual approach to everything, and what you see in

Figure 4-1 is designed for point-and-click convenience because the trackpad is
your primary navigational tool while you're using your Mac laptop. You move

your finger over the surface of the trackpad, and the cursor follows like an
obedient pup. The faster you move your finger, the farther the cursor goes.
You click an item, it opens, you do your thing, and life is good.

Never use any object other than your finger on the trackpad! That means no pen-

cils (no, not even the eraser end), pens, or chopsticks; they can damage your

trackpad in no time.

If you've grazed on the other side of the fence — one of Those Who Were
Once Windows Users — you’re probably accustomed to using a mouse with
at least two buttons. This brings up the nagging question: “Hey, Mark! Where

the heck are the buttons?”

In a nutshell, the buttons simply ain’t there if you’'re using your Mac laptop’s
trackpad. The entire surface of the trackpad can act as both buttons. To cus-
tomize how the trackpad operates, click the System Preferences icon in the
Dock and then click the Trackpad icon. From here you can
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v Select the Clicking check box: Now, when you tap once anywhere on
the trackpad quickly, your Mac laptop counts that as a click. Tap twice
quickly, and your MacBook recognizes that as a double-click.

1 Select the Tap Trackpad Using Two Fingers for Secondary Click check
box: Suddenly a single tap with two fingers displays the right-click menu
(which I cover in more detail in a paragraph or two).

v Adjust your tracking speed: Click and drag the Tracking speed slider to
speed up or slow down the rate at which your pointer moves.

I'll be honest here: When my laptop is on my desk at home, I plug in a
Logitech optical trackball (a really fancy mouse, in effect). This neat device
has two buttons and a scroll wheel, saving me wear and tear on my trackpad,
and offering even finer control within my applications. In fact, a new industry
is springing up for tiny USB mousing devices especially made for laptops.
Some devices are smaller than a business card, but they still carry a full com-
plement of two buttons and a scroll wheel.

In this book I'm going to refer to the pointer as the “mouse pointer,” whether
you're using your trackpad or a mouse. So here’s a Mark’s Maxim that I think
you’ll appreciate more and more as you use your laptop.

If you can afford a USB or wireless Bluetooth mouse or trackball for your
laptop, buy it. You can thank me later with an e-mail message, which you
can send to mark@mlcbooks.com.™

Doing the Multi-Touch thing

Today's crop of MacBooks have the smartest
trackpads on the planet! That's because Apple
now includes a feature called Multi-Touch,
which allows you to control the view of a docu-
ment by using specific finger motions on the
trackpad. At the time of this writing, here's the
rundown:

v Two-finger zooming: Pinching your thumb
and first fingertip toward each other on the
trackpad zooms in on a document or image.
The reverse (moving your fingertips away
from each other) zooms out. You can also
enable zooming with a modifier key within
the Trackpad pane in System Preferences.

v~ Two-finger rotating: Rotate your thumb and
first fingertip in a circle on the trackpad to
rotate an image or document in the corre-
sponding direction.

v~ Three-finger paging: Move your thumb and
first two fingertips to the left or right across
your trackpad to page through a document
or move to the next or previous image in
a set.

Unfortunately, Multi-Touch doesn’t work with
every application, but Apple software devel-
opers are rapidly adding support for this neat
feature. (For now, | recommend that you try out
your fingertips in iPhoto and Pages!)
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Figure 4-2:
Well-
adjusted
folks call
this a right-
click menu.
|

\\3

If you tap the trackpad with two fingertips (or click the right mouse button
on a USB mouse), Snow Leopard performs the same default function that

a right-click does in Windows. Namely, with a right-click on most items —
icons, documents, even your Desktop — you get a contextual menu of things.
That is, you get more commands specific to that item. (Boy, Howdy, [ hate
that word contextual, but that’s what engineers call it. I call it the right-click
menu, and [ promise to refer to it as such for the rest of the book.)

Figure 4-2 illustrates a typical convenient right-click menu within a Finder
window. I have all sorts of cool items at my disposal on this menu because of
the applications I've installed that make use of a right-click menu.

If you move two fingers over the surface of the trackpad at once, the Finder
window or application scrolis the contents of the window in the direction you
move. (For example, you can use the scroll function to move up and down
through the pages of a document or to move up and down through a long Web
page.) Who needs scroll bars?

Visit the Mouse pane within System Preferences to configure your wireless
mouse as well. (More on the System Preferences window in the next section.)
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Launching and Quitting Applications
with Aplomb

Now it’s time for you to pair your newly found trackpad acumen with Snow
Leopard’s Finder window. Follow along this simple exercise. Move your
cursor over the iTunes icon in the Dock (this icon looks like an audio CD with
a musical note on it). Then tap the trackpad once with your fingertip (see the
preceding section for how to set this preference). Whoosh! Snow Leopard
launches (or starts) the iTunes application, and you see a window much like
the one shown in Figure 4-3.

e If an application icon is already selected (which I discuss in the next section),

you can simply press 3+0 to launch it. The same key shortcut works with

documents, too.

|
Figure 4-3:
Click a Dock
icon to
launch that
application.
|
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Besides the Dock, you have several other ways to launch an application or
open a document in Snow Leopard:

1+ From the Apple menu (%): A number of different applications can
always be launched anywhere within Snow Leopard from the Apple
menu:

e System Preferences: This is where you change all sorts of settings,
such as your display background and how icons appear.

e Software Update: This uses the Internet to see whether update
patches are available for your Apple software, as [ discuss in
Chapter 23.

e Mac OS X Software: This launches the Safari browser and displays
software that you can download for your laptop.

v From the Desktop: If you have a document that you created or an appli-
cation icon on your Desktop, you can launch or open it here by double-
clicking that icon (tapping the trackpad twice with one finger in rapid
succession when the mouse pointer is on top of the icon).

<P Double-clicking a device or network connection on your Desktop opens
the contents in a Finder window. This works for CDs and DVDs that
you’ve loaded as well as external hard drives and USB flash drives. Just
double-click ’em to open them and display their contents in a Finder
window. Applications and documents typically launch from a CD, a
DVD, or an external drive just like they launch from your internal drive
(the one that’s typically named Macintosh HD), so you don’t have to
copy stuff from the external drive just to use it. Note, however, that run-
ning an application directly from your optical or external drive usually
results in that application running significantly slower. (Oh, and don’t
forget that you can’t change the contents of most CDs and DVDs; they’re
read-only, so you can’t write to them.)

v From the Recent Items selection: When you click the Apple menu and
hover your mouse pointer over the Recent Items menu item, the Finder
displays all the applications and documents that you used over the past
few computing sessions. Click an item in this list to launch or open it.

v From the Login Items list: Login Items are applications that Snow
Leopard launches automatically each time you log in to your user
account.

I cover Login Items in detail in Chapter 10.

v+ From the Finder window: You can also double-click an icon within the
confines of a Finder window to open it (for documents), launch it (for
applications), or display the contents (for a folder).
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Snow Leopard’s Quick Look feature can display the contents of just about any
document or file — but without actually opening the corresponding applica-
tion! Sweet. To use Quick Look from a Finder window, click a file to select it
and then click the Quick Look button (which bears an eye icon) on the Finder
window toolbar.

After you finish using an application, you can quit that application to close
its window and return to the Desktop. Here are a number of different ways to
quit an application:

1 Press 38+Q. This keyboard shortcut quits virtually every Macintosh
application on the planet. Just make sure that the application that you
want to quit is currently active first!

v+ Choose the Quit command from the application’s menu. To display
the Quit command, click the application’s name — its menu — from the
menu bar. This menu is always to the immediate right of the Apple (%)
menu. For example, Safari displays a Safari menu, and that same spot
in the menu is taken up by iCal when iCal is the active application. In
Figure 4-3, look for the iTunes menu, right next to €.

v Choose Quit from the Dock. You can Control-click (or right-click) an
application’s icon on the Dock and then choose Quit from the right-click
menu that appears. Alternatively, just click the icon and hold down the
button to display the same menu.

A running application displays a small blue dot under its icon on the
Dock.

v Click the Close button in the application window; refer to Figure 4-3.
Some applications quit entirely when you close their window, like the
System Preferences window or the Apple DVD Player. Other applications
might continue running without any window, like Safari or iTunes; to
close these applications, you have to use another method in this list.

v Choose Force Quit from the Apple menu. This is a last-resort mea-
sure! Use this only if an application has frozen and you can’t use
another method in this list to quit. Force-quitting an application doesn’t
save any changes to any open documents within that application!

Juaggling Folders and Icons

Finder windows aren’t just for launching applications and opening the files
and documents that you create. You can also use the icons within a Finder
window to select one or more specific items or to copy and move items from
place to place within your system.
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A field observer’s guide to icons

Not all icons are created equal. Earlier in this chapter, [ introduce you to your
MacBook’s hard drive icon on the Desktop, but here is a little background on
the other types of icons that you might encounter during your mobile Mac
travels:

v Hardware: These are your storage devices (such as your hard drive
and DVD drive) as well as external peripherals (such as your iPod and
printer).

v~ Applications: These icons represent the applications (or programs) that
you can launch. Most applications have a custom icon that incorporates
the company’s logo or the specific application logo, so they’re very easy
to recognize, as you can see in Figure 4-4. Double-clicking an application
usually doesn’t load a document automatically; you typically get a new
blank document, or an Open dialog box from which you can choose the
existing file you want to open.

|
Figure 4-4:
A collection
of some of
my favorite
application
icons.
|

v Documents: Many of the files on your hard drive are documents that can
be opened within the corresponding application, and the icon usually
looks similar to the application’s icon. Double-clicking a document auto-
matically launches the associated application (that is, as long as Mac OS
X recognizes the file type).

v Files: Most of the file icons on your system are mundane things (such as
preference and settings files, text files, log files, and miscellaneous data
files), yet most are identified with at least some type of recognizable
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icon that lets you guess what purpose the file serves. You'll also come
across generic file icons that look like a blank sheet of paper (used when
Snow Leopard has no earthly idea what the file type is).

v~ Aliases: An alias acts as a link to another item elsewhere on your system.
For example, to launch Adobe Acrobat, you can click an Adobe Acrobat
alias icon that you can create on your Desktop instead of clicking the
actual Acrobat application icon. The alias essentially acts the same way
as the original icon, but it doesn’t take up the same space — only a few
bytes for the icon itself, compared with the size of the actual applica-
tion. Plus, you don’t have to go digging through folders galore to find the
original application icon. (Windows Switchers know an alias as a shortcut,
and the idea is the same although Macs had it first. Harrumph.) You can
always identify an alias by the small curved arrow at the base of the icon,
and the icon might also sport the tag alias at the end of its name.

You have two ways to create an alias. Here’s one:
a. Select the item.
<P The following section has details about selecting icons.
b. Choose Filer>Make Alias, or press 38+L.

Figure 4-5 illustrates a number of aliases, arranged next to their
linked files.

|
Figure 4-5:
No, not the
popular
girl-spy

TV show.
These are
aliasicons
in Snow
Leopard.
|
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Here’s another way to create an alias:
a. Hold down 38+Option.
<P b. Drag the original icon to the location where you want the alias to be.

Note that this funky method doesn’t add the alias tag to the end
of the alias icon name!

So why bother to use an alias? Two good reasons:

v Launch an application or open a document from anywhere on your
drive. For example, you can start Pages directly from the folder where
you store the documents for your current Pages project. Speed, organi-
zation, and convenience . . . life is good.

v Send an alias to the Trash without affecting the original item. When
that school project is finished, you can safely delete the entire folder
without worrying about whether Keynote will run the next time you
double-click the application icon!

If you move or rename the original file, Snow Leopard is actually smart enough
to update the alias, too! However, if the original file is deleted (or if the original
is moved to a different volume, such as an external hard drive), the alias no
longer works. (Go figure.)

Selecting items

Often, the menu commands or keyboard commands that you perform in the
Finder need to be performed on something. Perhaps you’'re moving an item
to the Trash, getting more information on the item, or creating an alias for
that item. To identify the target of your action to the Finder, you need to
select one or more items on your Desktop or in a Finder window. In the fol-
lowing sections, [ show you just how to do that.

Selecting one thing

Snow Leopard gives you a couple of options when selecting just one item for
an upcoming action:

v Move your mouse pointer over the item and click. A dark border (or
highlight) appears around the icon, indicating that it’s selected.

v If an icon is already highlighted on your Desktop or within a window,
move the selection highlight to another icon in the same location by
using the arrow keys. To shift the selection highlight alphabetically,
press Tab (to move in order) or press Shift+Tab (to move in reverse
order).
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Figure 4-6:
Drag a box
around
icons to
select them.
|

Selecting items in the Finder doesn’t actually do anything to them by itself.
You have to perform an action on the selected items to make something
happen.

Selecting a whole bunch of things
You can also select multiple items with aplomb by using one of these methods:

v Adjacent items:

¢ Drag a box around them. If that sounds like ancient Sumerian,
here’s the explanation: Click a spot above and to the left of the first
item; then hold down the trackpad button and drag down and to
the right. (This is dragging in Mac-speak.) A box outline like the one
in Figure 4-6 appears, indicating what you're selecting. Any icons
that touch or appear within the box outline are selected when you
release the button.

e Click the first item to select it, and then hold down the Shift key while
you click the last item. Snow Leopard selects both items and every-
thing between them.

1 Nonadjacent items: Select these by holding down the 38 key while you
click each item.
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Check out the status line at the bottom of a Finder window. It tells you how
much space is available on the drive you're working in as well as how many
items are displayed in the current Finder window. When you select items, it
shows you how many you highlighted.

Copying items

Want to copy items from one Finder window to another, or from one location
(like a CD-ROM) to another (like your Desktop)? Tres easy. Just use one of
these methods:

»* On the same drive

e To copy one item to another location: Hold down the Option key
(you don’t have to select the icon first), and then click and drag
the item from its current home to the new location.

To put a copy of an item within a folder, just drop the item on top
of the receiving folder. If you hold the item that you're dragging
over the destination folder for a second or two, Snow Leopard
opens a new window so that you can see the contents of the target.
(This is called a spring-loaded folder. Really.) You can turn off this
spring-loaded behavior by clicking Finder=>Preferences and click-
ing the Spring-loaded Folders and Windows check box to disable it.

e To copy multiple items to another location: Select them all first (see
the previous section), hold down the Option key, and then drag
and drop one of the selected items where you want it. All the items
that you selected follow the item you drag. (Rather like lemmings.
Nice touch, don’t you think?)

To help indicate your target when you're copying files, Snow Leopard high-
lights the location to show you where the items will end up. (This works
whether the target location is a folder or a drive icon.) If the target location
is a window, Snow Leopard adds a highlight to the window border.

»* On a different drive

e To copy one or multiple items: Click and drag the icon (or the
selected items if you have more than one) from the original
window to a window you open on the target drive. (No need to
hold down the Option key while copying to a different drive.) You
can also drag one item (or a selected group of items) and simply
drop the items on top of the drive icon on your Desktop.

The items are copied to the top level, or root, of the target drive.
If you try to move or copy something to a location that already has an item
with the same name, you get a dialog that prompts you to decide whether to

replace the file or to stop the copy/move procedure and leave the existing
file alone. Good insurance, indeed.
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Moving things from place to place

Moving things from one location to another location on the same drive is the
easiest action you can take. Just drag the item (or selected items) to the new
location. The item disappears from the original spot and reappears in the
new spot.

Duplicating in a jiffy

If you need more than one copy of the same item within a folder, use the
Snow Leopard Duplicate command. [ use Duplicate often when | want to edit
a document but want to ensure that the original document stays pristine, no
matter what. I just create a duplicate and edit that file instead.

To use Duplicate, you can

v Click an item to select it and then choose Filez>Duplicate.
v Right-click the item and choose Duplicate from the menu.

+* Hold down the Option key and drag the original item to another spot in
the same window. When you release the trackpad button, the duplicate
file appears like magic!

The duplicate item has the word copy appended to its name. A second copy
is named copy?2, a third is copy3, and so on.

Duplicating a folder also duplicates all the contents of that folder, so creat-
ing a duplicate folder can take some time to create if the original folder was
stuffed full (or contained files several hundred megabytes or larger in size).
The duplicate folder has copy appended to its name, but the contents of the
duplicate folder keep their original names.

Keys and Keyboard Shortcuts
to Fame and Fortune

Your MacBook’s keyboard might not be as glamorous as your trackpad, but
any Macintosh power user will tell you that using keyboard shortcuts is usu-
ally the fastest method of performing certain tasks in the Finder, such as
saving or closing a file. | recommend committing these shortcuts to memory
and putting them to work as soon as you begin using your laptop so that they
become second nature to you as quickly as possible.
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Special keys on the keyboard

The Apple standard keyboard has a number of special keys that you might not
recognize — especially if you've made the smart move and decided to migrate
from the chaos that is Windows to Mac OS X! Table 4-1 lists the keys that bear
strange hieroglyphics on the Apple keyboard as well as what they do.

Table 4-1 Too-Cool Function Keys

Action Symbol Purpose

Media Eject V N Ejects a CD or DVD from your optical drive

[

Audio Mute < Mutes (and restores) all sound produced by
your MacBook

Keyboard . [ | Vs Increases, decreases, or turns off the

lllumination S Py brightness of your keyboard backlighting
(MacBook Air and MacBook Pro only)

Volume Up ‘ ))) Increases the sound volume

Volume Down ‘ ) Decreases the sound volume

Ctrl Displays right-click/Control+click menu with
trackpad

Command a8 Primary modifier for menus and keyboard
shortcuts

Delete Deletes selected text

Option Modifier for shortcuts

Using Finder and application
keyboard shortcuts

The Finder is chock-full of keyboard shortcuts that you can use to take care
of common tasks. Some of the handiest shortcuts are shown in Table 4-2.
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Table 4-2 Snow Leopard Keyboard Shortcuts of Distinction

Key Location Action
Combination
B+A Edit menu Selects all (works in the Finder, too)
#8+C Edit menu Copies the highlighted item to the Clipboard
88+H Application Hides the application
menu
8+M Window Minimizes the active window to the Dock (also
menu works in the Finder)
$8+0 File menu Opens an existing document, file, or folder
(also works in the Finder)
88+P File menu Prints the current document
88+Q Application Exits the application
menu
8+V Edit menu Pastes the contents of the Clipboard at the
current cursor position
8+X Edit menu Cuts the highlighted item to the Clipboard
¥8+Z Edit menu Reverses the effect of the last action you took
8+7? Help menu Displays the Help system (works in the Finder,
too)
88+Tab Finder Switches between open applications
&8+0ption+M Finder Minimizes all Finder windows to the Dock
38 +0ption+W Finder Closes all Finder windows

But wait, there’s more! Most of your applications also provide their own set of
keyboard shortcuts. While you're working with a new application, display the
application’s Help file and print a copy of the keyboard shortcuts as a handy
cheat sheet.

If you've used a PC before, you're certainly familiar with three-key shortcuts —
the most infamous being Ctrl+Alt+Delete, the beloved shut-down shortcut nick-
named the Windows Three-Finger Salute. Three-key shortcuts work the same
way in Snow Leopard (but you’ll be thrilled to know you won’t need to reboot
by using that notorious Windows shortcut!). If you’re new to computing, just
hold down the first two keys simultaneously and then press the third key.

You’re not limited to just the keyboard shortcuts listed above, either. Within
System Preferences, visit the Keyboard & Mouse pane and then click the
Keyboard Shortcuts button to change an existing shortcut or add another!
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Performing Tricks with Finder Windows

a\\J

In the following sections of your introduction to Mac OS X, I describe basic
windows management within Snow Leopard: how to move things around,
how to close windows, and how to make ’em disappear and reappear like
magic.

Scrolling in and resizing window's

Can you imagine what life would be like if you couldn’t see more than a single
window’s worth of stuff? Shopping would be curtailed quite a bit — and so
would the contents of the folders on your hard drives!

That’s why Snow Leopard adds scroll bars that you can click and drag to
move through the contents of the window. You can

v Click the scroll bar and drag it.

v Click anywhere in the empty area above or below the bar to scroll pages
one at a time.

+* Hold down the Option key and click anywhere in the empty area above
or below the bar to scroll to that spot in the document.

Of course, you can also drag two fingertips across the trackpad to scroll the
contents of a window (both vertically and horizontally). To control trackpad
behavior, open System Preferences, click the Keyboard & Mouse pane, and
then click the Trackpad tab. You can read all about this in the earlier section,
“Wait a Second: Where the Heck Is the Mouse Button?”

Figure 4-7 illustrates both vertical and horizontal scroll bars in a typical
Finder window.

Often, pressing your Page Up and Page Down keys moves you through a docu-
ment one page at a time. Also, pressing your arrow keys moves your insertion
cursor one line or one character in the four compass directions.

You can also resize most Finder and application windows by enlarging or
reducing the window frame itself. Move your mouse pointer over the Resize
handle in the lower-right corner of the window (which smartly bears a
number of slashed lines to help it stand out) and then drag the handle in any
direction until the window is the precise size you need.
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Minimizing and restoring window's

Resizing a window is indeed helpful, but maybe you simply want to banish
the doggone thing until you need it again. That’s a situation for the Minimize
button, which also appears in Figure 4-7. A minimized window disappears
from the Desktop but isn’t closed. It simply reappears in the Dock as a min-
iature icon. Minimizing a window is easy: Move your mouse pointer over
the Minimize button at the upper-left corner of the window — a minus sign
appears in the button to tell you that you're on target — and then click.
Here’s a good shortcut: Double-clicking the window’s title bar (that’s the

top frame of the window, which usually includes a document or application
name) minimizes the window.

Hold down the Shift key while you minimize, and prepare to be amazed when
the window shrinks in slow motion like Alice in Wonderland!
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Only one window can be active at once™

Yes, here's a very special Mark’s Maxim in the Tip: You can still use a window's Close,
Mac 0S X universe: Minimize, and Zoom buttons when it's
inactive.

You can always tell which window is active:

3

v The active window is on top of other
windows.

Only one application window can be
active in Snow Leopard at any time.™ v Any input you make by typing or by moving

your finger on the trackpad appears in the
active window.

v Mac 0S X dims the title bars of inactive
windows that you haven't minimized.

To restore the window to its full size again (and its original position on the
Desktop), just click its window icon on the Dock.

Moving and zooming window's

Perhaps you want to move a window to another location on the Desktop so
that you can see the contents of multiple windows at the same time. Click the
window’s title bar and drag the window anywhere you like. Then release the
button. (Don’t click the icon in the center of the title bar, though. You won’t
move the window, just the icon itself.)

Many applications can automatically arrange multiple windows for you.
Choose Windowr>Arrange All (if this option appears).

To see all that a window can show you, use the Zoom feature to expand any
Finder or application window to its maximum practical size. (This is differ-
ent from zooming with the Multi-Touch feature because you're expanding
only the window — and not an image or a document.) Note that a zoomed
window can fill the entire screen, or (if that extra space isn’t applicable

for the application) the window might expand only to a larger part of the
Desktop. To zoom a window, move your mouse pointer over the button (as
shown in Figure 4-7) at the upper-left corner of the window. When the plus
sign appears in the Zoom button, click to claim the additional territory on
your Desktop. (You can click the Zoom button again to automatically return
the same window to its original dimensions.)
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Toggling toolbars the Snow Leopard way

It's time to define a window control that's actu-
ally inside the window for a change. A toolbar
is a strip of icons that appears under the win-
dow’s title bar. These icons typically perform
the most common actions within an appli-
cation; the effect is the same as if you use a
menu command or press a keyboard shortcut.
Toolbars are very popular these days. You see
‘em within everything from the Finder window
to most application windows.

Closing windows

When you're finished with an application or no longer need to have a window

You can banish a window's toolbar to make
extra room for icons, documents, or whatever
it happens to be holding. Just click the little
lozenge-shaped button at the right corner of the
window. (You guessed it — the Toolbar button
is also shown in Figure 4-7.) Note: If you toggle
the Finder toolbar off, you also lose the Finder
window Sidebar.

open, move your mouse pointer over the Close button at the upper-left

corner of the window. When the X appears in the button, click it. (And yes, I
can get one more reference out of Figure 4-7, which I'm thinking of nominat-

ing as Figure of the Year.)

If you have more than one window open in the same application and you want

to close ’em all in one swoop, hold down the Option key while you click the
Close button in any of the windows.

If you haven’t saved a document and you try to close that application’s

/7

window, the application gets downright surly and prompts you for confirma-
tion. “Hey, human, you don’t really want to do this, do you?” If you answer in
the affirmative — “Why, yes, machine. Yes, indeed, | do want to throw this
away and not save it.” — the application discards the document that you were
working on. If you decide to keep your document (thereby saving your poste-
rior from harm), you can either save the document under the same filename
or under a new name.

www.it-ebooks.info


http://www.it-ebooks.info/

/8  Partii: Shaking Hands with Mac 0 X

www.it-ebooks.info


http://www.it-ebooks.info/

Chapter 5

Getting to the Heart
of the Snow Leopard

In This Chapter

Making the most of your Home folder

Arranging your Desktop for greater efficiency

Adding timesavers to the Dock

Using the Trash (and rescuing precious stuff from it)

Using Dashboard, Exposé, and Spaces, to perform Desktop magic

Printing documents

then you’re no longer a novice to Snow Leopard and the basics of the
Finder, turn your attention to a number of more advanced topics 'n

tricks to turn you into a MacBook power user — which, after all, is the goal of
every civilized consciousness on Planet Earth.

Consider this chapter a grab bag of Snow Leopard knowledge. Sure, [ jump
around a little, but these topics are indeed connected by a common thread:
They’re all surefire problem solvers and speeder-uppers. (I can’t believe the
latter is really a word, but evidently it is. My editors told me so.)

Home, Sweet Home Folder

Each user account that you create within Snow Leopard is actually a self-con-
tained universe. For example, each user has a number of unique characteris-
tics and folders devoted just to that person, and Snow Leopard keeps track of
everything that user changes or creates. (In Chapter 10, [ describe the innate
loveliness of multiple users living in peace and harmony on your laptop.)
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This unique universe includes a different system of folders for each user
account on your system. The top-level folder uses the short name that Snow
Leopard assigns when that user account is created; don’t necessarily look for
a folder named “Home.” Naturally, the actual folder name is different for each
person, and Mac techno-types typically refer to this folder as your Home
folder. (On the Sidebar, look for the teeny house icon under the Places head-
ing, marked with your account name.)

Each account’s Home folder contains a set of subfolders, including

v Movies
v Music
v Pictures

v Downloads (for files you download by using Safari or through Apple Mail
attachments)

v~ Sites (for Web pages created by the user)

v Documents (created by the user)

Although you can store your stuff at the root (top level) of your hard drive,
that gaggle of files, folders, and aliases can get very crowded and confusing
very quickly. Here’s a Mark’s Maxim to live by:

Your Home folder is where you hang out and where you store your stuff.
Use it to make your computing life much easier!™

Create subfolders within your Documents folder to organize your files and
folders even further. For example, | always create a subfolder in my
Documents folder for every book that [ write so that I can quickly and easily
locate all the documents and files associated with that book project.

[ discuss security within your Home folder and what gets stored where in
Chapter 10. For now, Figure 5-1 shows how convenient your Home folder is
to reach because it appears in the Finder window Sidebar. One click of your
Home folder, and all your stuff is in easy reach.

In addition to the Finder window Sidebar, you can also reach your Home
folder in other convenient ways:

v From the Go menu: Choose Go=>Home to display your Home folder

immediately from the Finder window. Alternatively, you can press
38 +Shift+H to accomplish the same thing.
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|
Figure 5-1:
Your Home
folderis
the central
location
for all your
stuff on your
MacBook.
|
v From within Open and Save dialogs: Snow Leopard’s standard File
Open and File Save dialogs also include the same Home folder (and sub-
folder) icons as the Finder window Sidebar.
v+ Within any new Finder window you open: If you like, you can set every
Finder window that you open to automatically display your Home folder:
a. Choose Finder=>Preferences to display the dialog that you see in
Figure 5-2.
b. Click the arrow button at the right side of the New Finder Windows
Open pop-up menu.
A menu pops up (hence, the name).
c. Click the Home entry in the menu.
d. Click the Close button at the upper-left corner of the dialog.
You're set to go. From now on, every Finder window you open dis-
plays your Home folder as the starting location!
3

Here’s another reason to use your Home folder to store your stuff: Snow
Leopard expects your stuff to be there when you migrate your files from an
older Mac to a new Mac.
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|
Figure 5-2:
Set Snow
Leopard to
open your
Home folder
within new
Finder
windows.
|

Personalizing Vour Desktop

Most folks put all their documents, pictures, and videos on their Snow
Leopard Desktop because the file icons are easy to locate! Your computing
stuff is right in front of you . . . or is it?

Call me a finicky, stubborn techno-oldster — go ahead, [ don’t mind — but

[ prefer a clean Snow Leopard Desktop without all the iconic clutter. In

fact, my Desktop usually has just three or four icons even though I use my
MacBook Pro several hours every day. It’s an organizational thing; I work
with literally hundreds of applications, documents, and assorted knickknacks
daily. Sooner or later, you’ll find that you're using that many, too. When you
keep your stuff crammed on your Desktop, you end up having to scan your
screen for one particular file, an alias, or a particular type of icon, which ends
up taking you more time to locate on your Desktop than in your Documents
folder! And don’t forget, open windows hang out on your Desktop too — in
order to find anything, you have to close or move those windows!

Plus, you'll likely find yourself looking at old icons that no longer mean

anything to you or stuff that’s covered in cobwebs that you haven’t used in
years. Stale icons . . . yuck.
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N [ recommend that you arrange your Desktop so that you see only a couple of

icons for the files or documents that you use the most. Leave the rest of the
Desktop for that cool image of your favorite actor or actress.

Besides keeping things clean, I can recommend a number of other favorite
tweaks that you can make to your Desktop:

1 Keep Desktop icons arranged as you like.
a. From the Finder menu, choose View->Show View Options.
b. Select the Arrange By check box.

c. From the pop-up menu, choose the criteria that Snow Leopard uses to
automatically arrange your Desktop icons, including the item name,
the last modification date, or the size of the items.

I personally like things organized by name, but many MacBook
owners prefer to see things organized by date (putting the most
recently modified at the top, for example).

v+ Choose a favorite background.

a. Hold down the Control key while you click any open spot on your
Desktop. (Or, if you use a pointing thing with a right mouse button,
click that instead.)

b. From the right-click menu that appears, choose Change Desktop
Background.

The Desktop & Screen Saver pane appears, as shown in Figure 5-3.
Browse through the various folders of background images that
Apple provides or use an image from your iPhoto library.

|
Figure 5-3:
Choose a
Desktop
background
of more
interest.
|
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v Display all the peripherals and network connections on your system.
a. Choose Finder~>Preferences.

b. Make sure that all four of the top check boxes (Hard Disks; External
Disks; CDs, DVDs, and iPods; and Connected Servers) are selected.

If you're connected to an external network or you've loaded an
external hard drive or device, that shows up on your Desktop. You
can double-click that Desktop icon to view your external stuff.

Customizing the Dock Just So

If the Dock seems like a nifty contraption to you, you're right again — it’s like
one of those big control rooms that NASA uses. From the Dock — that icon
toolbar at the bottom of Snow Leopard’s Desktop — you can launch an appli-
cation, monitor what’s running, and even use the pop-up menu commands

to control the applications that you launch. (Hey, that NASA analogy is even
better than I thought!)

By default, the Dock hangs out at the bottom of your screen, but you can
move it to another edge, change the size of the icons, or even hide it until you
need it. (You can find more details on customizing your Dock in Chapter 6.)

When you launch an application — either by clicking an icon on the Dock
or by double-clicking an icon in a Finder window or the Desktop — the icon
begins to bounce hilariously on the Dock to indicate that the application

is loading. (So much for my Mission Control analogy.) After an application
is running, the application icon appears on the Dock with a shiny blue dot
underneath. Thusly, you can easily see what’s running at any time just by
<MBER glancing at the Dock.

s&‘

You can hide most applications by pressing $+H.

Adding Dock icons

Ah, but there’s more: The Dock can offer more than just a set of default icons!
You can add your own MIS (or Most Important Stuff) to the Dock, making it the
most convenient method of taking care of business without cluttering your
Desktop. You can add

v~ Applications: Add any application to your Dock by dragging the applica-
tion icon into the area to the left of the separator line (the vertical dotted
line on the Dock that appears between applications and folders or docu-
ments). The existing Dock icons move aside so that you can place the
new neighbor in a choice location.
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Do not try to add an application anywhere to the right of the separator
line. You can’t put applications there — and Snow Leopard might even
think that you want the application dumped in the Trash! (You can, how-
ever, add a Stack filled with applications. I discuss Stacks in greater
detail later in this chapter.)

v Folders: Here’s where you want to add things to the area to the right of
the separator line. A folder or volume icon that you drag to the Dock is
called a Stack in Snow Leopard, and you can display the contents with a
single click. (The contents of the folder “fan out” into a half-circle or grid
arrangement, depending on the number of items in the folder.) To open
or launch an item, just click it in the Stack display. Folders that include
many items are displayed in a grid view.

Snow Leopard already includes two Stacks in the Dock by default: your
Documents folder and your Downloads folder.

v Web URLs: Sure, you can add your favorite Web site from Safari! Drag it
right from the Safari address bar into the area to the right of the separator
line. When you click the URL icon, Safari opens the page automatically.

Removing Dock icons

You can remove an icon from the Dock at any time (as long as the applica-

tion isn’t running). In fact, I always recommend that every Snow Leopard user
remove the default icons that never get used to make more room available for
your favorite icons. The only two icons you can’t remove are the Finder and
the Trash icons. To remove an icon from the Dock, just click and drag it off the
Dock. You're rewarded with a ridiculous puff of smoke straight out of a Warner
Brothers cartoon! (One of the Mac OS X developers was in a fun mood, I guess.)

When you delete an icon from the Dock, all you delete is the Dock icon. The
original application, folder, or volume is not deleted.

Using Dock icon menus

From the Dock menu, you can open documents, open the location in a Finder
window, set an application as a Login Item, control the features in some
applications, and other assorted fun, depending on the item.

To display the right-click Dock menu for an icon

1. Move your mouse over the icon.
2. Right-click.

Note that you can also press the Control key and click the icon, or even
hold down the left mouse button for a second or two.
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[ cover the Dock settings that you can change within System Preferences in
Chapter 6. You can also change the same settings from the Apple menu if you
hover your mouse over the Dock menu item, which displays a submenu with
the settings.

What's with the Trash?
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Another sign of a Mac laptop power user is a well-maintained Trash can. It’s
a breeze to empty the discarded items you no longer need, and you can even
rescue something that you suddenly discover you still need!

The Snow Leopard Trash icon resides on the Dock, and it works just like the
Trash has always worked in Mac OS X: Simply drag selected items to the
Trash to delete them.

Note one very important exception: If you drag a Desktop icon for an external
device or removable media drive to the Trash (such as an iPod, iPhone, DVD,
or an external hard drive), the Trash icon automatically turns into a giant
Eject icon, and the removable device or media is ejected or shut down — not
erased. Repeat, not erased. (That’s why the Trash icon changes to the Eject
icon — to remind you that you're not doing anything destructive.)

Here are other methods of chunking items you select to go to the wastebasket:

v Choose FileMove to Trash.

v Click the Action button on the Finder toolbar and choose Move to Trash
from the list that appears.

1 Press 88+Delete.

v Right-click the item and choose Move to Trash from the menu that
appears.

You can always tell when the Trash contains at least one item because the
basket icon is full of crumpled paper! However, you don’t have to unfold a
wad of paper to see what the Trash holds. Just click the Trash icon on the
Dock to display the contents of the Trash. To rescue something from the
Trash, drag the item(s) from the Trash folder to the Desktop or any other
folder in a Finder window. (If you're doing this for someone else who’s not
familiar with Snow Leopard, remember to act like it was a lot of work, and
you’ll earn big-time DRP, or Data Rescue Points.)

When you’re sure that you want to permanently delete the contents of the
Trash, use one of these methods to empty the Trash:
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Previewing images and documents
the Snow Leopard way

Snow Leopard’s Quick Look feature (available
on the Finder window toolbar) has garnered a
lot of attention within the technology press, and
rightly so. Just select a file and click the Quick
Look button (or just press the spacebar), and
Snow Leopard instantly displays the contents
of the document or image, without opening the
application. Heck, I've been waiting for such a
magic lamp for two decades now!

However, don’t forget that Mac 0S X has
always offered a Swiss Army knife applica-
tion for viewing image files and documents,
namely, Preview. You can use Preview to dis-
play digital photos in several popular image
formats, including TIFF, GIF, PICT, PNG, JPEG,
and Windows Bitmap. You can also display PDF
documents without any additional software.

| know, if that were the sum total of Preview's
features, it wouldnt deserve coverage here. So,
what else can it do? Here's a partial list (just my
favorites, mind you):

v Use Preview to add a bookmark at the cur-
rent page within a PDF document by choos-
ing Bookmarks=>Add Bookmark.

v~ Fill out a formin a PDF document by choos-
ing Tools=>Text Tool.

Click an area that's marked as an input
field, and you can type text into that field.

After you complete the form, you can fax or
print it.

v Take a screen snapshot (saving the con-
tents of your screen as a digital photo) by
choosing Filer>Grab=>Timed Screen.

Preview launches the Grab utility, which
displays an on-screen timer and then snaps
the image for you after ten seconds. (This
gives you time to get things just right before
saying, “Cheese!”)

v Convert an image into another format or
into a PDF file by choosing File=>Save As.

If a PDF document can be edited, you can
delete or insert pages at will.

v Resize or rotate an image by using the com-
mands on the Tools menu.

Snow Leopard automatically loads Preview
when you double-click an image in a format
that it recognizes or when you double-click
a PDF file. It also acts as the Print Preview
window, as you can read elsewhere in this
chapter. However, if you want to launch
Preview manually, open a Finder window, click
the Applications folder in the Sidebar, and then
double-click the Preview icon.

v Choose Finder~>Empty Trash.

v Choose Finder=>Secure Empty Trash.

If security is an issue around your laptop and you want to make sure
that no one can recover the files you've sent to the Trash, using the
Secure Empty Trash command takes a little time but helps to ensure

that no third-party hard drive repair or recovery program could resusci-

tate the items you discard.
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v Press 38+Shift+Delete.

v Right-click the Trash icon on the Dock and then choose Empty Trash
from the menu that appears.

Working Magic with Dashboard,
Exposé, and Spaces

3

MacBook power users tend to wax enthusiastic over the convenience fea-
tures built into Snow Leopard. In fact, we show ’em off to our PC-saddled
friends and family. Three of the features that I've demonstrated the most to
others are Snow Leopard’s Dashboard display, the amazing convenience of
Exposé, and the brand-new Spaces Desktop manager. In the following sec-
tions, I show ’em off to you as well. (Then you can become the Snow Leopard
evangelist on your block.)

Using Dashboard

The idea behind Dashboard is deceptively simple yet about as revolutionary
as it gets for a mainstream personal computer operating system. Dashboard
is an alternate Desktop that you can display at any time by using the key-
board or your mouse; the Dashboard desktop holds widgets (small applica-
tions that each provide a single function). Examples of default widgets that
come with Snow Leopard include a calculator, a world clock, a weather dis-
play, and a dictionary/thesaurus.

Oh, did [ mention that you’re not limited to the widgets that come with Snow
Leopard? Simply click the plus button at the bottom of the Dashboard display
and drag new widgets to your Dashboard from the menu at the bottom of the
screen. To remove a widget while you're in this mode, click the X icon that
appears next to each widget. When you're done with your widgets — that
sounds a bit strange, but [ mean no offense — press the Dashboard key again
to return to your Desktop. Finding (and potentially changing) the Dashboard
key is described later in this section.

Widgets can also be rearranged any way you like by dragging them to a new
location.

Simple applications like these are no big whoop — after all, Mac OS X has
always had a calculator and a clock. What’s revolutionary is how you access
your widgets. You can display and use them anywhere in Snow Leopard,

at any time, by simply pressing the Dashboard key. The default key is F4,
although you can change the Dashboard key via the Exposé & Spaces pane
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within System Preferences (or even turn it into a key sequence, such as
Option+F4). You can also click the Dashboard icon on the Dock to summon
your Dashboard widgets and then banish the Dashboard when you’re done.

A WebClip widget is a portion of a Web page that can include text, graphics,
and links, which Dashboard updates every time you display your widgets.
Think about that for a second: Dynamic displays, such as weather maps, car-
toons, and even the Free Music Download image from the iTunes Store, are
all good sources of WebClip widgets! (That last one is a real timesaver.)

Snow Leopard even allows you to create your own Dashboard widgets! That’s
right, this new feature is sure to be a winner amongst the In Crowd. Follow
these steps to create a new WebClip Dashboard widget from your favorite
Web site:

1. Run Safari and navigate to the site you want to view as a widget.

2. Click the Open This Page in Dashboard button on the Safari toolbar,
which bears a pair of scissors and a dotted box.

3. Select the portion of the page you want to include in your widget.

Most Web pages use frames to organize and separate sections of a page,
so this step allows you to choose the frame with the desired content.

4. Drag the handles at the edges of the selection border to resize your
widget frame to the right size, and then click Add.

Bam! Snow Leopard displays your new WebClip widget within the
Dashboard.

When you click a link in a WebClip widget, Dashboard loads the full Web page
in Safari, so you can even use WebClips for surfing chores with sites you visit
often.

Switching between apps with Exposé

Most MacBook owners are comfortable using the 38+Tab keyboard shortcut
to switch between open applications. If you’ve moved to the Mac from a PC
running Windows, you might think this simple shortcut is all there is to it. Ah,
dear reader, you're in Snow Leopard territory now!

Exposé is a rather racy-sounding feature, but (like Dashboard) it’s really all
about convenience. If you typically run a large number of applications at the
same time, Exposé can be a real timesaver, allowing you to quickly switch
between a forest of different application windows (or display your Desktop
instantly without those very same windows in the way). The feature works in
three ways:
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1 Press the All Windows key (or key sequence) to display all your applica-
tion windows on a single screen, as shown in the truly cool Figure 5-4.
(By default, F3 is the All Windows key.)

Then just click the window that you want to make active.

v Press the Application Windows key (or key sequence) to display all the
windows that have been opened by the active application. (By default,
Control+F3 is the Application Windows key sequence.)

This comes in handy with those mega-applications like Photoshop
Elements or FileMaker Pro, in which you often have three or four win-
dows open at one time. Again, you can click the window that you want
to make active.

1 Press the Desktop key (or key sequence) to move all your applica-
tion and Finder windows to the sides of your Desktop so that you
can access your Desktop icons. (The default Desktop key sequence is
Command+F3.)

After you’re done with your Desktop and you want to restore your win-
dows to their original locations, press the Desktop key (Command+F3)
again to put things back.

|
Figure 5-4:
With
Exposé,

you can
instantly

see every
open appli-
cation’s
window(s).
|
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|
Figure 5-5:
With
Spaces,

you can
instantly
switch
between
multiple
desktops!
|

Switching between desktops with Spaces

Ah, but what if you want to switch to an entirely different set of applications?
For example, suppose that you're slaving away at your pixel-pushing job,
designing a magazine cover with Adobe Illustrator. Your page design desktop
also includes Photoshop and Aperture, which you switch between often by
using one of the techniques I just described. Suddenly, however, you realize
that you need to schedule a meeting with others in your office by using iCal,
and you also want to check your e-mail in Apple Mail. What to do?

Well, you could certainly launch those two applications on top of your graph-
ics applications and then minimize or close them. With Snow Leopard’s

new Spaces feature, though, you can press the Control+« or Control+—
sequences to switch to a completely different “communications applications”
desktop, with iCal and Apple Mail windows already open and in your favor-
ite positions! Figure 5-5 illustrates the Spaces screen, showing two available
desktops.

After you’re done setting up your meeting and answering any important
e-mail, simply press Control+« or Control+— again to switch back to your
“graphics” desktop, where all your work is exactly as you left it!
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Now imagine that you've also created a custom “music” desktop for
GarageBand and iTunes . . . or perhaps you joined iWeb, Safari, and iPhoto
as a “Webmaster” desktop. See why everyone’s so excited? (Let’s see
Windows 7 do that out of the box.)

Unlike Exposé, Spaces has to be enabled and configured before you can use
it. You can create new desktops, customize your desktops, and even choose
a different set of key sequences to activate Spaces from within System
Preferences. For the complete story on configuring Spaces, see Chapter 6.

You can activate Exposé, Spaces, and Dashboard by using your mouse rather
than the keyboard. Follow these steps:

1. Click the System Preferences icon on the Dock.

2. Click the Exposé & Spaces icon to display the settings.

3. Click the desired Screen Corner pop-up menu to choose what function
that screen corner will trigger.

4. Press 3+Q to save your changes and then exit System Preferences.

When you move your mouse pointer to that corner, the feature you've
specified automatically kicks in.

Printing Within Mac 0S X

Snow Leopard makes document printing a breeze. Because virtually all Mac
printers use a Universal Serial Bus (USB) port, setting up printing couldn’t
be easier. Just turn on your printer and connect the USB cable between the
printer and your MacBook; Snow Leopard does the rest.

Printer manufacturers supply you with installation software that might add
cool extra software or fonts to your system. Even if Snow Leopard recognizes
your USB printer immediately, [ recommend that you still launch the manufac-
turer’s Mac OS X installation disc. For example, my new Epson printer came
with new fonts and a CD/DVD label application, but I wouldn’t have ’em if
hadn’t installed the Epson software package.

After your printer is connected and installed, you can use the same pro-
cedure to print from within just about every Mac OS X application on the
planet! To print with the default page layout settings — standard 8/%-x-11-inch
paper, portrait mode, no scaling — follow these steps:
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|
Figure 5-6:
Preparing

to print

the Great
American
Novel.
|

. Within the active application, choose File~>Print or press the 38+P

shortcut.

Mac OS X displays the Print sheet, as shown in Figure 5-6. Depending on
the application, you may see a thumbnail image of the printed document.

. Click the Printer pop-up menu and select the printer to which you

want to print.

On this pop-up menu, Snow Leopard displays all the printers that
you can access. You can print from a different printer connected to
your laptop or print over a network connection to a shared printer on
another computer.

. If you want to check what the printed document will look like, click

Preview.

Snow Leopard opens the document within the very same Preview appli-
cation I discuss earlier in this chapter.

. If you have to make changes to the document or you need to change

the default print settings, click Cancel to return to your document.

(You have to repeat Step 1 to display the Print dialog again.)
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5. If everything looks good at this point and you don’t need to change

any settings (like making multiple copies or printing only a portion of
the document), click Print — you’re done! If not, click the Expand
button next to the Printer pop-up menu. (It bears a downward-
pointing arrow.)

Now you can proceed with the following steps.

. (Optional) For more than one copy, click in the Copies field and type

the number of copies that you need.

Collation (separating copies) is also available, and it doesn’t cost a thing!

. (Optional) To print a range of selected pages, select the From radio

button and then enter the starting and ending pages.

To print the entire document, leave the default Pages option set to All.

. (Optional) If the application offers its own print settings, such as col-

lating and grayscale printing, make any necessary changes to those
settings.

To display these application-specific settings, click the pop-up menu in
the Print dialog and choose the desired settings pane that you need to

adjust. (You can blissfully ignore these settings and skip this step if the
defaults are fine.)

9. When you’re set to go, click Print.

You can also save an electronic version of a document in the popular Adobe
Acrobat PDF format from the Print dialog — without spending money on
Adobe Acrobat. (Slick.) Follow these steps:

1. Click the PDF button to display the destination pop-up menu.
2. Click Save as PDF.

Snow Leopard prompts you with a Save As dialog, where you can type
a name for the PDF document and specify a location on your hard drive
where the file should be saved.

Heck, if you like, you can even fax a PDF (with an external USB modem) or
send it as an e-mail attachment! Just choose these options from the destina-
tion list instead of choosing Save as PDF.
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A Nerd's Guide to System
Preferences

In This Chapter

Navigating System Preferences
Searching for specific controls

Customizing Snow Leopard from System Preferences

R emember the old TV series Voyage to the Bottom of the Sea? You always
knew you were on the bridge of the submarine Seaview because it had
an entire wall made up of randomly blinking lights, crewmen darting about
with clipboards, and all sorts of strange and exotic-looking controls on

every available surface. You could fix just about anything by looking into the
camera with grim determination and barking out an order. After all, you were
On The Bridge. That’s why virtually all the dialog and action inside the sub
took place on that one (expensive) set: It was the nerve center of the ship,
and a truly happenin’ place to be.

In the same vein, | devote this entire chapter to the System Preferences
window and the most commonly used settings within it. After all, if you want
to change how Snow Leopard works or customize the features within our
favorite operating system, this one window is the nerve center of Mac OS X,
and a truly happenin’ place to be. (Sorry, no built-in wall of randomly blinking
lights — but you do find exotic controls just about everywhere.)

An Explanation (In English, No Less)

The System Preferences window (shown in Figure 6-1) is a self-contained
beast, and you can reach it in a number of ways:
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|
Figure 6-1:
The power-
house of
settings and
switches:
System
Prefer-
ences.
|

v~ Click the Apple menu (%) and choose the System Preferences menu item.
v Click the System Preferences icon on the Dock — it’s a collection of gears.

v Click the Apple menu (#), choose Dock, and then choose the Dock
Preferences menu item.

v Click the Time and Date display in the Finder menu and then choose the
Open Date and Time menu item.

v Control-click (or right-click) any uninhabited area of your Desktop and
then choose Change Desktop Background.

v Click most of the Finder menu status icons and then choose the Open
Preferences menu item. (This includes the Bluetooth, AirPort, Display,
Modem, and Clock icons.)

When the System Preferences window is open, you can click any of the group
icons to switch to that group’s pane; the entire window morphs to display the
settings for the selected pane. For example, Figure 6-2 illustrates the Sound
pane, which allows you to set a system alert sound, configure your MacBook’s
built-in microphone, and choose from several different output options.

Many panes also include a number of tabbed buttons at the top — in this
case, Sound Effects, Output, and Input. You can click these tabs to switch to
another panel within the same pane. Many panes within System Preferences
have multiple panels. This design allows our friends at Apple to group a large
number of related settings together in the same pane (without things getting
too confusing).

To return to the top-level System Preferences pane from any other pane, just
click the Show All button (upper left) or press 38+L. You can also click the famil-
iar Previous and Next buttons to move backward through the panes you've
already visited and then move forward again, in sequence. (Yep, these buttons
work just like the browser controls in Safari. Sometimes life is funny that way.)
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|
Figure 6-2:
The Sound
pane,
proudly
showing off
the Sound
Effects
panel.
|

You won'’t find an OK button that you have to click to apply any System
Preference changes — Apple’s developers do things the right way. Your
changes to the settings in a pane are automatically saved when you click
Show All or when you click the Close button in the System Preferences
window. You can also press 8+Q to exit the window and save all your
changes automatically . . . a favorite shortcut of mine.

If you see an Apply button in a pane, you can click it to immediately apply any
changes you made, without exiting the pane. This is perfect for some settings
that you might want to try first before you accept them, like many of the con-
trols in the Network pane. However, if you're sure about what you changed and
how those changes will affect your system, you don’t have to click Apply. Just
exit the System Preferences window or click Show All as you normally would.

Locating That Certain Special Setting

Hey, wouldn’t it be great if you could search through all the different panes
in System Preferences — with all those countless radio buttons, check boxes,
and slider controls — from one place, even when you’re not quite sure
exactly what you’re looking for?

Figure 6-3 illustrates exactly that kind of activity taking place. Just click in the
System Preferences Spotlight Search box (upper right, with the magnifying
glass icon) and type in just about anything. For example, if you know part of
the name of a particular setting you need to change, type that. Snow Leopard
highlights the System Preferences panes that might contain matching set-
tings. And if you're a Switcher from the Windows world, you can even type in
what you might have called the same setting in Windows XP, Vista, or 7!
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|
Figure 6-3:
Searching
for specific
settings is a
breeze with
the Search
box.
|

3

The System Preferences window dims, and the group icons that might con-
tain what you're looking for stay highlighted. Slick.

You can also search for System Preferences controls by using the Spotlight
menu and Spotlight window. Find more on this cool feature in Chapter 7.

If you need to reset the Search box to try again, click the X icon that appears
at the right side of the box to clear it.

Popular Preference Panes Explained

Time to get down to brass tacks. Open the most often-used panes in System
Preferences to see what magic you can perform! I won’t discuss every pane
because I cover many of them in other chapters. (In fact, you might never
need to open some System Preferences panes, like the MobileMe pane.)
However, this chapter covers just about all the settings that you're likely to
use on a regular basis.

The Displays pane

If you're a heavy-duty game player or you work with applications like
Keynote or Final Cut Pro, you probably find yourself switching the charac-
teristics of your monitor on a regular basis. To easily accomplish switching,
visit the Displays pane (see Figure 6-4), which includes two panes:
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|
Figure 6-4:
The
Displays
pane also
comesin

a handy
Finder menu
bar size!
|
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v Display: Click a screen resolution to choose it from the Resolutions list
on the left. Snow Leopard displays the number of colors (or color depth)
allowed at that resolution, and you can pick a color depth from the Colors
pop-up menu. (Typically, it’s a good idea to use the highest resolution and
the highest number of colors.) If you have an external monitor connected
to your laptop, click the Detect Displays button to scan for that monitor.
Because MacBooks running Snow Leopard have a flat-panel LED screen,
the refresh rate is disabled while you're using your laptop’s display. If
you're working with a projector or external monitor, you can also use the
Detect Displays button to configure external displays. Drag the Brightness
slider to change the brightness level of your display.

When you enable (select) the Show Displays in Menu Bar check box, you
can switch resolutions and color levels right from the Finder menu!

v Color: Your MacBook can use a color profile file that controls the colors
on your display. This setting comes in handy for graphic artists and
illustrators who need color output from their printers that closely
matches the colors displayed by the laptop. Click the Calibrate button
to launch the Display Calibrator, which can create a custom ColorSync
profile and calibrate the colors that you see on your monitor.

The Desktop & Screen Saver pane

Hey, no offense to the awesome Snow Leopard background, but who doesn’t
want to choose his own background? And what about that nifty screen saver
you just downloaded from the Apple Web site? You can change both your
background and your screen saver by using these options in the Desktop &
Screen Saver pane.
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The settings on the Desktop panel (shown in Figure 6-5) include

v Current Desktop picture: To change your Desktop background, click
a thumbnail. You can also drag a picture from a Finder window or the
desktop and drop it into the well (the fancy techno-wizard word for the
square box with the sunken look). Snow Leopard automatically updates
your Desktop so that you can see the results. To open another collection
of images from Apple, click the desired collection folder in the list on the
left of the pane. (I recommend the stunning images in the Nature folder.)
If you want to open a different folder with your own images, click the
Add button (which bears a plus sign) at the lower left of the pane and
then navigate to that folder.

|
Figure 6-5:
Show

The Man
who's boss
and pick
your own
Desktop
background.
|

v Arrangement: You can automatically fit an image to your screen, tile
your background image (repeat it across the Desktop), center it, or
stretch it to fill the screen. Because the images from Apple are all sized
correctly already, the Arrangement control appears only when you're
using your own pictures.

v Change Picture: If you like a bit of automatic variety on your Desktop,
select the Change Picture check box. You can click the accompanying
pop-up menu to set the delay period. The images in the current collec-
tion or folder are then displayed in the sequence in which they appear in
the thumbnail list.

+» Random Order: Select this check box to throw caution utterly to the
wind and display random screens from the current collection or folder!

v Translucent Menu Bar: A bit of cosmetic finery — select this check box and
your Finder menu bar (and application menu bars) change from opaque to
translucent, allowing you to see your desktop pattern behind them.
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The settings on the Screen Saver tab include

v Screen Savers: Click the screen saver that you want to display from
the Screen Savers list. Snow Leopard displays an animated preview
of the selected saver on the right. You can also click the Test button to
try out the screen saver in full-screen mode. (Move your mouse a bit to
end the test.)

If the selected screen saver has any settings you can change, the
Options button displays them.

1~ Start Screen Saver: Drag this slider to choose the period of inactivity
that triggers the screen saver. Choose Never to disable the screen saver
entirely.

For additional security, check out the Security pane in System
Preferences, where you find the Require password to wake this com-
puter from sleep or screen saver check box. Select the check box, and
Snow Leopard requires your user account password before allowing
anyone to turn off the screen saver (a great idea when traveling, as you
can imagine).

+* Use Random Screen Saver: Another chance to rebel against conformity!
Select this check box and Snow Leopard picks a different screen saver
each time.

v+ Show with Clock: Select this check box and Snow Leopard adds a smart
clock display to your screen saver (a great help for those of us who
spend many minutes on the phone).

+* Hot Corners: Click this button to display a drop-down sheet, and then
click any of the four pop-up menus at the four corners of the screen
to select that corner as an activating hot corner. (Moving your mouse
pointer there immediately activates the screen saver.) You can also
specify a corner as a disabling hot corner — as long as the mouse pointer
stays in that corner, the screen saver is disabled. Note that you can also
set the Dashboard, Exposé, and Spaces activation corners from here.
(Read on for the entire lowdown.)

The Exposé & Spaces pane

The pane shown in Figure 6-6 illustrates the settings that control Snow
Leopard’s Spaces, Exposé, and Dashboard features, which I discuss in more
detail in Chapter 5. The settings on the Exposé tab include

v Active Screen Corners: The screen corners pop-up menus that I
describe in the preceding section operate just like those in the Screen
Savers pane. Click a corner’s list box to set it as

e An Exposé All Windows corner (displays all windows on your
Desktop).
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¢ An Exposé Application Windows corner (displays only the windows
from the active application).

e An Exposé Desktop corner (moves all windows to the outside of
the screen to uncover your Desktop).

* A Spaces corner (activates the Spaces Desktop selection feature).

¢ A Sleep Display corner (immediately turns off your display, putting
your screen in sleep mode).

e A Dashboard corner (displays your Dashboard widgets). Widgets
are small applications that each perform a single task; they appear
when you invoke the awesome power of the Dashboard.

These pop-up menus can also set the screen saver to activate and dis-
able hot corners.

+” Keyboard and mouse shortcuts: Pretty straightforward stuff here. Click
each pop-up menu to set the key sequences (and mouse button settings)
for all three Exposé functions as well as Dashboard.

<P If you hold down a modifier key (Shift, Control, Option, or &) while a
shortcut pop-up menu is open, Snow Leopard adds that modifier key to
the selections you can choose! (It’s perfect for those folks who already
have the F11 key in use by another application. Make your Desktop
shortcut key the Shift+F11 key sequence instead.)

|
Figure 6-6:
The Exposé
& Spaces
panein
System
Prefer-
ences.
|
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One of Snow Leopard’s hottest features is Spaces, which is the system you
use to configure and control multiple “prefabricated” desktops that you can
switch among at will! The settings on the Spaces tab include

v+ Enable Spaces: Select this check box to use Spaces. (Go figure.)

v Show Spaces in Menu Bar: When this check box is selected, Snow
Leopard displays the Spaces desktop number you're currently using in
the Finder menu bar. You can click the number on the menu bar to switch
to another Spaces desktop or to open the Spaces Preferences pane.

+* Rows buttons: To add a row of Spaces desktops to the Spaces grid, click
the Add button (with the plus sign). (By default, Spaces starts with two
desktops enabled, so new rows and columns are numbered beginning
with three.) To delete a row, click the Delete button (which bears a
minus sign).

v Columns buttons: To add a column of Spaces desktops to the Spaces
grid, click the Add (plus) button. Click the Delete (minus) button to
remove a column from the grid.

\3
P If you choose to remove a column or row, Snow Leopard alerts you that

the bindings (the specific applications linked to the deleted columns or
rows) will be reassigned.

v+ Add/Remove Application: Click the Add Application button (the button
with the plus sign under the Application Assignments list) to add an
application to one of your Spaces desktops. You can select which desk-
top should include an application by clicking the up/down arrows next
to the Space column for that application’s entry — just click the desired
desktop from the pop-up menu that appears. To remove an application,
click it in the Application Bindings list to select it and then click the

3 Remove Application button (which sports a minus sign).

Spaces can even add an application to all your desktops; just choose
Every Space from the pop-up menu.

+” Keyboard and mouse shortcuts: Click each pop-up menu to set the key

sequences (and mouse button settings) for all three Spaces functions.

<MBER . . .
N Like with Dashboard and Exposé keyboard and mouse shortcuts, you

can press Shift, Control, Option, and & keys (or even a combination of
them) while the box is open to display modified choices.

+ When Switching to an Application: When selected, this check box
allows you to switch applications between Spaces desktops by using the
88+Tab shortcut. Snow Leopard jumps to the desktop that has an open
window for the application you choose, even if that desktop is not
currently active. (This control only appears if you've enabled Spaces.)
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The Appearance pane

The talented Appearance pane (shown in Figure 6-7) determines the look and
operation of the controls that appear in application windows and Finder win-
dows. It looks complex, but I cover each option here.

|
Figure 6-7:
Appear-
ances might
not be
everything,
but they're
easy to find
here.
|

The settings include

v Appearance: Click this pop-up menu to specify the color that Snow
Leopard uses for buttons, menus, and windows.

v Highlight Color: Click this pop-up menu to choose the color that high-
lights selected text in fields.

+” Place Scroll Arrows: Select a radio button here to determine whether
the arrows that control the scroll bar in a window appear together at
the bottom of the scroll bar, or separately at the top and bottom of the
scroll bar.

v Click in the Scroll Bar To: By default, Snow Leopard scrolls to the next
or previous page when you click in an empty portion of the scroll bar.
Select the Jump to Here radio button to scroll the document to the
approximate position in relation to where you clicked. (Smooth scrolling
slows scrolling, which some people prefer.)

N You can minimize a Finder or application window by simply double-

clicking the window’s title bar. To enable this feature, select the
Minimize When Double Clicking a Window Title Bar check box.
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|
Figure 6-8:
Reduce your
MacBook
power
consump-
tion from
the Energy
Saver pane.
|

+* Number of Recent Items: By default, Snow Leopard displays ten recent
applications, documents, and servers within Recent Items on the Apple
menu. Need more? Just click the corresponding pop-up menu and spec-
ify up to 50 items.

v Use LCD Font Smoothing When Available: This feature performs a little
visual magic that makes the text on your display look more like the text
on a printed page. Most MacBook owners should choose Automatic or
Medium (for a typical flat-panel LCD/LED display).

v Turn Off Text Smoothing for Font Sizes: Below a certain point size, text
smoothing doesn’t help fonts look any smoother on-screen. By default,
any font displayed at 8 points or smaller isn’t smoothed, which is a good
choice for a MacBook with a flat-panel LCD/LED screen.

The Energy Saver pane

I'm an environmentalist — it’s surprising how many techno-types are col-
ored green — so these two panels here are pretty doggone important. When
you use them correctly, you not only conserve battery power but also even
invoke the Power of Snow Leopard to automatically start up and shut down
your laptop whenever you like!

Move the Computer Sleep slider to specify when Mac OS X should switch

to sleep mode (see Figure 6-8). The Never setting here disables sleep mode
entirely. To choose a separate delay period for blanking your monitor, drag
the Display Sleep delay slider to the desired period. You can also power
down the hard drive to conserve energy and prevent wear and tear (an espe-
cially good feature for laptop owners).
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If you want to start up or shut down your laptop at a scheduled time, click the
Schedule button. Select the desired schedules (the Start Up or Wake check
box and the Shut Down/Sleep check box) to enable them; then click the up
and down arrows next to the time display to set the trigger time. Click OK to
return to the Energy Saver pane.

Some of the settings can toggle events that control Snow Leopard’s sleep
mode, including a network connection by the network administrator (Wake
for Network Access). If you want the display to dim before your Mac goes

to sleep, select the Automatically Reduce Brightness before Display Goes

to Sleep check box. You can also set Mac OS X to restart automatically after
a power failure, which is a good idea if you're sharing music or files with
others. Naturally, MacBook owners will want to click the Show Battery Status
in the Menu Bar check box to select it.

Mac laptop owners can set two separate Energy Saver configurations by click-
ing one of the two tabs at the top of the pane:

v~ Battery Power: Applies when their MacBook is running on battery
power)

1 Power Adapter: Kicks in when the laptop is connected to an AC outlet

Your MacBook automatically switches to the proper configuration when you
plug in or unplug your laptop.

The Dock pane

I'll come clean: I think the Dock is the best thing since sliced bread! (I wonder
what people referred to before sliced bread was invented?) You can use the
settings, shown in Figure 6-9, to configure the Dock’s behavior until it fits
your personality like a glove:

v~ Size: Pretty self-explanatory. Just drag the slider to change the scale of
the Dock.

1 Magnification: When you select this check box, each icon in your Dock
swells like a puffer fish when you move your mouse cursor over it. (The
Magnification slider determines just how much it magnifies.) I really like
this feature because I resize my Dock smaller, and I have a large number
of Dock icons.

1 Position on Screen: Select a radio button here to position the Dock on
the left, bottom, or right edge of your Desktop.
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Figure 6-9:
Customize
your Dock
with these
controls.
|

v Minimize Windows Using: Snow Leopard includes two cool animations
that you can choose from when shrinking a window to the Dock (and
expanding it back to the Desktop). Click the Minimize Using pop-up
menu to specify the genie-in-a-bottle effect or a scale-up-or-down-
incrementally effect.

If animation isn’t your bag or you want to speed up the graphics perfor-
mance of an older G4 iBook or PowerBook, you can turn off these mini-
mizing effects.

v Minimize Windows into Application Icon: By default, Snow Leopard
minimizes a window as a thumbnail on the right side of the Dock. Select
this check box to minimize a window into the icon for the parent appli-
cation instead.

1 Animate Opening Applications: Are you into aerobics? How about punk
rock and slam dancing? Active souls who like animation likely get a kick
out of the bouncing application icons in the Dock. They indicate that
you’ve launched an application and that it’s loading. You can turn off
this bouncing behavior by deselecting this check box.

1 Automatically Hide and Show the Dock: Select this check box, and the
Dock disappears until you need it. (Depending on the size of your Dock,
the Desktop that you gain can be significant.) To display a hidden Dock,
move your mouse pointer over the corresponding edge of the Desktop.

The Sharing pane

So you're in a neighborly mood, and you want to share your toys with others
on your local wired or wireless network. Perhaps you’d like to start your own
Web site or protect yourself against the Bad Guys on the Internet. All these
fun diversions are available from the Sharing pane in System Preferences, as
shown in Figure 6-10.
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Figure 6-10:
Use con-
trols on the
Sharing
pane to
share your
toys.
|

Click the Edit button to change the default network name assigned to your
MacBook during the installation process. Your current network name is listed
in the Computer Name text field.

Each entry in the services list controls a specific type of sharing, including
DVD or CD Sharing, File Sharing (with other Macs and PCs running Windows),
Web Sharing, Screen Sharing, Remote Login, Remote Management (using
Apple Remote Desktop), Remote Apple Events, Xgrid Sharing, Internet
Sharing, Bluetooth Sharing, Scanner Sharing, and Printer Sharing. To turn on
any of these services, select the On check box for that service. To turn off a
service, click the corresponding On check box to deselect it.

From a security standpoint, I highly recommend that you enable only those
services that you actually use. Each service you enable automatically opens
your Snow Leopard firewall for that service. A Mark’s Maxim to remember:

Poking too many holes in your firewall is not A Good Thing.™

When you click one of the services in the list, the right side of the Sharing
pane changes to display the settings you can specify for that particular ser-
vice. Note that some services may be disabled, depending on the hardware
connected to or installed in your MacBook.
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Figure 6-11:
Put Time
Machine to
work, and
your data

is always
backed up.
|

\NG/
S

The Time Machine pane

Mac users are thrilled with the Time Machine automatic backup feature
that’s built in to Snow Leopard — I know it’s already saved my stuff numer-
ous times — and you can easily configure how Time Machine handles your
backups from this pane (as shown in Figure 6-11). Chapter 23 covers how

to use Time Machine. Of course, you need an external hard drive (or a Time
Capsule wireless backup station) for the best backup security. Note that
Time Machine doesn’t work with your CD or DVD rewriteable drive; you must
use a hard drive.

You can actually use a second partition on your existing internal hard drive to
hold your Time Machine data, but guess what happens if your internal hard
drive is hit with a hardware failure. You lose both your original data and your
backup in one fell swoop! For this reason, [ strongly recommend that you add
an external hard drive to your MacBook for use with Time Machine. (I don’t
know why Apple even made this an option. Sigh.)

To enable Time Machine, click the On toggle switch and then select a disk
to hold your Time Machine backup data on the sheet that appears; click Use
for Backup to confirm your choice. (Your external backup drive should be
at least twice the capacity of your internal drive, thus ensuring that your
backup files have the elbowroom they need.) If you have an external Time
Capsule wireless unit, click Set Up Time Capsule.

By default, Time Machine backs up all the hard drives on your system,;
however, you may not need to back up some hard drives or folders on your
MacBook. To save time and hard drive space, Time Machine allows you to
exclude specific drives and folders from the backup process. Click Options
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and then click the Add button (with the plus sign) to select the drives or fold-
ers you want to exclude, and they’ll appear in the Do Not Back Up list.

To remove an exclusion, select it in the list and click the Delete button (with
the minus sign). Note that the Total Included figure increases, and Time
Machine adds the item you deleted from the list to the next backup.

By default, Snow Leopard warns you when deleting older backup files, but
you can turn this off from the Options sheet as well.

You can elect to back up your MacBook immediately by clicking the Time
Machine icon in the Finder menu bar and choosing Back Up Now.
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Chapter 7

Sifting through Your Stuff

In This Chapter

Understanding how Spotlight works

Searching for data, files, and folders via Spotlight

Using the results you get from a Spotlight search
Searching with the Find dialog and the search box
Searching for stuff on the Internet with Dashboard widgets

Wlat would you say if I told you that you could search your entire
system for all the data connected with a person — and in only the

short time it takes to type that person’s name? And I'm not just talking about
files and folders that might include that person’s name. [ mean every e-mail
message and every iCal calendar event that references that person — and
even that person’s Address Book card to boot? Heck, how about if that
search could dig up every occurrence of the person’s name inside your elec-
tronic PDF documents?

You’d probably say, “That makes for good future tech — I'll bet I can do that
in five or ten years. It’ll take Apple at least that long to do it . . . and just in
time for me to buy a new MacBook! (Harrumph.)”

Don’t be so hasty. You can do all this, right now. The technology is the Mac
OS X feature named Spotlight, built right into Snow Leopard. In this chapter,
[ show you how to use it like a Mac power guru. I also show you how to take
advantage of Internet search widgets you can display within Dashboard.
(From what I hear, there’s good stuff on the Internet, too.)
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A Not-So-Confusing Introduction
to Spotlight

|
Figure 7-1:
The
Spotlight
search box.
|

Invoking the magic of Spotlight is a snap. As you can see in Figure 7-1, the
Spotlight search field always hangs out on the right side of the Finder menu
bar. You can either click once on the magnifying glass icon or just press
$+spacebar. Either way, Snow Leopard displays the Spotlight search box.

Spotlight search box

Spotlight works by indexing — in other words, searching for and keeping
track of keywords within your files. (In case you've never heard the term
before, a keyword is a word in the title or innards of a document that
describes the contents, like Snow Leopard, music, or soda. That last one turns
up a lot in my documents.)

In fact, Snow Leopard indexes the entire contents of your MacBook’s hard
drives, maintaining that humongous index continuously while you create new
files and modify existing files. Snow Leopard can search this index file in a
fraction of a second after you enter your search criteria. Your index file con-
tains all sorts of data, including quite a bit of information from inside various
documents, hence Spotlight’s ability to present matching data inside your
files and application records.

When you first boot Snow Leopard, it spends anywhere from a few minutes to
an hour or two creating the initial Spotlight index file. A blue dot appears in
the middle of the magnifying glass icon while indexing is underway. Creating
this full index happens only once, so it’s no great burden to bear.

You can search for any string of text characters in Spotlight, and you’ll

be surprised at everything this plucky feature can search. For example,
Spotlight searches through your Address Book contacts, Mail messages, iCal
calendars, iChat transcripts, temporary Web page cache, and even System
Preferences! Yep, you can even use it to find specific settings in all those
System Preferences panes, such as printer sharing or Dashboard. Of course,
Spotlight includes matching files and folders — like that other operating
system — but it does it in the blink of an eye.
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Figure 7-2:

A Spotlight
menu
search
takes as
little as one
character.
|

Spotlight matches all the items that include all your search text. Therefore,
if you enter just the word horse, you're likely to get far more matches than if
you enter a more-restrictive word string, such as horse show ticket.

If you add metadata to your documents — such as a Comment field in a Word
document (which you can display in the Get Info dialog box) — Spotlight
matches that information as well. Other recognized file formats include iWork
documents, Excel spreadsheets, and third-party applications that offer a
Spotlight plug-in.

Searching with Spotlight

To begin a Spotlight topic search, click within the Spotlight box and start
typing. As soon as your finger presses the first key, you see matching items
start to appear. Check out Figure 7-2, in which I typed only a single character
(). You don’t need to press Return to start the process, by the way. When
you type more characters, Spotlight’s results are updated in real time to
reflect those more-restrictive qualifiers. For example, if | had typed three
characters — say, Leo — my results would be far more specific: everything
from Snow Leopard to Leonard Bernstein.

www.it-ebooks.info


http://www.it-ebooks.info/

] 14 Partii: shaking Hands with Mac 0S X

A\\S

A\

Spotlight displays what it considers the top 20 matching items within the
Spotlight menu itself. These most relevant hits are arranged into categories,
such as Documents, Images, and Folders. You can change the order in which
categories appear (via the Spotlight pane within System Preferences, which I
cover a bit later in this chapter).

With its internal magic, Spotlight presents the category Top Hit (with what it
considers the single, most-relevant match) at the top of the search results, as
also shown in Figure 7-2. You'll find that the Top Hit is often just what you're
looking for. To open or launch the Top Hit item from the keyboard, click the
entry or press the down-arrow key () to select Top Hit; then press Return.

Didn’t find what you were after? Click the X icon that appears at the right side
of the Spotlight box to reset the search box and then start over.

If all you know about the item you’re searching for is its file type, prefix a
keyword with the text kind: in front of the file type in the Spotlight search
field. For example, say you're searching for a QuickTime movie, but you
don’t know the title. In this case, you’d type kind:movies. This trick also
works with image files (kind:images), contacts (kind:contacts), applications
(kind:applications), and audio files (kind:music).

Here’s another trick that’s built into Spotlight: You can type in a date that a
file was created or received, such as modified:=>10/01/10, to match all items
modified on or after October 1, 2010. Heck, you can even combine appended
criteria, such as kind:music created:07/18/10. Note: Be sure to include a
space between the criteria. Spotlight then matches every audio file that was
created on that date. One hundred percent sassy!

To allow even greater flexibility in your searches, Apple uses those helpful
Boolean search friends that you might already be familiar with: AND, OR, and
NOT (separated by spaces). For example, in Snow Leopard, you can perform
Spotlight searches, such as

v Horse AND cow: Collects all references to both those barnyard animals
into one search
v Batman OR Robin: Returns all references to either Batman or Robin

v Apple NOT PC: Displays all references to Apple that don’t include any
information on dastardly PCs
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How secure is Spotlight?

Say you're sharing your MacBook as a mul-
tiuser computer, or accessing other Macs
remotely. What about all those files, folders,
contacts, and events that you don’t want to
appear in Spotlight? Can other folks search for
and access your personal information through
Spotlight?

Definitely not! The results displayed by
Spotlight are controlled by file and folder per-
missions as well as your account login, just like
the applications that create and display your
personal data. For example, you can’t access
other users’ calendars by using iCal, and they
can’t see your Mail messages. Only you have

access to your data, and only after you log in
with your username and password. Spotlight
works the same way. If a user doesn’t normally
have access to an item, it simply doesn’t appear
when that user performs a Spotlight search. (In
other words, only you get to see your stuff.)

However, you can even hide certain folders
and disks from your own Spotlight searches if
necessary. Perhaps you'd prefer keeping your
tax and financial records away from Spotlight’s
all-searching eye. Check out the section of
this chapter titled “Marking stuff off-limits”
for details on setting private locations on your
system.

Working with matching stuff

After you run a fruitful search and Spotlight finds the proverbial needle in
your system’s haystack, what’s next?

Just click the item — that’s all it takes. Depending on the type of item, Snow
Leopard does one of four things:

v Launches an application

v Opens a specific pane in System Preferences (if the match is the name of
a setting or is contained in the text on a Preferences pane)

v Opens a document or data item, such as an Address Book card

v Displays a folder within a Finder window

To see all sorts of useful info about each Spotlight menu item — otherwise
known as filtering — click the Show All item (above the Top Hit listing; refer
to Figure 7-2) to expand your Spotlight menu into the Results window, as
shown in Figure 7-3. From the keyboard, you can press the Results window
shortcut key, which you can set from System Preferences (more on this in a
page or two).
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Figure 7-3:
The
Spotlight
Results
window
offers more
ways to
group and
sort your
matches.
|

To further filter the search, click one of the buttons on the Spotlight Results
window toolbar or create your own custom filter. Click the button with the
plus sign to display the search criteria bar, and then click the pop-up menus
to choose from criteria, such as the type of file, text content, or the location
on your system (such as your hard drive, your Home folder, or a network
server). You can also filter your results listing by the date when the items
were created or last saved. To add or delete criteria, click the plus and minus
buttons at the right side of the search criteria bar. To save a custom filter
that you created, click Save.

After you locate the item you want, click it to open, launch, or display it, just
like you would on the Spotlight menu.

Tweaking Spotlight in System Preferences

The System Preferences window boasts a Spotlight pane, which you can use
to customize what search matches you see and how they are presented. To
adjust these settings, click the System Preferences icon on the Dock (look for
the Three Gears of Justice) and then click the Spotlight icon (under Personal).

Configuring the Search Results settings

Figure 7-4 illustrates the Search Results tab of the Spotlight Preferences pane.
From here, you can

v Pick your categories. To disable a category (typically because you don’t

use those types of files), select the check box next to the unnecessary
category to clear it.
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1 Specify the order in which categories appear within Spotlight. Drag
the categories into the order that you want them to appear on the
Spotlight menu and in the Results window.

1 Select new Spotlight menu and Spotlight Results window keyboard
shortcuts. In fact, you can enable or disable either keyboard shortcut,
as you like. Click the pop-up menu to choose a key combination. (This is
good news for applications like Photoshop that may demand to use the
& +Space shortcut for themselves!)

Marking stuff off-limits

Click the Privacy tab (shown in Figure 7-5) to add disks and folders that
should never be listed as results in a Spotlight search. The disks and folders
that you add to this list won’t appear even if they actually match your search
string, no matter what type of search you use. This safeguard can come in
handy for organizations (such as hospitals) that are required by law to pro-
tect their patient or client data. However, you can select a removable hard
drive here, which is often stored in a safe after business hours.

To add a private location, click the Add button (which bears a plus sign) and
navigate to the desired location. Then click the location to select it and click
Choose.

If you already have the location open in a Finder window, you also can drag
folders or disks directly from the window and drop them into the list.
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Some things
should
never

been seen;
specify
them within
Spotlight.

Other Search Tools Are Available, Too

The Finder window toolbar has featured a search box for a few years now
(and Snow Leopard includes a Find dialog), but even the older Search fea-
tures within Snow Leopard have been updated to take advantage of Spotlight
technology. Now you can even use file types (such as image or movie) and
relative time periods (such as yesterday and last week) in the Finder window
search box and Find displays!

Typically, I use the Finder window search box if I need to do a simple file or
folder name search. It works the same as using the Spotlight search field. Just
begin typing. To reset the field and start anew, click the X button in the search
box. To choose a specific location for your search — say, your Home folder

or a hard drive volume — click the desired button along the top of the Search
Results display. The Finder window automatically turns into a Results display.

Snow Leopard also includes the oldest Search method in the book: the

Find display. (It used to be a dialog all by itself, but Find controls are now
displayed in the Finder window, so it’s more of an extension to the Finder
window.) Choose File>Find or press 88+F to display the Find controls. From
here, you can click pop-up menus to choose a specific filename or portion
of a filename. Other modifiers include the file type, content, file size, and the
most recent date when the file was opened. Again, click the location buttons
at the top of the window to choose where to search.
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<P For a truly mind-blowing list of modifiers, click the Other item in the modifier
menu. You'll find you can search for all photos where a certain shutter speed
was used or all files that are read-only. Heck, I sometimes use this expanded
list to search for documents that use a certain font!

The Find display, however, is a little more sophisticated than the toolbar
search box. You can click the plus (+) button next to a search criterion field
in the Find display to add another field, allowing matches based on more
than one condition. Click the minus (-) button next to a search criterion field
to remove it.

After you find a match, both older Search methods work the same: Click

the item once to display its location, or double-click it to launch or open it.
Files can also be moved or copied, respectively, from the Results and Find
displays with the standard drag or Option+drag methods. You can return to
the more mundane Finder window display by clicking the Back button on the
toolbar to erase the contents of the Spotlight box.

<P These older Search methods can also do one thing that Spotlight doesn’t offer:
You can use them to create a new Smart Folder, which is a folder with contents
that Snow Leopard automatically updates according to the criteria you set —
the same modifiers I discuss earlier.

Click the Save button in either the Finder window Search Results or Find
display. You're prompted to specify the name and location for the new Smart
Folder and whether it should appear in the Finder window Sidebar.

After you create the folder, Snow Leopard automatically updates the con-
tents of the Smart Folder with whatever items match the criteria you saved.
You never have to search by using the same text or criteria again because the
search is saved as part of the Smart Folder! (Each icon in a Smart Folder is a
link to the actual file or folder — just like an alias — so nothing gets moved,
and no extra space is wasted with multiple copies of the same items.) In
other words, you can work with the files and folders inside a Smart Folder as
if they were the actual items themselves.

With Widgets, the Internet
Is Your Resource

No chapter on searching within Mac OS X would be complete without a dis-
cussion about the Internet resources available through your Snow Leopard
Dashboard. (I describe widgets in illuminating detail in Chapter 5.) Figure 7-6
illustrates many of these widgets:
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v Dictionary: This multipurpose widget can display the Oxford American
dictionary or thesaurus entry for the word you enter.

v Weather: Check out the six-day forecast for a specific zip code or city/
state combination at a glance.

To enter the location data, click the tiny i button that appears when you
mouse over the bottom-right corner of the widget. This trick works with
just about every widget, allowing you to set any options it offers.

v Flight Tracker: Keep tabs on the arrival and destination time for the
flight you specify.

v Google: Yep, it’s a shortcut to the king of all Internet search engines.
Just type in the words you want to search for and then press Return.
The widget automatically launches your default Web browser (typically
Safari) with the results!

v Business: Put your local Yellow Pages to work by typing in a business
name or category. This widget displays matching telephone numbers
and addresses. Click an entry to get directions or a map from the Web.

Okay, I know you're going to roll your eyes, but I have to remind you that you
need an Internet connection to use these widgets. Otherwise, Business and
Flight Tracker are about as useful as a pair of swim fins in the Sahara Desert.

Naturally, you can find countless other Internet-enabled widgets on the Apple

Web site, in the Download area. For all the details on adding built-in widgets
to your Dashboard, visit Chapter 5.

www.it-ebooks.info



http://www.it-ebooks.info/

Part Il

Connecting and
Communicating

The 5th Wave By Rich Tennant

“Tt worKed, honey! T’'m connected to
the network!”
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In this part . . .

ou want to do the Internet thing, don’t you? Sure, you

do! In this part, I describe and demonstrate your
Safari Web browser. You also find out about Apple’s
MobileMe Internet subscription service.

Ready to share your Mac laptop among all the members of
your family? If you decided to build a home network
(wired or wireless), you’ve come to the right place. In this
part, I show you how to provide others with access to
your documents and data — securely, mind you, and with
the least amount of hassle.

Finally, this part fills you in on connecting important stuff,
such as printers and scanners, as well as how you can use
your laptop’s built-in iSight Web cam and Photo Booth.
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Chapter 8
Let's Go on Safari!

In This Chapter

Introducing the Safari window and controls

Visiting Web sites with Safari and setting up a home page
Creating and using bookmarks

Receiving files with Safari

Surfing with your tabs showing

Saving Web pages and protecting your privacy

Blocking those irritating pop-ups

proudly surf the Web via a lean, mean — and very fast — browser appli-

cation. That’s Safari, of course, and it just keeps getting better with each
new version of Mac OS X. Safari delivers the Web the right way, without the
wait. (Heck, if you like, you can even enlist your friends using PCs on this
expedition — you can find a version of Safari for Windows as well.)

If you need a guide to Safari, this is your chapter. Sure, you can start using it
immediately, but wouldn’t you rather read a few pages to surf like a power user?

Pretend You've Never Used This Thing

Figure 8-1 illustrates the Safari window. You can launch Safari directly from
the Dock, or you can click the Safari icon within your Applications folder.
Major sections of the Safari window include

1 The toolbar: You find the most-often-used commands on this toolbar —
for tasks such as navigating, adding bookmarks, and searching Google.
Plus, here you can type or paste the address for Web sites that you'd
like to visit. The toolbar can be hidden to provide you with more real
estate in your browser window for Web content. To toggle hidden mode
on and off, press 88+ (the vertical bar right above the backslash) or
choose Viewr>Hide/Show Toolbar.
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Toolbar Bookmarks bar

Status bar Content window

+* The Bookmarks bar: Consider this a toolbar that allows you to jump

directly to your favorite Web sites with a single click or two. I show you
later, in the section “Adding and Using Bookmarks,” how to add and
remove sites from your Bookmarks bar. For now, remember that you
can toggle the display of the Bookmarks bar by choosing View=>Hide/
Show Bookmarks Bar or by pressing 38+Shift+B.

v The Content window: Congratulations! At last, you’'ve waded through

all the pregame show and you’ve reached the area where Web pages are
actually displayed. As can any other window, the Content window can
be scrolled; when you minimize Safari to the Dock, you get a thumbnail
(minimized) image of the Content window.

The Content window often contains underlined (or highlighted) text and
graphical elements that transport you to other pages when you click them.
These underlined words and icons are links, and they make it easy to move
from one area of a site to another or to a completely different site.

v The status bar: The status bar displays information about what the

cursor is currently resting upon, such as the address for a link or the
name of an image; it also updates you on what’s happening while a page
is loading. To hide or display the status bar, press 3+/ (forward slash)
or choose View>Hide/Show Status Bar.
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Visiting Web Sites
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Here’s the stuff that virtually everyone over the age of 5 knows howtodo ...
but I get paid by the word, and some folks might not be aware of the myriad
ways of visiting a site. You can load a Web page by using any of the following
methods:

v Type (or paste) a Web site address into the Address box on the tool-
bar, and then press Return.

If you're typing in an address and Safari recognizes the site as one that
you’ve visited in the past, it helps by completing the address for you.
Press Return if you want to accept the suggested site. If this is a new
site, just keep typing.

The latest version of Safari includes a Smart Address field that displays
a new pop-up menu of sites that match the text you've entered. Safari
does this by using sites taken from your History file and your book-
marks. If the site you want to visit appears in the list, click it to jump
there immediately.

v+ Click a Bookmarks entry within Safari.

v+~ If the Home button appears on your toolbar, click it to return to the
home page that you specify.

You find more on this in the section “Setting Up Your Home Page,” later
in this chapter.

v Click the Show Top Sites button on the toolbar.

Safari displays a wall of preview thumbnail pages from your most fre-
quently visited sites, and you can jump to a site just by clicking the pre-
view. Click the Edit button on the Top Sites screen to delete a preview
thumbnail — click the X — or you can “anchor” a thumbnail to keep it
on the screen permanently by clicking the pin icon next to the desired
thumbnail. You can also choose the size of the preview thumbnails in
Edit mode.

Because each thumbnail is updated with the most current content, the
Top Sites wall makes a great timesaver — you can quickly make a visual
check of all your favorite haunts from one screen!

v Click a page link in Apple Mail or another Internet-savvy application.

Some Mac applications require you to hold down 8 while clicking to
open a Web page. (Note that if the link is in plain text, you can often
select the text, right-click, and choose Open URL from the menu that
appears.)
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v Click a page link within another Web page.
v Use the Google box on the toolbar.

Click in the Google box, type the contents that you want to find, and
then press Return. Safari presents you with the search results page on
Google for the text that you entered. (In case you’ve been living under
the Internet equivalent of a rock for the last couple of years, Google.com
is the preeminent search site on the Web — people use Google to find
everything from used auto parts to ex-spouses.)

v Click a Safari page icon in the Dock or a Finder window.

For example, Mac OS X already has an icon in the Dock that takes you
to the Mac OS X page on the Apple Web site. Drag a site from your
Bookmarks bar and drop it on the right side of the Dock. Clicking the
icon that you add launches Safari and automatically loads that site.

This trick works only on the side of the Dock to the right of the
vertical line.

If you minimize Safari to the Dock, you can see a thumbnail of the page
with the Safari logo superimposed on it. Click this thumbnail in the Dock to
restore the page to its full glory.

Navigating the Web

A typical Web-surfing session is a linear experience — you bop from one page
to the next, absorbing the information that you want and discarding the rest.
However, after you visit a few sites, you might find that you need to return to
where you’ve been or head to the familiar ground of your home page. Safari
offers these default navigational controls on the toolbar:

v Back: Click the Back button (the left-facing arrow) on the toolbar to

return to the last page you visited. Additional clicks take you to previ-
ous pages, in reverse order. The Back button is disabled if you haven’t
visited at least two sites. If you click and hold the Back button, Safari dis-
plays a pop-up menu with all the pages to which you can return — just
click on the desired page to jump right to it.

v Forward: If you've clicked the Back button at least once, clicking the

Forward button (the right-facing arrow) takes you to the next page (or
through the pages) where you originally were, in forward order. The
Forward button is disabled if you haven’t used the Back button. As with
the Back button, you can click and hold the Forward button to display a
pop-up menu of pages, allowing you to jump forward to a desired page.
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+* Home: Click the Home button to immediately return to your Home page.
(More on setting your Home page in the next section.)

Not all these buttons and controls must appear on your toolbar. To display
or hide toolbar controls, choose View=>Customize Toolbar. The sheet

that appears works just like the Customize Toolbar sheet within a Finder
window: Drag the control you want from the sheet to your Safari toolbar,
or drag a control that you don’t want from the toolbar to the sheet. (For
example, I like to add the Home button to the default toolbar — a click on
the Home button immediately returns you to your home page.)

v AutoFill: If you fill out a lot of forms online — when you’re shopping at
Web sites, for example — you can click the AutoFill button (which looks
like a little text box and a pen) to complete these forms for you. You can
set what information is used for AutoFill by choosing Safaric>Preferences
and clicking the AutoFill toolbar button.

To be honest, I'm not a big fan of releasing any of my personal informa-
tion to any Web site, so I don’t use AutoFill often. If you do decide to use
this feature, make sure that the connection is secure (look for the pad-
lock icon in the upper-right corner of the Safari window) and read the
site’s Privacy Agreement page first to see how your identity data will be
treated.

v Zoom: Shrinks or expands the size of text on the page, offering smaller,
space-saving characters (for the shrinking crowd) or larger, easier-to-
read text (for the expanding crowd). Hence the button, which is labeled
with a small and large letter A.

v~ Stop/Reload: Click Reload at the right side of the Address box (look for
the circular arrow) to refresh (reload) the contents of the current page.
Many pages change their content at regular intervals. Reload allows you
to see what’s changed on these pages. (I use Reload every hour or so
with CNN.com, for example.) While a page is loading, the Reload button
turns into the Stop button — with a little X mark — and you can click it
to stop the loading of the content from the current page. This is a real
boon when a download takes foorrevverr.

v+ Open in Dashboard: Click this button to create a Dashboard widget by
using the contents of the currently displayed Web page. Safari prompts
you to choose which clickable section of the page to include within the
widget’s borders (such as the local radar map on your favorite weather
Web site). Click Add, and Dashboard loads automatically with your new
widget. (More on widgets in Chapter 5.)

v Add Bookmark: Click this toolbar button (which carries a plus sign) to
add a page to your Bookmarks bar or Bookmarks menu. (More on this in
a minute.)
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1 Google Search: As [ mention earlier, you can click in this box and type
text that you want to find on the Web via the Google search engine; press
Return to display the results. To repeat a recent search, click the down
arrow in the Google Search box and select it from the pop-up menu.

v Print: Click this convenient button to print the contents of the Safari
window. (Dig that crazy printer icon!)

+* Report Bug: When you click the Bug button, you see a sheet with the
settings shown in Figure 8-2; take time to enter a short description of the
problem. Click More Options to enable the Send Screen Shot of Current
Page and the Send Source of Current Page check boxes, giving the Apple
folks more to work with. Click the Submit button.

|
Figure 8-2:
Have
atthee,
troublesome

buggy page!
|

Setting Up Your Home Page

Choosing a home page is one of the easiest methods of speeding up your
Web surfing, especially if you're using a dialup modem. However, a large per-
centage of the Mac owners whom I've talked with have never set their own
home page; instead, they simply use the default home page provided by their
browser! With Safari running, take a moment to follow these steps to declare
your own freedom to choose your own home page:
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1. If you want to use a specific Web page as your new home page, dis-
3 play it in Safari.

[ recommend selecting a page with few graphics or a fast-loading
popular site.

2. Choose Safari~>Preferences or press 8+, (comma).
3. Click the General button.

You see the settings shown in Figure 8-3.

|
Figure 8-3:
Adding
your own
home page
is an easy
change you
can make.
|
4. Click the Set to Current Page button.
5. Alternatively, click the New Windows Open With pop-up menu and
choose Empty Page if you want Safari to open a new window with a
blank page.
This is the fastest choice of all for a home page.
Choose Top Sites from the New Windows Open With pop-up menu to
display the Top Sites screen (described earlier) each time you open a
new window.
3 6. Click the Close button to exit the Preferences dialog.

Visit your home page at any time by clicking the Home button on the toolbar.
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Adding and Using Bookmarks

No doubt about it: Bookmarks make the Web a friendly place. As you collect
bookmarks in Safari, you can immediately jump from one site to another with
a single click of the Bookmarks menu or the buttons on the Bookmarks bar.

To add a bookmark, first navigate to the desired page and then do any of the
following:

1 Choose Bookmarks—>Add Bookmark.
v Press 38+D.

Safari displays a sheet where you can enter the name for the book-
mark and also select where it appears (on the Bookmarks bar or the
Bookmarks menu).

1 Drag the icon next to the Web address from the Address field to the
Bookmarks bar.
‘\? You can also drag a link on the current page to the Bookmarks bar, but note that
doing this adds a bookmark only for the page that corresponds to the link —
not the current page.

To jump to a bookmark, use any of the following methods:

1 Choose it from the Bookmarks menu.

If the bookmark is contained in a folder, which I discuss later in this
section, move your pointer over the folder name to show its contents
and then click the bookmark.

v Click the bookmark on the Bookmarks bar.

N If you've added a large number of items to the Bookmarks bar, click the

More icon on the edge of the Bookmarks bar to display the rest of the
buttons.

v Click the Show All Bookmarks button (which looks like a small,
opened book) on the Bookmarks bar, and then click the desired
bookmark.

The Bookmarks window that you see in Figure 8-4 appears — complete
with swank Cover Flow display — where you can review each collection
of bookmarks at your leisure. As you might expect, Safari’s Cover Flow
works just like the Cover Flow view does in a Finder window.
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|
Figure 8-4:
The
Bookmarks
window
puts all your
bookmarks
within easy
reach.
|

The more bookmarks you add, the more unwieldy the Bookmarks menu
and the Bookmarks window become. To keep things organized, choose
Bookmarks=Add Bookmark Folder and then type a name for the new
folder. With folders, you can organize your bookmarks into collections,
which appear in the column at the left of the Bookmarks window (or as
separate submenus within the Bookmarks menu). You can drag book-
marks into the new folder to help reduce the clutter. To delete a bookmark
or a folder from the Bookmarks window, click it and then press Delete.

Downloading Files

A huge chunk of the fun that you’ll find on the Web is the ability to download
images and other files. If you've visited a site that offers files for download-
ing, typically you just click the Download button or the download file link,
and Safari takes care of the rest. You see the Downloads status window,
which keeps you updated as to the progress of the transfer. While the file

is downloading, feel free to continue browsing or even download additional
files; the status window helps you keep track of what’s going on and when
everything will be finished transferring. To display the Download status
window from the keyboard, press 88+Option-+L.
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By default, Safari saves any downloaded files to the Downloads folder that
appears in your Dock, which I like and use. To change the specified location
where downloaded files are stored — for example, if you'd like to save them
directly to the desktop — follow these steps:

1. Choose Safari->Preferences or press 3+, (comma).

2. Click the General tab and then click the Save Downloaded Files To
pop-up menu.

. Choose Other.
. Navigate to the location where you want the files to be stored.
. Click the Select button.

S G s W

. Click the Close button to exit Preferences.

To download a specific image that appears on a Web page, move your
pointer over the image and right-click. Then choose Save Image As from the
pop-up menu that appears. Safari prompts you for the location where you
want to store the file.

You can choose to automatically open files that Safari considers safe —
things like movies, text files, and PDF files that are very unlikely to store
avirus or a damaging macro. By default, the Open “Safe” Files after
Downloading check box is selected on the General pane. However, if you're
interested in preventing anything you download from running until you've
manually checked it with your antivirus application, you can deselect the
check box and breathe easy.

Luckily, Safari has matured to the point that it can seamlessly handle virtually
any multimedia file type that it encounters. However, if you’ve downloaded

a multimedia file and Safari doesn’t seem to be able to play or display it, try
loading the file within QuickTime Player. QuickTime Player is the Swiss Army
knife of multimedia players, and it can recognize a huge number of audio,
video, and image formats. (Personally, I also recommend the freeware Perian
QuickTime plug-in, available for downloading from http://perian.org.
Installing Perian adds support to QuickTime Player for a wide range of addi-
tional audio and video formats.)

Using Subscriptions and History

To keep track of where you’ve been, you can display the History list by click-
ing the History menu. To return to a page in the list, just choose it from the

www.it-ebooks.info


http://www.it-ebooks.info/

Chapter 8: Let's Go on Safari! 133

History menu. Note that Safari also arranges older history items by the date
you visited the site, so you can easily jump back a couple of days to that page
you forgot to bookmark!

In fact, Safari also searches the History list automatically, when it fills in an
address that you're typing — that’s the feature [ mention in the earlier
section, “Visiting Web Sites.”

To view your Top Sites thumbnail screen, press 38+Shift+1 or choose Show
Top Sites from the History menu.

If you're worried about security and would rather not keep track of where
you've been online, I show you how to clear the contents of the History file in
the “Handling ancient history” section, later in this chapter.

Tabs Are Your Browsing Friends

Safari also offers tabbed browsing, which many folks use to display (and orga-
nize) multiple Web pages at the same time. For example, if you're doing a bit
of comparison shopping for a new piece of hardware among different online
stores, tabs are ideal.

When you hold down the 38 key and click a link or bookmark by using tabs,
a tab that represents the new page appears at the top of the Safari window.
Just click the tab to switch to that page. (If you don’t hold down 38, things
revert to business as usual, and Safari replaces the contents of the window
with the new page.) If you hold down both Shift and 8 while you click, Safari
opens a new tab and automatically switches to the new tab. Figure 8-5 illus-
trates a number of pages that I've opened in Safari by using tabs.

o You can also open a new tab by clicking the plus sign that appears at the

upper-right corner of the Safari window. Done with a page? You can remove a

tabbed page by clicking the X button next to the tab’s title.

To fine-tune your tabbed browsing experience, choose Safaric>Preferences to
display the Preferences dialog; then click Tabs. From here, you can turn off
the confirmation window that normally appears when you close Safari with
multiple tabs or windows open. You can also specify whether a new tab or
window automatically becomes the active window within Safari.
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|
Figure 8-5:
Hang on,
Martha;
we've

struck tabs!
|

Saving Web Pages

If you've encountered a page that you’d like to load later, you can save it to
disk in its entirety. (Just the text, mind you, not the images.) Follow these
steps:

1. Display the desired page.

2. Choose File~>Save As or press 38+S.

3. In the Save As text field, type a name for the saved page.

4.

From the Where pop-up menu, navigate to the location where you
want to store the file on your system.

To expand the sheet to allow navigation to any location on your system,
click the button with the downward arrow.

5. Click the Format pop-up menu to choose the format for the saved
page.
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Usually, you’ll want to choose a Web Archive, which saves the entire
page and can be displayed just as you see it. However, if you want to
save just the HTML source code, choose Page Source.

6. Click Save to begin the download process.

After the saved file has been created, double-click it to load it in Safari.

A quick word about printing a page within Safari: Some combinations of back-
ground and text colors might conspire together to render your printed copy
practically worthless. In a case like that, use your printer’s grayscale setting
(if it has one) or deselect the Print Backgrounds check box in the Print dialog.
Alternatively, you can simply click and drag to select the text on the page,
press 38+C to copy it, and then paste the text into TextEdit, Word, or Pages,
where you can print the page on a less-offensive background (while still keep-
ing the text formatting largely untouched). You can also save the contents of a
page as plain text, as I just demonstrated.

If you'd rather e-mail the contents of a Web page to a friend — or just send the
friend a link to the page, which is faster — choose either Filem>Mail Contents
of This Page or Filer>Mail Link to This Page. (From the keyboard, press 38+I

to send the contents in an e-mail message or press 3+Shift+I to send a link in
e-mail.) Mail loads automatically, complete with a prepared e-mail message.
Just address it to the recipients and then click Send!

Protecting Your Privacy

A\

No chapter on Safari would be complete without a discussion of security,
against both outside intrusion from the Internet and prying eyes around your
MacBook. Hence this last section, which covers protecting your privacy.

Although diminutive, the padlock icon that appears at the top of the Safari
window when you’re connected to a secure Web site means a great deal! A
secure site encrypts the information that you send and receive, making it much
harder for those of unscrupulous ideals to obtain things such as credit card
numbers and personal information. You can click the padlock icon (next to
the site name) to display the security certificate in use on that particular site.

Ves, there are such things as bad cookies

First, here’s a definition of this ridiculous term: A cookie, a small file that a
Web site automatically saves on your hard drive, contains information that
the site can use on your future visits. For example, a site might save a cookie
to preserve your site preferences for the next time or — in the case of a site
such as Amazon.com — to identify you automatically and help customize the
offerings that you see.
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In and of themselves, cookies aren’t bad things. Unlike a virus, a cookie file
isn’t going to replicate itself or wreak havoc on your system, and only the
original site can read the cookie that it creates. However, many folks don’t
appreciate acting as a gracious host for a slew of little snippets of personal
information. (Not to mention that some cookies have highly suggestive
names, which could lead to all sorts of conclusions. End of story.)

You can choose to accept all cookies — the default — or you can opt to dis-
able cookies altogether. You can also set Safari to accept cookies only from
the sites you choose to visit. To change your Cookie Acceptance Plan (or
CAP, for those who absolutely crave acronyms), follow these steps:

1. Choose Safari~>Preferences.
2. Click the Security toolbar button.
Safari displays the preference settings shown in Figure 8-6.
3. Choose how to accept cookies via these radio button choices:
® Never: Block cookies entirely.
e Always: Accept all cookies.

® Only from Sites You Navigate To: Personally, I use this option,
which allows sites like Amazon.com to work correctly without
allowing a barrage of illicit cookies.

4. To view the cookies currently on your system, click the Show Cookies
button.

|
Figure 8-6:
Specifying
who's wel-
come in my
cookie jar.
|
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If a site’s cookies are blocked, you might have to take care of things
manually, such as by providing a password on the site that used to be
read automatically from the cookie.

5. Click the Close button to save your changes.

Cleaning your cache

Safari speeds up the loading of Web sites by storing often-used images and
multimedia files in a temporary storage, or cache, folder. Naturally, the files
in your cache folder can be displayed (hint), which could lead to assump-
tions (hint, hint) about the sites you've been visiting (hint, hint, hint).
(Tactful, ain’t [?)

Luckily, Safari makes it easy to dump the contents of your cache file. Just
choose Safari"Empty Cache; then click Empty to confirm that you want to
clean up your cache.

Handling ancient history

As you might imagine, your History file leaves a very clear set of footprints
indicating where you’ve been on the Web. To delete the contents of the
History menu, choose History=>Clear History (at the very bottom of the
History menu).

Safari also allows you to specify an amount of time to retain entries in your
History file. Open the Safari Preferences dialog, click the General tab, and
then click the Remove History Items pop-up menu to specify the desired
amount of time. Items can be rolled off daily, weekly, biweekly, monthly, or
yearly.

Avoiding those @*!"%$ pop-up ads

[ hate pop-up ads, and I'm sure you do, too. To block most of those pop-up
windows with advertisements for everything from low-rate mortgages to
“sure-thing” Internet casinos, click the Safari menu and verify that Block
Pop-Up Windows is selected. (If it’s not selected, click the menu item to
toggle it on.)

If you need to temporarily deactivate pop-up blocking, press 8+Shift+K to

toggle it off. Then press 38+Shift+K again to turn pop-up blocking back on after
you've finished with the site.
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Chapter 9
MobileMe Is Made for MacBooks

In This Chapter
Understanding online storage
Opening a new MobileMe account
Using your iDisk
Backing up your hard drive with iDisk

R eaders often ask me to name my favorite reasons why they should
switch — that is, why should a Windows user who thinks all is well
should move to the Apple universe? Of course, | always mention the superior
hardware and how much better of a job Snow Leopard does as an operating
system. Here’s my favorite selling point: “Apple simply does things right the
first time, and everyone else plays catch-up.”

And then I pose this question: “What if you could reach a hard drive with
your files over any Internet connection — anywhere in the world — and it
just showed up on your MacBook desktop automatically?” Usually, another
person decides to find out more — about the Apple MobileMe online hosting
service, that is. In fact, if you've used online storage — for example, through
Google — you've already been introduced to cloud computing, where both
data and applications are accessed through the Internet, wherever you

are. (And yes, you can also access much of your MobileMe services with a
Windows PC. Just in case!)

In this chapter, [ save you the trouble of researching all the benefits of
MobileMe. Heck, that’s one of the reasons why you bought this book, right?

Grabbing Internet Storage
for Vour MacBook

To set up iDisk — the online data storage provided by MobileMe that [ men-
tion earlier — on your Mac OS X system, you need a MobileMe account. You
did create one during the installation of the Big X, right? These trial accounts

www.it-ebooks.info


http://www.it-ebooks.info/

7 40 Part lll: Connecting and Communicating

|
Figure 9-1:
Your iDisk
settings are
available
from System
Preferences.
|

are active for 60 days. To subscribe, visit www . me . com and follow the prompts
to join from there. (At the time of this writing, the subscription fee for an
individual account is $99 per year from Apple. However, Amazon.com sells
MobileMe subscriptions for significantly less. You need a credit card to create
a MobileMe account, but you can cancel your trial account at any time.)

Here’s a bit of good news: Other than the 60-day limit, you find almost no dif-
ference between a MobileMe trial account and a full, $99 yearly subscription,
so if you're not sure that you want to invest the dough, you can try out all the

MobileMe features, exactly as though you were already paying for them. Sweet!

With an active MobileMe account, iDisk is available automatically. To see
how much storage you’re using and to configure access to your Public folder,
open System Preferences, click the MobileMe icon, and then click the iDisk
button to display the settings that you see in Figure 9-1. (You can also click
the Upgrade Storage button in this pane to subscribe to MobileMe, or if
you'’re already a MobileMe subscriber, add storage space.)

The iDisk Disk Space bar graph illustrates how much of your current iDisk
territory you're using.

You can specify the access privilege level for other MobileMe users from
this pane as well. Select the Read Only radio button to prevent any other
MobileMe user from copying files to your Public folder, or select the Read &
Write radio button to allow others to save files there.
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Pinning down your iDisk

Sowhere exactly areyourfiles keptwhenyou use
your iDisk? In earlier versions of Mac 0S X, your
acre of storage farmland always sat exclusively
on one of Apple’s iDisk file servers — perhaps
in Cupertino, perhaps elsewhere. These server
computers are especially designed to store
terabytes (TB) of information (1TB equals
1,000GB), and they're connected to the Internet
via high-speed trunk lines. (And yes, they do
have a firewall.) Your Internet copy of your iDisk
is still stored on an Apple file server.

However, you can elect to keep a local copy
of your iDisk storage area — usually called a
mirror— on your MacBook's hard drive. Before
you scratch your head wondering why you're
duplicating your iDisk files on your computer,
here's the reason: If you do decide to keep
a local copy of your files, you can work on
them even when you're not connected to the
Internet! Snow Leopard automatically synchro-
nizes any files that you've updated locally with
your remote iDisk whenever you connect to the
Internet. (If you use multiple Macs at different
locations, think about being able to access the
latest copies of your files from any of them, right
from the Finder!)

This nifty mirror also greatly speeds up things
when you're browsing the contents of your
iDisk or perhaps loading and saving an iDisk
document. That's because you’re working with
your local copy, and Mac 0S X updates any
changes that you make to the corresponding
remote file on the iDisk server. You can tell
that things are updating when that funky little
yin-yang, circular doodad — the thing next to
your iDisk in the Finder window — is rotating
in its animated fashion. (And yes, | have it on
good authority: That's what the Apple software
developers call it, too.)

You're not required to use a mirror, however.
To disable the mirroring feature and return
to the remote-only operation of old, click the
iDisk Syncing Stop button in the iDisk pane in
System Preferences to turn it off. Remember,
though, that with the mirroring feature turned
off, you must have an Internet connection to
use iDisk, and things will move more slowly
because you're accessing everything across
the Internet.

A\

No matter which privilege level you choose, you can also set a password that

other MobileMe users must type before they’re allowed access to your Public

folder. This is the very definition of A Truly Good Idea. (More on the Public

folder in the next section.)

If you've already set a password, you can change it by clicking the Set
Password button and typing the new word in the Password box. Retype the
word in the Confirm box to verify it; then click OK to save the change and
return to the MobileMe System Preferences pane.
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Understanding What's on Your iDisk

In contrast to the physical hard drive in your MacBook, your iDisk never
needs formatting or defragmenting, and you never have to check it for errors.
However, the structure of an iDisk is fixed, so you can’t just go crazy creating
your own folders. In fact, you can’t create new folders at the root — the top
level — of your iDisk at all. However, you can create new folders inside most
of the root folders.

Now that you’re thoroughly rooterized, here are the folders that you find
hanging out in your iDisk:

v Backup: This is a read-only folder that contains the backup files created
with the MobileMe Backup application. You can copy the files in this
folder to a removable drive on your system for an additional level of
safekeeping.

v Documents: This folder holds any application documents that you want
to store — things like spreadsheets and letters. By default, no one but
you can access these items; you can tag items in the Documents folder
as shared, allowing individuals or groups to download them by using an
access code sent by MobileMe in an e-mail message. Sharing files is a
great way to transfer files too big to send as e-mail attachments.

v Groups: This folder holds files that you want to share with others in any
MobileMe groups you might have joined.

v~ Library: Another read-only folder. This spot contains the configuration
data and custom settings that you've created for other MobileMe features.

v Movies: QuickTime movies go here — again, you can add the movies
stored here to your Web pages.

v Music: This is the repository for all your iTunes music and playlists, and the
contents can be added to your Web pages. (iTunes is the star of Chapter
13.) My playlists are stuffed full of Mozart, Scarlatti, and that Bach fellow.

v Pictures: This folder is the vault for your images, including those that
you want to use with your Web pages.

v Public: This is the spot to place files that you specifically want to share
with others, either directly through iDisk or with your Web pages. If you
allow write access, others can copy files to your Public folder as well.

v~ Sites: The Web pages that you store here can be created with iWeb. In
fact, you can even use your own Web page design application and copy
the completed site files here.

v~ Software: Apple provides this read-only folder as a service to
MobileMe members; it contains a selection of the latest freeware,
shareware, and commercial demos for you to enjoy. To try something
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out, open the Software folder and copy whatever you like to your Mac
OS X desktop. Then you can install and run the application from the
local copy of the files.

v Web: This folder holds your MobileMe galleries created from within
iPhoto, as well as other media used by iWeb.

Opening and Using iDisk

|
Figure 9-2:
The con-
tents of your
iDisk —
pretty iNeat,
I'm thinking.
|

When you’re connected to the Internet, you can open your iDisk in one of the
following ways:

v From the Finder menu, choose Go=>iDisk and then choose My iDisk from
the submenu or use the 38+Shift+] keyboard shortcut.

v Click the iDisk icon in the Finder Sidebar.

v Add an iDisk button to your Finder window toolbar by choosing View=>
Customize Toolbar.

After you add the button, you can click it to connect to your iDisk from
anywhere in the Finder.

Your iDisk opens in a new Finder window. After you use one of these
methods in a Mac OS X session, your iDisk icon appears on the Mac OS

X desktop; Figure 9-2 shows the iDisk contents in a Finder window. The
iDisk volume icon remains until you shut down or restart your MacBook.
(Alternatively, you can dismiss the iDisk volume icon from your Desktop,
using the same method by which you eject an external drive: Click the iDisk
icon and press 88+E or click the Eject button next to the iDisk icon in the
Finder Sidebar.)
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If you're using Windows XP, Windows Vista, or Windows 7, Apple has pro-
vided an easy way to manage your iDisk: Use MobileMe Control Panel for
Windows, which you can download from www . me . com. Alternately, you can
log in to the MobileMe page at www .me . com and use your Web browser. (Hey,
sometimes this is the only choice you have.)

However, you don’t actually need to open your iDisk in a Finder window to
use it, because you can also load and save files directly to your iDisk from
within any application. Simply choose your iDisk as you would any of the
hard drives on your system when using the application’s Open, Save, or Save
As commands.

You can also open an iDisk Public folder — either yours or the Public folder
inside another person’s iDisk — as if it were an Internet file server. As I
explain earlier in the chapter, if that person has set a password, you need to
enter that password to gain access to all of his or her iDisk folders. From the
Finder menu, choose Go=iDisk=>Other User’s iDisk (or, to jump directly to
that person’s Public folder, choose Go>iDiske>Other User’s Public Folder).
If you choose the former, Snow Leopard prompts you for the other person’s
member name and password; if you pick the latter, you need only enter the
other MobileMe member’s account name.

After you enter a valid iDisk member name (and password, if required), you
see the MobileMe member’s Public folder.

You can also use the server address
http://idisk.me.com/username-Public?

to connect to an iDisk from computers running Windows and Linux. Check

the Help for your operating system to determine how to connect to a

WebDAV server (usually called a Web folder in the Windows world). When

prompted for your access username and password, use your MobileMe
account name and password.
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Chapter 10
Your Laptop Goes Multiuser

In This Chapter

Enjoying the advantages of a multiuser MacBook
Understanding access levels

Adding, editing, and deleting user accounts
Restricting access for managed accounts
Configuring your login window

Sharing files with other users

Securing your stuff with FileVault

Everybody wants a piece. (Of your laptop, that is.)

Perhaps you live in a busy household with kids, significant others, grandpar-
ents, and a wide selection of friends — all of them clamoring for a chance to
spend time on the Internet, take care of homework, or enjoy a good game.

On the other hand, your MacBook might occupy a college classroom or
boardroom at your office — and suddenly your classmate or co-worker wants
his own Private iDaho on the road warrior, complete with a reserved spot

on the hard drive and his own hand-picked attractive Desktop background.
(Even flying at 30,000 feet, your co-worker will be eyeing your MacBook.)

Before you throw your hands up in the air in defeat, read this chapter and
take heart! Here you find all the step-by-step procedures, explanations, and
tips to help you build a safe multiuser MacBook that’s accessible to everyone
with clean hands.

Oh, and you still get to use it, too. And, no, that’s not being selfish.
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Once Upon a Time (An
Access Fairy Tale)

Okay, so you don’t have Cinderella, Snow White, or that porridge-loving kid
with the trespassing problem. Instead, you have your brother Bob.

Every time Bob visits your place, it seems he needs to do “something” on the
Internet, or he needs a moment with your MacBook Air to bang out a quick
message, using his Web-based e-mail application. Unfortunately, Bob’s forays
onto your laptop always result in stuff getting changed, like your desktop set-
tings, Address Book, and Safari bookmarks.

What you need, good reader, is a visit from the Account Fairy. Your problem
is that you have but a single user account on your system, and Snow Leopard
thinks that Bob is you. By turning your MacBook into a multiuser system and
giving Bob his own account, Snow Leopard can tell the difference between
the two of you, keeping your druthers separate!

With a unique user account, Snow Leopard can track all sorts of things for
Bob, leaving your computing environment blissfully pristine. A user account
keeps track of stuff such as

v Address Book contacts
v~ Safari bookmarks and settings

v Desktop settings (including background images, screen resolutions, and
Finder tweaks)

v~ iTunes Libraries, just in case Bob brings his own music (sigh)

v Web sites that Bob might ask you to host on your computer (resigned
sigh)

Plus, Bob gets his own reserved Home folder on your laptop’s hard drive, so
he’ll quit complaining about how he can’t find his files. Oh, and did [ mention
how user accounts keep others from accessing your stuff? And how you can
lock Bob out of where-he-should-not-be, such as certain applications, iChat,
Mail, and Web sites (including that offshore Internet casino site that he’s
hooked on)?

Naturally, this is only the tip of the iceberg. User accounts affect just about
everything you can do in Snow Leopard and on your laptop. The moral of my
little tale? A Mark’s Maxim to the rescue:

Assign others their own user accounts, and let Snow Leopard keep track
of everything. Then you can share your MacBook with others and still live
happily ever after!™
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Big-Shot Administrator Stuff

Get one thing straight right off the bat: You are the administrator of your
MacBook. In network-speak, an administrator (or admin for short) is the one
with the power to Do Unto Others — creating new accounts, deciding who
gets access to what, and generally running the multiuser show. In other words,
think of yourself as the Monarch of Mac OS X. (The ruler, not the butterfly.)

<P [ always recommend that you have only one (or perhaps two) accounts with
administrator-level access on any computer. This makes good sense because
you can be assured that no one can monkey with your laptop while you're
away from the keyboard. So why might you want a second admin account?
Well, if you're away from your laptop — think “daughter takes it with her on
trip to Europe” — you might need to assign a second administrator account to
a trusted individual who knows as much about your road warrior as you do. (Tell
’em to buy a copy of this book.) That way, if something breaks or an account
needs to be tweaked in some way, the other person can take care of it while
you're absent (but without giving that person access to your personal data).

In the following sections, I explain the typical duties of a first-class MacBook
administrator.

Deciding who needs what access

Snow Leopard provides three levels of individual user accounts:

v Admin (administrator): See the beginning of this section.

1~ Standard level: Perfect for most users, these accounts allow access to
just about everything but don’t let the user make drastic changes to
Snow Leopard or create new accounts.

1+ Managed with Parental Controls level: These are standard accounts
with specific limits that are assigned either by you or by another admin
account.

Assign other folks standard-level accounts, and then decide whether each
new account needs to be modified to restrict access as a managed account.
Another Mark’s Maxim is in order:

Never assign an account admin-level access unless you deem it truly
necessary.™

Standard accounts are quick and easy to set up, and I think they provide the
perfect compromise between access and security. You'll find that standard
access allows your users to do just about anything they need to do, with a
minimum of hassle.
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Managed accounts (with Parental Controls) are highly configurable so you
can make sure that your kids don’t end up trashing the hard drive, sending
junk mail, or engaging in unmonitored chatting. (Note: Attention, all parents,
teachers, and those folks designing a single public access account for a
library or organization — this means you.)

Adding users

All right, Mark, enough pregame jabbering — show this good reader how to
set up new accounts! Your laptop already has one admin-level account set
up for you (created during the initial Snow Leopard setup process), and you
need to be logged in with that account to add a user. To add a new account,
follow these steps:

1. Click the System Preferences icon on the Dock, and then click
the Accounts icon to display the Accounts pane that you see in
Figure 10-1.

|
Figure 10-1:
Add new
user
accounts
here.
|
2. Click the New User button — the one with the plus sign at the bottom of
the accounts list — to display the new user sheet shown in Figure 10-2.
<P If your New User button is grayed out, your Accounts pane is locked.

Remember that you can toggle the padlock icon at the lower-left corner
of most of the panes in System Preferences to lock or allow changes. To
gain access, do the following:

a. Click the padlock icon to make changes to the Accounts pane.

b. When Snow Leopard prompts you for your admin account password
(the account you're currently using), enter it. (This is the password
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|
Figure 10-2:
Fill out those
fields, and
you have a
new user.
|
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you entered during Setup, when you created your personal user
account.)

c. Click OK.

Now you can click the New User button.

. Click the New Account pop-up menu and specify the account level

status.

Choose from Administrator, Standard, or Managed with Parental
Controls.

You should have only one or two administrator-level users, and your
account is already an admin account.

. Type the name that you want to display for this account in the Full

Name text box. Press Tab to move to the next field.

By default, Snow Leopard displays this name on the Login screen, so
behave! (For example, Bob has only one “0” the last time I checked.)

. (Optional) Although Snow Leopard automatically generates the user’s

short name (for use in iChat and for naming the user’s Home folder),
you can type a new one into the Account Name text box. (No spaces,
please.) Press Tab again.

. In the Password text box, type the password for the new account.

Press Tab to move to the next field.

Generally, [ recommend a password of at least six characters, using a
mixture of alpha and numeric characters.

. In the Verify text box, retype the password you chose. Press Tab again

to continue your quest.
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8. (Optional) Snow Leopard can provide a password hint after three
unsuccessful login attempts. To offer a hint, type a short question in
the Password Hint text box.

From a security standpoint, password hints are taboo. (Personally, I
never use 'em. If someone is having a problem logging in to a computer
[ administer, you better believe [ want to know why.) Therefore, despite
the recommendation that Snow Leopard shows here, I strongly recom-
mend that you skip this field — and if you do offer a hint, keep it vague!
Avoid hints like, “Your password is the name of the Wookie in Star
Wars.” Geez.

9. Click the Create Account button.

The new account shows up in the list at the left of the Accounts pane.

Each user’s Home folder has the same default subfolders, including Movies,
Music, Pictures, Sites, and so on. A user can create new subfolders within his
or her Home folder at any time.

Here’s one more neat fact about a user’s Home folder: No matter what the
account level, most of the contents of a Home folder can’t be viewed by other
users. (Yes, that includes admin-level users. This way, everyone using your
MacBook Pro gets her own little area of privacy.) Within the Home folder,
only the Sites and Public folders can be accessed by other users — and only
in a limited fashion. More on these folders later in this chapter. (And read all
about Home folders in Chapter 5.)

Modifying user accounts

Next, consider the basic modifications that you can make to a user account,
such as changing existing information or selecting a new picture to represent
that user’s unique personality.

To edit an existing account, log in with your admin account, display the
System Preferences window, and click Accounts to display the account list.
Then follow these steps:

1. Click the account that you want to change.

Don’t forget to unlock the Accounts pane if necessary. See the previous
section in this chapter to read how.

2. Edit the settings that you need to change.

For example, you can reset the user’s password or (if absolutely neces-
sary) upgrade the account to admin level.
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Figure 10-3:
Pick the
image that
best rep-
resents a
user.
|
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3. Click the picture well and then click a thumbnail image to represent
this user (as shown in Figure 10-3).

An easy way to get an image is to use one from your hard drive. Click
Edit Picture and then drag a new image from a Finder window into the
picture well. (Alternatively, you could click Edit Picture and then click
the Snapshot button — which bears a tiny camera — to grab a picture
from your iSight video camera. When you’ve captured the essence of
your subject as a photo, click Set to return to the Accounts pane.)

Snow Leopard displays this image in the Login list next to the account name.

4. When everything is correct, press $#+Q to close the System
Preferences window.

You don’t need to save your changes (as a separate step) within System

Preferences because Snow Leopard does that automatically when you
close the System Preferences window.

Standard-level users have some control over their accounts — they’re not
helpless, after all. Standard users can log in, open System Preferences, and
click Accounts to change the account password or picture, as well as the My
Card assigned to them in the Snow Leopard Address Book. All standard users
can also set up Login Items, which [ cover later in this chapter. Note, however,
that managed users might not have access to System Preferences, so they
can’t make changes. (Read about this in the upcoming section, “Managing
access settings for an account.”)
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1 banish thee, Mischievous User!

Not all user accounts last forever. Students graduate, co-workers quit, kids
move out of the house (at last!), and Bob might even find a significant other
who has a faster cable modem. We can only hope.

Anyway, no matter what the reason, you can delete a user account at any
time. Log in with your admin account, display the Accounts pane in System
Preferences, and then follow these steps to eradicate an account:

1. Click the account that you want to delete.

2. Click the Delete User button (which bears the Minus Sign of Doom).
Refer to Figure 10-2.

Snow Leopard displays a confirmation sheet, as shown in Figure 10-4. By
default, the contents of the user’s Home folder are saved in a disk image
file, which you can restore with Disk Utility — in the Deleted Users folder.

Figure 10-4:
This is your
last chance
to save the
stuff from a
deleted user
account.
|

3. To clean up completely, select the Delete the Home Folder radio
button and then click OK.

Snow Leopard wipes everything connected with the user account off
your hard drive.

4. Press 38+Q to close the System Preferences window.
Time once again for a Mark’s Maxim:

Always delete unnecessary user accounts. Otherwise, you’re leaving holes
in your laptop’s security.™
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Figure 10-5:
Add apps to
your Login
Items list.
|

Setting up Login Items
and Parental Controls

Every account on your MacBook can be customized. Understandably, some
settings are accessible only to admin-level accounts, and others can be
adjusted by standard-level accounts. In the following sections, I introduce
you to the things that can be enabled (or disabled) within a user account.

Automating with Login Items

Login Items are applications or documents that can be set to launch or load
automatically as soon as a specific user logs in — for example, Apple Mail or
Address Book. In fact, a user must be logged in to add or remove Login Items.
Even an admin-level account can’t change the Login Items for another user.

A user must have access to the Accounts pane within the System Preferences
window to use Login Items. As you can read in the following section, a user
can be locked out of System Preferences, which makes it more difficult for
Login Items to be added or deleted for that account. (Go figure.)

To set Login Items for your account, follow these steps:

1. Click the System Preferences icon on the Dock, and then click the
Accounts icon.

2. Click the Login Items tab to display the settings that you see in
Figure 10-5.

3. Click the Add button (with the plus sign) to display a file selection
sheet.

www.it-ebooks.info

153


http://www.it-ebooks.info/

754 Part lll: Connecting and Communicating

3

<MBER
é"\&

4. Navigate to the application you want to launch each time you log in,
click it to select it, and then click Add.

If you're in the mood to drag and drop, just drag the applications you
want to add from a Finder window and drop them directly into the list.

5. Press $+Q to quit System Preferences and save your changes.

If the application is running at the moment, you can take an easy shortcut and
avoid these steps: Simply right-click on the application icon in the Dock and
choose Open at Login from the pop-up menu that appears.

Login Items are launched in the order that they appear in the list, so feel free
to drag the items into any order you like.

Managing access settings for an account

A standard-level account with restrictions is a managed account. (You can
read about these accounts earlier in this chapter.) With these accounts, you
can restrict access to many different places within Snow Leopard and your
laptop’s applications via Parental Controls. (Naturally, admin-level accounts
don’t have Parental Controls because an admin account has no restrictions.)

In short, Parental Controls come in handy in preventing users — family mem-
bers, students, co-workers, friends, or the public at large — from damaging
your computer, your software, or Snow Leopard itself. If an account has been
restricted with Parental Controls, the account description changes from
Standard to Managed in the Accounts list.

To display the Parental Controls for a standard account, start here:

1. Log in with an admin-level account.
2. Open System Preferences and then click Accounts.

3. Click the Standard account in the list and then select the Enable
Parental Controls check box.

Now click the Open Parental Controls button to display the specific catego-
ries (tabs) that you see in Figure 10-6:

1 System: These settings (which I discuss in more detail in a second)
affect what the user can do within Snow Leopard as well as what the
Finder itself looks like to that user.

v Content: These settings control the Dictionary and Safari applications.
If you prefer that profane terms be hidden within the Dictionary for this
user, select the Hide Profanity in Dictionary check box to enable it. Snow
Leopard also offers three levels of control for Web sites:
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e Allow Unrestricted Access: Select this radio button to allow unfet-
tered access for this user.

e Try to Limit Access: You can allow Safari to automatically block
Web sites that it deems “adult.” To specify particular sites that
Safari should allow or deny, click the Customize button. On the
Customize sheet, click the Add button under the Always Allow
These Sites list box to enter the Web addresses that you approve;
then click the Add button under the Never Allow These Sites list
box to enter those Web addresses to be banned.

e Allow Access to Only These Websites: Select this radio button to
specify which Web sites the user can view. To add a Web site,
click the Add button (which bears a plus sign); Snow Leopard then
prompts you for a title and the Web site address.

v Mail & iChat: Select the Limit Mail and the Limit iChat check boxes to
specify the e-mail and instant-messaging addresses that this user can
communicate with. To add an address that the user can e-mail or chat
with, click the Add button.

If you want a notification if the user is attempting to send an e-mail to
someone not in the list, select the Send Permission Requests To check
box to enable it and then type your e-mail address in the text box.

3

Figure 10-6:
You don't
have to be

a parent

to assign
Parental
Controls!
|
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v+~ Time Limits: Parents, click the Time Limits button, and you’ll shout with

pure joy! You can limit an account to a certain number of hours of usage
per weekday (Weekday Time Limits), limit to a specified number of
hours of usage per weekend day (Weekend Time Limits), and set a bed-
time computer curfew time for both weekdays and weekend days. (Note,
however, that the limit doesn’t apply to holidays or vacations!)

1 Logs: Snow Leopard keeps a number of different types of text log files

(which track where the user goes on the Internet, which applications are
launched by the account, and the contents of any iChat conversations
where the user was a participant). From this central pane, you can moni-
tor all the logs for a particular account. Note that these logs are enabled
or disabled from other locations within Snow Leopard. For example,

the log showing the Web sites visited and blocked is enabled from the
Content panel that [ describe a little earlier, whereas the applications
log is enabled from the System panel. iChat logging is turned on from the
Preferences dialog within the iChat application.

You can always tell whether an account has been assigned Parental Controls

because the account description changes from Standard to Managed in the
Accounts list.

Of particular importance are the System controls. Click the System tab to
modify these settings:

v Use Simple Finder: The Simple Finder is a great idea for families and

classrooms with smaller children. For the ultimate in restrictive Snow
Leopard environments — think public access or kiosk mode — you can
assign the Simple Finder to an account. Even the Dock itself is restricted,
sporting only the Finder icon, Trash, the Dashboard, and those folders
that allow the user to access their documents and applications.

v Only Allow Selected Applications: When this option is enabled, you can

select the specific applications that appear to the user. These restric-
tions are in effect whether the user has access to the full Finder or just
the Simple Finder:

e To allow access to all the applications of a specific type: Select the
check box next to the desired group heading to enable it. This
includes iLife, iWork, Internet, Widgets, Other, and Utilities.

e To restrict access to all applications within a group: If a group head-
ing check box is selected and you want to deny access to all the
applications in that group, deselect the check box next to the
heading to disable it.

¢ To toggle restriction on and off for specific applications within these
groups: Click the triangle icon next to each group heading to expand
its list and then either select or deselect the check box next to the
desired applications. Snow Leopard denotes partial access within
a group — a mixture of full and restricted applications — with a
dash mark in the group heading check box.
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To locate a specific application, click in the Search box and type
the application name.

¢ To add a new application to the Allow list: Drag its icon from the
Finder and drop it in the list within the Other group. After you add
an application, it appears in the Other group, and you can toggle
access to it on and off like the applications in the named groups.

1 Can Administer Printers: With this check box selected, the user can
modify the printers and printer queues within the Print & Fax pane in
System Preferences. If disabled, the user can still print to the default
printer and switch to other assigned printers, but can’t add or delete
printers.

v Can Burn CDs and DVDs: Deselect this check box to prevent the user
from recording CDs or DVDs via the built-in disc-recording features in
Mac OS X. (Note: If you load a third-party recording program, such as
Toast, the user can still record discs with it unless you deny the user
access to the burning program.)

v Can Change Password: Select this check box to allow the user to change
the account password.

<® If you're creating a single standard-level account for an entire group of
people to use — for example, if you want to leave the machine in kiosk
mode in one corner of the office or if everyone in a classroom will use
the same account on the machine — [ recommend disabling the ability
to change the account password. (Oh, and please do me a favor .. . don’t
create a system with just one admin-level account that everyone is sup-
posed to use! Instead, keep your one admin-level account close to your
bosom and create a standard-level account for the Unwashed Horde.)

v Can Modify the Dock: Select this check box, and the user can add or
remove applications, documents, and folders from the Dock in the full
Finder. (If you don’t want the contents of the Dock changing according
to the whims of other users, it’s a good idea to deselect this check box.)

Mundane Chores for the
Multiuser Laptop

After you’re hip on user accounts and the changes you can make to them,
turn to a number of topics that affect all users of your MacBook — things like
how they log in, how a user can share information with everyone else on the
computer, and how each user account can be protected from unscrupulous
outsiders with state-of-the-art encryption. (Suddenly you're James Bond!
told you Snow Leopard would open new doors for you.)
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Figure 10-7:
The Fast
User
Switching
menu,
unfurled for
all to see.
|

Logging in and out in Snow
Leopard For Dummies

Hey, how about the login screen itself? How do your users identify them-
selves? Time for another of my “Shortest books in the For Dummies series”
special editions. (The title is practically longer than the entire book.)

Snow Leopard offers four methods of logging folks in to your multiuser laptop:

v The username and password login: This is the most secure type of login

screen you'll see in Snow Leopard because you have to actually type
your account username and your password. (A typical hacker isn’t going
to know all the usernames on your MacBook.) Press Return or click the
Log In button to complete the process.

When you enter your password, you see bullets rather than your pass-
word because Snow Leopard displays bullet characters to ensure secu-
rity. Otherwise, someone could simply look over your shoulder and see
your password.

Keep your laptop secure: Use a username and password login, and
always choose a password that’s tough to guess.™

v The list login: This login screen offers a good middle of the road

between security and convenience. Click your account username in the
list and type your password when the login screen displays the pass-
word prompt. Press Return or click the Log In button to continue.

v Fast User Switching: This feature allows another user to sit down and

log in while the previous user’s applications are still running in the back-
ground. This is perfect for a fast e-mail check or a scan of your eBay bids
without forcing someone else completely off the MacBook. When you
turn on Fast User Switching, Snow Leopard displays the currently active
user’s name at the right side of the Finder menu bar.
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To switch to another account
a. Click the current user’s name in the Finder menu (see Figure 10-7).
b. Click the name of the user who wants to log in.

Snow Leopard displays the login window, just as if the laptop had
Vg\‘;\NG! been rebooted.

The previous user’s stuff is still running, so you definitely
shouldn’t reboot or shut down the computer!

To switch back to the previous user
a. Click the username again on the Finder menu.
b. Click the previous user’s name.

For security, Snow Leopard prompts you for that account’s login
password.

v Auto login: This is the most convenient method of logging in but offers
no security whatsoever. Snow Leopard automatically logs in the speci-
@‘“\NG! fied account when you start or reboot your MacBook.
s [ strongly recommend that you use auto login only if
® Your laptop is in a secure location — say, your home or a locked
office. If you're on the road, you and your data need the protection
of a username and password login!

® You are the only one using your laptop.

® You're setting up a public-access laptop kiosk, in which case you
want your MacBook to immediately log in with the public account.

Working in a public environment? Never set an admin-level account
as the auto login account. This is the very definition of ASDI, or A
Supremely Dumb Idea.

To set up a username/password or list login, open System Preferences, click
the Accounts icon, and then display the Login Options settings (see Figure
10-8). Select the List of Users radio button for a list login screen, or select the
Name and Password radio button to require your users to type their full user-
name and password.

To enable Fast User Switching, select the Show Fast User Switching Menu As
check box (also shown in Figure 10-8).

To set Auto Login, click the Automatic Login pop-up menu and choose the

account that Snow Leopard should use (shown also by the now-legendary
Figure 10-8).
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Figure 10-8:
Configure
your login

settings
from the
Login
Options
pane.
|
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Logging out of Snow Leopard all the way (without Fast User Switching) is a
cinch. Just click the Apple menu (%) and then choose Log Out. (From the
keyboard, press 8+Shift+Q.) A confirmation dialog appears that automati-
cally logs you off in one minute. And that one minute is important because

if someone walks up and clicks Cancel, he’ll be using your laptop with your
account! Your MacBook returns to the login screen, ready for its next victim.
Heed this Mark’s Maxim:

Always click the Log Out button in the logout confirmation dialog before
you leave your MacBook.™

Interesting stuff about sharing stuff

You might wonder where shared documents and files reside on your MacBook.
That’s a good question. Like just about everything in Snow Leopard, there’s a
simple answer. The Users folder on your laptop has a Shared folder within it.
To share a file or folder, it should be placed in the Shared folder.

You don’t have to turn on file sharing in the Sharing pane of System
Preferences to use Shared folders on your laptop. Personal File Sharing affects
only network access to your machine by users of other computers.

Each user account on your MacBook also has a Public folder within that user’s
Home folder. This is a read-only folder that other users on your laptop (and
across the network) can access. They can only open and copy the files that it
contains. (Sorry, no changes to existing documents from other users or new
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documents from other users.) Every user’s Public folder contains a Drop Box
folder, where other users can copy or save files but can’t view the contents.
Think of the Drop Box as a mailbox where you drop off stuff for the other user.

Encrypting your Home folder can be fun

Allowing others to use your Mac laptop always incurs a risk — especially if
you store sensitive information and documents on your computer. Although
your login password should ensure that your Home folder is off limits to
everyone else, consider an extra level of security to prevent even a dedicated
hacker from accessing your stuff. All it takes is a forgetful moment in an air-
port or classroom, and your personal and business data is suddenly within
someone else’s reach. Adequate security is A Supremely Good Thing!

To this end, Snow Leopard includes FileVault, which automatically encrypts
the contents of your Home folder. Without the proper key (in this case, either
your login password or your admin’s master password), the data contained
in your Home folder is impossible for just about anyone to read. (I guess the
FBI or NSA would be able to decrypt it, but they’re not likely a worry at your
place!)

The nice thing about FileVault is that it’s completely transparent to you and
your users. In other words, when you log in, Snow Leopard automatically
takes care of decrypting the stuff in your Home folder for you. You literally
won’t know that FileVault is working for you (which is how computers are
supposed to work).

To turn on FileVault protection for a specific account, follow these steps:

1. Click the System Preferences icon on the Dock, and then click the
Security icon.

2. Click the FileVault button.
3. If necessary, click Set Master Password to create a master password.

You need to be logged in with an admin-level account to set a master
password. However, this needs to be done only once, no matter how
many accounts you're hosting on your MacBook. When using this
master password, any admin-level user can unlock any Home folder for
any user.

Before you move to Step 4, note that you must be logged in using the
account that requires the FileVault protection. (Therefore, if you had to log
in by using your admin-level account to set a master password, you have to
log out and log in again, using the account you want to protect. Arrgh.)
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. Click the Turn on FileVault button.
. Enter your account’s login password when prompted, and then click OK.

. Click the Turn on FileVault button on the confirmation screen.

N O G e

. After Snow Leopard encrypts your Home folder and logs you out, log
in again normally.

You're done!

Remember those passwords. Again, do not forget your account login password,
and make doggone sure that your admin user never forgets the master pass-
word! If you forget these passwords, you can’t read anything in your Home
folder, and even the smartest Apple support technician will tell you that noth-
ing can be done.
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Working Well with Networks

In This Chapter

Considering the benefits of a network

Choosing between wired and wireless networks
Sharing an Internet connection

Gathering the stuff you need to network
Making the network connection

Using your network

Protecting your MacBook with a firewall

n my book, network access ranks right up there with air conditioning and

the microwave oven. Like other “I can’t imagine life without them” kinds of
technologies, it’s hard to imagine sharing data from your laptop with others
around you without a network. Sure, I've used a sneakernet (the old-fashioned
term for running back and forth between computers with a floppy disk), but
for a long time now, Apple computers don’t even come with floppy drives.
(Heck, the MacBook Air doesn’t even come standard with an optical drive!)

Nope, networking is here to stay. Whether you use it to share an Internet
connection, challenge your friends to a nice relaxing game of WWII battlefield
action, or stream your MP3 collection to other computers that use iTunes,
you’ll wonder how you ever got along without one. In this chapter, I fill you in
on all the details you need to know to get your road warrior hooked up to a
new (or an existing) network.

What Exactly Is the Network Advantage?

If you have other family members with computers or if your MacBook is in
an office with other computers (including those rascally PCs), here’s just a
sample of what you can do with a network connection:
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v~ Share an Internet connection: This is the major reason why many fami-
lies and most small businesses install a network. Everyone can simul-
taneously use the same digital subscriber line (DSL) or cable Internet
connection on every computer on the network.

v~ Share a printer: You say your fellow employee — or even worse, your
big sister — has a great printer connected to his or her computer?
Luckily, that printer can be shared with anyone across your network.

+* Copy and move files of all sizes: Need to get a large iDVD project from
one Mac to another? With a network connection, you can accomplish
this task in just minutes. Otherwise you’d have to burn that file to a
DVD-R or use an external hard drive. A network connection makes copy-
ing as simple as dragging the project folder from one Finder window to
another. (MacBook Air owners, take note!)

v Share documents across your network: Talk about a wonderful col-
laboration tool. For example, you can drop a Word document or Keynote
presentation file in your Public folder and ask for comments and edits
from others in your office (or around the planet).

1 Stream music and video: With iTunes, you can share your audio and
video media collection on your MacBook Pro with other Macs and PCs
on your network. Your eyes and ears can’t tell the difference!

v Play multiplayer games: Invite your friends over and tell ’em that you're
hosting a LAN party (the techno-nerd term for a large gathering of game
players, connected through the same network, all playing the same mul-
tiplayer game). (Suddenly you’ll see firsthand just how devious a human
opponent can be.) Each participant needs to buy a copy of the same
game, naturally, but the fun you’ll have is worth every cent you spend.
Don’t forget the chips!

If your laptop isn’t within shouting distance of an existing network or you
don’t plan on buying any additional computers, stop right here because a
lone MacBook hanging out in your home with no other computers around
won’t need a network.

If you have just your Mac laptop and an Internet connection (either through
a dialup modem or a high-speed DSL/cable modem) and you have no plans to
add another computer or a network printer or mobile device, a network isn’t
necessary.

Should You Go Wired or Wireless?

After you decide that you indeed need a network for your home or office, you
have another decision to make: Should you install a wired network (running
cables between your computers) or a wireless network? Heck, should you
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throw caution completely to the wind and build a combination network with
both wireless and wired hardware?

Your first instinct is probably to choose a wireless network for convenience.

After all, this option allows you to eliminate running cables behind furniture (or
in the ceiling of your office). Ah, but I must show you the advantages to a wired
network as well. Table 11-1 shows the lowdown to help you make up your mind.

Table 11-1 Network Decision Making

Factor Wireless Networks Wired Networks
Speed Moderate Much faster
Security Moderate Better
Convenience Better Worse

Compatibility

Confusing standards

Easier to understand

Cables

Few (or none)

Required

As I call it, here are the advantages of choosing a wired or a wireless network

setup:

v Wired: Using a wired network offers two significant perks over a wire-

less network:

e Faster speeds: In general, wired networks that are compatible with
your MacBook are many times faster than the fastest 802.11n wire-

less connections.

QNING/ The performance of a wireless connection can be compromised
by interference (from impeding structures, such as concrete walls,
and from household appliances, such as some wireless phones and
microwave ovens) and by distance.

e Better security: A wired network doesn’t broadcast a signal that can
V&“\NG! be picked up outside your home or office, so it’s more secure.

Hackers can attack through your Internet connection, though.
Hence the section “USE YOUR FIREWALL!,” later in this chapter.

v Wireless: A wireless connection really has only one advantage, but it’s a
big one: convenience (which, in this case, is another word for mobility for
all your networked devices). Laptop owners crave this independence — a
freedom that desktop computers can only dream about.

Accessing your network anywhere within your home or office — without
cables — is so easy. You can also easily connect a wireless printer. And
when using an AirPort Express mobile Base Station, even your home
stereo can get connected to your MP3 collection on your MacBook. Read
more about base stations later on.
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Grafting wireless access to a wired network

Maybe you're caught in the middle, choosing
between wired and wireless networking? Or
perhaps you're already using a wired network
but would be absolutely thrilled by the idea
of sitting on your deck in the sunshine while
checking your e-mail on your laptop, unte-
thered. By combining both technologies, you
can get the faster transfers of a wired network
between all the computers in your office and

That is the configuration | use in my home
office. | use a wireless base station that also
includes a built-in wired switch, which is a very
common feature in today’s wireless routers
and base stations. My family gets all the conve-
nience a wireless network offers, and everyone
can connect to the Internet from anywhere in
our house. On the other hand, my office com-
puters have the faster performance and tighter

the freedom you crave. security of a wired network. Sassyindeed!

Be a Pal — Share Your Internet!

Time to see what’s necessary to share an Internet connection. In the follow-
ing sections, I cover two methods of connecting your network to the Internet.
(And before you open your wallet, keep in mind that you might be able to use
your laptop to share your broadband connection across your network!)

Using your MacBook as a sharing device

You can use your MacBook to provide a shared Internet connection across a
simple wireless network, using either

v A broadband DSL or cable connection
v An external USB dialup modem

I recommend sharing a dialup modem Internet connection only if you
have no other option. A dialup modem connection really can’t handle
the data transfer speeds for more than one computer to access the
Internet comfortably at one time. (In plain English, an external USB
modem that you add to your MacBook isn’t fast enough for both you and
your significant other to surf the Web at the same time.) Sharing a dialup
connection just isn’t practical.

WING/
&

In these configurations, the only hardware you need to buy for your wired
network is an external USB modem and an Ethernet switch (more on this
device in the next section).

www.it-ebooks.info



http://www.it-ebooks.info/

Chapter 11: Working Well with Networks 1 6 7

WMBER
@?«
&

Because your MacBook has built-in AirPort Extreme wireless hardware, it’s
easy to share your broadband connection wirelessly with other computers in
your home or office.

In either configuration, your laptop uses the Mac OS X Snow Leopard built-in
Internet connection-sharing feature to get the job done, but your Mac must
remain turned on fo allow Internet sharing. I show you how to do this in the
upcoming section, “Network Internet connections.”

Using a dedicated Internet-sharing device

You can also choose to use a dedicated Internet-sharing device (often called
an Internet router) to connect to your cable or DSL. modem. You do have

to buy this additional hardware, but here’s the advantage: Your MacBook
doesn’t have to remain turned on just so that everyone can get on the
Internet.

Internet routers usually include either wired or wireless network connec-
tions, and many include both.

Setting up an Internet router is usually a pretty simple matter, but the
configuration depends on the device manufacturer and usually involves a
number of different settings in System Preferences that vary according to the
model of router you're installing. Grab a diet cola, sit down with the router’s
manual, and follow the installation instructions you find there. (In many
cases, you must set up your cable or DSL modem as a bridge between your
ISP and your router, which should be covered in your modem and router
manuals as well.)

Most Internet routers offer a DHCP server, which automatically assigns
Internet protocol (IP) addresses, and [ strongly recommend that you turn on
this feature! (You can read more on DHCP later in this chapter, in the sidebar
“The little abbreviation that definitely could.”)

What Do 1 Need to Connect?

Most normal folks — whom I define as those who have never met a network
system administrator, and couldn’t care less — think that connecting to a
network probably involves all sorts of arcane chants and a mystical symbol
or two. In the following sections, I provide you with the shopping list that you
need to set up a network — or connect to a network that’s already running.
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Wireless connections

Today’s Mac laptops come complete with a built-in AirPort Extreme wire-
less card, so if you already have an AirPort Extreme or Express Base Station,
you're set to go. Otherwise, hold on tight while I lead you through the hard-
ware requirements for wireless networking.

The maximum signal range — and effectiveness — of any wireless network can
be impeded by intervening walls or by electrical devices, such as microwave
ovens and some wireless phones, all of which can generate interference.

Connecting a MacBook to an existing wireless network

Connecting a MacBook to an existing wireless network requires no extra
hardware because your hardware is already built in. (Whew. That was
easy!)

Using a base station to go wireless

If you decide that you want to build your own wireless network, you eschew
cables, or you want to add wireless support to your existing wired network,
you need a base station. (If you do have an existing wired network, the base
station can act as a bridge between computers using wireless hardware and
your wired network, allowing both types of computers to talk to each other.)
Such a wireless base station will either have

v A port that can connect to your existing wired network’s switch
v~ A full built-in switch for wired connectivity (which means you can sell
your old wired Ethernet switch to your sister in Tucson)

And, of course, a base station can simply act as a central switch for your
wireless network (with no support for a wired network).

You can use either a cool Apple Base Station or a boring 802.11n generic
wireless base station; however, the Apple hardware requires less configura-
tion and tweaking. (Sounds like a Mark’s Maxim!)

If you don’t want the hassle of tweaking PC hardware to accommodate your
Mac laptop, buy Apple hardware and software.™

Apple Base Station models

As listed in the upcoming Table 11-2, your MacBook can work with four differ-
ent Apple Base Station models for wireless networking:
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v AirPort Extreme

I recommend using AirPort Extreme if your network needs an enhanced
antenna, which provides greater range. You can read about connectivity
ranges in the upcoming Table 11-2.

v+ Time Capsule

Apple’s Time Capsule unit (an external wireless backup unit) isn’t just a
wireless remote hard drive. It can also act as a full AirPort Extreme Base
Station. In fact, the wireless specifications for a Time Capsule unit and
an AirPort Extreme Base Station are almost identical.

v AirPort Express (as shown in Figure 11-1)
I recommend using AirPort Express if you want to

e Carry your wireless base station with you. Express is much smaller
than the other Apple Base Station models. (Think “party on the
patio” or a LAN gaming get-together at a friend’s house.)

e Connect your home stereo for wireless music streaming. You can use
the AirTunes feature in iTunes.

|
Figure 11-1:
The AirPort
Express por-
table Base
Station.
|
v AirPort (discontinued)
You might find an original 802.11b or 802.11g AirPort Base Station on
eBay or at a garage sale. Go ahead and pick it up if you want to save
cash, unless you're considering multiplayer gaming or using high-speed
file transfers over your wireless network.
\‘&N\BER The 802.11n standard used by the AirPort Extreme, Time Capsule, and
& AirPort Express Base Stations delivers a connection that’s several times

faster than the old AirPort Base Station’s 802.11b/802.11g standards.
802.11n is also compatible with all the older standards — 802.11b/a/g —
so | highly recommend that you stick with 802.11n in the future. It plays
well with others, and at warp speed to boot!

www.it-ebooks.info


http://www.it-ebooks.info/

’ 70 Part lll: Connecting and Communicating

\NG/
g““

Table 11-2 Apple Wireless Network Base Stations
Feature AirPort Extreme/ AirPort AirPort
Time Capsule Express
Price $180/$299 $99 $30 (used)
Users (maximum) 50 10 50
802.11n support Yes Yes No
802.11g support Yes Yes No
802.11b support Yes Yes Yes
LAN Ethernet jack Yes Yes Yes
(high-speed Internet
connection)
WAN Ethernet jack Yes No No
(wired computer
network)
Stereo mini-jack No Yes No
USB printer port Yes Yes No
Maximum signal 150 feet (standard); 150 feet 100 feet
range (approximate) 250 feet (with
add-on antenna)
AC adapter Separate on Builtin Separate
AirPort Extreme/
builtin on Time
Capsule

The names of the Apple Base Stations are irritatingly similar; Apple usually
does a better job of differentiating its product names. Jot down the name of
your model on a Sticky on your laptop’s Desktop just so that you don’t get
confused.

Installing an Apple Base Station is simple. Follow these steps:
1. If you have a DSL or cable modem, connect it to the WAN (wide-area

network) port on the base station with an Ethernet cable.

2. If you have an existing wired Ethernet computer network with a
switch or router, connect it to the Ethernet LAN port on the base sta-
tion with an Ethernet cable.

Remember that only the AirPort Extreme and Time Capsule stations
have a WAN port.
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3. If you have a USB printer, connect it to the USB port on the base station.

As I mention in Table 11-2, older AirPort Base Stations didn’t have USB
ports.

I cover the steps to share a printer in the upcoming section, “Sharing a
network printer.”

4. Connect the power cable from the AC power adapter.

The AirPort Express and Time Capsule units have a built-in AC adapter,
so if you're using one of these models, just plug the device itself into
the wall.

5. Switch on your base station.

6. Run the installation software provided by Apple on your laptop.

Using non-Apple base stations

If any company other than Apple manufactured your wireless base station,
the installation procedure is almost certainly the same. (Naturally, you
should take a gander at the manufacturer’s installation guide just to make
sure, but I added many different brands of these devices and used the same
steps for each one.)

However, [ should note that Apple wireless hardware uses a slightly different
security encryption standard than most PC wireless hardware, which results
in an extra hurdle to connecting to a non-Apple base station or access point
with your laptop. (More on this in the next section. For now, just remember
that [ recommend using Apple wireless hardware with your MacBook when-
ever possible. It’s just a little easier!)

Joining a wireless network

As far as I'm concerned, the only two types of base stations on the planet are
Apple and non-Apple (which includes all 802.11n and 802.11g base stations
and access points). In the following two sections, I relate what you need to
know to get on-board with either type of hardware.

Apple AirPort Base Stations

To join a wireless network that’s served by any flavor of Apple Base Station,
follow these steps on each Mac with wireless support:

1. Click the System Preferences icon on the Dock.

2. Click the Network icon.

3. From the Connection list on the left, click AirPort.

4. Select the Show AirPort Status in Menu Bar check box.
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5. Click the Apply button.
6. Press 38+Q to quit System Preferences and save your settings.

7. Click the AirPort status icon (which looks like a fan) on the Finder
menu bar.

8. From the AirPort menu, choose an existing network connection that
you’d like to join.

The network name is the same as the network name you chose when
you set up your AirPort Base Station.

9. If you set up a secure network, enter the password you assigned to the
network during setup.

By the way, security is always A Good Thing, and I strongly recommend that
you enable the password encryption features of your Apple Base Station
while installing it! (Luckily, the Apple Base Station setup application leads
you through this very process.) In the words of an important Mark’s Maxim:

Keep uninvited guests out of your network! Use your base station’s security
features and encrypt your data by using WPA2 encryption!™

Some wireless networks might not appear in your AirPort menu list. These
are closed networks, which can be specified when you set up your AirPort
Base Station. You can'’t join a closed network unless you know the exact net-
work name (which is far more secure than simply broadcasting the network
name). To join a closed network, follow these steps:

1. Choose Join Other Network from the AirPort menu.

To open the menu, click the AirPort status icon (which looks like a fan)
on the Finder menu bar.

2. Type the name of the network.

3. If the network is secured with WPA, WPA2, WEP, or LEAP encryption —
the security standards for protecting your data through encryption —
click the Security pop-up menu and choose which type of encryption
is being used.

[ recommend avoiding WEP encryption whenever possible — your best
bet is WPA2 encryption, which is the current standard for home wireless
networks.

4. Enter the network password, if required.
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To disconnect from an AirPort network, click the AirPort menu and either

v Choose Turn AirPort Off.
v Connect to another AirPort network.

In other words, if you choose another available AirPort network from
the AirPort menu, your MacBook will automatically drop the previous
connection. (You can only be connected to one wireless network at a
time, which makes Good Sense.)

Using non-Apple Base Stations

If you're using your MacBook to connect to a non-Apple base station at
your office, you might need to follow a specific procedure that takes care of
the slightly different password functionality used by standard 802.11b/g/n
hardware.

Snow Leopard can take care of many potential wireless “language barriers”
caused by security encryption — the two most common forms are WPA2 and
WEP — so whether you need to massage your password to connect to your
non-Apple base station depends on the specific hardware and encryption
system that it uses.

To read or print the latest version of this procedure, fire up Safari and visit
http://kbase.info.apple.com/index.html, searching for the number
106250. (This is the Apple Knowledge Base article number, which you can
type in the first search field.) This article provides the details on how to con-
vert a standard wireless encrypted password to a format that your AirPort
Extreme hardware can understand.

Wired connections

If you're installing a wired network, your MacBook or MacBook Pro already
comes with most of what you need for joining your new cabled world. You
just connect the hardware and configure the connection. Don’t forget that
you also need cables and an inexpensive Ethernet switch. (If you're using an
Internet router or other hardware sharing device, it almost certainly has a
built-in 4- or 8-port switch.)

Another aside to owners of MacBook Air laptops: Your machine doesn’t come
from Apple with a wired Ethernet port onboard, but you can add a USB-to-
Ethernet connector that allows you to use a wired network. After you add the
connector to your system, you can follow along without any problem.
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Connecting a MacBook or MacBook Pro to a wired network

Your Ethernet 10/100/1000 port (which looks like a slightly oversized modem
port) is located on one of the sides of your MacBook or MacBook Pro, ready
to accept a standard Ethernet Cat5/Cat5E/Cat6 cable with RJ-45 connectors.
If you're connecting to an existing wired network, you need a standard Cat5/
Cat5E/Cat6 Ethernet cable of the necessary length. I recommend a length of
no more than 25 feet because cables longer than 25 feet are often subject to
line interference (which can slow or even cripple your connection). You also
need a live Ethernet port from the network near your laptop. Plug the cable
into your MacBook, and then plug the other end into the network port.

Wired network hardware

If you don’t know your switch from your NIC, don’t worry. Here, [ provide you
with a description of the hardware that you need for your wired network.

Wired network components
If you're building your own wired network, you need

v A switch: This gizmo’s job is to provide more network ports for the
other computers in your network. They typically come in 4- and 8-port
configurations.

As I mention earlier in this chapter, most Internet routers (sometimes
called Internet-sharing devices) include a built-in switch, so if you've already
invested in an Internet router, make doggone sure that it doesn’t come
equipped with the ports you need before you go shopping for a switch!

v A number of Ethernet cables: Exactly how many cables you need is
determined by how many computers you’re connecting. If you're work-
ing with a Gigabit Ethernet system, you need Cat5E or Cat6 cables. Cat6
cables provide better performance, but they are more expensive.

Naturally, if you're using a broadband Internet connection, you also have a
DSL or cable modem. These boxes always include a port for connecting to
your wired Ethernet network. (If you have one of the new breed of wireless
modems — which acts as a wireless base station — don’t panic, for it should
also have a wired port for connecting to your existing switch.)

Wired network connections

After you assemble your cables and your router or switch, connect the Ethernet
cables from each of your computers to the router or switch and then turn on
the device. (Most need AC power to work.) Check the manual that comes with
your device to make sure that the lights you're seeing on the front indicate
normal operation. (Colors vary by manufacturer, but green is usually good.)

Next, connect your cable or DSL modem’s Ethernet port to the WAN port on

your switch with an Ethernet cable. If your modem isn’t already on, turn it on
now and check for normal operation.
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Figure 11-2:
All hail
DHCP, the
magical
networking
fairy!
|

When your router or switch is powered on and operating normally, you're
ready to configure Mac OS X for network operation. Just hop to the upcom-
ing section, “Connecting to the Network.” (How about that? Now you can add
network technician to your rapidly growing computer résumé!)

Joining a wired Ethernet network

After all the cables are connected and your central connection gizmo is
plugged in and turned on, you've essentially created the hardware portion of
your network. Congratulations! (Now you need a beard and suspenders.)

With the hardware in place, it’s time to configure Snow Leopard. In this sec-
tion, I assume that you're connecting to a network with an Internet router or
switch that includes a DHCP server. (Jump to the sidebar “The little abbrevia-
tion that definitely could,” later in this chapter, for more on DHCP.)

Follow these steps on each Mac running Mac OS X that you want to connect
to the network:

1. Click the System Preferences icon on the Dock.

2. Click the Network icon (under Internet & Network).

3. From the Connection list on the left, click Ethernet.

4. Click the Configure IPv4 pop-up menu (see Figure 11-2) and choose
Using DHCP.

5. Click the Apply button.
(The Apply button in the figure is grayed out because I'm already connected.)
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Enjoy the automatic goodness as Mac OS X connects to the DHCP server
to obtain an IP address, a subnet mask, a gateway router IP address, and
a Domain Name System (DNS) address. (Without a DHCP server, you'd
have to add all this stuff manually. Ugh.)

A few seconds after clicking the Apply button, you should see the infor-
mation come up. You might also notice that the DNS Server field is
empty, but fear not because Mac OS X is really using DNS Server infor-
mation provided by the DHCP server.

6. Press 3+Q to quit System Preferences and save your settings.

You're on!

Connecting to the Network

All right! The hardware is powered up, the cables (if any) are installed and
connected, and you configured Snow Leopard. You're ready to start (or join)
the party. In the following sections, I show you how to verify that you're con-
nected as well as how to share data and devices with others on your network.

The little abbreviation that definitely could

You know, some technologies are just peachy.
(So much for my liber-tech image.) Anyway,
these well-designed technologies work instantly,
you don't have to fling settings around like
wrapping paper on Christmas day, and every
computer on the planet can use them: Mac,
Windows, Linux, and even the laptops used by
funny-looking folks from Roswell, New Mexico.

Dynamic Host Configuration Protocol, or DHCP
for short, is about as peachy as it gets. This pro-
tocol enables a computer to automatically get
all the technical information necessary to join a
network. Let me hear you say, “Oh yeah!” Just
about every network device on the planet can
use DHCP these days, including Internet rout-
ers, switches, and (go figure) Mac 0S X. Today's
networking hardware and operating systems
provide a DHCP server, which flings the proper
settings at every computer on the network all
by itself. Your Mac just accepts the settings and
relaxes in a placid networking nirvana.

In this book, you can bet the farm that | assume
that you want to use DHCP and that your net-
work hardware supports it as well. That way, |
won't spend 30 pages of this book leading you
through the twisting alleyways of manual net-
work settings. (If you're really into such things,
I spend those 30 pages and explain every single
techno-wizard detail in my book Mac 0S X
Snow Leopard All-in-0One For Dummies [pub-
lished by Wileyl. It's about 800 pages long —
hence the comprehensive angle.)

If you're connecting to an existing network, tell
the network administrator that you're taking
the easy route and using DHCP. One word of
warning, however: Adding more than one DHCP
server on a single network causes a civil war,
and your system will lock up tight. Therefore,
before adding hardware with a DHCP server to
an existing network, ask your network admin-
istrator to make sure that you aren’t making a
mistake.
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Verifying that the contraption works

After you have at least two computers on a wired or wireless network, test
whether they’re talking to each other over the network by pinging them. (No,
[ didn’t make up the term, honest.) Essentially, pinging another computer is
like yelling, “Are you there?” across a crevasse.

To ping another computer on the same network from any Mac running Snow
Leopard, follow these steps:

1. Open a Finder window, click Applications, and then click Utilities.

2. Double-click the Network Utility icon to launch the application.

3. Click the Ping tab; see Figure 11-3.

|
Figure 11-3:
Look, Ma,
I’'m pinging!
|
4. In the Enter the Network Address to Ping text field, enter the IP
address of the computer that you want to ping.
WMBER
g“(" e [f you’re pinging another Mac running Mac OS X, you can get the IP

address of that machine by simply displaying its Network pane
within System Preferences, which always displays the IP address.

e [f you're trying to ping a PC running Windows and you don’t know
the IP address of that machine, follow these steps:

a. Click Start, rightclick My Network Places (XP)/Network
and Windows 7), and then choose Properties.

b. From the Network Connections window, right-click your
Area Network connection icon and then choose Status from the
menu that appears.
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c. Click the Support tab.
The IP address of that PC is proudly displayed.
5. Select the Send Only x Pings radio button and enter 5 in the text field.
6. Click the Ping button.

* Yay!: If everything is working, you should see results similar to those
shown in Figure 11-3, in which I'm pinging my Windows server at IP
address 192.168.1.102, across my wired Ethernet network.

The address 192.168.1.xxx is a common series of local network IP
addresses provided by Internet routers, hubs, and switches with
DHCP servers, so don’t freak if you have the same local IP address.
Similarly, Apple tends to use the form 10.0.1.xxx for local networks.

e Nay: If you don'’t get a successful ping, check your cable connec-
tions, power cords, and Mac OS X settings. Folks using a wireless
connection might have to move closer to the network base station
to connect successfully, especially through walls.

Sharing stuff nicely with others

It works . . . by golly, it works! Okay, now what do you do with your all-new
shining chrome network connection? Ah, my friend, let me be the first to
congratulate you and the first to show you around! In the following sections,
[ cover the most popular network perks. (And the good news is that these
perks work with both wired and wireless connections.)

Network Intemet connections

If your DSL or cable modem plugs directly into your MacBook (rather than into a
dedicated Internet sharing device or Internet router), you might ponder just how
the other computers on your network can share that spiffy high-speed broad-
band connection. If you're running a wireless network, it comes to the rescue!

Follow these steps to share your connection wirelessly:

. Click the System Preferences icon on the Dock.
. Click the Sharing icon (under Internet & Network).
. Click the Internet Sharing entry in the Services list to the left of the pane.

. From the Share Your Connection From pop-up menu, choose Ethernet.

V1 = W N

. Select the AirPort check box (in the To Computers Using list).

Snow Leopard displays a warning dialog stating that connection sharing
could affect your Internet service provider (ISP) or violate your agree-
ment with your ISP. I've never heard of this actually happening, but if
you want to be sure, contact your ISP and ask the good folks there.
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6. Click Start in the warning dialog to continue.

7. Select the On check box next to the Internet Sharing entry in the
Services list.

8. Click the Close button to exit System Preferences.

\‘&N\BEB Sharing an Internet connection (without an Internet router or dedicated hard-
<
<&

ware device) through Mac OS X requires your computer to remain on continu-
ously. Remind others in your office or your home that the svelte laptop must
remain on, or they’ll lose their Internet connection! Naturally, when you take
off on your next trip with your road warrior, the folks left at your home or
office will be without an Internet connection until you return.

If your MacBook has an external USB modem, you can indeed share a dialup
modem Internet connection. Just don’t be too surprised if you quickly decide
to shelve the idea. Those dinosaurs are s-l-o-w beyond belief.

Don’t forget, you won’t need to configure Internet sharing if your DSL or
cable modem connects to a dedicated sharing device or router. That snazzy
equipment automatically connects your entire network to the Internet.

Network file sharing

You can swap all sorts of interesting files with other Macintosh computers on
your network. When you turn on Personal File Sharing, Snow Leopard lets all
Macs on the network connect to your MacBook and share the files in your Public
folder. (Note that sharing across a network is different from sharing a single
computer betwixt several people. I cover that environment in Chapter 10.)

Follow these steps to start sharing files and folders with others across your
network:

1. Click the System Preferences icon on the Dock.
2. Click the Sharing icon.

3. Select the On check box next to the File Sharing service entry to
enable the connections for Mac and Windows sharing.

Other Mac users can connect to your computer by clicking Go in the Finder
menu and choosing the Network menu item. The Network window appears,
and your laptop is among the choices. If the other Macs are running Snow
Leopard, your MacBook’s shared files and folders appear in a Finder
window, and they’re listed under the Shared heading in the Sidebar.

Windows XP users should be able to connect to your Mac from their

My Network Places window, and Vista/Windows 7 users can use the
Network window. (Users of pre-XP versions of Windows, head to Network
Neighborhood.) Those lucky Windows folks also get to print to any shared
printers you've set up. (The following section covers shared printers.)

4. Click the Close button to exit System Preferences.
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Snow Leopard conveniently reminds you of the network name for your
MacBook at the bottom of the Sharing pane.

Shating a network printer
Boy, Howdy, do I love describing easy procedures, and sharing a printer on a
Mac network ranks high on the list! You can share a printer that’s connected
to your laptop (or your AirPort Extreme, Time Capsule, or AirPort Express
Base Station) by following these very simple steps:

1. Click the System Preferences icon on the Dock.

2. Click the Sharing icon.

3. Select the On check box next to the Printer Sharing service entry.

4.

Select the printer you want to share from the list at the right of the
System Preferences window.

5. Click the Close button to exit System Preferences.

A printer that you share automatically appears in the Print dialog on other
computers connected to your network.

USE YOUR FIREWALL!

Yep. That’s the only heading in this entire book that’s all uppercase. It’s that
important.

The following Mark’s Maxim, good reader, isn’t a request, a strong recom-
mendation, or even a regular Maxim. Consider it an absolute commandment
(right up there with Pay your taxes).

Turn on your firewall now.™

When you connect a network to the Internet, you open a door to the outside
world. As a consultant to several businesses and organizations in my home-
town, I can tell you that the outside world is chock-full of malicious individu-
als who would dearly love to inflict damage on your data or take control of
your MacBook for their own purposes. Call '’em hackers, call ’em delinquents,
or call ’em something [ can’t repeat, but don’t let them in!

Snow Leopard comes to the rescue again with the built-in firewall within Mac
0OS X. When you use this, you essentially build a virtual brick wall between
you and the hackers out there (both on the Internet, and even within your
local network). Follow these steps:
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. Click the System Preferences icon on the Dock.
. Click the Security icon.

. Click the Firewall tab.

. Click the Start button to activate your firewall.
. Click the Advanced button.

. Select the Enable Stealth Mode check box.

This is an important feature that prevents hackers from “trolling” for
your MacBook on the Internet — or, in normal-speak, searching for an
unprotected computer — so it’s much harder for them to attack you.

(I should also mention that it prevents other computers from pinging
you, so don’t be surprised if your MacBook suddenly clams up if you try
to ping it.)

7. Click OK.

8. Click the Close button to exit System Preferences.

S U AW N -

Snow Leopard even keeps track of the Internet traffic that you do want to
reach your laptop, such as Web page requests and file sharing. When you
activate one of the network features that [ demonstrate in the preceding
section, Snow Leopard automatically opens a tiny hole (called a port by net-
types) in your firewall to allow just that type of communication to your Mac.

For example, if you decide to turn on Web Sharing (as [ demonstrate earlier),
Snow Leopard automatically allows incoming Web access.

You can also add ports for applications that aren’t on the firewall’s Allow list.
This includes third-party Instant Messaging clients, multiplayer game serv-
ers, and so on. Depending on the type of connection, Snow Leopard will often
automatically display a dialog prompting you for confirmation before allow-
ing certain traffic, so most folks won’t need to do anything manually.

However, you can manually add a program to your list of allowed (or
blocked) firewall ports. Follow these steps:

1. Click the System Preferences icon on the Dock.

2. Click the Security icon.

3. Click the Firewall tab and click the Advanced button.

4. Click the Add button (which carries a plus sign).

Snow Leopard displays a standard File browsing sheet.
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5. Browse to the application that requires access to the outside world — or
the application that you want to block from outside communication —
and click it to select it.

6. Click the Add button in the File sheet.

The application appears in the Firewall list. By default, it’s set to Allow
Incoming Connections.

7. If you want to block any incoming communication to the application,
click the Allow Incoming Connections pop-up menu and choose Block
Incoming Connections instead.

8. Click the Close button to exit System Preferences.
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Spiffy Connections for
the Road Warrior

In This Chapter
Adding a printer or a scanner to your MacBook
Using Photo Booth
Putting Front Row to work

Watching cable or satellite TV on your laptop

Tlis chapter is all about getting interesting things connected to your
MacBook. Some are more common (almost mundane these days) and
pretty easy to take care of, such as scanners and printers. Then I might
surprise you with something new to you, like your laptop’s built-in video
camera, which is the perfect companion to Photo Booth.

[ also show you how to turn your road warrior into a photo booth, and how
to use an Apple Remote to control your MacBook or MacBook Pro wirelessly
by using Snow Leopard’s Front Row application. Heck, I even describe how
you can pull that fancy satellite or cable TV signal into your laptop.

Sure, you can connect your MacBook Pro to a printer and do some serious
work — but then again, you could also snap your photo and send it to your
friends as an e-mail attachment or upload it to your blog. Decisions, decisions!

Connecting Printers

<\

All hail the USB port! It’s the primary connection point for all sorts of good-
ies. In the following sections, I concentrate on adding a local USB printer and
describe the basics of adding a network printer to your system.

You can find out how to connect a wireless Bluetooth printer in the bonus
chapter available at my Web site at www.mlcbooks . com.
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USB printers

Connecting a USB printer to your MacBook is duck soup. Don’t you wish all
things in life were this easy? You might very well be able to skip most of the
steps in this section entirely, depending on whether your printer came with
an installation disc. (Virtually all do, of course, but you might have bought
yours used, say from eBay.)

Your printer needs to be fully supported within Mac OS X:
v~ If the software is designed for earlier versions of Mac OS X (say, v. 10.4

or v. 10.5), it probably works with Snow Leopard.

v | always recommend visiting the manufacturer’s Web site to download
the latest printer driver and support software before you install your
printer. That way, you know that you’re up to date. (Don’t forget to
check the Read Me file that accompanies your new software to make
sure that there are no new system requirements!)

Save and close open files and applications before installing your printer. You
might have to restart your laptop to complete the installation.

The physical connections for your printer are pretty simple:
1. Make sure that your printer’s USB cable is plugged in to both your
laptop and the printer itself.
2. After the USB connection is made, plug the printer in to an AC wall
socket and turn it on.

Don’t forget to add the paper and check the cartridge(s)!

The finishing printer installation steps depend on whether you have a manu-
facturer’s installation CD for your printer.

Sure, | have the install disc
If your printer comes with its manufacturer’s installation disc, follow these

steps when everything is connected and powered on:
1. Insert the installation disc in the laptop.

The disc contents usually appear in a Finder window. If they don’t, dou-
ble-click the installation disc icon on the Desktop to open the window.

If you're using a MacBook Air, you need to use either an external
SuperDrive or a computer with an optical drive on your local network.
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2. Double-click the installation application to start the ball rolling.
3. Follow the on-screen instructions.
Files get copied to your hard drive.

You might have to restart your MacBook.
You're ready to print!

Don’t forget to visit your printer manufacturer’s Web site to check whether
any driver updates are available for your particular model.

Whoops, | have diddly-squat (Software-wise)

Didn’t get an installation CD? Try installing the printer without software, or
download the software from the manufacturer’s Web site.

Installing without software

If you didn’t get an installation CD with your printer, you might be lucky
enough that your printer’s driver was included in your installation of Mac OS
X. First, press 38+P within an application to display the Print dialog, and see
whether the printer you connected is already recognized.

If it’s not displayed, here’s how to check for that pesky driver after you con-
nect the printer and switch it on:

. Open the System Preferences window.

. Click the Print & Fax icon.

. Click the Add button (which sports a plus sign).

- W N e

. Check the Printer list in the Printer Setup Utility window to see
whether your printer has already been added automatically within
Snow Leopard.

If your printer appears here, dance a celebratory jig. You can close
System Preferences and choose that printer from the Print dialog in your
applications. You can set it as the default from the System Preferences
Print & Fax pane; just click the Default Printer pop-up menu to select
your new printer.

Downloading software

If you don’t have installation software and your laptop doesn’t automatically
match your USB printer with a driver, it’s time to check the Internet to locate
a Snow Leopard-compatible driver for your printer.
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Check the manufacturer’s Web site for your printer’s software. Look for

1 Special software drivers that the printer might need

\NG/
§g~“ Install any drivers you find before you run an installation application.

Otherwise, the installation app might not be able to recognize or config-
ure the printer if the driver hasn’t been installed first.

v An installation application

If the manufacturer offers an installation application for your printer,
download the application and run it.

Networked printers

Your wired or wireless Ethernet network provides a quick and easy way to
share any printer that’s connected to your MacBook. Follow these steps to
share your printers across the network with others:

1. Click the System Preferences icon on the Dock.

2. Click the Sharing icon.

3. Select the On check box next to the Printer Sharing service entry.

4. Click the Close button to exit System Preferences.
In most cases, a printer that you share automatically appears in the Print
dialog on other computers connected to your network. Therefore, if you want
to access a printer being shared by another Mac across your network, open

the Print dialog within your application and click the Printer pop-up menu to
select it.

If the remote printer isn’t listed automatically, you can dig a little further.
To add a printer that another Mac on your network is sharing to your list of
printers, follow these steps:

1. Click System Preferences on the Dock.

2. Click the Print & Fax icon.

3. Click the Add button (which carries a plus sign).

4. Click the Default button on the toolbar.

Snow Leopard displays all the available local shared printers. Click the
desired printer and then click Add.
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Connecting Scanners
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USB and FireWire scanners practically install themselves. As long as the
model is listed as Mac OS X-compatible (check the system requirements on
the scanner’s box or on the manufacturer’s Web site for compatible comput-
ers) and it supports the TWAIN device standard (just about all scanners do),
things really are plug and play.

The MacBook Air doesn’t have a FireWire port, so it’s a USB-only ticket.

If you have the scanner manufacturer’s installation disc, go ahead and use
it. However, most scanners don’t require specialized drivers, so even that
orphan model that you picked up from Uncle Milton last year should work
(if it’s recognized by Mac OS X). It doesn’t hurt to check the manufacturer’s
Web site to see whether any of the software has been updated since the disc
was produced.

If Mac OS X doesn’t support your older scanner, a third-party application
might be able to help. Get thee hence to Hamrick Software at www . hamrick.
com and download a copy of the latest version of VueScan. This great scan-
ning application supports over 1,500 scanner models, including a number
that don’t work with Snow Leopard otherwise (and functionality that may not
be available using Snow Leopard’s default drivers). At $40, it’s a world-class
bargain to boot.

Ready to go? Make sure that your scanner is powered on and connected to
your laptop (and that you load a page or photograph to scan). If your scan-
ner’s installation disc provided you with a proprietary scanning application,
[ recommend that you use that application to test your scanner. In fact, it’s
Mark’s Maxim time!

If your printer or scanner includes bundled applications, use them!™

Sure, Mac OS X has the Print & Fax pane within System Preferences for printers
and the Image Capture application for scanners and digital cameras, but these
are bare-bones tools compared with the print manager and image acquisition
software that comes bundled with your hardware. I turn to Snow Leopard’s
built-in hardware for handling stuff only when I don’t have anything better.

Hey, 'm not saying that anything’s wrong with Image Capture, which is in
your Applications folder, if you need to use it. However, don’t expect Image
Capture to support any specialized features offered by your scanner (like
one-button e-mail or Web publishing). You have to use the application espe-
cially designed for your manufacturer and model to take advantage of any
extras that it offers.
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Of course, you can also search for a third-party application that out-performs
both the functionality built in to Snow Leopard and the manufacturer’s bun-
dled software! You're likely to pay for that third-party application, of course.

Using Photo Booth and Front Row

Figure 12-1:
The iSight
camerais

a sightto
behold.
|

Many Apple Switchers and first-time owners quickly notice that tiny square
lens and LED light at the top of the MacBook’s svelte frame. You're looking at
the lens of your laptop’s built-in iSight camera, which allows you to capture
video or snap a quick fun series of photos via Snow Leopard’s Photo Booth
application.

As if that wasn’t cool enough, you can also use the Apple Remote to con-

trol your MacBook from the comfort of your lounge chair or breakfast nook
via Snow Leopard’s Front Row software. You can pick an Apple Remote on
Apple’s Web site. Note, however, that the MacBook Air is not compatible with
the Apple Remote because the Air model doesn’t have an infrared sensor.

Capturing the moment with Photo Booth

What’s that you say? You've never used a computer video camera? Well then,
good reader, you've come to the right place!

The iSight camera’s indicator light (see Figure 12-1) glows green whenever
you're taking a snapshot or recording video . . . which, when you think about
it, is A Good Thing (especially if you prefer chatting at home in Leisure Mode).

Camera
indicator light

iSight
camera lens
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Figure 12-2:
Photo Booth
does one
thing
particularly
well —
candid
photography.
|

If you need a quick picture of yourself for use on your Web page, or perhaps
your iChat icon needs an update to show off your new haircut, use Photo
Booth to capture images at 640 x 480 resolution and 32-bit color. Although
today’s digital cameras can produce a much higher-quality photo, you can’t
beat the built-in convenience of Photo Booth for that quick snapshot!

To snap an image in Photo Booth, follow these steps:

1. Launch Photo Booth from the Dock or from the Applications folder.
Check out that glowing LED!

2. (Optional) Click the Effects button to choose an effect that you’d like
to apply to your image.

Photo Booth displays four screens of thumbnail preview images. Each
screen displays nine thumbnails (see Figure 12-2) so that you can see
how each effect changes the photo. To move through the thumbnail
screens, click the Previous and Next arrow buttons that appear around
the Effects button.

Film strip viewer
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You can produce some of the simple effects you might be familiar with
from Photoshop (such as a black-and-white image or a fancy, colored
pencil filter), but it can also deliver some mind-blowing distortion
effects, and even an Andy Warhol-style pop-art image!

Of course, you can always launch your favorite image editor afterward
to use a filter or effect on a photo — for example, the effects available in
iPhoto — but Photo Booth can apply these effects automatically as soon
as you take the picture.

3. (Optional) Click a thumbnail to select the desired effect.

To return the display to normal, click the Normal thumbnail, which
appears in the center. (Um, that would be Paul Lynde’s spot, for those of
you old enough to remember Hollywood Squares.)

4. Click the Camera button.

The image appears in the filmstrip at the bottom of the window.
Photo Booth keeps a copy of all the images you take in the filmstrip so that
you can use them later. After you click a photo in the filmstrip, a series of
buttons appear, inviting you take any one of a series of actions, including

v Sending the photo in an e-mail message

v Saving the photo directly to iPhoto

v+~ Using the image as your Snow Leopard user account icon
v Using the image as your iChat Buddy icon

To delete an image from the Photo Booth filmstrip, click the offending photo
and then click the X button that appears underneath.

If you're itching to connect a USB digital camera for use with iPhoto, let me
redirect you to Chapter 14, where I cover the iPhoto experience in depth.

To capture a video clip, click the Movie Clip button (which bears frames from
an old-fashioned movie reel) at the lower left of the Photo Booth window.
Click the Big Red Movie Button to start recording, and again to end the clip.

Controlling your laptop remotely
with Front Row

Okay, you've seen some neat stuff so far, but things get really cool about now!
With Apple’s Front Row software, you can turn your MacBook into a multime-
dia presentation center that can show off all your digital media to your ador-
ing public (and friends and family to boot). In fact, with the Apple Remote,
you don’t even have to leave the comfort of the couch to start the show.
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The Front Row application performs four different functions:

1 Watching DVD movies with DVD Player: If you already loaded a DVD
into your optical drive, you can watch it. (Sorry, your MacBook doesn’t
load the DVD for you. I guess some things have to remain manually
driven for a few years yet.) Naturally, MacBook Air owners need an
external SuperDrive to watch movies from a disc.

1 Viewing photos and slideshows: Front Row calls upon iPhoto so that
you can see your albums, film rolls, and slideshows.

v Displaying videos in QuickTime Player: You can choose a video you
download from the iTunes Music Store or save to your Movies folder.

1 Coaxing your favorite music, podcasts, and TV shows from your
iTunes Library: Find your media and playlists available from Front Row.

All this is accomplished by using the awesome, infrared Apple Remote (avail-
able from Apple for about $20). If your last computer — the beige box — didn’t
have a remote control, don’t panic. It’s as simple to use as an iPod shuffle!

To launch the application, press the Menu button on the remote. As long as
your laptop is on, Front Row runs automatically. To put your MacBook to
sleep after a night of fun, press and hold the Select/Play/Pause button.

Table 12-1 includes the important functions of the Apple Remote in Front Row.

Table 12-1 Using the Apple Remote in Front Row

Action Purpose

Menu Press to launch Front Row or to return to the previous
menu.

Volume/Menu Down Press to navigate down through menu options or to

lower the volume while media is playing.

Volume/Menu Up Press to navigate up through menu options or to raise
the volume while media is playing.

Select/Play/Pause Press to select a menu item, or play or pause media
from within iTunes, DVD Player, QuickTime, or iPhoto.

Next/Fast Forward Press to skip to the next song or DVD chapter, or hold
down to fast-forward through a song.

Previous/Rewind Press to skip to the previous song or DVD chapter, or
hold down to rewind a song.

You can also go the mundane route and use keyboard shortcuts to control
Front Row (but it’s nowhere near as cool). Table 12-2 explains the keyboard
shortcuts.
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Table 12-2 Using the Keyboard in Front Row
Action Keyboard Equivalent

Menu 88+Esc to enter the menu; Esc to exit it
Volume/Menu Down Down arrow ({)

Volume/Menu Up Up arrow (T)

Select/Play/Pause Spacebar or Return

Next/Fast Forward Right arrow (—)

Previous/Rewind Left arrow (<)

Note that Front Row has no complex configuration. Front Row is what designers
call a front-end application; that is, it launches the Snow Leopard applications
necessary to display or play the media you select. (You find a simple Settings
menu in Front Row, offering you the chance to toggle your screen saver and
menu sound effects off or on. Both options are turned on by default.)

Your Apple Remote works only with a handful of third-party applications at
the time of this writing. For example, you can use it as a presentation aid in
PowerPoint 2008. Several Apple applications do recognize the Apple Remote
(like Keynote), and it’s a sure bet that Apple will continue to add functionality
to the Apple Remote in the future. Check the Apple Remote section of Snow
Leopard’s online Help system to keep tabs on what’s happening!

Using iSight with iChat AV

Although your MacBook comes ready for videoconferencing, you should
understand two caveats before embarking on the Voyage of Video Chat:

1 Speed is an issue. To take advantage of video in iChat AV, you need a
fast Internet connection — at least high-speed DSL or cable Internet, or
even a connection between computers on the same network.

v+~ All participants need a video camera. Plenty of folks online have sud-
denly realized that most of their iChat AV buddies didn’t have video
capability!

Even though your laptop has an iSight camera installed, you can still join

text-based and audio chats. (Your Mac has a built-in microphone, so even if
your online buddies aren’t equipped with video hardware, you can enjoy an
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audio chat.) iChat AV displays audio and video buttons next to each person
on your buddy list to help you keep track of who can communicate with you
and how they can do it.

Starting a video chat is as simple as launching iChat AV from the Dock (or
from your Application folder). Then in the buddy list, click any buddy entry
with a Camera button next to it to connect. Wave hello for me!

Turning Your MacBook
into a TU — And More

Your laptop’s beautiful LED screen would seem to be the perfect artist’s
canvas for watching live cable or satellite TV broadcasts, but there’s no coax-
ial (coax) input on the back of your computer. Therefore, unless you invest in
some additional hardware, you're restricted to watching DVD movies (using
your optical drive) or watching movies and TV shows that you downloaded
from the iTunes Store and other Web sites.

Such an obvious need is going to be filled quickly, and a number of different
hardware manufacturers have produced external devices that can merge
your MacBook and your TV signal. Most are USB or FireWire peripherals, and
many have all the features of today’s TiVo and digital video recorders.

My favorite example is the EyeTV Hybrid Plus, from Elgato Systems (www .
elgato.com), which uses a USB connection (so it’s suitable for use with the
MacBook Air). Check out what this superstar includes for your investment
of $150:

v Built-in NTSC (analog) and ATSC (digital TV) tuners, cable-ready with a
coaxial connector

v The ability to pause, fast-forward, record, or even edit the video you
stored on your laptop’s hard drive

v Capability to schedule recordings with an on-screen program guide

v Full-screen TV display or in a window anywhere on your Desktop

v No external power supply required
[ really love the ability to fast-forward through commercials, and I can take
anything that I record on my MacBook Pro and use it in iDVD and iMovie. The

addition of TV under your control sorta finalizes the whole digital hub thing,
now doesn’t it?
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“Do you think the ‘Bidden Rhino’ clip shouid

come before or atter the “Waving Hello’
video clip?”
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In this part . . .

’{ere they are, the applications that everyone craves.
This part covers iTunes, iPhoto, iMovie, iDVD, and
GarageBand like your grandma’s best quilt. You discover
how to share your images, music, and video clips among
the iLife ’09 applications on your Mac laptop and how to
create everything from your own DVDs to a truly awesome
hardcover photo album!
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Chapter 13
The Multimedia Joy of iTunes

In This Chapter

Playing music with your MacBook

Arranging and organizing your music collection
Tuning into the world with Internet radio
Sharing your songs across a network

Creating eye candy with the Visualizer

Buying the good stuff from the iTunes Store

Sometimes, words just aren’t enough. iTunes is that kind of perfection.

To envision how iTunes changes your MacBook, you have to paint the pic-
ture with music — music that’s easy to play, easy to search, and easy to
transfer from device to device. Whether it be classical, alternative, jazz, rock,
hip-hop, or folk, I can guarantee you that you won't find a better application
than iTunes to fill your life with your music. And podcasts. And video. And
TV shows. And Internet radio. (See how hard it is to pin down this wonderful
application? Along with your MacBook, iTunes really does form the hub of
your digital lifestyle — including that snazzy new iPhone or iPad.)

In this chapter, I lead you through all the features of my absolute favorite
member of the iLife suite . . . and it’s going to be pretty doggone obvious how
much I appreciate this one piece of software.

What Can I Play on iTunes?

Simply put, iTunes is a media player; it plays audio and video files. These files
can be in any of many different formats. Some of the more common audio for-
mats that iTunes supports are

v MP3: The small size of MP3 files has made them popular for file trad-

ing on the Internet. A typical CD-quality, three-minute pop song in MP3
format has a size of 3-5MB.
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v AAC: AAC (short for Advanced Audio Coding) is an audio format that’s
very similar to MP3; in fact, AAC files offer better recording quality at the
same file sizes. However, this format originally supported a built-in copy
protection scheme that prevented AAC music purchased from iTunes
from being widely distributed on Macs. (Luckily, this copy protection is
no longer applied to iTunes tracks, and you can still burn protected AAC
tracks to an audio CD, just as you can MP3 tracks.) The tracks that you
download from the iTunes Store are in AAC format.

The iTunes Store’s iTunes Plus tracks are also in AAC format, and they're
encoded at a higher-quality 256-Kbps rate.

v~ Apple Lossless: Another format direct from Apple, Apple Lossless format
provides the best compromise between file size and sound quality: These
tracks are encoded without loss of quality. However, Apple Lossless
tracks are somewhat larger than AAC files, so it’s generally the favorite
of the most discerning audiophile for his or her entire Music Library.

v AIFF: The standard Macintosh audio format produces sound of the
absolute highest quality. This high quality, however, also means that the
files are pretty darn huge. A typical pop song in AIFF format has a size of
30-50MB (about 10MB per minute of audio).

1 WAV: Not to be outdone, Microsoft created its own audio file format (WAV)
that works much like AIFF. It can reproduce sound at a higher quality than
MP3, but the file sizes are very large, virtually identical in size to AIFF files.

v+ CD audio: iTunes can play audio CDs. Because you don’t usually store
CD audio anywhere but on an audio CD, file size is no big whoop.

v Movies and video: You can buy and download full-length movies, TV
shows, music videos, and movie trailers from the iTunes Store . . . and,
with an Apple TV unit connected to your home theater system, you can
watch those movies and videos from the comfort of your sofa on the
other side of your house.

v Podcasts: These audio downloads are like radio programs for your
iPod — but iTunes can play and organize them, too. Some podcasts also
include video and photos to boot.

+ Ringtones: iPhone owners, rejoice! iTunes automatically offers to create
ringtones for your iPhone from the tracks you bought from the iTunes
Store. (You can also create ringtones with GarageBand, using songs you
added to your iTunes Library or recorded yourself.)

v Audiobooks: No longer do you need cassettes or audio CDs to enjoy
your spoken books — iTunes can play them for you, or you can send
them to your iPod for listening on the go.

1 Streaming Internet radio: You can listen to a continuous broadcast of
songs from one of tens of thousands of Internet radio stations, with qual-
ity levels ranging from what you’d expect from FM radio to the full quality
of an audio CD. You can’t save the music in iTunes, but it’s still great fun.
(In fact, I run my own station . . . more on MLC Radio later in the chapter.)
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Playing an Audio CD

Figure 13-1:
The main
playback

controls:Play,
Previous,
and Next.
|

To play an audio CD in iTunes, insert the CD in your MacBook’s disc slot,
start iTunes by clicking its icon in the Dock, and click the Play button. (Note
that your Mac might be set to automatically launch iTunes when you insert
an audio CD.) The iTunes interface resembles that of a traditional cassette or
CD player. The main playback controls of the iTunes are Play, Previous Song,
Next Song, and the volume slider, as shown in Figure 13-1.

Play/Pause

Click the Play button to begin listening to a song. While a song is playing, the
Play button toggles to a Pause button. Clicking that button again pauses the
music.

Click the Next Song button to advance to the next song on the CD. The
Previous Song button works like the Next Song button but with a slight twist:
If a song is currently playing and you click the Previous Song button, iTunes
first returns to the beginning of the current song (just like a CD player). To
advance to the previous song, double-click the Previous Song button. To
change the volume of your music, click and drag the volume slider.
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As with other Macintosh applications, you can control much of iTunes with
the keyboard. Table 13-1 lists some of the more common iTunes keyboard
shortcuts.

Table 13-1 Common iTunes Keyboard Shortcuts

Press This Key Combination To Do This

Spacebar Play the currently selected song if iTunes is idle.

Spacebar Pause the music if a song is playing.

- Advance to the next song.

«— Go back to the beginning of a song. Press a
second time to return to the previous song.

%8+T Increase the volume of the music.

8+l Decrease the volume of the music.

98+0ption+d Mute the audio if any is playing. Press again to

play the audio.

Playing Digital Audio and Video

\\3

In addition to playing audio CDs, iTunes can play the digital audio files that
you download from the Internet or obtain from other sources in the WAV,
AAC, Apple Lossless, AIFF, and MP3 file formats. Enjoying a digital audio file
is just slightly more complicated than playing a CD. After downloading or
saving your audio files to your MacBook, open the Finder and navigate to the
stored files. Then simply drag the music files (or an entire folder of music)
from the Finder into the Music entry in the iTunes Source list. The added files
appear in the Music section of your iTunes Library. Think of the Library as a
master list of your digital media. To view the Music Library, select the Music
entry in the left column of the iTunes player, as shown in Figure 13-2. Heck,
you can also drag a song file from a Finder window and drop it on the iTunes
icon in the Dock, which adds it to your Music Library as well.

If you drop the file on top of a playlist name in the Source list, iTunes adds it
to that particular playlist as well as the main Library. (More about playlists in a
bit.) If you drop a folder of songs on top of the Playlists header, iTunes creates
a new playlist using the name of the folder and adds all the songs in the folder
to the new playlist.

To play a song, just double-click it in the Music list. Alternatively, you can use

the playback controls (Play, Previous Song, and Next Song) that I discuss ear-
lier in this chapter (refer to Figure 13-1).
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Figure 13-2:
The Music
Library
keeps track
of all your
audio files.
|

The Source list of iTunes can list up to five possible sources for music:

v Library: This section includes Music, Movies, TV Shows, Podcasts,
Books, Apps, and Radio. (Think Internet radio, which I discuss further in
the section “iTunes Radio,” later in this chapter.)

v Devices: If an iPod, iPhone, or iPad is connected, it appears in the list.
(And yes, Virginia, other models of MP3 players from other companies
also appear in the list if they support iTunes.) If you load an audio CD,
it appears in the Devices heading . . . anything from the Bee Gees to Fall
Out Boy.

v Store: | discuss the iTunes Store in the section “Buying Digital Media the
Apple Way,” later in this chapter.

v Genius: Why not let iTunes match new music to your tastes? You’'ll find
out more about the Genius feature later in this chapter in the section
“Keeping Slim Whitman and Slim Shady Apart: Organizing with Playlists.”

v Shared: If another Mac or PC on your local network is running iTunes
and is set to share part or all of its Library, you can connect to the other
computer for your music. (Shared music on another Mac appears as a
separate named folder in the Source list.)

v~ Playlists: Think of playlists as folders you use to organize your music.
(More on playlists later in this chapter.)
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If you've invested in an Apple TV, it will appear in the list as well, allowing
iTunes to share media with your Apple TV, which in turn sends it to your ED-
or HD-TV.

Notice also that the Library lists information for each song that you add to it,
such as

v Song Name: The title of the song

v+ Time: The length of the song

v Artist: The artist who performs the song

v Album: The album on which the song appears

If some of the songs that you're adding don’t display anything for the title,
album, or artist information, don’t panic; most MP3 files have embedded data
that iTunes can read. If a song doesn’t include any data, you can always add
the information to these fields manually. I show you how later, in the section
“Setting or changing the song information manually.”

Clicking any of the column headings in the Library causes iTunes to reorder
the Library according to that category. For example, clicking the Song Name
column heading alphabetizes your Library by song title. I click the Time head-
ing often to sort my Library according to the length of the songs. Oh, and you
can drag column titles to reorder them any way you like (as long as the Name
column remains at the far left of the named columns).

iTunes can display your Music Library in three ways: By default, the applica-
tion uses the List view you see in Figure 13-1, where each song is one entry.
Click the second View button (at the top of the iTunes window) to group
tracks together by album artwork in Grid view. Click the third View button,
and you’re browsing by album cover in Cover Flow view, complete with reflec-
tive surface!

Browsing the Library

After you add a few dozen songs to iTunes, viewing the Library can become a
task. Although a master list is nice for some purposes, it becomes as cumber-
some as an elephant in a subway tunnel if the list is very long. To help out,
iTunes can display your Library in another format, too: namely, Browsing
mode. To view the Library in Browsing mode, click the View menu and click
the Show Browser item, or press 38+B.
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Will | trash my Count Basie?

Novice iTunes users, take note: iTunes watches
your back when you trash tracks.

To illustrate: Suppose you delete a song from
the Library that's located only in the iTunes
music folder (which you didn’t copy into iTunes
from another location on your hard drive).
That means you're about to delete the song
entirely, and there’ll be no copy remaining on
your laptop. Rest assured, though, that iTunes
prompts you to make sure that you really want
to move the file to the Trash. (I get fearful e-mail

messages all the time from readers who are
loath to delete anything from iTunes because
they're afraid they’ll trash their digital music
files completely.)

Remember: f you delete a song from the Library
that also exists elsewhere on your hard drive
(outside the reach of the iTunes music folder),
it isn't deleted from your hard drive. In fact, if
you mistakenly remove a song that you meant
to keep, just drag it back into iTunes from the
Finder, or even from the Trash. ‘Nuff said.

The Browsing mode of iTunes displays your Library in a compact fashion,
organizing your tunes into four sections:

v Genre
v Artist
v Album
v Song Name

Selecting an artist from the Artist list causes iTunes to display that artist’s
albums in the Album list. Select an album from the Album list, and iTunes
displays that album’s songs in the bottom section of the Browse window.
(Those Apple software designers . . . always thinking of you and me.)

Finding songs in your Music Library

After your collection of audio files grows large, you might have trouble locat-
ing that Swedish remix version of “I'm Your Boogie Man.” To help you out,
iTunes has a built-in Search function. To find a song, type some text into the
search field of the main iTunes window. While you type, iTunes tries to find a
selection that matches your search text. The search is quite thorough, show-
ing any matching text from the artist, album, song title, and genre fields in the
results. For example, if you type electronic into the field, iTunes might return
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results for the band named Electronic or other tunes that you classified as
electronic in the Genre field. (The section “Know Your Songs,” later in this
chapter, tells you how to classify your songs by genre, among other options.)
Click the magnifying glass at the left side of the search field to restrict the
search to Artists, Albums, Composers, and Songs.

Removing old music from the Library

After you spend some time playing songs with iTunes, you might decide that
you didn’t really want to add 40 different versions of “Louie Louie” to your
Library. (Personally, I prefer either the original or the cast from the movie
Animal House.) To remove a song from the Library, click the song to select it
and then press Delete.

You can also remove a song from the Library by dragging it to the Trash in
your Dock.

Watching video

Watching video in iTunes is similar to listening to music. To view your video
collection, click one of these entries in the Source list:

v Movies
v TV Shows

If you select Movies or TV Shows, iTunes displays your videos as thumbnails,
as a list, or in Cover Flow view. Music videos appear as a smart playlist.

From your collection, you can

+* Double-click a video thumbnail or an entry in the list.

v Drag a QuickTime video clip from the Finder window to the iTunes
window. Video files that can be viewed by using QuickTime typically
have file extensions of .mov or .mp4.

iTunes plays video in the box below the Source list, within the iTunes
window, in a separate window, or in full-screen mode, depending on the set-
tings you’ve chosen on the General pane in the iTunes Preferences window.
In full-screen mode, move your pointer to display a control strip at the
bottom of the screen. The control strip sports a slider bar that you can
drag to move through the video, a volume control, and Play/Pause and Fast
Forward/Reverse buttons.
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Keeping Slim Whitman and Slim Shady
Apart: Organizing with Playlists

Your iTunes Music Library can contain thousands upon thousands of songs:
If your Library grows anywhere near that large, finding all the songs in your

lifelong collection of Paul Simon albums is not a fun task. Furthermore, with

the Library, you're stuck playing songs in the order that iTunes lists them.

To help you organize your music into groups, use the iTunes playlist fea-
ture. A playlist is a collection of songs from the Library you want to group
together. You can create as many playlists as you want, and each playlist can
contain any number of songs. Whereas the Library lists all available songs, a
playlist displays only the songs that you add to it. Further, any changes that
you make to a playlist affect only that playlist, leaving the Library intact.

To create a playlist, you can do any of the following:

v Choose Filer>New Playlist.
1 Press 3#8+N.

1 Choose Filem>New Playlist from Selection. This creates a new play-
list and automatically adds any tracks that are currently selected.
(Alternately, you can select a number of tracks and drag them onto the
Playlists heading with the same result.)

v Click a song to select it; then click the Genius button at the lower-
right corner of the window. (The Genius button bears a striking “atom’
symbol.) iTunes builds a playlist of songs that are similar in some
way (typically by matching the genre of the selection or the beats per
minute, but also based on recommendations from other iTunes mem-
bers). Your MacBook needs an Internet connection to create a Genius
playlist, and the larger your Music Library, the longer it will take iTunes
to build the playlist.

"

v Click the iTunes DJ entry in the Playlist section on the left side of the
window. iTunes delivers a random selection of songs taken from your
iTunes Music Library — perfect for your next spontaneous party! You
can change the order of the songs in the iTunes DJ playlist (known as
Party Shuffle in older versions of iTunes), add songs from your Library,
or delete songs that don't fit the scintillating ambience of your gather-
ing. Enjoy!

v Click the New Playlist button in the iTunes window (the plus sign
button in the lower-left corner). You get a newly created empty playlist
(the toe-tappin’ untitled playlist).
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Some playlists are smarter than others

Click the File menu, and you see the New Smart
Playlist menu command. The contents of a
smart playlist are automatically created from a
specific condition or set of conditions that you
set via the Smart Playlist dialog: You can limit
the track selection by mundane things, such
as album, genre, or artist; or you can get funky
and specify songs that were played last, by the
date you added tracks, or even by the sampling
rate or total length of the song. For example,
iTunes can create a playlist packed with songs
that are shorter than three minutes, so you can
fill your iPod Shuffle with more stuff! Ah, but
wait, you're not limited to a single criterion. If
you want to add another criterion, click the plus
sign at the right side of the dialog and you get
another condition field to refine your selection
even further.

You can choose the maximum number of songs
to add to the smart playlist, or limit the size of
the playlist by the minutes or hours of play or
the number of megabytes or gigabytes the play-
list will occupy. (Again, this is great for auto-
matically gathering as much from your KISS

collection as will fit into a specific amount of
space on a CD or your iPod.) Select the Live
Updating check box for the ultimate in con-
venience. iTunes automatically maintains the
contents of the smart playlist to keep it current
with your conditions at all times in the future. (If
you remove tracks manually from a smart play-
list, iTunes adds other tracks that match your
conditions.)

Now think about what all these settings mean
when combined . . . whoa. Here's an example
yanked directly from my own iTunes Library. |
created a smart playlist that selects only those
songs in the Rock genre. It's limited to 25 songs,
selected by least often played, and live updating
is turned on. The playlist is named Tracks I've
Gotta Hear because it finds the 25 rock songs
(from my collection of 1,654 songs) that I've
heard least often! After | listen to a song from
this smart playlist, iTunes automatically “fresh-
ens” it with another song, allowing me to catch
up on the tracks I've been ignoring. Completely,
unbelievably sweet— and another reason that
iTunes is the best music player on Planet Earth!

All playlists appear in the Source list. To help organize your playlists, it’s a
good idea to . . . well, name them. (Aren’t you glad now that you have this
book?) For example, suppose that you want to plan a party for your polka-

loving friends. Instead of running to your computer after each song to change

the music, you could create a polka-only playlist. Select and start the playlist
at the beginning of the party, and you won’t have to worry about changing

the music the whole night. (You can concentrate on the accordion.) To load a

playlist, select it in the Source list; iTunes displays the songs for that playlist.

The same song can appear in any number of playlists because the songs in a
playlist are simply pointers to songs in your Music Library — not the songs
themselves. Add and remove them at will to or from any playlist, secure in

the knowledge that the songs remain safe in the Library. Removing a playlist

is simple: Select the playlist in the Source list and then press Delete.

Removing a playlist doesn’t actually delete any songs from your Library.
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Know Vour Songs

Besides organizing your music into Elvis and non-Elvis playlists, iTunes gives
you the option to track your music at the song level. Each song that you add
to the Music Library has a complete set of information associated with it.
iTunes displays this information in the Info dialog, including

v Name: The name of the song

v Artist: The name of the artist who performed the song

v Composer: The name of the astute individual who actually wrote the song

v+ Album Artist: The name of the artist responsible for a compilation or
tribute album

v Album: The album where the song appears

v Grouping: A group type that you assign

v Year: The year the artist recorded the song

v BPM: The beats per minute (which indicates the song’s tempo)

v Track Number: The position of the song on the original album

v Disc Number: The original disc number in a multi-CD set

1+ Comments: A text field that can contain any comments on the song
v Genre: The classification of the song (such as rock, jazz, or pop)

You can display this information by clicking a song name and pressing 88+ —
the fields appear on the Info tab.

Setting the song information
automatically

Each song that you add to the iTunes Music Library might have song informa-
tion included with it. If you add music from a commercial audio CD, iTunes
connects to a server on the Internet and attempts to find the information for
each song on the CD. If you download a song from the Internet, it often comes
with some information embedded in the file already; the amount of included
information depends on what the creator supplied. (And believe me, it’s often
misspelled as well — think Leenard Skeenard.) If you don’t have an Internet
connection, iTunes can’t access the information and displays generic titles
instead.
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Figure 13-3:
View and
edit song

information

here.
|

Setting or changing the song
information manually

If iTunes can’t find your CD in the online database or someone gives you an MP3
with incomplete or inaccurate information, you can change the information
yourself — believe me, you want at least the artist and song name, as well as
the genre! To view and change the information for a song, perform the follow-
ing steps:

1. Select the song in either the Library’s Music category or a playlist.
2. Press 38+I or choose Filew>Get Info.

3. Edit the song’s information under the Info tab, as shown in Figure 13-3.

Keep in mind that the more work you put into setting the information of the
songs in your Library, the easier it is to browse and use iTunes. Incomplete
song information can make it more difficult to find your songs in a hurry.

If you prefer, you don’t have to change all information about a song (it just
makes life easier later if you do). Normally, you can get away with setting
only a song’s title, artist, and genre. The more information you put in, how-
ever, the faster you can locate songs and the easier they are to arrange.
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iTunes tries to help by automatically retrieving known song information, but
sometimes you have to roll up your sleeves and do a little work. (Sorry, but
the Data Elves are out to lunch.)

“What about cover art, Mark?” Well, I'm overjoyed that you asked! iTunes
can try to locate artwork automatically for the tracks you select. (Note that
adding large images can significantly increase the size of the song file.)
Follow these steps to locate cover art:

1. Select the desired songs from the track list.

2. Click Advanced=>Get Album Artwork.

<P You can set iTunes to automatically attempt the addition of album artwork
every time you rip tracks from an audio CD, or when you add songs without
artwork to your Music Library. Click iTunes and choose Preferences; then
click the Store button and select the Automatically Download Missing Album
Artwork check box to enable it.

<P Want to manually add album covers to your song info? Select one of (or all)
the songs from a single album in the track list, display the Info dialog, and
click the Artwork tab. Now launch Safari, visit Amazon.com, and do a search
on the same album. Drag the cover image from the Web page right into the
Info dialog, and drop it on top of the “sunken square” image well. When you
click OK, the image appears in the Summary pane, and you can display it while
your music is playing by pressing 88+G, or by pressing the Show or Hide Song
Artwork button at the lower left of the iTunes window! (Note that adding large
W images can significantly increase the size of the song file.)

By the way, if you buy tracks or an album from the iTunes Store, Apple always

automatically includes album covers. Thanks, Steve!

Ripping Audio Files

You don’t have to rely on Internet downloads to get audio files. You can create
your own MP3, AAC, Apple Lossless, AIFF, and WAV files from your audio
CDs with iTunes. (If you have a MacBook Air, you need an external drive [like
Apple’s SuperDrive] to read audio CDs. Go figure.) The process of converting
audio files to different formats is called ripping. (Audiophiles with technical
teeth also call this process digital extraction, but the popular crowd usually
ignores them at parties.) Depending on what hardware or software you use,
each has its own unique format preferences. For example, most iPod owners
prefer MP3 or AAC files, but your audio CDs aren’t in that format. Being able
to convert files from one format to another is like having a personal transla-
tor in the digital world. You don’t need to worry about whether you have the
wrong format; you can simply convert it to the format that you need.
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The most common type of ripping is to convert CD audio to the AAC or MP3
format. To rip MP3s from an audio CD, follow these simple steps:

1.

S U1 e W

Launch iTunes by clicking its icon in the Dock.

Alternatively, you can locate it in your Applications folder.

. Load an audio CD into your MacBook.

The CD title shows up in the iTunes Source list (under the Devices head-
ing), which is on the left side of the iTunes window. The CD track listing
appears on the right side of the window.

If iTunes asks you whether you want to import the contents of the CD
into your Music Library, you can click Yes and skip the rest of the steps;
however, if you’'ve disabled this prompt, just continue with the remain-
ing steps.

. Click the CD entry under the Devices listing.

. Click the Import Settings button.

. Choose MP3 Encoder from the Import Using pop-up menu.

. Choose High Quality (160 Kbps) from the Setting pop-up menu and

then click OK.

This bit rate setting provides the best compromise between quality and
file size (tracks you rip will be significantly smaller than “audiophile” bit
rates such as 192 Kbps or higher).

. Deselect the check box of any song that you don’t want to import from

the CD.

All songs on the CD have a check box next to their title by default.
Deselected songs aren’t imported.

. After you select the songs that you want to add to the Library, click

the Import CD button.

Tweaking the Audio for Vour Ears

Besides the standard volume controls that I mention earlier in this chapter,
iTunes offers a full equalizer. An equalizer permits you to alter the volume of
various frequencies in your music, allowing you to boost low sounds, lower
high sounds, or anything in between. Now you can customize the way your
music sounds and adjust it to your liking.

To open the Equalizer (shown in Figure 13-4), do one of the following:

v Choose Window=>Equalizer.

v Press 38+Option+2.
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Figure 13-4:
Use the
Equalizer
sliders to
tweak the
sound of
your music.
|

The Equalizer window has an impressive array of 11 sliders. Use the leftmost
slider (Preamp) to set the overall level of the Equalizer. The remaining sliders
represent various frequencies that the human ear can perceive. Setting a slider
to a position in the middle of its travel causes that frequency to play back with no
change. Move the slider above the midpoint to boost that frequency; conversely,
move the slider below the midpoint to reduce the volume of that frequency.

Continue adjusting the Equalizer sliders until your music sounds the way you like
it. When you close the Equalizer window, iTunes remembers your settings until
you change them again. In case you prefer to leave frequencies to the experts, the
iTunes Equalizer has several predefined settings to match most musical styles.
Click the pop-up menu at the top of the Equalizer window to select a genre.

After you adjust the sound to your satisfaction, close the Equalizer window
to return to the iTunes interface and relax with those funky custom notes
from James Brown.

A New Kind of Radio Station

Besides playing back your favorite audio files, iTunes can also tune in to
Internet radio stations from around the globe. You can listen to any of a large
number of preset stations, seek out lesser-known stations not recognized by
iTunes, or even add your favorite stations to your playlists. The following
sections show you how to do it all.
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iTunes Radio

Although it’s not a radio tuner in the strictest sense, iTunes Radio can locate

virtual radio stations all over the world that send audio over the Internet — a
process usually dubbed streaming among the “in” Internet crowd. iTunes can

track down hundreds of Internet radio stations in a variety of styles with only
a few clicks.

To begin listening to Internet radio with iTunes, click the Radio icon located
beneath the Library icon in the Source list. The result is a list of more than 20
types of radio stations, organized by genre.

When you expand a Radio category by clicking its triangle, iTunes queries a
tuning server and locates the name and address of dozens of radio stations
for that category. Whether you like Elvis or not-Elvis (those passing fads,
like new wave, classical, or alternative), something’s here for everyone. The
Radio also offers news, sports, and talk radio.

After iTunes fetches the names and descriptions of radio stations, double-
click one that you want to hear. iTunes immediately jumps into action, loads
the station, and begins to play it.

Tuning in your own stations

Although iTunes offers you a large list of popular radio stations on the Web,
it’s by no means comprehensive. Eventually, you might run across a radio
station that you’d like to hear, but it’s not listed in iTunes. Luckily, iTunes
permits you to listen to other stations, too. To listen to a radio station that
iTunes doesn’t list, you need the station’s Web address.

What's with the numbers next
to the station names?

When choosing an Internet radio station, keep At 128 Kbps, for example, you're listening to
your Internet connection speed in mind. If you're  sound that's almost as good as an audio CD.

using a broadband DSL or cable connection —
orifyou're listening at work over your company'’s
high-speed network — you can listen to stations
broadcasting at 128 Kbps (or even higher). The
higher the bit rate, the better the music sounds.

However, if you're listening over a dialup modem
connection, iTunes can’t keep up with audio
streaming at higher bit rates, so you're limited to
stations broadcasting at 56 Kbps or lower.

www.it-ebooks.info


http://www.it-ebooks.info/

Chapter 13: The Multimedia Joy of iTunes

“l have an itch to hear ‘Kung Fu Fighting'!”

This particular technology author has a prefer-
ence for a certain hot Net jam spot: MLC Radio,
the Internet radio station I've been running for
several years now. | call my station a ‘70s Time
Machine because it includes hundreds of clas-
sic hits from 1970 to 1979, inclusive. You hear
everything from “Rock and Roll Hoochie Koo”
by Rick Derringer to “Moonlight Feels Right” by

so be prepared for both Rush and the Captain
and Tennille, too.) The station broadcasts at
128 Kbps (near audio CD quality), so you need a
broadband connection to listen. For the radio’s
Internet address or help connecting to MLC
Radio, visit my Web site at www.m1cbooks .
com — and then follow the steps in the next
section to add MLC Radio to your playlists!

213

Starbuck. (Hey, I'm summing up a decade here,

In iTunes, choose Advanced=>Open Audio Stream (or press 8+U). In the
Open Stream dialog that appears (as shown in Figure 13-5), enter the URL of
your desired radio station and then click OK. Within seconds, iTunes tunes in
your station.

Figure 13-5:
Tuning into
MLC Radio,
my Internet
radio
station.
|
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Radio stations in your playlists

If you find yourself visiting an online radio station more than once, you'll be
glad to know that iTunes supports radio stations in its playlists. To add a
radio station to a playlist from the Radio list, do the following:

1. Open the category that contains the station you want to add to your
playlist.

2. Locate the station that you want to add to your playlist and drag it
from the Radio list to the desired playlist on the left.

If you haven'’t created any playlists yet, see the section “Keeping Slim
Whitman and Slim Shady Apart: Organizing with Playlists,” earlier in this
chapter, to find out how.

Adding a radio station that doesn’t appear in the Radio list is a bit trickier but
possible nonetheless. Even though iTunes allows you to load a radio station
URL manually by using the Open Stream command on the Advanced menu,

it doesn’t give you an easy way to add it to the playlist. Follow these steps to
add a specific radio station to a playlist:

1. Add any radio station from the Radio list to your desired playlist.

Any station in the list will do, as you’ll immediately change both the sta-
tion’s URL and name to create your new station entry in the playlist.

2. Press 38+I or choose Filer>Get Info to open the information dialog for
that station.

3. Click the Summary section and change the URL by clicking the Edit
URL button.

4. Enter the desired URL and click OK.
5. Click the Info tab, type the new station name, and then click OK.

iSending iStuff to iPod

If you're lucky enough (like me) to own an iPod, you’ll be happy to know that
iTunes has features for your personal audio and video jukebox as well. iPods,
Apple’s multimedia players, comprise an entire family of portable devices
(ranging from $59 to about $399) that can hold anywhere from about 300 songs
to literally thousands of songs, as well as podcasts, photos, and video. This great
gadget and those like it have become known worldwide as the preferred portable
digital media player. (Heck, even the iPhone and iPad can act as an iPod!)

You connect your iPod to any Macintosh or Windows PC with USB 2.0 ports

with the included cable. After the iPod is connected, you can synchronize
the iPod with iTunes. By default, this process is automatic: The iPod and the
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iTunes software communicate with each other and figure out what items are
in your iTunes Library (as compared to the iPod Library). If they discover
songs, podcasts, and video in your iTunes Library that are missing from your
iPod, the items automatically transfer to the iPod. Conversely, if the iPod con-
tains stuff that’s no longer in iTunes, the iPod automatically removes those
files from its drive.

Go back and reread that last sentence about the iPod automatically removing
files from its drive. (I'll wait here.) Apple added this feature in an effort to be
attentive to copyright concerns. The reasoning is that if you connect your
iPod to your friend’s computer, you can’t transfer songs from the iPod to that
computer. Of course, you could always look at it from the marketing perspec-
tive as a feature that makes sure that your MacBook and iPod are always in
total sync. Whatever the case, pay close attention and read all warning dialogs
when connecting to a computer other than your own, or you might wipe out
your iPod’s library.

You can change your settings so that iTunes autosyncs only selected playl-
ists. Or if you're really nervous, you can manually sync your iPod with iTunes.

This chapter — even as long as it is — just can’t explain all the ins and outs
of the iTunes/iPod relationship! For a complete look at both iTunes and the
iPod, I can heartily recommend a fellow For Dummies book, iPod & iTunes For
Dummies by Tony Bove (Wiley).

Sharing Media across a Network

Ready to share music, podcasts, and video — legally, mind you — with other
folks on your local network? You can offer your digital media to other iTunes
users across your home or office. Follow these steps:

1. Choose iTunes=>Preferences to open the Preferences dialog.

2. Click Sharing.

3. Select the Share My Library on My Local Network check box.

4

. Specify whether you want to share your entire library or only selected
playlists and files.

Sharing selected playlists is a good idea for those Meatmen and Sex
Pistols fans who work at a cubicle farm in a big corporation.

5. If you want to restrict access to just a few people, select the Require
Password check box; then type a password in the text box.

6. Click OK.

Your shared folder appears within the Source list for all iTunes users who
selected the Look for Shared Libraries check box on the same pane of their
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iTunes Preferences dialog. Note that the music you share with others can’t
be imported or copied, so everything stays legal.

Want to change that frumpy default name for your shared Media Library to
something more exotic, like “Dan’s Techno Beat Palace”? No problem — dis-
play the Preferences dialog again, but this time click the General button and
click in the Library Name text box. Edit your network entertainment persona
to your heart’s content.

iTunes also offers a feature called Home Sharing, which can automatically copy
the media you bought through the iTunes Store among other networked com-
puters in your home. (You can choose whether everything is shared, or just
specific items.) To enable Home Sharing, click the Home Sharing item under
the Shared category in the Source list, enter your iTunes Account information,
and then click Create Home Share. (Note that you also have to enter the same
iTunes Account and password on each computer that will share the media.)

Burning Music to Shiny Plastic Discs

\NG/
S

Besides being a great audio player, iTunes is adept at creating CDs, too. iTunes
makes the process of recording songs to a CD as simple as a few clicks. Making
the modern version of a compilation (or mix) tape is easier than getting a kid
to eat ice cream. iTunes lets you burn CDs in one of three formats:

v Audio CD: This is the typical kind of commercial music CD that you buy
at a store. Most typical music audio CDs store 700MB of data, which
translates into about 80 minutes of music.

v Data CD or DVD: A standard CD-ROM or DVD-ROM is recorded with the
audio files. This disc can’t be played in any standard audio CD player
(even if it supports MP3 CDs, which I discuss next). Therefore, you can
listen to these songs only by using iTunes (or another media player) on
aMac or a PC.

v MP3 CD: As does the ordinary computer CD-ROM that I describe, an
MP3 CD holds MP3 files in data format. However, the files are arranged
in such a way that they can be recognized by audio CD players that sup-
port the MP3 CD format (especially boom boxes, DVD players, personal
CD players, and car stereos). Because MP3 files are so much smaller
than the digital audio tracks found on traditional audio CDs, you can fit
as many as 160 typical 4-minute songs on one disc. These discs can also
be played on your MacBook via iTunes.

Keep in mind that MP3 CDs aren’t the same as the standard audio CDs that
you buy at the store, and you can’t play them in older audio CD players that
don’t support the MP3 CD format. Rather, this is the kind of archival disc that
you burn at home for your own collection.
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Sending music elsewhere with AirTunes

If you're using an AirPort Express portable wire-
less Base Station, you can ship your songs right
to your Base Station from within iTunes, and
from there to your home stereo or hoom box!

After your AirPort Express Base Station is
plugged in and you connect your home stereo
(or a boom box, or a pair of powered stereo
speakers) to the stereo minijack on the Base
Station, you see a Speakers pop-up list button
appear at the bottom of the iTunes window. (If

the Speakers button doesn’t appear, choose
iTunes=>Preferences to open the Preferences
dialog and click the Devices button on the
toolbar. Make sure that the Look for Remote
Speakers Connected with AirTunes check box
is selected.)

Click the Speakers button, and you can choose
to broadcast the music you're playing in iTunes
across your wireless network. Ain't technology
truly grand?

To begin the process, build a playlist (or select an existing playlist that you
want to record). If necessary, create a new playlist and add to it whatever
songs you would like to have on the CD. (See the earlier section, “Keeping
Slim Whitman and Slim Shady Apart: Organizing with Playlists,” if you need a
refresher.) With the songs in the correct order, select the playlist. Click the
Burn Disc button at the bottom of the iTunes window to commence the disc-
burning process. Click the desired recording format (again, usually Audio
CD) in the Burn Settings dialog that appears.

N To save yourself from sonic shock, [ always recommend that you select the

Sound Check check box before you burn. iTunes will adjust the volume on all

the songs on your audio CD so that they’ll play at the same volume level.

Ready to go? Click OK, and iTunes lets you know when the recording is
complete.

Feasting on iTunes Visuals

By now, you know that iTunes is a feast for the ears, but did you know that
it can provide you with eye candy as well? With just a click or two, you can
view mind-bending graphics that stretch, move, and pulse with your music,
as shown in Figure 13-6.

To begin viewing iTunes visuals, choose Viewr>Show Visualizer (or press
8+T). Immediately, most of your iTunes interface disappears and begins
displaying groovy lava lamp-style animations (like, sassy, man). To stop the
visuals, choose View=>Hide Visualizer (or press 38+T again). The usual sunny
aluminum face of iTunes returns.
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|
Figure 13-6:
iTunes can
display
some
awesome
patterns!
|
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You can also change the viewing size of the iTunes visuals on the View menu.
From the View menu item, choose Full Screen (or press 3+F). To escape from
the Full Screen mode, move your finger on the trackpad or press Esc.

You can still control iTunes with the keyboard while the visuals are zooming
around your screen. See Table 13-1 earlier in this chapter for a rundown on
common keyboard shortcuts.

The iTunes Visualizer has many hidden features. While viewing the
Visualizer, press ? to see a list of hidden Visualizer settings.

But wait, more Easter eggs are to be found! Again, while viewing the
Visualizer, press one of following keys:

1 M: Changes the Visualizer pattern

v P: Changes the Visualizer color scheme
Press either of these keys repeatedly to cycle through the various patterns
and color schemes lurking deep within the Visualizer. (Personally, I'm a

random Visualizer guy . . . so many patterns and schemes are available that I
just let my MacBook do all the work.)
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Backing up within iTunes

iTunes offers a built-in backup feature for your
Media Library — | told you this was the best
media player ever designed!

Choose FilecoLibrary=>Back Up to Disc to start
the process. You can choose to back up your
entire iTunes library and all your playlists (which
| recommend) or just the content you purchased
from the iTunes Store. Personally, if | lost every-
thing in my collection except for what | bought
from the iTunes Store, I'd be just as crushed.

Click Back Up, and iTunes prompts you for
blank CDs or DVDs. If you need to restore from
your completed backup, just launch iTunes and
load the first backup disc into your drive.

How often is often enough when it comes
to backing up your content? That depends
completely on how often your Media Library
changes. The idea is to back up often enough
so that you always have a recent copy of your
media files close by.

Back it all up, and you won't be sorry.

Additionally, you’ll find third-party Visualizer plug-ins available for download-
ing on Apple’s Web site and other Mac-related download sites — heck, some
even display lyrics, karaoke-style! Choose a different Visualizer plug-in from
the Viewr>Visualizer menu item. (Call me old-fashioned, but I like the default,
iTunes Visualizer.)

Buying Digital Media the Apple Way

Before we wave good-bye to the happy residents of iTunes iSland, I won’t
forget to mention the hottest spot on the Internet for buying music and video:
the iTunes Store, which you can reach from the cozy confines of iTunes.
(That is, as long as you have an Internet connection. If you don't, it’s time

to turn the page to a different chapter.) If you're not in iTunes, go to www.
apple.com/itunes/store.

Click the iTunes Store item in the Source list, and after a few moments, you're
presented with the latest offerings. Click a link in the store list to browse
according to media type, or click the Power Search link to search by song
title, artist, album, or composer. The Back/Forward buttons at the top of

the iTunes Store window operate much the same as those in Safari, moving
you backward or forward in sequence through pages you've already seen.
Clicking the Home button (which, through no great coincidence, looks like a
miniature house) takes you back to the Store’s main page.
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To display the details on a specific album, track, video, podcast, or audio-
book (whew), just click it. If you're interested in buying just certain tracks
(for that perfect road warrior mix), you get to listen to 30 seconds of any
track — for free, no less, and at full sound quality. To add an item to your
iTunes Store shopping cart, click the Add button. When you’re ready to buy,
click the Shopping Cart item in the Source list and then click the Buy Now
button. (At the time of this writing, tracks are usually 99 cents a pop, and an
entire album is typically $9.99 . . . what a bargain!)

The iTunes Store creates an account for you based on your e-mail address,
and it keeps secure track of your credit card information for future pur-
chases. After you use the iTunes Store once, you never have to log on or
retype your credit card information again (as long as you'’re logged on using
your account).

The tracks and files that you download are saved to a separate playlist called
Purchased. After the download is finished, you can play them, move them

to other playlists, burn them to CD or DVD, share ’em over your network, or
ship them to your iPod, just as you can any other item in your iTunes Library.

You can also put the Genius button to work for you, in league with the iTunes
store. Click the Show Genius Sidebar button at the lower-right corner of the
iTunes window — it looks like an arrow inside a square — and iTunes dis-
plays the Genius Sidebar, where iTunes recommends music that you can buy
in the iTunes Store that’s similar to the albums in your Music Library. Click
the button again to banish the sidebar.

Remember all those skeptics who claimed that buying digital audio and video
could never work over the Internet because of piracy issues and high costs?
Well, bunkie, hats off to Apple: Once again, our favorite technology leader
has done something the right way!
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The Masterpiece That Is iPhoto

In This Chapter

Importing pictures from your hard drive or digital camera

Organizing images with iPhoto

Tweaking the appearance of photographs
Creating a photo book

Sharing photos with your friends

Urtually every MacBook owner is likely to have a digital camera or a
scanner. Digital video (DV) camcorders have certainly grown more
plentiful over the past decade, and the iPod is still the hottest piece of music
hardware on the planet at the time of this writing. The digital camera, how-
ever, has reached what those funny (strange) marketing people refer to as
saturation, and iPhoto was written to address the needs of the vast majority
of MacBook owners!

With iPhoto, you organize, edit, and even publish your photographs. (It
sports more features than a handful of Swiss Army knives.) After you shoot
your photos with a digital camera, you can import them into iPhoto, edit
them, and publish them. You’re not limited to photos that you take yourself,
either; you can edit, publish, and organize all kinds of digital image files. You
can even create a photo album and use the iPhoto interface to order a hand-
some hard-bound copy shipped to you.

To sum it all up, I'm willing to bet that iPhoto is either the first or the second
iLife ’09 application that you fall in love with (running neck and neck with
iTunes). In this chapter, I show you how you can work digital image magic
with true Apple panache!
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Delving into iPhoto

In Figure 14-1, you can see most of the major controls offered in iPhoto ’09.
(Other controls automatically appear when you enter different modes;
[ cover them in upcoming sections of this chapter.)

|
Figure 14-1:
iPhoto
greets you
with an
attractive
window.
| ‘
Create button| Enter Full Screen button

Get Info button

Although these controls and sections of the window are covered in more detail
in the following sections, here’s a quick rundown of what you’re looking at:

v Source list: This list of image locations determines which photos iPhoto
displays.

* You can choose to display either your entire image library or just
the last event’s worth of digital images that you downloaded from
your camera.
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® You can create new albums of your own that appear in the Source
list; albums make it much easier to organize your photos.

¢ Photos can be grouped by Event (when they were taken), Faces
(who appears in the photos), Places (where photos were taken),
and Albums (the traditional method you may be familiar with from
older versions of iPhoto).

¢ You can create books, calendars, cards, and slideshows.

v Viewer: This pane displays the images from the currently selected
photo source.

You can drag or click to select photos in the Viewer for further tricks,
such as assigning keywords and image editing.

1 Create button: Click this button to add a new blank album, Smart Album,
MobileMe Gallery, book, calendar, card, or slideshow to your Source list.

v Get Info button: Click this button to display information on the cur-
rently selected photos.

v Enter Full Screen button: Click this button to switch to a full-screen
display of your photos. In full-screen mode, the images in the selected
album appear in a filmstrip across the top of the screen, and you can
click one to view that image, using your Mac’s entire screen real estate.
You can also use the same controls that I discuss later in this chapter
for editing and adjusting images; just move the cursor to the top edge of
the full-screen display to show the menu or to the bottom edge to show
the editing toolbar.

v~ Play Slideshow: Select an event, album, book, or slideshow in the
Source list (or multiple images you’ve selected in the Viewer) and click
this button to start a full-screen slideshow using those images.

v Search box: Click the button next to the Search text box to locate
photos by specific criteria, or just click in the box and start typing to
search by description and title.

+ Toolbar buttons: This group of buttons selects an operation you want
to perform on the images you've selected in the Viewer. (Note that the
toolbar buttons you see may depend on your screen resolution. If you
resize the iPhoto window so that it is sufficiently small, some toolbar
buttons will “collapse” into a Keepsakes button with a drop-down menu
attached.)

v+ Thumbnail Resize slider: Drag this slider to the left to reduce the size of
the thumbnails in the Viewer. This allows you to see more thumbnails at
one time, which is a great boon for quick visual searches. Drag the slider
to the right to expand the size of the thumbnails, which makes it easier
to differentiate details between similar photos in the Viewer.
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Working with Images in iPhoto

Even a superbly designed image display and editing application, such as
iPhoto ’09, would look overwhelming if everything were jammed into one
window. Thus, Apple’s developers provide different operation modes (such
as editing and book creation) that you can use in the one iPhoto window.
Each mode allows you to perform different tasks, and you can switch modes
at just about any time by clicking the corresponding toolbar button.

In the following sections, I discuss three of these modes — import, organize,
and edit — and what you can do when you're in them. Then I conclude the
chapter with sections on publishing and sharing your images.

Import Images 101

In import mode, you're ready to download images directly from your digital
camera — as long as your specific camera model is supported in iPhoto. The
Apple iPhoto support page at www.apple.com/macosx/upgrade/cameras .
html lists many of the cameras that are supported in iPhoto.

Follow these steps to import images:

1. Connect your digital camera to your MacBook.

Plug one end of a USB cable into your camera and the other end into
your laptop’s USB port, and prepare your camera to download images.

2. Launch iPhoto.

Your MacBook will probably launch iPhoto automatically when your
camera is detected, but you can always launch iPhoto manually by
clicking its icon in the Dock (or double-clicking it in your Applications
folder).

3. Type an event name for the imported photos, such as Birthday Party
or Godzilla Ravages Tokyo (depending on your birthday parties, this
could be the same event).

4. Type a description for the event.

5. To allow iPhoto to automatically separate images into separate events
based on the date they were taken, select the Autosplit Events after
Importing check box.

6. Click the Import All button to import your photographs from the
camera.
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The images are added to your Photo Library, where you can organize
them as you want.

To select specific images to import, hold down the 8 key and click each
desired photo; then click Import Selected rather than Import All.

7. Specify whether the images you’re importing should be deleted from
the camera afterward.

If you don’t expect to download these images again to another computer
or another device, you can choose to delete the photos from your
camera automatically. This saves you a step, frees space for new photos,
and helps eliminate the guilt that can crop up when you nix your pix.
(Sorry, I couldn’t resist.)

“What’s that about an event, Mark?” After you download the contents of your
digital camera, those contents count as a virtual event in iPhoto — based

on either the date that you imported them or the date they were taken. For
example, you can always display the last images you imported by clicking
Last Import. If you want to see photos from your son’s graduation, they
appear as a separate event. (Both of these organizational tools appear in the
Source list.) Think about that . . . it’s pretty tough to arrange old-fashioned
film prints by the moment in time that they document, but iPhoto makes it
easy for you to see which photos are part of the same group! I explain more
about events in the next section.

Organize mode: Organizing
and sorting your images

In the days of film prints, you could always stuff another shoebox with your
latest photos or buy another sticky album to expand your library. Your
digital camera, though, stores images as files instead, and many folks don’t
print their digital photographs. Instead, you can keep your entire collection
of digital photographs and scanned images well ordered and easily retrieved
by using iPhoto’s Organize mode. Then you can display them in a slideshow,
e-mail them, print them, use them as desktop backgrounds, or burn them to
an archive disc.

A new kind of photo album

The most familiar method of organizing images in iPhoto is the album. Each
album can represent any designation you like, be it a year, a vacation, your
daughter, or your daughter’s ex-boyfriends. Follow these steps to organize

your images:

www.it-ebooks.info


http://www.it-ebooks.info/

220 PartIv: Living the ilLife

|
Figure 14-2:
Add a new
albumin
iPhoto.
|

1. Create a new album.

You can either choose File>New Album or click the plus (+) button at
the bottom of the Source list. Click the Album button at the top of the
sheet to display the settings you see in Figure 14-2.

2. Type the name for your new photo album.

If you want to create an empty album (without automatically including
any images that might be selected), make sure that you click the Use
Selected Items in New Album check box to deselect it.

3. Click OK.

iPhoto also offers a special type of album called a Smart Album, which you
can create from the File menu. (For even faster action, hold down the Option
key while you click the Add button.) A Smart Album contains only photos
that match certain criteria that you choose, using the keywords and rating
that you assign your images. Other criteria text is the photo filenames, dates
the images were added to iPhoto, and any comments you might have added.
Now here’s the really nifty angle: iPhoto automatically builds and maintains
Smart Albums for you, adding new photos that match the criteria (and delet-
ing those that you remove from your Photo Library)! Smart Albums carry a
gear icon in the Source list.

www.it-ebooks.info


http://www.it-ebooks.info/

Chapter 14: The Masterpiece That Is iPhoto 22 7

Importing images from your hard drive

If you have a folder of images that you've
already collected on your hard drive, a CD, a
DVD, an external drive, or a USB flash drive,
adding them to your Library is easy. Just drag
the folder from a Finder window and drop it into
the Albums header (within the Source listin the
iPhoto window). iPhoto automatically creates a
new album using the folder name, and you can
sit back while the images are imported into that
new album. iPhoto recognizes images in sev-
eral formats: JPEG, GIF, RAW, PNG, PICT, PSD,
PDF, and TIFF.

If you have individual images, you can drag
them as well. Select the images in a Finder
window and drag them into the desired album
in the Source list. To add them to the album
currently displayed in the Viewer, drag the
selected photos and drop them in the Viewer
instead.

If you'd rather import images by using a stan-
dard Mac Open dialog, choose File>Import to
Library. Simplicity strikes again!

a\\J
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You can display information about the currently selected item in the informa-
tion pane under the Source list. Just click the Show Information button at the
bottom of the iPhoto window, which sports the familiar “i-in-a-circle” logo.
You can also type a short note or description in the Description box that
appears in the Information pane. For more in-depth information, select the
desired item and then press 38+1.

You can also change information on an image by selecting it in the Viewer and
clicking the Show Information button. Click any of the headings in the pane
(Title, Date, Time, and so on) to display a text edit box, and you can simply
click in either box to type a new name or alter the photo’s date stamp.

You can drag images from the Viewer into any album you choose. For exam-
ple, you can copy an image to another album by dragging it from the Viewer
to the desired album in the Source list.

To remove a photo that has fallen out of favor, follow these steps:

1. In the Source list, select the desired album.
2. In the Viewer, select the photo (click it) that you want to remove.

3. Press Delete.

When you remove a photo from an album, you don’t remove the photo from
your collection (which is represented by the Photos entry under the Library
heading in the Source list). That’s because an album is just a group of links to
the images in your collection. If you want to completely remove an offending
photo from iPhoto, click the Photos entry under the Library heading to dis-
play your entire collection of images and delete the picture there. The photo
disappears from all albums with which it is associated.
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To remove an entire album from the Source list, just click it in the Source list
to select it — in the Viewer, you can see the images that it contains — and
then press Delete. (Alternatively, right-click or Control-click the offending
album and choose Delete Album.)

To rename an album, click the entry under the Albums heading in the Source
list to select it and then click again to display a text box. Type the new album
name and press Return.

<P Change your mind? iPhoto comes complete with a handy-dandy Undo feature.
Just press 88+Z, and it’s as though your last action never happened (a great
trick for those moments when you realize you just deleted your only image of
your first car from your Library).

Arranging stuff by events

As I mention earlier, an event is a group of images that you shot or down-
loaded at the same time — iPhoto figures that those images belong together
(which is usually a pretty safe assumption). Figure 14-3 illustrates some of
the events I've created in my iPhoto collection.

Figure 14-3:
Events help
you orga-
nize by what
happened,
not just
when it
happened!
|
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As can an album, an event can be renamed — you just use a different proce-
dure. Click the Events entry under the Library heading in the Source list to
display your events in the Viewer; then click the existing event name in the
caption underneath the thumbnail. A text box appears in which you can type
a new name; click Return to update the event.

Try moving your cursor over an event thumbnail in the Viewer and you see
that iPhoto displays the date range when the images were taken, as well as
the total number of images in the event. Ah, but things get really cool when
you move your cursor back and forth over an event with many images: The
thumbnail animates and displays all the images in the event, without having
to use old-fashioned scroll bars or silly arrows! (Why can’t I think of this
stuff? This is the future, dear readers.)

Notice the “i-in-a-circle” that appears when you hover your cursor over an
event thumbnail? Click it to display the location where the shot was taken,
using the Places feature [ describe in a page or two.

To display the contents of an event in the Viewer, just double-click the event
thumbnail. To return to the events thumbnails, click the All Events button at
the top of the Viewer.

Decided to merge those Prom Event pictures with your daughter’s Graduation
Event? No problem! You could drag one event thumbnail on top of another,
but that’s the easy way. Alternatively, click the Events entry under the Library
heading in the Source list to display your events and then hold down 88 while
you click the events that you want to merge. Click the Merge button in the
toolbar at the bottom of the window, or choose Events>Merge Events. (Forgot
about that menu bar, didn’t you?) Click Merge in the confirmation dialog that
appears.

While organizing, you can create a brand-new empty event by choosing
Eventst>Create Event. Feel free to drag photos from albums, other events, or
your Photo Library into your new event.

Working with Faces and Places

iPhoto '09 added two new organizational tools called Faces and Places. These
two categories now appear in the Library section of the Source list.

First, let’s tackle Faces. This feature is a sophisticated recognition system
that automatically recognizes human faces within the photos that you add

to your Library. (I don’t know whether it works well with pets — but you can
try, anyway.) Naturally, you have to identify faces first before iPhoto can rec-
ognize them, which it does through a process called tagging.
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Figure 14-4:
Adding
another

mug to my
collection of
Faces.
|
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To tag a face, follow these steps:

1.
2.

In the Source list, click the Photos item to display your image library.
In the Viewer, click the photo containing a person you want to tag.

The photo is selected, as indicated by the yellow border.

. Click the Name button in the iPhoto toolbar at the bottom of the

window.

iPhoto displays the tagging pane you see in Figure 14-4. Note that iPhoto
has indicated each person’s face in the photo with a label.

. If the face is unrecognized (labeled as unnamed), click the label to

open a text box and type the person’s name.

If iPhoto recognizes the face correctly and the name matches the
person, click the check mark to confirm the tag. If the face is incorrectly
identified, click the X and you can enter a new name.

If the name appears on an Address Book contact card, you can click the
matching entry that appears to confirm the identity. Wowzers!

If iPhoto doesn’t recognize a face in the photo (which can happen if the
person’s face is turned at an angle to the camera or is in a darker area of
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the photo), click the Add Missing Face button, and iPhoto places a box

in the center of the image. Drag the box over the person’s face. If neces-
sary, you can resize the box by using the four handles at the corners of
the box. Now you can click the label and type the person’s name.

5. Press Return to save the face.

? . . 9
P Notice the expansion button that appears next to the person’s name?

Click it, and iPhoto displays other photos that likely contain this per-
son’s face, allowing you to tag him or her there as well.

6. Click Done after you identify all the faces in the photo.

After you tag an image, it appears in your Faces collection, which you can
view by clicking the Faces entry in the Source list. You can click a portrait in
your Faces collection to see all the images that contain that person. As you
might expect, the more tags you add for a specific person, the better iPhoto
gets at recognizing that person!

Places makes it easy to track the location where photos were taken, but

it requires a digital camera that includes GPS tracking information in the
image metadata. (This is a relatively new feature for digital cameras, so older
models aren’t likely to support GPS tracking.) Places also requires an Internet
connection, because it uses Google Maps.

Click the Places entry in the Source list to display a global map, with push-
pins indicating where your photos were taken. You can switch the Places
map between terrain and satellite modes, or choose a hybrid display. If
you're familiar with Google Maps, these settings are old friends of yours.

Alternatively, click the List View button to display a character-based
browser, where you can click country, state, and city names.

No matter which view mode you choose, clicking a pushpin or location dis-
plays the images taken in that area.

Organizing with keywords

“Okay, Mark, albums, events, Faces, and Places are great ideas, but there has
to be a way to search my collection by category!” Never fear, good road war-

rior. You can also assign descriptive keywords to images to help you organize
your collection and locate certain pictures fast. iPhoto comes with a number

of standard keywords, and you can create your own as well.

To illustrate, suppose you’d like to identify your images according to special
events in your family. Birthday photos should have their own keyword, and
anniversaries deserve another. By assigning keywords, you can search for
Elsie’s sixth birthday or your silver wedding anniversary (no matter what
event or album they’re in), and all related photos with those keywords appear
like magic! (Well, almost like magic. You need to choose Viewr>Keywords,
which toggles the Keyword display on and off in the Viewer.)
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iPhoto includes a number of keywords that are already available:

v Favorite
v Family
v Kids
v Vacation
v Birthday
1 Movie
v Checkmark
<P What'’s the Checkmark all about, you ask? It’s a special case: Adding this key-
word displays a tiny check mark icon in the lower-right corner of the image.

The Checkmark keyword comes in handy for temporarily identifying specific
images because you can search for just your checkmarked photos.

To assign keywords to images (or remove keywords that have already been
assigned), select one or more photos in the Viewer. Choose Window=>Show
Keywords or press 38+K to display the Keywords window, as shown in
Figure 14-5.

Figure 14-5:
Time to add
keywords

to these
selected
images.
|
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Click the keyword buttons that you want to attach to the selected images
to mark them. Or, click the highlighted keyword buttons that you want to
remove from the selected images to disable them.

Digging through your Library with keywords

Behold the power of keywords! To sift through your entire collection of
images by using keywords, click the magnifying glass button next to the
Search box at the bottom of the iPhoto window and then choose Keyword
from the pop-up menu. iPhoto displays a pop-up Keywords panel, and you
can click one or more keyword buttons to display just the photos that carry
those keywords.

The images that remain in the Viewer after a search must have all the key-
words that you specified. If an image is identified, for example, by only three
of four keywords you chose, it isn’t a match and it doesn’t appear in the
Viewer. (You can create a Smart Album with specific keywords to get around
this limitation.)

To search for a photo by words in its description, just click in the Search box
and start typing. You can also click that same magnifying glass by the Search
box to search through your images by date and rating as well.

Speaking of ratings . . .

Playing favorites by assigning ratings

Be your own critic! iPhoto allows you to assign any photo a rating of any-
where from zero to five stars. | use this system to help me keep track of the
images that [ feel are the best in my Library. Select one (or more) image and
then assign a rating by using one of the following methods:

v Choose Photos=>My Rating and then choose the desired rating from the
pop-up submenu.

v Use the 8+0 through 88+5 shortcuts.

Sorting your images just so

The View menu provides an easy way to arrange your images in the Viewer
by a number of different criteria. Choose View=>Sort Photos and then click
the desired sort criteria from the pop-up submenu. You can arrange the
display by date, keyword, title, or rating. If you select an album in the Source
list, you can also choose to arrange photos manually, which means that you
can drag and drop thumbnails in the Viewer to place them in the precise
order you want them.
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Naturally, iPhoto allows you to print selected images, but you can also send
photos directly to iWeb for use on your MobileMe Web site. Select Share=>
Send to iWeb and then choose either Photo Page or Blog from the submenu
that appears. iPhoto automatically sends the selected images or album to
iWeb and launches the application! You can also use iPhoto’s Web Gallery fea-
ture to get your photos on the Web. (More on the Web Gallery at the end of
this chapter.)

Edit mode: Removing and
fixing stuff the right way

Not every digital image is perfect — just look at my collection if you need
proof. For those shots that need a pixel massage, iPhoto includes a number
of editing tools that you can use to correct common problems.

The first step in any editing job is to select the image you want to fix in the
Viewer. Then click the Edit button on the iPhoto toolbar to switch to the Edit
mode controls, as shown in Figure 14-6. Now you’re ready to fix problems,
using the tools that I discuss in the following sections. (If you're editing a
photo that’s part of an event, album, Faces, or Places, note the spiffy scroll-
ing photo strip at the top, which allows you to switch to another image to
edit from the same grouping.)

When you’re done with Edit mode, click the ... (wait for it) . . . Done button!

Rotating tipped-over shots

If an image is in the wrong orientation and needs to be turned to display cor-
rectly, click the Rotate button to turn it once in a counterclockwise direction.
Hold down the Option key while you click the Rotate button to rotate in a
clockwise direction.

Crop 'til you drop

Does that photo have an intruder hovering around the edges of the subject?
You can remove some of the border by cropping an image, just as folks once
did with film prints and a pair of scissors. (We’ve come a long way.) With
iPhoto, you can remove unwanted portions of an image; it’s a great way to get
Uncle Milton’s stray head (complete with toupee) out of an otherwise perfect
holiday snapshot.
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Figure 14-6:
iPhoto is
now in Edit
mode —
watch out,
image
problems!
|
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Follow these steps to crop an image:

1. Click the Crop button on the Edit toolbar.
2. Select the portion of the image that you want to keep.

In the Viewer, click and drag the handles on the rectangle to outline the
part of the image that you want. Remember, whatever’s outside this
rectangle disappears after the crop is completed.

When you drag a corner or edge of the outline, a semi-opaque grid
(familiar to amateur and professional photographers as the nine squares
from the Rule of Thirds) appears to help you visualize what you're
claiming. (Check it out in Figure 14-7.)

. (Optional) Choose a preset aspect ratio.

If you want to force your cropped selection to a specific aspect ratio —
such as 4 x 3 or 16 x 9 for an iDVD project — select the Constrain check
box and choose that ratio from the Constrain pop-up menu.

. Click the Apply button.

Oh, and don’t forget that you can use iPhoto’s Undo feature if you mess
up and need to try again. Just press 38+Z.
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Figure 14-7:
Select the
stuff that
you want to
keep in your
photo.
|
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iPhoto features multiple Undo levels, so you can press 38+Z several times to
travel back through your last several changes.

Straightening what'’s crooked

Was your camera slightly tilted when you took the perfect shot? Never fear!
Click the Straighten button and then drag the slider to tilt the image in the
desired direction. Click the Close button to return to Edit mode.

Enhancing images to add pizzazz

If a photo looks washed out, click the Enhance button to increase (or
decrease) the color saturation and improve the contrast. Enhance is auto-
matic, so you don’t have to set anything.

Removing rampant red-eye

Unfortunately, today’s digital cameras can still produce the same “zombies
with red eyeballs” as traditional film cameras. Red-eye is caused by a cam-
era’s flash reflecting off the retinas of a subject’s eyes, and it can occur with
both humans and animals. (I'm told that pets get green-eye, but iPhoto can
handle that, too!)
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iPhoto can remove that red- and green-eye and turn frightening zombies

back into your family and friends! Click the Red-Eye button and then select

a demonized eyeball by clicking in the center of it. (If the new eyeball is too
small or too large, drag the Size slider to adjust the dimensions.) To complete
the process, click the X in the button that appears in the image.

Retouching like the stars

The iPhoto Retouch feature is perfect for removing minor flecks or lines in
an image (especially those you scanned from prints). Click Retouch and you
notice that the cursor turns into a crosshair; just drag the cursor across the
imperfection.

Switching to black-and-white or sepia

Ever wonder whether a particular photo in your Library would look better
as a black-and-white (or grayscale) print? Or perhaps an old-fashioned sepia
tone in shades of copper and brown? Just click the Effects button to display
the Effects window, which offers eight different effects you can apply to the
photo.

Adjusting photo properties manually

Click Adjust to perform manual adjustments to brightness and contrast (the
light levels in your image), as well as the sharpness, shadow, and highlight
levels. To adjust a value, make sure that nothing’s selected in the image and
then drag the corresponding slider until the image looks the way you want.
Click the Close button to return to Edit mode.
o While you're editing, you can use the Next and Previous buttons at the lower-
right corner of the iPhoto window to move to the next image in the current
group (or back to the previous image).

Producing Your Own Coffee-Table
Masterpiece

Book mode unleashes what I think is probably the coolest feature of iPhoto:
the chance to design and print a high-quality bound photo book! After you
complete an album — all the images have been edited just the way you want,
and the album contains all the photos you want to include in your book —
iPhoto can send your images as data over the Internet to a company that
prints and binds your finished book for you. (No, they don’t publish For
Dummies titles, but then again, [ don’t get high-resolution color plates in most
of my books, either.)
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At the time of this writing, you can order many different sizes and bindings,
including an 8.5-x-11-inch soft-cover book with ten double-sided pages for
about $20 and a hardbound 8.5-x-11-inch keepsake album with ten double-
sided pages for about $30 (shipping included for both). Extra pages can be
added for about $0.70 and $1.00 a pop, respectively.

iPhoto 09 can also produce and automatically order calendars and greeting
cards, using a process similar to the one [ describe in this section for produc-
ing a book. Who needs that stationery store in the mall anymore?

If you're going to create a photo book, make sure that the images have the
highest quality and highest resolution. The higher the resolution, the better
the photos look in the finished book. I personally always try to use images of
over 1,000 pixels in both the vertical and horizontal dimensions. (Full-page
prints should be at least 2,000 pixels in both dimensions.)

To create a photo book, follow these steps:

1. Click the desired album in the Source list to select it.

2. Click the Keepsakes toolbar button, and click Book from the pop-up
menu.

Depending on your screen resolution, iPhoto may have room to display
the Book button by itself — no big deal, because things work the same.

3. Select the size of the book and a theme.

Your choices determine the number of pages and layout scheme, as well
as the background graphics for each page.

4. Click Choose.
You see the controls shown in Figure 14-8.

In Book mode, the Viewer changes in subtle ways. It displays the current
page at the bottom of the display and adds a scrolling row of thumbnail
images above it. This row of images represents the remaining images
from the selected album that you can add to your book. You can drag any
image thumbnail into one of the photo placeholders to add it to the page.
You can also click the Page button at the left of the thumbnail strip — it
looks like a page with a turned-down corner — to display thumbnails of
each page in your book. (To return to the album image strip, click the
Photos button under the Page button.)

5. Rearrange the page order to suit yourself by dragging the thumbnail
of any page from one location to another in the strip.
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Figure 14-8:
Preparing
to publish
my own
coffee-table
master-
piece.
|
6. In the Book toolbar below the page view, you can adjust a variety of
settings for the final book, including the book’s theme, background,
page numbers, and text fonts.
At this point, you can also add captions and short descriptions to the
pages of your photo album. Click any one of the text boxes in the page
display and begin typing to add text to that page.
7. When you’re ready to publish your book, click the Buy Book button.
8. In a series of dialogs that appear, iPhoto guides you through the final
steps to order a bound book.
Note that you're asked for credit card information, so have that plastic
ready.
V?‘“\NG! [ wouldn’t attempt to order a book when using a dialup modem connection.
S The images are likely far too large to be sent successfully. If possible, use a

broadband or network connection to the Internet while you’re ordering. If
your only connection to the Internet is through a dialup modem, I recommend
saving your book in PDF format and having it printed at a copy shop or print-
ing service instead. (Choose File=>Print and then click the Save as PDF button.)
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| really need a slideshow

You can use iPhoto to create slideshows! Click
the album or event you want to display and
click the Add button; then choose Slideshow
from the toolbar and click Create. Notice that
iPhoto adds a Slideshow item in the Source list.
The same scrolling thumbnail strip appears at
the top of the Viewer — this time displaying the
images inthe album or event. Click and drag the
thumbnails so that they appear in the desired
order.

To choose background music for your slide-
show, click the Music button on the Slideshow
toolbar to display Apple’'s theme music, as
well as the tracks from your iTunes Library.
To choose a standard theme, click the Source
pop-up menu and choose Theme Music; then
select that perfect song and click Apply. To
choose an iTunes song or playlist, click the
Source pop-up menu and choose either the
Music item (for your entire Library) or a playlist.
You can also create a custom playlist by select-
ing the Custom Playlist for Slideshow check
box. Then drag the individual songs you want
to the song list at the bottom of the sheet. (You
can drag them to rearrange their order in the
list as well.) Click Apply to accept your song list.

To configure your slideshow, click the Settings
button on the Slideshow toolbar and click the
All Slides tab. In the dialog that appears, you

can specify the amount of time that each slide
remains on the screen, as well as an optional
title and rating displays. You can choose the
transition that occurs between photos, too,
or specify a random transition each time. The
Aspect Ratio pop-up menu allows you to choose
a 16:9 widescreen display for your slideshow.

Click the This Slide tab to modify the settings for
a specific slide (useful for keeping a slide on-
screen for a longer period of time or for setting
a different transition than the default transition
you choose from the Slideshow toolbar). | can
recommend the Automatic Ken Burns effect —
yep, the same one in iMovie — which lends
an animated movement to the selected image.
You can also set the selected photo to display
in black and white, sepia, or antique coloring.

To display a preview of a single slide and its
transitions, click the desired slide and then
click Preview; this is a handy way of determin-
ing whether your delay and transition settings
are really what you want for a particular slide.
When you're ready to play your slideshow, click
the Play button, and iPhoto switches to full-
screen mode. You can share your completed
slideshow by clicking Share on the iPhoto
menu, where you can send the slideshow to
iDVD (for later burning onto a DVD) or send it
through e-mail.

Vou'll Love MobileMe Gallery!

iPhoto 09 includes a feature called MobileMe Gallery that does for images
what podcasting does for audio: You can share your photos with friends,
family, business clients, and anyone else with an Internet connection! (Your
adoring public doesn’t even require a Mac; it can use That Other Kind of
Computer.) iPhoto automatically uploads the selected images and leads you
through the process of creating a new Web page to proudly display your
photos. However, you must be a MobileMe subscriber to use the MobileMe
Gallery feature. If you haven’t heard the news on Apple’s MobileMe service

yet, see Chapter 9 for the details.
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To create a MobileMe Gallery, you designate one or more photos in the
Viewer (or even select entire albums or events in the Source list) and then
click the Add button. Click the MobileMe toolbar button in the sheet that
appears to display the Web Gallery settings.

Type a name for your new Web Gallery. You can elect to show the title of
each photo, allow your visitors to download your images or upload their
own, and even allow photos to be uploaded by other computer owners using
an e-mail address or a Web browser!

By default, any visitor to your MobileMe Web site can see your gallery. But
what if you prefer a little security for those images? In that case, click the
Album Viewable By pop-up menu, where you can limit your viewing audience
(you can even require that your visitors enter a logon name and password
before they can receive your photos).

Click Publish, and you see that iPhoto indicates that your images are being
uploaded with a cool twirling progress icon to the right of the album in the
Source list. When the process is complete, iPhoto indicates that the photos
appear in a MobileMe Gallery with a new heading in the Source list. You're on
the air!

Now for the other side of the coin: By selecting your MobileMe Gallery in the
Source list and clicking Tell a Friend on the iPhoto toolbar, iPhoto automati-
cally prepares an e-mail message in Apple Mail that announces your new
gallery! Just add the recipient names and click Send. This spiffy message
includes instructions for

v Folks using iPhoto '09 on a Mac: As you can imagine, this is the easiest
receive option to configure. After these folks are subscribed, they get an
automatically updated album of the same name that appears in their Source
list, and they can use those images in their own iPhoto projects! From
within iPhoto, your visitors can subscribe to your MobileMe Gallery by
clicking File>Subscribe to Photo Feed and entering the subscription URL.

1 Folks using Windows or an older version of iPhoto: These subscribers
can use any Web browser with RSS support (such as the Safari browser
that comes with Snow Leopard and is available from Apple for Windows)
or any RSS reader. (In effect, your MobileMe Gallery becomes an RSS
feed for those without iPhoto '09.)

By default, any changes you make to the contents of your MobileMe Gallery
are updated automatically on your MobileMe account and, in turn, are
updated automatically to everyone who receives your images. You can turn
this feature off, however, if you have a large number of images and you update
often (which can result in your sister’s computer downloading a lot of data).
To display the Check for New Photos setting for MobileMe Gallery, choose
iPhotor>Preferences and click the Web button on the Preferences window
toolbar. (You can also change the title for your gallery and monitor your iDisk
usage from this pane.)
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Is that Facebook and Flickr | spy?

Indeed it is! iPhoto ‘09 introduced a direct con-
nection to both your Facebook social networking
account (at www . facebook . com) and your
Flickr online gallery account (at www . £1ickr.
com), allowing you to simply select one or more
photos and send them automatically to either
service! These two buttons appear on the toolbar
when you're organizing your photos.

The first time you select photos in the Viewer
(or an album or event in the Source list) and

click either button, iPhoto prompts you for per-
mission to set up your connection. (Of course,
this requires you to enter your Facebook and
Flickr account information — hence the confir-
mation request.) Click Set Up and provide the
data that each site requires.

After you set up your accounts, simply select
your photos, albums, or events and click the
toolbar button for the desired service. Apple,
you absolutely rock!

Mailing Photos to Aunt Mildred

A\

Figure 14-9:
Preparing

to send
animage
through
Apple Mail.
|

iPhoto can help you send your images through e-mail by automating the pro-
cess. The application can prepare your image and embed it automatically in a
new message.

To send an image through e-mail, select it and then click the Email button
in the toolbar. The dialog, shown in Figure 14-9, appears, allowing you to
choose the size of the images and decide whether you want to include their
titles, descriptions, and Places location information as well.

Keep in mind that many ISP (Internet service provider) e-mail servers don’t
accept an e-mail message that’s more than 3MB or 4MB, so watch that Size
display. If you're trying to send a number of images and the size goes over
2MB, you might have to click the Size pop-up menu and choose a smaller size
(reducing the image resolution) to get them all embedded in a single message.

When you're satisfied with the total file size and you’re ready to create your
message, click the Compose button. iPhoto automatically launches Apple
Mail (or whatever e-mail application you specify) and creates a new message
that contains the images, ready for you to click Send!
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Chapter 15

Making Film History with iMovie

In This Chapter

Taking stock of the iMovie window
Importing and adding media content
Using transitions in your movie
Putting text titles to work

Sharing your movie with others

R emember those home movies that you used to make in high school?
They were entertaining and fun to create, and your friends were
impressed. In fact, some kids are so downright inspired that you're not sur-
prised when you discover at your high school reunion that they turned out to
be graphic artists, or got involved in video or TV production.

iMovie, part of the iLife '09 suite, makes moviemaking as easy as those home-
made movies. Apple simplified all the technical stuff, such as importing video
and adding audio, leaving you free to concentrate on your creative ideas. In
fact, you won'’t find techy terms such as codecs or keyframes in this chapter
at all. [ guarantee that you’ll understand what’s going on at all times. (How
often do you get a promise like that with video-editing software?)

With iMovie, your digital video (DV) camcorder, and the other parts of the
iLife suite, you can soon produce and share professional-looking movies, with
some of the same creative transitions and titles used by Those Hollywood
Types every single day — all on your MacBook, all by yourself.

If you turn out to be a world-famous Hollywood Type Director in a decade or
so, don’t forget the little people along the way!
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Shaking Hands with the iMovie Window

If you've ever tried a professional-level video-editing application, you proba-
bly felt as though you were suddenly dropped in the cockpit of a jumbo jet. In
iMovie, though, all the controls you need are easy to use and logically placed.

To launch iMovie, click the iMovie icon in the Dock. (It looks like a star from
the Hollywood Walk of Fame.) You can also click the Application folder in any
Finder window sidebar and then double-click the iMovie icon.

To follow the examples | show you here, follow these strenuous steps and
create a new movie project:
1. Choose Filem>New Project (or press 88+N).
iMovie displays the sheet you see in Figure 15-1.
2. Type a name for your project.

3. Select the aspect ratio (or screen dimensions) for your movie.

Figure 15-1:
Creating a
new movie

project
within
iMovie.
|
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You can select a widescreen display (16:9), a standard display (4:3), or

a display especially suited for an iPhone (3:2). If compatibility with the
familiar SDTV format is important, I always recommend that you choose
the standard (4:3) ratio; choosing 16:9 for an SDTV set will result in
those familiar black “letterbox” bars at the top and bottom of the screen.
On the flip side, choosing 4:3 results in pillarboxing (black bars on the
left and right) when shown on an HD set.

4. Click a thumbnail to select a theme to apply to your finished movie.

If you choose a theme, iMovie automatically adds the transitions and
titles that correspond to that theme. (Normally, this is what you want to
do. However, if you want to add transitions and titles manually, click the
Automatically Add Transitions and Titles check box to deselect it.)

If you decide not to use a theme (by selecting the None thumbnail), iMovie
can still add an automatic effect between clips. Select the Automatically
Add check box and click the pop-up menu to choose the desired effect.

5. Click Create.

You're on your way! Check out Figure 15-2: This is the whole enchilada,
in one window.

Playhead Editing toolbar Project pane Monitor

Figure 15-2:
iMovie is a
lean, mean,
video-
producing
machine.
|

Camera Import Event pane Browser toolbar
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The controls and displays that you’ll use most often follow:

v Monitor: Think of this as being just like your TV or computer monitor.
Your video clips, still images, and finished movie play here. You also
crop and rotate your video within the monitor.

v Browser toolbar: This row of buttons allows you to switch between
your media clips (video clips, photos, and audio) and the various tools
that you use to make your film. The selected items fill the right side of
the browser pane below the monitor.

v+~ Event pane: All the video clips that you use to create your movie are
stored in the Event pane. | show you what each of the panes in the iMovie
workspace looks like when you tackle different tasks in this chapter.

v Project pane: iMovie displays the elements that you've added to your
movie project in this pane.

v~ Playhead: The red vertical line that you see in the Event and Project
panes is the playhead, which indicates the current editing point while
you’re creating your movie. When you're playing your movie, the play-
head moves to follow your progress through the movie.

v Editing toolbar: This strip of buttons allows you to control editing func-
tions such as cropping, audio, and video adjustments, voiceovers, and
selecting items.

v Camera Import window: Click this switch to import DV clips from your
DV camcorder or iSight camera.

Those are the major highlights of the iMovie window. A director’s chair and
megaphone are optional, of course, but they do add to the mood.

A Bird’s-Eye Uiew of Moviemaking

[ don’t want to box in your creative skills here — after all, you can attack
the moviemaking process from a number of angles. (Pun, unfortunately,
intended.) However, I've found that my movies turn out the best when I
follow a linear process, so before I dive into specifics, allow me to provide
you with an overview of moviemaking with iMovie.

Here’s my take on the process, reduced to seven steps:

1. Import your video clips directly from your DV camcorder, iSight
camera, or your hard drive.

2. Drag your new selection of clips from the Event pane to the Project
pane and arrange them in the desired order.

www.it-ebooks.info


http://www.it-ebooks.info/

Chapter 15: Making Film History with iMovie 2/} 7

3. Import or record audio clips (from iTunes, GarageBand, or external
sources, such as audio CDs or audio files that you’ve recorded your-
self) and add them to your movie.

4. Import your photos (directly from iPhoto or from your hard drive) and
place them where needed in your movie.

5. Add professional niceties, such as voiceovers, transitions, effects, and
text to the project.

6. Preview your film and edit it further if necessary.

7. Share your finished film with others through the Web, e-mail, or a
DVD that you create and burn with iDVD.

<P As you might imagine, this chapter simply can’t hold a full description of every
setting and every procedure within iMovie '09 — but luckily, my good friends
Dennis and Michael Cohen have done exactly that in their book iMouvie 09
& iDVD °09 For Dummies (published by Wiley). Dennis and Michael take you
from the basics to all the in-depth features of these two iLife applications!

Importing the Building Blocks

Sure, you need video clips to create a movie of your own, but don’t panic if
you have but a short supply. You can certainly turn to the other iLife applica-
tions for additional raw material. (See, I told you that integration thing would
come in handy.)

Along with video clips you import from your DV camcorder, built-in iSight
camera, and hard drive, you can also call on iPhoto for still images (think
credits) and iTunes for background audio and effects. In the following sec-
tions, I show you how.

Pulling in video clips

Your MacBook is already equipped with the large hard drive you need for
editing digital video. In fact, because your MacBook has an iSight camera on-
board, you're a self-contained movie studio! Of course, you can also use clips
filmed with a camcorder — depending on the MacBook model and camcorder
you're using, you may be using either a FireWire or a USB 2.0 connection.
(Fear not, the instructions I give in this section are easily modified for your
particular device!) Note that MacBook and MacBook Air models do not have
a FireWire port, and the FireWire 800 port on the MacBook Pro requires a
special cable to connect to older FireWire 400 camcorders.
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Here’s the drill if your clips are on your FireWire-equipped mini-DV
camcorder:

1. Plug the proper cable into your laptop.
2. Set the DV camcorder to VIR (or VCR) mode.

Some camcorders call this Play mode.

. Click the Camera Import button (labeled in Figure 15-2).

iMovie opens a new window.

. Click the Camera pop-up menu (at the bottom of the Import window)

and select your DV camcorder or iSight camera.

Playback controls appear under the Camera Import window, mirroring
the controls on your FireWire DV camcorder. This allows you to control
the unit from iMovie. Keen!

To capture video from your iSight camera, click the Video Size pop-up
menu to choose the dimensions of the clip; then click Capture. On the
sheet that appears, choose the location where the video will be saved,
and choose whether to add this video to an existing event or create a
new event. Click Capture to start recording, and click Stop when your
video is complete. (You can skip the rest of the steps in this section,
which deal only with DV camcorders.)

5. Click the Import button.

6. Click the Save To pop-up menu and choose the drive that should store

your clips.

You can choose to add the new clips to an existing event or create a new
event. Heck, if the event spanned more than one day, you can create a
new event for each day. (How do they think up these things?)

. Click OK and admire your handiwork.

iMovie begins transferring the footage to your MacBook and automati-
cally adds the imported clips to your Event Library.

If your clips are already on your hard drive, rest assured that iMovie can

import them, including those in high-definition video (HDV) format. iMovie also

recognizes a number of other video formats, as shown in Table 15-1.
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Table 15-1 Video Formats Supported by iMovie

File Type Description

DV Standard 4:3 digital video

DV Widescreen Widescreen 16:9 digital video

MoV QuickTime movies

HDV & AVCHD High-definition (popularly called widescreen) digital
video, in 720p and 1080i

MPEG-2 Digital video format used for DVD movies and digital TV

MPEG-4 A popular format for streaming Internet and wireless
digital video

To import a movie file, follow this bouncing ball:

1. Choose File~>Import and choose Movies from the submenu.
2. If you’re importing 1080i video clips, choose the quality setting.

The Large setting saves you a significant amount of hard drive space,
but the Full setting preserves the original resolution and detail. (If you're
not importing 1080i video, use the default Large setting and click OK.
The Full setting demands all the CPU and RAM resources your MacBook
can offer, so don’t expect to do much multitasking while importing.)

3. Click the drive that should store your clips in the sidebar, and then
navigate to the desired location.

4. Specify whether you want to add the imported video to an existing
event or create a new event.

If you choose to add the video to an existing event, click the pop-up
menu and select an event.

5. Specify whether you want to copy the video (leaving the original
movie intact) or have the movie deleted after a successful import.

6. Click Import.

Alternatively, you can also drag a video clip from a Finder window and
drop it in the Project pane.
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Making use of still images

Still images come in handy as impressive-looking titles or as ending credits

to your movie. (Make sure that you list a gaffer and a best boy to be truly
professional.) However, you can use still images also to introduce scenes or
to separate clips according to your whim. For example, I use stills when delin-
eating the days of a vacation within a movie or different Christmas celebra-
tions over time.

Here are two methods of adding stills to your movie:

1 Adding images from iPhoto: Click the Photo Browser button on the
Browser toolbar (or press $8+2), and you’ll experience the thrill that is
your iPhoto Library, right from iMovie (as shown in Figure 15-3). You
can elect to display your entire iPhoto Library or more selective picks
such as specific albums or events. When you find the image you want to
add, just drag it to the right spot in the Project pane.

1 Importing images from your hard drive: If you're a member of the
International Drag-and-Drop Society, you can drag TIFF, JPEG, GIF, PICT,
PNG, and PSD images directly from a Finder window and drop them into
the Project pane as well.

|
Figure 15-3:
Pulling still
images from
iPhoto is
child’s play.
|
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Figure 15-4:
Calling on
my iTunes
Library to
add Dinah

Washington

to my
iMovie.
|

Importing and adding audio
from all sorts of places

You can pull in everything from Wagner to Weezer as both background music
and sound effects for your movie. In this section, I focus on how to get those
notes into iMovie and then how to add them to your movie by dragging them
to the Project pane.

You can add audio from a number of sources:

v Adding songs from iTunes: Click the Show Music and Sound Effects
button on the Browser toolbar (or press 8+1) to display the contents
of your iTunes Library. Click the desired playlist in the scrolling list
box, such as the Dinah Washington playlist I selected in Figure 15-4. (If
you exported any original music you composed in GarageBand to your
iTunes Library, you can use those songs in your own movie!) You can
add a track to your movie by dragging the song entry from the Music
and Sound Effects list to the desired spot in the Project pane.
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1+ Adding sound effects: Yep, if you need the sound of a horse gallop-
ing for your Rocky Mountain vacation clips, click either iMovie Sound
Effects or iLife Sound Effects in the scrolling list box. iMovie includes a
number of top-shelf audio effects that you can use in the second audio
track on the timeline viewer. This way, you can add sound effects even
when you've already added a background song. Again, to add a sound
effect, drag it to the perfect spot in the Project pane.

If you have several gigabytes of music in your iTunes Library, it might
be more of a challenge to locate “Me and Bobby McGee” by Janis Joplin,
especially if she’s included in a compilation. Let your MacBook do the
digging for you! Click in the Search box below the track list and begin
typing a song name. iMovie narrows the song titles displayed to those
that match the characters you type. To reset the search box and display
all your songs in the Library or selected playlist, click the X icon that
appears to the right of the box.

v Ripping songs from an audio CD: Load an audio CD and then choose
Audio CD from the scrolling list box. iMovie displays the tracks from the
CD, and you can add them at the current playhead position the same
way as you would iTunes songs.

1 Recording directly from a microphone: Yep, if you're thinking
voiceover narration, you've hit the nail on the head. Check out the
nearby sidebar, “Narration the easy way,” for the scoop.

You can fine-tune both the audio within a video clip or the audio clips that
you add to your project. With the desired clip selected, click the Inspector
button on the Editing toolbar (it bears a proud letter i) and click the Audio
tab. The Audio Adjustments window that appears includes an array of audio
controls that allow you to change the volume of the selected clip, or to give
that audio priority over other audio playing simultaneously (such as a sound
effect that needs to be clearly heard over background music and the video
clip). If your clips dramatically vary in volume, click the Normalize Clip
Volume button and then select each clip that you want to set to the same
volume; click Normalize Clip Volume again for each clip. You can also set

an automatic or manual Fade-in/Fade-out for the audio. When you’re done
tweaking, click Done. (Oh, and don’t forget that you can always return the
clip to its original volume; just open this window again and click Revert to
Original.)
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Ready to create that award-winning nature
documentary? You can add voiceover narra-
tion to your iMovie project that would make
Jacques Cousteau proud. In fact, you can
record your voice while you watch your movie
play, allowing perfect synchronization with the
action! To add narration, follow these steps:

1. Click the Voiceover button on the Editing
toolbar — it sports a microphone icon —
to open the Voiceover window.

2. Click the Record From pop-up menu and
select the input device.

MacBooks sport a decent internal micro-
phone, but you can always add a USB
microphone (or digital TOSlink microphone
for the MacBook Pro) to your system.

3. Drag the input volume slider to a comfort-
able level.

You can monitor the volume level of your
voice with the left and right input meters —
try to keep the meters at 50 percent or so
for the proper volume level.

4. To block out ambient noise levels, drag
the Noise Reduction slider to the right if
necessary.

Narration the easy way

If you'd like iMovie to enhance your voice
electronically for a more professional
sound, click the Voice Enhancement check
box to select it. If you need to hear the
audio from your movie project while you
speak, click the Play Project Audio While
Recording check box to select it. Note,
however, that you need to listen to the audio
while using a set of headphones (plugged in
to your laptop’s headphone jack) to avoid
feedback problems.

. Click in the desired spot within a clip in the

Project pane where the narration should
begin.

. Begin speaking when prompted by iMovie.

. Watch the video while you narrate so that

you can coordinate your narration track
with the action.

. Click anywhere in the iMovie window to

stop recording (or wait until the clip ends).

iMovie adds an icon to the Project pane
underneath the video with the voiceover.

. Click the Close button in the Voiceover

window.

Building the Cinematic Basics

Time to dive in and add the building blocks to create your movie. Along with
video clips, audio tracks, and still images, you can add Hollywood-quality
transitions, optical effects, and animated text titles. In the following sections,
[ demonstrate how to elevate your collection of video clips into a real-life

furshlugginer movie.

www.it-ebooks.info



http://www.it-ebooks.info/

254 PartIv: Living the ilife

Adding clips to your movie

You can add clips to your movie by using the Project pane and the Event
pane. The Dynamic Duo work like this:

v Project pane: This displays the media you've added to your project
so far, allowing you to rearrange the clips, titles, transitions, and still
images in your movie.

v~ Event pane: This displays your video clips arranged by event (the date
they were shot or the date they were imported), acting as the source
repository for all your clips. Movies pulled into iMovie, imported into
iPhoto, or added manually from the Finder appear here.

To add a clip to your movie, follow these steps:

1. Move your cursor across clips in the Event pane to watch a preview of
the video.

2. When you decide what to add to your project, you can either add the
entire clip or a selection:

¢ To select an entire clip, right-click the clip’s thumbnail and choose
Select Entire Clip from the menu that appears.

¢ To select a portion of a clip, drag your cursor across the thumb-
nail. A yellow frame appears around your selection. To change
the length of the selected video, drag the handles that appear on
either side. If you make a mistake while selecting video, just click
any empty space within the Event pane to remove the selection
frame and try again.

3. Drag the selection from the Event pane to the spot where it belongs in
the Project pane.

Alternatively, you can press E or click the Add to Project button (the
first button on the Editing toolbar).

Preview your work — and do it often.

iMovie offers two Play Full screen buttons: one under the Event Library and one
under the Project Library. Select the project or event you want to play and then
click the corresponding button (or press 8+G). You can also choose Viewr>Play
Full Screen to watch the selection. Press the spacebar to pause, and press Esc
to return to iMovie. You can also move your cursor to display a filmstrip that
you can click to skip forward or backward in the project or event.

To play a selection from the beginning, press \ (the backslash). (If you've
ever watched directors at work on today’s movie sets, you may have noticed
that they’re constantly watching a monitor to see what things will look like
for the audience. You have the same option in iMovie!)
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While you're watching video in the Event pane, you may decide that a certain
clip has a favorite scene or that another clip has material you don’t want, such
as Uncle Ed’s shadow puppets. (Shudder.) iMovie ’09 features Favorite and
Rejected frames, allowing you to view and use your best camera work (and
ignore the worst stuff). To mark video, select a range of frames or an entire
clip and then click the Mark as Favorite button on the Editing toolbar. Click
the Reject button to hide the selected video or frames from view. (You can
always unmark a Favorite or Rejected scene by using the Unmark button on
the Editing toolbar — click the Show pop-up menu and choose Rejected to
display hidden material.)

Removing clips from your movie

Don’t like a clip? Bah. To banish a clip from your movie, follow these steps:

1. Click the offending clip in the Project pane to select it.
2. Press Delete.

Alternatively, you can right-click the clip (or a selection you made by
dragging) and choose either Delete Entire Clip or Delete Selection from
the menu that appears.

If you remove the wrong clip, don’t panic. Instead, use iMovie’s Undo feature
(press 8+7Z) to restore it.

Reordering clips in your movie

If Day One of your vacation appears after Day Two, you can easily reorder
your clips and stills by dragging them to the proper space in the Project
pane. When you take your finger off the trackpad, iMovie automatically
moves the rest of your movie aside with a minimum of fuss and bother.

Editing clips in iMovie
If a clip has extra seconds of footage at the beginning or end, you don’t want
that superfluous stuff in your masterpiece. Our favorite video editor gives
you the following functions:

1 Crop: Removes unwanted material from a video clip or still image

1 Rotate: Rotates a clip or image on its center axis

v Trim: Trims frames from a video clip
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Before you can edit, however, you have to select a section of a clip:

\\3

1. Click a clip or image in either the Project pane (where changes you

make are specific to this project) or the Event pane (where edits you
make are reflected in any project using that footage).

iMovie displays the clip or image in the monitor.

2. To select the entire clip or image, simply click it.

3. Drag your cursor across the thumbnail to select the section of the

media you want to edit. (Note that some editing functions, such as
Crop and Rotate, automatically apply to the entire clip.)

A yellow frame surrounds the selected region. You're ready to edit that
selected part of the clip.

Note the handles that appear at the beginning or ending of the selection. You
can make fine changes to the selected section by dragging them or by pressing
the arrow keys.

v To crop: Click the Crop button on the Edit toolbar to display the frame

in the Monitor pane and then click Crop at the top of the Monitor pane.
Drag the edges of the frame and the handles to select the section you
want to keep. To preview your selection, click the Play button at the top
of the monitor. When you’re ready, click Done, and everything but the
selected region is removed.

v To rotate: Click the Crop button on the Edit toolbar and then click one of

the two rotation buttons (which carry a curved arrow icon). Each click
rotates the media 90 degrees in that direction. Click Done when the clip
or image is properly oriented.

v To trim: Choose Edit=>Trim to Selection. iMovie removes the frames

from around the selected video.

Edits that you make to one clip or still image can actually be copied to mul-
tiple items! Select the edited clip and choose Edit=>Copy. Now you can select
one or more clips and choose Edit=>Paste Adjustments to apply video, audio,
or crop edits. (To apply all three types of edits, just choose All)

Transitions for the masses

Many iMovie owners approach transitions as visual bookends: They merely
act as placeholders that appear between video clips. Nothing could be far-
ther from the truth, because judicious use of transitions can make or break a
scene. For example, which would you prefer after a wedding ceremony — an
abrupt, jarring cut to the reception or a gradual fadeout to the reception?
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Figure 15-5:
Add
transitions
for flow
between
clipsin
iMovie.
|

Today’s audiences are sensitive to transitions between scenes. Try not to
overuse the same transition. Also weigh the visual impact of a transition
carefully.

iMovie includes a surprising array of transitions, including old favorites
(such as Fade In and Dissolve) and some nifty stuff you might not be familiar
with (such as Cube and Page Curl). To display your transition collection (see
Figure 15-5), click the Show Transitions button on the Browser toolbar (or
press 88+4).

To see what a particular transition looks like, move your cursor over the
thumbnail to display the transition in miniature.

Adding a transition couldn’t be easier: Drag the transition from the list in the

Transitions Browser pane and drop it between clips or between a clip and a still
image in the Project pane. In iMovie 09, transitions are applied in real time.

Even Gone with the Wind had titles

The last stop on our iMovie Hollywood Features Tour is the Titles Browser,
as shown in Figure 15-6. You can find it by clicking the Title button on the
Browser toolbar (which bears a big capital T) or by pressing 8+3. You can
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add a title with a still image, but iMovie also includes everything you need to
add basic animated text to your movie.

|
Figure 15-6:
Add titles
for your next
silent film.
|

Most of the controls you can adjust are the same for each animation style.
You can change the font, the size of the text, and the color of the text. To add
a title manually, follow these steps:

1. Select an animation thumbnail from the Title Browser pane and drag
it to the desired spot in the Project pane.
2. Click a background thumbnail to select a background for your title.

3. Click the Show Fonts button in the monitor window to make any
changes to the fonts or text attributes.

4. Click in a text box to type your own line of text.
5. Click the Play button to preview your title.

iMovie displays a preview of the effect in the monitor with the settings
that you choose.

6. Click Done.

The title appears in the Project pane.
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Sharing Your Finished Classic
with Others
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Your movie is complete, you've saved it to your hard drive, and now you're
wondering where to go from here. Click Share on the application menu bar,
and you see that iMovie can unleash your movie upon your unsuspecting
family and friends (and even the entire world) in a number of ways:

v iTunes: Send your movie to your iTunes Library as a movie.
v iDVD: Open your movie within iDVD as a new project.

1 Media Browser: Make your iMovie project available within other iLife
’09 applications, in five different sizes suited to different display devices.
Note that the Media Browser is also available for other Apple applica-
tions, like Final Cut Studio, and to third-party applications like Toast
Titanium.

v YouTube: Yep, you read right, you can send your iMovie directly to the
YouTube Web site! Can it get more convenient than that? (I think not.)

1 MobileMe Gallery: Share your movie with the world at large by posting
it within a gallery on your MobileMe Web site. (I provide more MobileMe
details to chew on in Chapter 9.)

v Export Movie: Create a copy of your movie on your hard drive in one of
five different sizes.

v Export using QuickTime: Create a QuickTime movie with your project,
using the QuickTime encoding engine (allowing greater control over the
export process and the attributes of the finished movie file).

If you use this option, any computer with an installed copy of QuickTime
can display your movies, and you can use QuickTime movies in Keynote
presentations as well.

v Export to Final Cut XML: If you’d like to transfer your iMovie '09 project
to Final Cut Pro, use this option to create a compatible XML file.

When you choose a sharing option, iMovie displays the video quality for the
option and makes automatic changes to the movie attributes. (For example,
choosing Tiny reduces the finished movie as far as possible in file size, and
the audio is reduced to mono instead of stereo.)

If you’re worried about permanently reducing the quality of your project

by sharing it in a smaller size, fear not! When you choose a sharing option

to export your movie, your original project remains on your hard drive,
unchanged, so you can share a better-quality version at any time in the future!
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Chapter 16

Creating DVDs on the Road
with iDVD

In This Chapter

Traversing the iDVD window

Starting a new iDVD project

Tweaking and adjusting your DVD

Previewing your (nearly) finished DVD

Doing things automatically with OneStep DVD and Magic iDVD
Burning a DVD for your friends and family

How does the old adage go? Oh, yes, it’s like this:

Any DVD movie must be a pain to create. You'll need a ton of money for soft-
ware, too. And you'll have to take hours of training that will cause your brain
to explode.

Funny thing is, DVD authoring — designing and creating a DVD movie —
really was like that for many years. Only video professionals could afford the
software and tackle the training needed to master all the intricacies of DVD
Menu design.

Take one guess as to the company that changed all that. (No, it wasn’t Coca-
Cola.) Apple’s introduction of iDVD was (quite literally) a revolution in DVD
authoring. Suddenly you, your kids, and Aunt Harriet could all design and burn
DVD movies and picture slideshows. Dear reader, this iDVD thing is huge.

Plus, you'll quickly find out that iDVD is tightly connected to all the other
slices of your digital hub. In plain English, you can pull content from iTunes,
iPhoto, and iMovie as easily as a politician makes promises. You’ll be creat-
ing DVDs for those special occasions on the fly, on the road. And that, friends
and neighbors, is the quintessential definition of cool.
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In this chapter, I show you how your MacBook can take on Hollywood as
well as how you can produce a DVD movie with content that’s as good as any
you’d rent at the video store!

Hey, Where’s the Complex Window?

Figure 16-1 shows iDVD in all its glory. The same smart people who brought
you the iMovie window designed the iDVD window. You have to supply
your own digital video clips, background audio, and digital photographs, of
course.

Menu display

Figure 16-1:
iDVD is a
jewel of an
application
— easyto
use and
powerful to
boot.
|

Add DVD Map Preview Media pane

Inspector Window Edit Drop Zones Burn
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Take a moment to appreciate iDVD — no half-a-dozen secondary windows to
fiddle with or silly palettes strung out everywhere. (Can you tell that I've had
my fill of old-style DVD authoring applications?) Instead, iDVD uses a set of
panes that conveniently slide into and out of view. Allow me to list the high-
lights of the iDVD window:

1+ Menu display: This section takes up the largest part of the iDVD
window, with good reason. You create your project here. In this case,
Menu refers to your DVD Menu, not the menu at the top of your Mac’s
display.

v Media pane: You add video, still images, and audio to your project from
here, as well as tweak and fine-tune things. The Media pane actually
comprises three separate panes. To choose a new pane, click one of
these buttons at the lower-right corner of the screen:

e Themes: You apply themes (such as Travel Cards, Wedding White,
and Baby Mobile) to your DVD Menu to give it a certain look and feel.

* Buttons: These options apply to the selected item, such as drop shad-
ows on your text titles or the appearance of your menu buttons.

e Media: From here, you can add media items, such as video clips
and photos, to your menu.

v Add: Clicking this button opens a pop-up menu (which sports a dapper
plus sign) from which you can choose one of three types of buttons to
add to a project. The choices are

¢ Add Submenu: Choose this item to add a new submenu button
to your DVD Menu. The person using your DVD Menu can click
a button to display a new submenu that can include additional
movies or slideshows. (If that sounds like ancient Greek, hang on.
All becomes clearer later in the chapter in the section “Adding
movies.”

In iDVD, a menu can hold up to 12 buttons, so submenus let you
pack more content on your DVD. (Older versions of the application
only allowed six buttons, so don’t feel too cheated.) Anyway, each
submenu you create can hold another 12 buttons.

e Add Movie: Yep, this is the most popular button in the whole
shootin’ match. Click this menu item to add a new movie clip to
your menu.

e Add Slideshow: If you want to add a slideshow to your DVD — say,
using photos from your hard drive or pictures from your iPhoto
library — click this menu item. (Read all about iPhoto in Chapter 14.)

v+ Inspector Window: Click this button to display the Inspector window
for the current menu or a highlighted object. From this window, you can
change the look of an individual submenu button or an entire menu.

www.it-ebooks.info


http://www.it-ebooks.info/

204 Partiv: Living the ilife

»* Motion: Click this button (which bears two arrows in a circular shape)
to start or stop the animation cycle used with the current iDVD theme.
The animation repeats (just like it will on your finished DVD) until you
click the Motion button again.

<P Need a visual indicator of the length of your menu’s animation cycle?
Just follow the animation playhead, which moves below the Menu
display to indicate where you are in the animation cycle. Like other
playheads in the iLife suite, you can click and drag the diamond-shaped
playhead button to move anywhere in the animation cycle. Choose
Viewr>Hide Motion Playhead to turn off the playhead display.

v DVD Map: Click the DVD Map button to display the organizational chart
for your DVD Menu. Each button and submenu that you add to your top-
level DVD Menu is displayed here, and you can jump directly to a par-
ticular item by double-clicking it. Use this road map to help design the
layout of your DVD Menu system or to get to a particular item quickly.
To return to the Menu display, click the DVD Map button again.

v Edit Drop Zones: Clicking this button allows you to edit the look and
contents of a drop zone on your menu. Don’t worry; I explain more
about drop zones in the sidebar “Taking advantage of drop zones,” later
in this chapter.

v Preview: To see how your DVD Menu project looks when burned to a
DVD, click Preview. You get a truly nifty on-screen remote control that
you can use to navigate your DVD Menu, just as if you were watching
your DVD on a standard DVD player. To exit Preview mode, click the
Stop button on the remote control. Read more about this control in the
upcoming section, “Previewing Your Masterpiece.”

v Burn: Oh, yeah, you know what this one is for — recording your com-
pleted DVD movie to a blank disc.

That’s the lot! It’s time to get down to the step-by-step business of making
movies.

Starting a New DVD Project

When you launch iDVD for the first time (or if you close all iDVD windows),
you get the sporty menu shown in Figure 16-2. Take a moment to discover
more about these four choices.
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|
Figure 16-2:

be create
manual or

automatic?
|
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Creating a new project

If you choose Create a New Project, iDVD prompts you to type a name for
your new DVD project and to set a location where the project files should

be saved. By default, the very reasonable choice is your Documents folder.
You also get to choose whether your project will display in a standard (full-
screen) aspect ratio of 4:3 or a widescreen aspect ratio of 16:9. If you've been
watching DVD movies for some time, you recognize these two terms.

You'll probably crave widescreen format if you have a widescreen TV (and a
source of widescreen video) — go figure — but both formats can display on
both types of televisions.

Click Create, and the iDVD window appears in all its glory.

Opening an existing project

If you've used iDVD and had a DVD project open the last time you quit the
application, iDVD automatically loads the DVD project you were working on.
However, you can open any DVD you created by clicking Open an Existing
Project. (To choose a different existing project from the iDVD window, press
3+0 or choose File=>Open Recent.)
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Automating the whole darn process

If you're a fan of click-it-and-forget-it (or are in a hurry), you can throw cau-
tion to the wind and allow iDVD to create your latest epic for you! iDVD offers
two automated methods of creating a DVD movie disc, which [ describe in the
following sections.

Using OneStep DVD

With OneStep, iDVD does most of the work automatically by using raw
footage from your miniDV/FireWire camcorder. To allow iDVD to help you
create a movie, click the OneStep DVD button on the top-level menu (refer
to Figure 16-2). If you already opened a project, choose File>OneStep DVD
from the application menu bar (to import clips directly from your camera)
or Filem>OneStep DVD from Movie (to select a clip to import from your hard
drive). I tell you more about the OneStep DVD feature later in the section “A
Word about Automation.”

Using Magic iDVD

Magic iDVD falls neatly between total automation (with OneStep DVD) and
total manual control. Click the Magic iDVD button on the top-level menu

(as shown in Figure 16-2). If you already opened a project, you can choose
Filec>Magic iDVD from the menu bar to choose a theme, drop specific movies
and specific photos into filmstrips, and choose an audio track.

Unlike OneStep DVD, you get to preview the finished product. If it’s to your
liking, you can choose to either burn the disc directly or save a full-blown
iDVD project to your hard drive with the results. Sweet.

You can find out more about the new Magic iDVD feature later in the section
“A Word about Automation.”

Creating a DVD from Scratch

Doing things the old-fashioned, creative, and manual way (following the
examples in this section) involves four basic steps:

1. Design the DVD Menu.
Choose a theme and any necessary buttons or links.
2. Add media.

You can drag movie files from iMovie HD, still images from iPhoto, and
music from iTunes.
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Figure 16-3:
Selecta
new theme
from the
Themes
pane.
|

3. Tweak.
Adjust and fine-tune your DVD Menu settings.
4. Finish things up.

Preview and burn your DVD, or save it to your hard drive.

Choosing just the right theme

The first step to take when manually designing a new DVD Menu system is
to add a theme. In the iDVD world, a theme is a preset package that helps
determine the appearance and visual appeal of your DVD Menu, including a
background image, menu animation, an audio track, and a group of settings
for text fonts and button styles.

iDVD helps those of us who are graphically challenged by including a wide
range of professionally designed themes for all sorts of occasions, as well as
more generic themes with the accent on action, friendship, and technology.
(Heck, you can even download or buy third-party themes and install them
into iDVD!) To view the included themes, click the Themes button in the
lower-right corner of the iDVD window (see Figure 16-3).
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To choose a theme for your project — or to see what a theme looks like on
your menu — click any thumbnail and watch iDVD update the Menu display.

While creating your DVD Menu, if you decide that you need a different theme,
you can change themes at any time. iDVD won'’t lose a single button or video
clip that you add to your DVD Menu. You'll be amazed at how the look and
sound of your DVD Menu completely change with just the click of a theme
thumbnail.

Adding movies

Drop zones and themes are cool, but most folks want to add video to their
DVD. To accomplish this, iDVD uses buttons as links to your video clips. In
fact, some iDVD Movie buttons display a preview of the video they’ll display!
To play the video on a DVD player, you select the Movie button with the
remote control, just like you do for a commercial DVD.

To add a Movie button, drag a QuickTime movie file from the Finder and drop
it onto your DVD Menu display. (Note that only MPEG-4 QuickTime movies
are supported. MPEG-1 and MPEG-2 movie clips might be rejected, or con-
verted when possible.) Alternatively, drag a clip from the iDVD media pane
into the iDVD window, or click the Add button and choose Add Movie from
the pop-up menu.

iDVD and iMovie are soul mates, so you can also display the iDVD Media pane
and then click Movies from the pop-up menu. Now you can drag clips from
your Movies folder.

No matter the source of the clip, when you drop it onto your DVD Menu,
iDVD adds a Movie button, as you can see in Figure 16-4. Note that some but-
tons appear as text links rather than actual buttons. The appearance of a
Movie button on your DVD Menu is determined by the theme you choose.

A Movie button doesn’t have to stay where iDVD places it! By default, iDVD
aligns buttons and text objects on an invisible grid. However, if you don’t

want such order imposed on your creativity, just drag the object wherever
you’d like to turn on Free Positioning. (You can also right-click the object and
choose Free Positioning from the menu that appears.) iDVD even provides
cool automatic guides that help you align objects when you're using Free
Positioning. You see them as yellow lines that appear when objects are aligned
along a vertical or horizontal plane.
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Taking advantage of drop zones

Most of Apple’s animated themes include spe-
cial bordered areas marked as drop zones.
These locations have nothing to do with skydiv-
ing; rather, a drop zone is a placeholder in the
Menu that can hold a single video clip or photo-
graph. When you drag a video clip or an image
to a drop zone, that clip or picture is added to
the animation in Apple’s theme! Think about
that for a moment; | know | did. You can actually
personalize a Hollywood-quality animated DVD
Menu with your own photos and video!

To add a video clip or image to a drop zone,
simply drag the clip or photo from a Finder
window and drop it on the desired drop zone.
You can also drag clips or photos from other
sources, including the Movie and iPhoto panes
in iDVD, the iMovie window, or the iPhoto
window. Drop zones don't act as links or buttons
to other content; the stuff you add to a menu's
drop zones appears only as part of the theme's
animation cycle. You can even drag an iPhoto
event or album to a drop zone, and it will con-
tinuously cycle through the images. Wowsers!

As I mention earlier, you can have up to 12 buttons on your iDVD Menu. To

add more content than 12 buttons allow, add a submenu by clicking the Add
button and choosing Add Submenu from the pop-up menu. Now you can click
the submenu button to jump to that screen and drag up to another 12 movie

files into it.

Figure 16-4:
A new
Movie
button

appears on

your pristine

DVD Menu.

|
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QgN\BEH Keep in mind your target audience while you create your DVD. Standard TV

& sets have a different aspect ratio (height to width) and resolution (number of
pixels on the screen) than a digital video clip, and a standard TV isn’t as pre-
cise in focusing that image on the tube. If you select the standard aspect ratio
when you create the project, you can make sure that your DVD content looks
great on a standard TV screen by following these steps:

1. Click View on the old-fashioned iDVD Menu (the one at the top of
the screen).

2. Choose the Show TV Safe Area command.
You can also press the convenient 8+T shortcut.

iDVD adds a smaller rectangle within the iDVD window to mark the
viewable screen dimensions of a standard TV.

3. Place your content within the safe area.

If you take care that your menu buttons and (most of) your background
image fit within this smaller rectangle, you’re assured that folks with a
standard television can enjoy your work.

To toggle off the TV Safe Area rectangle, press $8+T again.

If your entire family is blessed with a fleet of HD TVs (or you chose the wide-
screen aspect ratio for this project), leave the Show TV Safe Area option off.
Today’s widescreen displays can handle just about any orientation.

Great! Now my audience demands
a slideshow!

Many Mac owners don’t realize that iDVD can use not only video clips but
also digital photos as content. In fact, you can add a group of images to your
DVD Menu via the Slideshow buttons, which allow the viewer to play back a
series of digital photographs. iDVD handles everything for you, so there’s no
tricky timing to figure out or weird scripts to write. Just click the Add button
at the bottom of the iDVD window and choose Add Slideshow. iDVD places a
Slideshow button on your DVD Menu.

After the Slideshow button is on tap, add the content — in this case, by
choosing the images that iDVD adds to your DVD Menu. Follow these steps to
select your slideshow images:

1. Double-click the Slideshow Menu button — the one you just added to
the menu — to open the Slideshow display (see Figure 16-5).
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Figure 16-5:
Who needs
a projector
anymore?
iDVD can
create a
great slide-
show!
|
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2. Click the Media button (lower right of the screen).
3. Click the Photos button (upper right of the screen) to display your

iPhoto library and photo albums.

. Drag your favorite image thumbnails from the Photos list and drop

them into the My Slideshow window.

You can also drag images straight from a Finder window or the iPhoto
window itself. (Those Apple folks are sooooo predictable.)

. Drag around the photos in the My Slideshow window to set their order

of appearance in your slideshow.

. To add audio to these pictures, drag your favorite audio file from the

Finder and drop it in the Audio well in the My Slideshow window.

The Audio well is the box bearing the speaker icon, next to the volume
control below the My Slideshow window.

Alternatively, click the Audio button (upper right of the screen) to
select an audio track from your iTunes Library, iTunes playlists, or
GarageBand creations.

. Click the Return button on the Slideshow display to return to your

DVD Menu.
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A word on image dimensions

For best playback results on a standard TV,
make sure that your background image has the
same dimensions as standard digital vidleo —
640 x 480 pixels. If the dimensions of your image
don’t match the dimensions of digital video,

iDVD will stretch or shrink the image to fit,
which might have undesirable effects. When
your image is stretched and skewed to fit the
DVD Menu, Aunt Harriet might end up looking
like Shrek (or perhaps Fiona).

\\3

If you're using a menu with animated buttons that display an image (rather
than text buttons), you can choose which image you want to appear on the
Slideshow button. Click the Slideshow button that you added and note the
slider that appears above the Slideshow button. Drag this slider to scroll
through the images you added. When you find the image that you want to use
for the Slideshow button on the DVD Menu, click the Slideshow button again
to save your changes.

Now for the music . . .

Most of the Apple-supplied themes already have their own background music
for your menu, so you might not even need to add music to your DVD Menu.
However, if you want to change the existing background music (or if your
menu currently doesn’t have any music), adding your own audio to the cur-
rent menu is child’s play! Follow these steps:

1. Click the Media button.

2. Click the Audio button to reveal the musical Shangri-La, as shown in
Figure 16-6.

3. Drag an audio file from the iTunes playlist or GarageBand folder dis-
play and drop it on the menu background.

iDVD accepts every sound format that you can use for encoding in
iTunes: AIFF, MP3, AAC, Apple Lossless, and WAV audio files, as well as
the MP2 format.

4. Click the Motion button (labeled in Figure 16-1) to watch your DVD
Menu animation cycle set to the new background audio.

5. Click the Motion button again to stop the animation and return to seri-
ous work.
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Figure 16-6:
Youdo a

lot of fine-
tuning from
the Settings
pane.
|

Giving Vour DUD the Personal Touch

You can easily make changes to the default settings provided with the theme
you choose. iDVD offers all sorts of controls that allow you to change the
appearance and behavior of buttons, text, and the presentation of your con-
tent. In the following sections, I show you how to cast out iDVD’s (perfectly
good) defaults and then tweak things to perfection.

Using Uncle Morty for your
DUD Menu background

Hey, Uncle Morty might not be a supermodel, but he has birthdays and anni-
versaries. Follow these steps to change the background of your DVD Menu:

1. Click the Inspector button (refer to Figure 16-1).
iDVD displays the Menu Info dialog.
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2. Get an image, using one of the following methods:

¢ Drag an image from the Finder and drop it into the Background
well, which appears as a square with a white outline at the top of
the Menu Info dialog.

® Drag the image directly into the Menu display.

® Use an image from your iPhoto Library by clicking the Media button,
choosing Photos, and then dragging the desired image into the
Menu display.

iDVD updates the DVD Menu to reflect your new background choice.

Adding your own titles

The one tweak you’ll probably have to perform in every iDVD project is
changing titles. Unfortunately, the default labels provided by iDVD are pretty
lame, and they appear in two important places:

v Menu title: Your large main title usually appears at the top of the DVD
Menu.

+* Button captions: Each Submenu, Movie, and Slideshow button that you
add to your menu has its own title.

To change the text in your Menu title or the titles below your buttons, follow
these steps:

1. Select the text by clicking it.
2. Click it again to edit it.

A rectangle with a cursor appears to indicate that you can now edit
the text.

3. Type the new text and then press Return to save the change.

Changing buttons like a
highly paid professional
Customizing Movie buttons? You can do it with aplomb! Follow these steps:

1. Click Buttons.
2. Click any Movie button from the DVD Menu to select it.

A slider appears above the button, which you can drag to set the thumb-
nail picture for that button in your DVD Menu. (Naturally, this is only for
animated buttons, not text buttons.)
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Select the Movie check box to animate the button.

3. To create a Movie button with a still image, drag a picture from a
Finder window or the Media pane and drop it on top of the button.

4. To adjust the properties for the button, click the Inspector button.

Table 16-1 describes the button properties. Note that some properties won’t
appear for text buttons.

Table 16-1 Button Settings You Can Customize

Movie Button Property What It Does

Label Font Changes the label font, text size, color,
and attributes.

Label Attributes Specifies the position of the label and whether it has
a shadow.

Custom Thumbnail Allows you to select the image that will appear on the

button. Drag an image to the Custom Thumbnail well.
For Slideshow buttons, drag the Thumbnail slider to
select the image that will appear on the button.

Transition Determines the transition that occurs when the
button is clicked (before the action occurs).
Size Adjusts the size of the button. Move the slider to the

right to increase the button size.

Give my creation motion!

Earlier in this chapter, you can read about how to use a different image for
your background, but what about using an animated background? You can
use any QuickTime movie from your iMovie library to animate your DVD
Menu background! Didn’t I tell you that this iDVD thing was huge?

Keep in mind that your background movie should be a short clip; 20-30 sec-
onds is optimal. A clip with a fade-in at the beginning and a fade-out at the end
is the best choice because iDVD loops your background clip continuously, and
your animated background flows seamlessly behind your menu.

I'm not talking drop zones here. (See the sidebar “Taking advantage of drop
zones.”) You can add a movie to a drop zone, of course, but by using a movie
clip as a background, you're replacing the entire animation sequence rather
than just a single area of the background.
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Follow these steps to add a new animated background:

1. Click your old friend, the Inspector Window button (refer to Figure 16-1).

Make sure that no individual objects are highlighted so that the
Inspector window displays the Menu properties instead.

2. Drag a movie from the Finder and drop it into the Background well.

You can click the Movies button in the Media pane to instantly display
your iMovie collection.

3. Click the Motion button in the iDVD window to try out your new
background.

4. Click the Motion button again to stop the animation cycle.

Previewing Vour Masterpiece

Figure 16-7 captures the elusive Preview remote control — truly an awesome
sight. When you click Preview, the Media pane disappears, and your DVD
Menu appears exactly as it will on the finished DVD.

Figure 16-7:
Preview
mode — an
incredible
simulation
indeed.
|
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Ah, but appearances aren’t everything: You can also use your DVD Menu!
Click the buttons on the remote control to simulate the remote on your DVD
player, or think outside the box and click a menu button directly with your
mouse pointer. iDVD presents the video clip, runs the slideshow, or jumps to
a submenu, just as it will with the completed disc.

This is a great time to test-drive a project before you burn it to disc. To make
sure that you don’t waste a blank DVD, make certain that everything you
expect to happen actually happens. Nothing is worse than discovering that
Aunt Edna’s slideshow from her Hong Kong trip actually displays your fam-
ily’s summer trip to the zoo (whoops). If you made a mistake or something
needs tweaking, click the Exit button on the controller and you’re back to the
iDVD window proper, where you can edit or fine-tune your project.

<P iDVD allows you to save your project as a standard Mac OS X disc image
rather than as a simple project file (or a physical DVD) — which is a good idea
if you're out of blank media because you can use the Apple Disk Utility to open
and mount the disc image as if it were a burned disc. (If you're a MacBook
Air Road Warrior without your external SuperDrive, this feature is just plain
wonderful!) To save an iDVD project as a disc image, choose Filec>Save as Disc
Image (or press 38+Shift+R).

<P Interested in tweaking settings across your entire project? Perhaps you’d like
to improve the quality of your recorded video, or you'd like to switch video
modes from NTSC to PAL for a DVD that’s to be sent overseas. If you'd like to
view or change the overall settings for your entire DVD, click Project=>Project
Info to display the Project Info dialog.

A Word about Automation

At the beginning of the chapter, I mention the easy way to produce an iDVD
disc or project, using either OneStep DVD (for complete automation) or
Magic iDVD (for partial automation). In the following sections, I provide you
with the details.

One-click paradise with OneStep DVD

If you're in a hurry to create a DVD from clips on your DV camcorder and

you don’t mind losing your creative input, OneStep DVD is just the ticket. In
short, iDVD allows you to plug in your DV camcorder, answer a question or
two, and then sit back while the application does all the work. iDVD imports
the DV clips, creates a basic menu design, and burns the disc automatically!
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Using OneStep DVD will appeal to any MacBook owner with a FireWire port
handy. Why not produce a DVD right after a wedding or birthday that you
can give as a gift — in minutes after the event is over? Photographers who
cover those same special events might consider selling a DVD made with
OneStep DVD. If you happen to capture something incredibly unique — say,
a UFO landing or an honest politician — you can use OneStep DVD to create
an instant backup of the clips on your miniDV camcorder. You could even
keep your friends and family up-to-date with the progress of your vacation
by sending them a daily DVD of your exploits! (You gotta admit that even
Grandma would consider that eminently sassy!)

Follow these steps to start the OneStep DVD process:
1. Click the OneStep DVD button on the iDVD top-level menu (refer to
Figure 16-2).
Alternatively, choose File=>OneStep DVD.
iDVD displays the OneStep dialog.

If you want to use OneStep DVD with an existing movie on your
MacBook’s hard drive, choose Filec>OneStep DVD from Movie instead.
iDVD prompts you for the video clip to use.

2. Following the prompts, connect the FireWire cable from your miniDV
camcorder; then turn on the camcorder and set it to VCR mode.

3. Click OK.
4. Load a blank DVD when prompted.

Exercising control with Magic iDVD

Got a little extra time? For those who prefer to make just a few choices and
let iDVD do the rest, the new Magic iDVD feature just plain rocks! However,
you can’t import clips directly from your miniDV camcorder like you can with
OneStep DVD. Instead, you select the following:

v An iDVD theme

v Video clips you created with iMovie HD or that you dragged from the
Finder

+* Photos from your iPhoto Library or dragged from the Finder

v Audio from your iTunes playlist or dragged from the Finder

Follow these steps to start the OneStep DVD process:
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1. Click the Magic iDVD button on the iDVD top-level menu (refer to
Figure 16-2).

iDVD displays the Magic iDVD window.
2. Click in the DVD Title box and type a name for your disc (or project).
3. Click to select a theme from the Theme strip.

4. Click the Movies button and drag the desired clips into the Drop
Movies Here strip.

5. To add a slideshow, click the Photos button and drag the desired
photos into the Drop Photos Here strip.

6. To add audio for your slideshow, click the Audio button and drag the
desired song into the Drop Photos Here strip.

\3
P No, you won't find a Drop Audio Here strip, but a speaker icon does

appear in the first cell of the Drop Photos Here strip to indicate that you
added a soundtrack.

7. Click Preview to see a preview of the finished project, complete with
remote control. To exit Preview mode, click Exit.

8. To open the project in its current form in the main iDVD window, click
Create Project.

Opening your Magic iDVD work as a full iDVD project gives you full cre-
ative control over what’s been completed so far. (In effect, Magic iDVD
has acted as an assistant and helped you to quickly build the foundation
for an iDVD project.)

9. To record your completed project directly to DVD, load a blank DVD
and then click Burn.

To return to the iDVD main window at any time, just click the Close button in
the Magic iDVD window.

Recording a Finished Project
to a Shiny Disc

When you’re ready to record your next Oscar-winning documentary on family
behaviors during vacation, just follow these simple words:

1. Click the Burn button at the bottom of the iDVD window.
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[ have to admit, the Burn button that appears has to be my favorite
single control in all my 20+ years of computing! It looks powerful, it looks
sexy ... it wants to burn. (Sorry about that. Rather wanton of me.)

2. After iDVD asks you to insert a blank DVD-R into the SuperDrive,
load a blank DVD-R, DVD-RW, DVD+R, or DVD+RW (depending on the
media your Mac can handle).

Your SuperDrive might be able to burn and read a DVD+R, DVD-RW,

or DVD+RW, but what about your DVD player? Keep in mind that only
DVD-Rs are likely to work in older DVD players. The latest generation

of DVD players is likely to be DVD+R compatible as well. Therefore,
remember the destination for the discs you burn and choose your media
accordingly.

After a short pause, iDVD begins burning the DVD. The application keeps
you updated with a progress bar.

When the disc is finished, you're ready to load it into your favorite local DVD
player, or you can load it back into your laptop and enjoy your work, using
the Apple DVD Player.

Either way, it’s all good!
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Recording Your Hits
with GarageBand

In This Chapter

Navigating the GarageBand window
Adding tracks and loops to your song
Repeating loops and extending your song
Building arrangements

Adding effects to instruments

Exporting your work to iTunes and iWeb

Burning your song to an audio CD

Do you dream of making music? I've always wanted to join a band, but
I never devoted the time nor learned to play the guitar. You know the
drill: Those rock stars struggled for years to gain the upper hand over an
instrument, practicing for untold hours, memorizing chords, and . . . wait a
second. I almost forgot. You don’t need to do any of that now!

Apple’s GarageBand ’09 lets a musical wanna-be (like yours truly) make
music with a MacBook — complete with a driving bass line, funky horns, and
perfect drums that never miss a beat. In fact, the thousands of prerecorded
loops on tap in this awesome application allow you to design your music to
match that melody running through your head, from techno to jazz to alter-
native rock.

Oh, and did I mention that you can also use GarageBand ’09 to produce pod-
casts? That’s right! You can record your voice and easily create your own
show, and then share it with others from your iWeb site! Heck, add photos
if you like. You'll be the talk of your family and friends and maybe even your
Mac user group.
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This chapter explains everything you need to know to create your first song.
[ also show you how to import your hit record into iTunes so that you can
listen to it on your iPod with a big silly grin on your face (like I do) or add it
to your next iMovie or iDVD project.

Don’t be too smug when you think of all that practicing and hard work you
missed out on. What a shame!

Shaking Hands with Vour Band

As you can see in Figure 17-1, the GarageBand window isn’t complex at all,
and that’s good design. In this section, I list the most important controls so
that you know your Play button from your Loop Browser button.

Track list  Playhead Loop Timeline

L

Figure 17-1:
The Garage
Band
window —
edged in
wood grain,
no less.

Return to Beginning | Play Time/Tempo display ~ Volume slider View/
Hide
Create a New Track Move Forward One Measure View/Hide | Media

Loop Browser | g
rowser
Move Back One Measure

Track Info
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Your music-making machine includes

v Track list: In GarageBand, a track is a discrete instrument that you set

up to play one part of your song. For example, a classical piece for string
quartet would have four tracks — one each for violin, viola, cello, and
bass. The Track list contains all the tracks in your song arranged so that
you can easily see and modify them, like the rows in a spreadsheet. A
track begins in the list, stretching out to the right all the way to the end
of the song. As you can see in the upper left of Figure 17-1, I already have
one track defined — a grand piano.

If you're creating a podcast, a Podcast artwork track can also appear.
Video podcasts can include a movie track as well.

v Timeline: This scrolling area holds the loops (see the following bullet)

that you add or record, allowing you to move and edit them easily.
When a song plays, the Timeline scrolls to give you a visual look at your
music. (Bear with me; you’ll understand that cryptic statement in a page
or two.)

v Loop: This is a prerecorded clip of an instrument being played in a spe-

cific style and tempo. Loops are the building blocks of your song. You
can drag loops from the Loop Browser to a track and literally build a
bass line or a guitar solo. (It’s a little like adding video clips in iMovie to
build a film.)

v Playhead: This vertical line is a moving indicator that shows you the

current position in your song while it scrolls by in the Timeline. You can
drag the playhead to a new location at any time. The playhead also acts

like the insertion cursor in a word processing application: If you insert a
section of a song or a loop from the Clipboard, it appears at the current

location of the playhead. (More on copying and inserting loops later, so

don’t panic.)

1 Create a New Track button: Click this button to add a new track to your

song.

v Track Info button: If you need to display the instrument used in a track,

click the track to select it and then click this button. You can also con-
trol settings, such as Echo and Reverb, from the Edit pane of the Track
Info display.

v+ View/Hide Loop Browser button: Click the button with the striking eye

icon to display the Loop Browser at the bottom of the window; click
it again to close it. You can see more of your tracks at a time without
scrolling by closing the Loop Browser.

1 View/Hide Media Browser button: Click this button (which bears icons

of a filmstrip, slide, and musical note) to display the media browser
at the right side of the window; click it again to close it. By closing
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the media browser, you can see more of your tracks. If you're already
familiar with iDVD, iWeb, or iMovie, you recognize this pane in the
GarageBand window; it allows you to add media (in this case, digital
song files, still images, or video clips) to your GarageBand project for
use in a podcast or as iPhone ringtones.

+* Return to Beginning button: Clicking this button immediately moves
the playhead back to the beginning of the Timeline.

v Move Back/Forward One Measure buttons: To move quickly through
your song by jumping to the previous or next measure, click the corre-
sponding button.

v Play button: Hey, old friend! At last, a control that you've probably used
countless times before — and it works just like the same control on your
audio CD player. Click Play, and GarageBand begins playing your entire
song. Notice that the Play button turns blue. To pause the music, click
Play again; the button loses that sexy blue sheen and the playhead stops
immediately.

v+ Time/Tempo display: This cool-looking LCD display shows you the cur-
3 rent playhead position in seconds.

You can click the icon at the left of the display to choose other modes,
such as

® Measures (to display the current measure and mark the beat)
¢ Chord (to display note and chord names)

® Project (to show or change the key, tempo, and signature for the
song)

v Volume slider: Here’s another familiar face. Just drag the slider to raise
or lower the volume.

Of course, more controls are scattered around the GarageBand window, but
these are the main controls used to compose a song . . . which is the next stop!

Composing and Podcasting Made Easy

In this section, I cover the basics of composition in GarageBand, working
from the very beginning. Follow along with this running example:
1. Close all existing GarageBand windows.
GarageBand displays the top-level New Project dialog.
2. Click New Project in the list at the left.
3. Click the Piano icon and click Choose.

GarageBand displays the New Project dialog, as shown in Figure 17-2.
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|
Figure 17-2:
Start creat-
ing your
new song
here.
|

\\3

By choosing the Piano icon, my new GarageBand project will have one
track already in place — a grand piano. If you choose Electric Guitar or
Voice, you’ll have a project automatically created with an electric guitar
track or male and female voice tracks. To create a completely empty
project, choose Loops.

. Type a name for your new song and then drag the Tempo slider to

select the beats per minute (bpm).

A GarageBand song can have only one tempo (or speed) throughout,
expressed as beats per minute.

. If you want to adjust the settings for your song, you can select the

¢ Time signature (the Time box)
¢ Key (the Key box)

If you're new to music theory (the rules and syntax by which music is
created and written), just use the defaults. Most of the toe-tappin’ tunes
that you and I are familiar with fit right in with these settings.

. Click the Create button.

You see the window shown in Figure 17-1. (The Blues Jazz Piano 01 loop
in Figure 17-1 — which [ show you how to add in the next section — is
an example of a typical loop.)
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Adding tracks

Although I'm not a musician, | am a music lover, and [ know that many clas-
sical composers approached a new work in the same way you approach a
new song in GarageBand: by envisioning the instruments that they wanted
to hear. (I imagine Mozart and Beethoven would’ve been thrilled to use
GarageBand, but I think they did a decent job with pen and paper, too.)

In fact, GarageBand ’09 introduces a Songwriting project (also available from
the top-level New Project dialog). When you choose the Songwriting project,
GarageBand presents you with a full set of four instrument tracks, plus a real
instrument track for your voice. (More on software versus real instrument
tracks in a page or two.) You're instantly ready to start adding loops and
recording your own voice!

If you've followed along to this point, you’'ve noticed two problems with your
GarageBand window:

+* You find no keyboard. You can record the contents of a software instru-
ment track by “playing” the keyboard, clicking the keys by tapping your
trackpad. (As you might imagine, this isn’t the best solution.) If you're
a musician, the best method of recording your own notes is with a USB
MIDI instrument, which I discuss later in the chapter. For now, you can
display the keyboard window by pressing 88+K. If the keyboard window
is on the screen and you don’t need it, banish the window by clicking
the Close button.

Even if you're not interested in the “point-and-click” keyboard,
GarageBand offers a musical typing keyboard, where you press the keys
on your keyboard to simulate the keys on a musical keyboard. (Hey, if
you don’t have a MIDI instrument, at least it’s better than nothing.) To
display the musical typing keyboard window, press Shift+&+K.

v The example song has only one track. If you want to write the next
classical masterpiece for Grand Piano, that’s fine. Otherwise, on the
GarageBand menu bar, choose Track=>Delete Track to start with a clean
slate. (1 know, I could have started with a Loops project, but this way
you get to see how to delete a track.)

You can use the following five kinds of tracks in GarageBand ’09:

v Software instrument tracks: These tracks aren’t audio recordings.
Rather, they’re mathematically precise algorithms that your laptop
renders (or builds) to fit your needs. If you have a MIDI instrument con-
nected to your MacBook, you can create your own software instrument
tracks. (More on MIDI instruments later in this chapter.)
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In this chapter, | focus on software instrument tracks, which are the
easiest for a nonmusician to use.

+* Real instrument tracks: A real instrument track is an actual audio
recording, such as your voice or a physical instrument without a MIDI
connection. (Think microphone.)

v Electric Guitar tracks: GarageBand includes a real instrument track,
especially made for an electric guitar, that allows you to use one of five
different amplifiers and a number of stompboxes (those effect pedals
that guitarists are always poking with their foot to change the sound of
their instruments).

v Podcast artwork track: You get only one of these; it holds photos that
will appear on a video iPod (or a window on your iWeb site) when your
podcast is playing.

1 Movie tracks: The video sound track appears if you're scoring (adding
music to) an iMovie movie. Along with the video sound track, you get a
cool, companion video track that shows the clips in your movie. (More
on this in the “Look, I'm John Williams!” sidebar, later in this chapter.)

It’s time to add a software instrument track of your very own. Follow these
steps:

1. Click the Create a New Track button (which carries a plus sign),
labeled in Figure 17-1.
GarageBand displays the New Track dialog.
2. Click the Software Instrument radio button and then click Create.
See all those great instruments in the Track Info pane on the right?
3. Choose the general instrument category by clicking it.
I chose Drum Kits.

4. From the right column, choose your specific style of weapon, such as
Rock Kit for an arena sound.

Figure 17-3 illustrates the new track that appears in your list when you
follow these steps.

If you're creating a podcast and you want to add a series of still images that will
appear on a video iPod’s screen (or on your iWeb page), follow these steps:

1. Click the View Media Browser button (labeled in Figure 17-1).
2. Click the Photos button.
GarageBand displays all the photos in your iPhoto Library and events.
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Figure 17-3:
The new
track
appears,
ready to
rock.
|

3. Drag an image from your iPhoto Library in the media browser to the
Track list.

The Podcast track appears at the top of the Track list, and you can add
and move images in the list at any time, just like the loops that you add
to your instrument tracks. (More on adding and rearranging the con-
tents of a track in the following sections.)

Choosing loops

When you have a new, empty track, you can add loops to build your song.
You do that by adding loops to your track from the Loop Browser — Apple
provides you with thousands of loops to choose from, along with more you
can buy — and photos from your media browser. Click the Loop Browser
button (which bears the all-seeing eye) to display your collection, as shown
in Figure 17-4.
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Figure 17-4:
The Loop
Browser,
shown in

button view.

|

A\

Search box

If your Loop Browser looks different from what you see in Figure 17-4, that’s
because of the view mode you’re using, just like the different view modes
available for a Finder window. The three-icon button in the upper-left corner
of the Loop Browser toggles the browser display among Column, Musical
Button, and Podcast Sounds views. Click the middle of the three buttons to
switch to Button mode.

Looking for just the right loop

The track in this running example uses a Rock drum kit, but you haven’t
added a loop yet. (Refer to Figure 17-3.) Follow these steps to search through
your loop library for just the right rhythm:

1. Click the button that corresponds to the instrument you’re using.

I chose the Kits button in the Loop Browser. Click it, and a list of dif-
ferent beats appears in the pane at the bottom of the Loop Browser
window. (Check out Figure 17-4 for a sneak peek.)

2. Click one of the loops with a green musical-note icon.
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Figure 17-5:
Atrack

with a loop
added.
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Go ahead; this is where things get fun! GarageBand begins playing the loop
nonstop, allowing you to get a feel for how that particular loop sounds.

The examples I chose for this chapter are software instruments, which
are identified by a green musical-note icon. (If you have a band at home,
have at it with live instruments.)

. Click another entry in the list, and the application switches immedi-

ately to that loop.

Now you’re beginning to understand why GarageBand is so cool for both
musicians and the note-impaired. It’s like having your own band, with
members who never get tired and who play whatever you want while
you’re composing. (Mozart would’ve loved this.)

If you want to search for a particular instrument, click in the Search
box (labeled in Figure 17-4) and type the text you want to match.
GarageBand returns the search results in the list.

. Scroll down the list and continue to sample the different loops until

you find one that fits like a glove.

For this reporter, it’s Southern Rock Drums 01.

. Drag the entry to your Rock Kit track and drop it at the very begin-

ning of the Timeline (as indicated by the playhead).

Your window looks like Figure 17-5.
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Figure 17-6:
My Timeline
with a synth
and an elec-
tric bass
on-board.
Let's rock!
|

If you want that same beat throughout the song, you don’t need to add any
more loops to that track. (More on extending that beat in the next section.)
However, if you want the drum’s beat to change later in the song, you add a
second loop after the first one in the same track. For now, leave this track as is.

Whoops! Did you do something that you regret? Don’t forget that you can
undo most actions in GarageBand by pressing the old standby — 88+Z —
immediately afterward.

Second verse, same as the first
When you compose, you can add tracks for each instrument that you want in
your song:

v Each track can have more than one loop.
v Loops don’t have to start at the beginning; you can drop a loop any-
where in the Timeline.

For example, in Figure 17-6, you can see that my drum kit kicks in first, but
my bass line doesn’t begin until some time later (for a funkier opening).
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Look, I'm John Williams!

You, too, can be a famous composer of
soundtracks . . . well, perhaps not quite as
famous as Mr. Williams, but even he had to start
somewhere. To add a GarageBand score to an
iMovie, click the Track menu in Garage Band
and then click Show Movie Track to display the
Movie track. Choose a movie to score from the
familiar confines of the Media Browser, and
drag it to the Movie track.

At this point, you add and modify instrument
tracks and loops just as you would any other
GarageBand project. The existing sound for
the iMovie project appears in the Movie Sound

track. A Video Preview pane appears on top
of the Track Info pane on the right side of the
GarageBand window. When you click the Play
button, the video is shown as well so that you
can check your work and tweak settings (as |
describe later in the chapter).

After you finish composing, you can click Share
on the menu bar and choose to export your
work to iDVD, as a QuickTime movie directly
to your hard drive, or to iTunes as a movie.
Note that you can’t return to iMovie with your
project, so scoring should be a final step in the
production of your movie.

You put loops on separate tracks so that they can play simultaneously on
different instruments. If all your loops in a song are added on the same track,

you hear only one loop at any one time, and all the loops use the same software
instrument. By creating multiple tracks, you give yourself the elbowroom to

bring in the entire band at the same time. It’s {iber-convenient to compose your
song when you can see each instrument’s loops and where they fall in the song.

Click the Reset button in the Loop Browser to choose another instrument or
genre category.

Resizing, repeating, and moving loops

If you haven’t already tried listening to your entire song, try it now. You
can click Play at any time without wreaking havoc on your carefully created
tracks. Sounds pretty good, doesn’t it?

But wait: [ bet the song stopped after about five seconds, right? (You can
watch the passing seconds, using either the Time/Tempo display or the
second rule that appears at the very top of the Timeline.) I'm sure that you
want your song to last more than five seconds! After the playhead moves
past the end of the last loop, your song is over. Click Play again to pause the
playback; then click the Return to Beginning button (labeled in Figure 17-1) to
move the playhead back to the beginning of the song.

The music stops so soon because your loops are only so long. Most are five

seconds in length, and others are even shorter. To keep the groove going,
you have to do one of three things:

www.it-ebooks.info


http://www.it-ebooks.info/

Chapter 17: Recording Your Hits with GarageBand 293

Figure 17-7:
By repeat-
ing the bass
loop, you
can keep
the thump
flowing.
|

1 Resize the loop: Hover your cursor over either the left or right edge of

most loops, and an interesting thing happens: Your cursor changes to a
vertical line with an arrow pointing away from the loop. That’s your cue
to click and drag — and as you drag, most loops expand to fill the space
you’re making, repeating the beats in perfect time. By resizing a loop,
you can literally drag the loop’s edge as long as you like.

1 Repeat the loop: Depending on the loop that you chose, you might find

that resizing it doesn’t repeat the measure. Instead, the new part of the
loop is simply dead air. In fact, the length of many loops is limited to
anywhere from one to five seconds. However, if you move your cursor
over the side of a loop that you want to extend, it turns into a verti-

cal line with a circular arrow, which tells you that you can click and
repeat the loop. GarageBand actually adds multiple copies of the same
loop automatically, for as far as you drag the loop. In Figure 17-7, I've
repeated the bass loop that you see in Figure 17-6.

v Add a new loop: You can switch to a different loop to change the flow

of the music. Naturally, the instrument stays the same, but there’s no
reason you can’t use a horn-riff loop in your violin track (as long as it
sounds good played by a violin!). To GarageBand, a software instrument
track is compatible with any software instrument loop that you add from
the Loop Browser as long as that loop is marked with our old friend the
green musical note.
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You can also use the familiar cut (88+X), copy (88+C), and paste (88+V) editing
keys to cut, copy, and paste loops from place to place — both on the Timeline
and from track to track. And you can click a loop and drag it anywhere.

Each track can be adjusted so that you can listen to the interplay between
two or more tracks or hear how your song sounds without a specific track:

v Click the tiny Speaker button under the track name in the list, and the
button turns blue to indicate that the track is muted. To turn off the
mute, click the Speaker icon again.

» You can change the volume or balance of each individual track by using
the mixer that appears next to the track name. This comes in handy if
you want an instrument to sound louder or confine that instrument to
the left or right speaker.

A track doesn’t have to be filled for every second with one loop or another.
Most of my songs have a number of repeating loops with empty space
between them as different instruments perform solo.

Using the Arrange track

GarageBand includes another method you can use to monkey with your
music: The Arrange track can be used to define specific sections of a song,
allowing you to reorganize things by selecting, moving, and copying entire
sections. For example, you're probably familiar with the chorus (or refrain)
of a song and how often it appears during the course of the tune. With the
Arrange track, you can reposition the entire chorus within your song, car-
rying all the loops and settings within the chorus along with it! If you need
another chorus, just copy that arrangement.

To use the Arrange track, display it by choosing Track=>Show Arrange Track.
The Arrange track then appears as a thin strip at the top of the Track list.
Click the Add Region button in the Arrange track (which carries a plus sign)
and you see a new, untitled region appear (as shown in Figure 17-8). You can
drag the right side of the Arrangement region to resize it, or drag it to move it
anywhere in the song.

Who wants an arrangement full of regions named “untitled”? To rename an
Arrangement region, click the word untitled to select it (the Arrange track
turns blue), and then click the title again to display a text box. Type a new
name for the region and press Return.
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Figure 17-8:
I've just
added a

new region

in my song'’s
Arrange
track.
|

Now, here’s where Arrangement regions get cool:
v To move an entire Arrangement region, click the region’s title in the
Arrange track and then drag it anywhere you like in the song.

v To copy an Arrangement region, hold down the Option key and drag the
desired region’s title to the spot where you want the copy to appear.

v To delete an Arrangement region, select it and press 3 +Option+Delete.

v To replace the contents of an Arrangement region with those of another
Arrangement region, hold down the 8 key and drag the desired region’s
title on top of the offending region’s title.

v To switch two Arrangement regions in your song — swapping the con-
tents completely — drag one of the Arrangement region titles on top of
the other and lift your finger from the trackpad.

Tweaking the settings for a track

You don’t think that John Mayer or U2 just “play and walk away,” do you? No,
they spend hours after the recording session is over, tweaking their music in
the studio and on the mixing board until every note sounds just as it should.
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Figure 17-9:
Finesse

your tune

by tweaking
the sound

of a specific
track.
|

You can adjust the settings for a track, too. The tweaks that you can perform
include adding effects (pull a Hendrix and add echo and reverb to your elec-
tric guitar track) and kicking in an equalizer (for fine-tuning the sound of your
background horns).

To make adjustments to a track, follow these steps:

1. Click the desired track in the Track list to select it.
2. Click the Track Info button (labeled in Figure 17-1).
3. Click the Edit tab to display the settings shown in Figure 17-9.

4. Click the button next to each effect you want to enable. (The button
glows green when enabled.)

Each of the effects has a modifier setting. For example, you can adjust
the amount of echo to add by dragging its slider.

GarageBand offers a Visual Equalizer window that you can use to create
a custom equalizer setting for each track. You can display the Visual EQ
window by clicking the animated button next to the Visual EQ control on
the Edit pane. To change the Bass, Low Mid, High Mid, or Treble setting
for a track, click and drag the equalizer waveform in the desired direc-
tion. And yep, you can do this while your song is playing, so you can use
both your eyes and ears to define the perfect settings!
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5. To save the instrument as a new custom instrument, click the Save

Instrument button.

Now you can use the instrument the next time you add a track.

6. Click the Track Info button again to return to GarageBand.

Save your work often in GarageBand, just as you do in the other iLife appli-
cations. One power blackout, and you’ll never forgive yourself. Press 38+S
frequently and enjoy the peace of mind.™

Join in and jam. .. or talk!

As | mention elsewhere in this chapter,
GarageBand is even more fun if you happen to
play an instrument! (And yes, I'm envious, no
matter how much | enjoy the techno and jazz
music that | create. After all, take away my
MacBook, and I'm back to playing the kazoo. ..
at least until | absorb all the Learn to Play les-
sons for the guitar.)

Most musicians use MIDI instruments to play
music on the computer. That pleasant-sounding
acronym stands for Musical Instrument Digital
Interface. A wide variety of MIDI instruments
is available these days, from traditional MIDI
keyboards to more exotic fun, such as MIDI
saxophones. For example, Apple sells a 49-key
MIDI keyboard from M-Audio for around $100; it
connects to your laptop with a USB connection.

Most MIDI instruments on the market today use
a USB connection. If you have an older instru-
ment with traditional MIDI ports — they're
round, so you'll never confuse them with USB
connectors — you need a USB-to-MIDI con-
verter. You can find this type of converter on
the Apple Web site for around $50. (If you're
recording your voice for a podcast, things are
easier because you can use your MacBook's

built-in microphone; however, most podcasting
professionals opt for an external microphone,
which offers better fidelity and doesn’t force
you to sit directly in front of your screen to
record.)

After your instrument is connected, you can
record tracks using any software instrument.
Create a new software instrument track as |
demonstrate in this chapter, select it, and then
play a few notes. Suddenly you’re playing the
instrument you chose! (If nothing happens,
check the MIDI status light — which appears
in the time display — to see whether it blinks
with each note you play. If not, check the instal-
lation of your MIDI connection and make sure
that you've loaded any required drivers, as well
as your MIDI settings within QuickTime and the
input settings in the System Preferences Sound
pane.)

Drag the playhead to a beat or two before
the spot in the Timeline where you want your
recording to start. This gives you time to match
the beat. Then click the big red Record button
and start jamming or speaking! When you
finish, click the Play button to stop recording.
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Automatic Composition with
Magic GarageBand

In a hurry? Too rushed to snag loops and tweak effects? Never fear,
GarageBand ’09 can even compose a song automatically! The Magic
GarageBand feature (shown in Figure 17-10) provides a wide range of
nine different genres of music to choose from — everything from blues
to reggae to funk and rock.

|
Figure 17-10:
Creating my
own arena-
rock classic
with Magic
Garage
Band.
|

To create a song automatically, follow these steps:

1. Close all GarageBand windows.

If you're currently working on a song, GarageBand prompts you to save
it before closing the window.

2. Click the Magic GarageBand button in the New Project dialog.
3. Click the desired genre button and click Choose.

Hover your cursor over a genre button to get a preview of the song for
that genre.
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4. To hear the entire song with the default instruments, click Entire Song
and click the Play button.

Alternatively, to hear a short sample of the song, click Snippet and click
the Play button.

In Figure 17-10, you see each instrument onstage. To choose a different
musical style for an instrument (or a variation of the instrument), click it
and then select the desired sound from the menu below the stage.

Click My Instrument (the empty space in the middle of the stage) to add
your own voice or instrumental, using a microphone or MIDI instrument.

5. When the song fits like a glove, click Create Project to open the song
as a project in GarageBand.

Now you can edit and tweak the song to your heart’s delight as you can any
other GarageBand project, adding other software or real instrument tracks as
necessary.

Sharing Your Songs and Podcasts

A\

After you finish your song, you can play it whenever you like through
GarageBand. But then again, that isn’t really what you want, is it? You want to
share your music with others with an audio CD or download it to your iPod
so that you can enjoy it yourself while walking through the mall!

iTunes to the rescue! As with the other iLife applications that I cover in this
book, GarageBand can share the music you make through the digital hub that
is your Mac.

Creating MP3 and AAC files and ringtones

You can create an MP3 or AAC file (or even an iPhone ringtone) from your
song or podcast project in just a few simple steps:
1. Open the song that you want to share.
2. Choose Share~>Send Song to iTunes.
GarageBand displays the settings you see in Figure 17-11.

To create a ringtone and send it to iTunes, choose Share=>Send
Ringtones to iTunes.

www.it-ebooks.info


http://www.it-ebooks.info/

300 Partiv: Living the iite

Figure 17-11:
Tweaking
settings for
iTunes song
files.
|

3. Click in each of the four text boxes to type the playlist, artist name,
composer name, and album name for the tracks you create.

You can leave the defaults as they are, if you prefer. Each track that you
export is named after the song’s name in GarageBand.

4. Click the Compress Using pop-up menu and choose the encoder
GarageBand should use to compress your song file.

The default is AAC, but you can also choose MP3 encoding for wider
device compatibility.

5. Click the Audio Settings pop-up menu to select the proper audio qual-
ity for the finished file.

The higher the quality, the larger the file. GarageBand displays the
approximate file size and finished file information in the description box.

6. Click Share.

After a second or two of hard work, your MacBook opens the iTunes window
and highlights the new (or existing) playlist that contains your new song.
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Sending a podcast to ilWeb or iTunes

If you prepare a new podcast episode in GarageBand, you can send it auto-
matically to iWeb or iTunes by following these steps:

1. Open the podcast that you want to export to iWeb.

Make sure that the Podcast track is displayed. If necessary, choose
Track=>Show Podcast Track to display it.

2. Choose Share=>Send Podcast to iWeb (or Share=Send Podcast to iTunes).

3. Click the Compress Using pop-up menu and choose the encoder that
GarageBand should use to compress your podcast file.

Your choices are the AAC and MP3 formats.

4. Click the Audio Settings pop-up menu to select the proper audio

quality for the finished file.

5. Click Share.

Burning an audio CD

Ready to create a demo CD with your latest GarageBand creation? Follow
these steps to burn an audio disc from within GarageBand:

1. Open the song that you want to record to disc.
2. Choose Share->Burn Song to CD.

3. Load a blank disc into your optical drive.

Hey, GarageBand, teach me how to play!

Until the arrival of GarageBand ‘09, you were
limited to creating music — and if you were a
nonmusician like yours truly, GarageBand had
no practical use as a tool for teaching yourself
how to actually p/ay an instrument.

Ah, but Apple’s introduction of Learn to Play
actually turns GarageBand into your private
video tutor for basic piano and guitar! From
the New Project dialog, click the Learn to
Play heading to display your lessons. Right
out of the box, you have an introduction to
both instruments, but you can download eight

more free lessons for each instrument from the
Lesson Store — and they cover more advanced
topics such as fingering and chords. Tim, your
on-screen instructor, can even record what
you play.

If you find the free Learn to Play lessons valu-
able, you can move up to the Artist lessons,
which are actually taught by famous musi-
cians (including favorites of mine such as John
Fogerty and Sting, who actually teaches you
how to play “Roxanne”!). Each Artist lesson is
$4.99 — well worth the price.
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Getting Productive
with iWork

The 5th Wave By Rich Tennant
ORTENNANT e

Good thing T had
my laptop with me.

Try turning it
ovey now!
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In this part . . .

ho needs that other office productivity suite? If

you've invested in Apple’s iWork 09, these
chapters will provide all the basics you need to use Pages,
Numbers, and Keynote to produce eye-popping printed
documents, spreadsheets, and professional-grade
presentations!
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Desktop Publishing with Pages

In This Chapter

Creating a Pages document

Entering, editing, and formatting text
Inserting tables and graphics
Adding a shape as a background
Checking your spelling

Printing Pages documents

Sharing your work

Wlat’s the difference between word processing and desktop publish-
ing? In a nutshell, it’s in how you design your document. Most folks

use a word processor like an old-fashioned typewriter. (Yawn.)

A desktop publishing application allows far more creativity in choosing where
to place text, how to align graphics, and how to edit formats. In this chapter, |
show you how to set your inner designer free from the tedious constraints of
word processing! Whether you need a simple letter, a stunning brochure, or a
multipage newsletter, Pages '09 can handle the job with ease — and you’ll be
surprised at how simple it is to use.

Creating a New Pages Document

To create a new Pages document from scratch, follow these steps:

1. Double-click your hard drive icon and click the Applications entry in
the Finder window sidebar. Double-click the iWork folder to open it.
2. Double-click the Pages icon.

Pages displays the Template Chooser window that you see in Figure 18-1.
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Figure 18-1:
Selecting
atemplate
from the
Template
Chooser
window.
|

3. Click the type of document you want to create in the list to the left.

The thumbnails on the right are updated with templates that match your
choice.

4. Click the template that most closely matches your needs.

5. Click Choose to create a new document using the template you
selected.

Open an Existing Pages Document

Of course, you can always open a Pages document from a Finder window —
just double-click the document icon. However, you can also open a Pages
document from within the program. Follow these steps:

1. Double-click the Pages icon to run the program.

2. Press 3+0 to display the Open dialog.

The Open dialog operates much the same as a Finder window in icon,
list, or column view mode.
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3. Click the desired drive in the Devices list at the left of the dialog and
then click folders and subfolders until you’ve located the Pages
document.

You can also click in the Search box at the top of the Open dialog and
type in a portion of the document name or its contents.

4. Double-click the filename to load it.

\§
P If you want to open a Pages document that you've edited in the recent past,
things get even easier! Just choose File>Open Recent, and you can open the

document with a single click from the submenu that appears.

Saving Vour Work

To save a Pages document after you finish it (or to take a break while
designing), follow these steps:

1. Press 38+S.

If you're saving a document that hasn’t yet been saved, the familiar
Save As sheet appears.

2. Type a filename for your new document.

3. Click the Where pop-up menu and choose a location to save the
document.

Alternatively, click the button sporting the down arrow to expand the
Save As sheet. This allows you to navigate to a different location, or to
create a new folder to store this Pages project.

4. Click Save.

Touring the Pages Window

Before you dive into any real work, let me show you around the Pages
window! You'll find the following major components and controls, shown in
Figure 18-2:

1 Pages list: This thumbnail list displays all the pages you’ve created
within your document. (For a single-page document, of course, the
Pages list will contain only a single thumbnail.) You can switch instantly
between different pages in your document by clicking the desired
thumbnail in the list.
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Format Bar

Pages list Layout pane Toolbar | Styles Drawer

|
Figure 18-2:
The major
points of
interestin
the Pages
window.
|

v Layout pane: This section takes up most of the Pages window — it’s
where you design and edit each page in your document.

v Toolbar: Yep, Pages has its own toolbar. The toolbar keeps all the most
common application controls within easy, one-click reach.

v Styles Drawer: This window extension allows you to quickly switch the
appearance of selected paragraphs, characters, and lists. You can hide
and display the Styles Drawer from the View menu or from the View
drop-down menu on the toolbar.

v Format Bar: This button strip runs under the Pages toolbar. Use it to
format selected text, paragraphs, and lists on the fly.

Entering and Editing Text

If you've used a modern word processing program, you'll feel right at home
typing within Pages. To enter text, simply begin typing. To edit existing text
in your Pages document, select and highlight the text. You can delete text by
pressing Delete.
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Using Text and Graphics Boxes

<MBER
S

Figure 18-3:
Moving a
text box
within the
Layout

pane.
|

Within Pages, text and graphics appear in boxes, which can be resized by
clicking and dragging on one of the handles that appear around the edges

of the box. (Hover your cursor over one of the square handles, and you’ll
see that it changes to a double-sided arrow, indicating that Pages is ready to
resize the box.)

You can also move a box, including all the stuff it contains, to another loca-
tion within the Layout pane. Click in the center of the box and drag the box
to the desired spot. Note that Pages displays blue alignment lines to help you
align the box with other elements around it (or with regular divisions of the
page, such as the vertical center of a poster or flyer). Figure 18-3 illustrates

a box containing text that 'm moving; note the vertical alignment line that
automatically appears.

To select text or graphics within a box, you must first click the box to select it
and then click again on the line of text or the graphic that you want to change.

Alignment line
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The Three Amigos: Cut, Copy, and Paste

“Hang on, Mark, you’ve covered moving stuff, but what if you want to copy

a block of text or a photo to a second location? Or how about cutting some-
thing from a document open in another application?” Good questions, dear
reader! That’s when you can call on the power of the cut, copy, and paste fea-
tures within Pages. The next few sections explain how you do these actions.

Cutting stuff

Cutting selected text or graphics removes it from your Pages document and
places that material within your Clipboard. (Think of the Clipboard as a holding
area for snippets of text and graphics that you want to manipulate.) To cut text
or graphics, select some material and choose Edit>Cut or press 38+X.

Copying text and images

When you copy text or graphics, the original selection remains untouched,
but a copy of the selection is placed in the Clipboard. Select some text or
graphics and choose Edit=>Copy or press 38+C.

To copy selected items by dragging, hold down the Option key while you drag
the items to their destination.

If you cut or copy a new selection into the Clipboard, it erases what was there
previously. In other words, the Clipboard holds only the latest material you
cut or copied.

Pasting from the Clipboard

Are you wondering what you can do with all that stuff that’s accumulating
in your Clipboard? Pasting the contents of the Clipboard places the material
at the current location of the insertion cursor. You must paste the contents
before you cut or copy again to avoid losing what’s in the Clipboard.

To paste the Clipboard contents, click the insertion cursor at the location
you want and choose Edit=>Paste or press $8+V.
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Formatting Text the Easy Way

If you feel that some (or all) of the text in your Pages document needs a face-
lift, you can format that text any way you like. Formatting lets you change the
color, font family, character size, and attributes as necessary.

After the text is selected, you can apply basic formatting in two ways:

+* Use the Format Bar. The Format Bar appears directly underneath the
Pages toolbar (refer to Figure 18-2). Click to select a font control to
display a pop-up menu and then click your choice. For example, click
the Font Family button and change the font family from Arial to a more
daring font. You can also select characteristics such as the font’s back-
ground color (perfect for highlighting key information) or choose italics
or bold. The Format Bar also provides buttons for text alignment (Align
Left, Center, Align Right, and Justify).

+” Use the Format menu. Most controls on the Format Bar are also avail-
able from the Format menu. Click Format and hover the cursor over the
Font menu item, and you can then apply bold, italics, and underlining
to the selected text. You can also make the text bigger or smaller. To
change the alignment from the Format menu, click Format and hover the
cursor over the Text menu item.

Adding a Spiffy Table

In the world of word processing, a fable is a grid that holds text or graphics
for easy comparison. You can create a custom table layout within Pages with
a few simple taps on the old trackpad!

Follow these steps:
1. Click the insertion cursor at the location where you want the table to
appear.
2. Click the Table button on the Pages toolbar.

Pages inserts a simple table and displays the Table Inspector, shown on
the right in Figure 18-4.

By default, Pages creates a table with three rows and three columns,
with an extra row for headings at the top. You can change this layout
from the Table Inspector — just click in the Body Rows or Body
Columns box and type a number.
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Figure 18-4:
Preparing

to tweak a
table in

my Pages
document.
|

3
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3. Click within a cell in the table to enter text.

The table cell automatically resizes and “wraps” the text to fit.

You can paste material from the Clipboard into a table. See the earlier
section “Pasting from the Clipboard” for details on pasting.

. To change the borders on a cell, click the cell to select it and then

click one of the Cell Borders buttons to change the border.

Select a range of multiple cells in a table by holding down Shift as you
click. Hold down the 8 key and click to select multiple cells that aren’t
contiguous.

. To add a background color (or even fill cells with an image for a back-

ground), click the Cell Background pop-up menu and choose a type of
background.

Adding Alluring Photos

You can choose from two methods of adding a picture within your Pages
document: as a floating object, meaning that you can place the image in a par-
ticular spot and it doesn’t move, even if you make changes to the text; and as
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|
Figure 18-5:
Hey, isn't
that the
Pages
Media
Browser?
|
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an inline object, which flows with the surrounding text as you make layout
changes. Here’s the lowdown on adding these objects:

1 Add a floating object. Drag an image file from a Finder window and
place it at the spot you want it within your document. Alternatively, you
can click the Media button on the toolbar and click Photos, navigate to
the location where the file is saved, and drag the image thumbnail to
the spot where you want it in the document. Figure 18-5 illustrates the
Media Browser in action.

Note that a floating object (such as a shape or image) can be sent to the
background, where text will not wrap around it. To bring a background
object back as a regular floating object, click the object to select it and
choose Arranger>Bring Background Objects to Front. (More about back-
ground objects later in this chapter.)

To resize an image object, click the image to select it and then drag

one of the selection handles that appear along the border of the image.
(They look like tiny squares.) The side-selection handles drag only that
edge of the frame. The corner-selection handles resize both adjoining
edges of the selection frame. Hold down the Shift key so that the vertical
and horizontal proportions remain fixed.
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v Add an inline object. Hold down the 3 key as you drag an image file
from a Finder window and place it where you want it within your docu-
ment. You can also click the Media toolbar button and click Photos to
display the Media Browser. Navigate to the location where the file is
saved, hold down the 8 key, and drag the image thumbnail to the spot
where you want it in the document.

Adding a Background Shape

To add a shape (such as a rectangle or circle) as a background for your text,

follow these steps:

1. Click the insertion cursor in the location you want.

2. Click the Shapes button on the Pages toolbar and choose a shape.
The shape appears in your document.

3. Click the center of the shape and drag it to a new spot.
Shapes can be resized or moved in the same manner as image boxes.

4. Before you can type over a shape, remember to select it and choose
Arrange~>Send Object to Background.

Are You Sure about That Spelling?

WMBER
@Q
&

Pages can check spelling as you type (the default setting) or check it after
you complete your document. If you find automatic spell-checking distract-
ing, you should definitely pick the latter method.

To check spelling as you type, follow these steps:

1. Click Edit and hover the cursor over the Spelling menu item.
2. Click Check Spelling As You Type in the submenu that appears.

If a possible misspelling is found, Pages underlines the word with a red,
dashed line.

3. Right-click the word to choose a possible correct spelling from the list,
or ignore the word if it’s spelled correctly.

To turn off automatic spell checking, click the Check Spelling As You Type
menu item again to deselect it.
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To check spelling manually, follow these steps:
1. Click within the document to place the text insertion cursor where the
spell check should begin.

2. Click Edit and hover the cursor over the Spelling menu item; then
choose Check Spelling from the submenu that appears.

3. Right-click any possible misspellings and choose the correct spelling,
or choose Ignore if the word is spelled correctly.

Printing Your Pages Documents

Ready to start the presses? You can print your Pages document on real
paper, of course, but don’t forget that you can also save a tree by creating an
electronic, PDF-format document instead of a printout — you’ll find the PDF
button within the standard Snow Leopard Print dialog.

To print your Pages document on old-fashioned paper, follow these steps:

1. Within Pages, choose File=>Print.
Pages displays the Print sheet.
2. Click in the Copies field and enter the number of copies you need.
3. Select the pages to print.
¢ To print the entire document, select All.

e To print a range of selected pages, select the From radio button
and enter the starting and ending pages.

4. Click the Print button to send the document to your printer.

Sharing That Poster with Others

Besides printing — which is, after all, so passé — you can choose to share
your Pages document electronically in a number of ways:

v Sharing on iWork.com. Apple provides a Web site, iwork.com, where
you can invite others to view and comment on your Pages document.
Click the iWork.com button on the Pages toolbar to get started, and the
site will walk you through the rest of the process.
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You need an Internet connection to use iWork.com (naturally), as well as
an Apple ID and a working Apple Mail account. If you didn’t create an
Apple ID when setting up your MacBook or installing Snow Leopard, you
can save the day by clicking the Create New Account button on the
iWork.com site.

v Sharing through e-mail. Choose Sharem>Send via Mail and select one of

the following formats to add your Pages document to a Mail message:
as a native Pages document file, as a Word format document, or as a
PDF file. After you've selected a format, Pages obligingly launches Apple
Mail and creates a new message, ready for you to address and send!
(Remember, most Internet Service Providers have a maximum message
size, so if your document is too large, it will likely be rejected by your
mail server.)

v Sharing through iWeb. Again, click the Share menu, but this time

choose Send to iWeb. Pages automatically opens the iWeb site you last
edited and provides your Pages document as a native Pages document
file or as a PDF file. (If your visitors may be using PCs or Linux, choose
the PDF option.)

v+~ Exporting. Don’t forget that Pages can export your work in one of four

different formats: a PDF document; a Word format document; an RTF
(Rich Text Format) file; or even plain text. Choose Share=>Export, pick
your format, click Next, and then select the location where Pages should
save the file. Click Export and sit back while your favorite desktop pub-
lishing application does all the work.

To keep your document as close to how it appears in Pages as possible,
I recommend selecting either PDF or Word. Your document will retain
far more of your original formatting than an RTF or plain-text document
would.
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Creating Spreadsheets
with Numbers

In This Chapter

Opening, saving, and creating spreadsheets
Selecting cells, entering data, and editing data
Formatting cells

Adding and removing rows and columns
Creating simple calculations

Adding charts to your spreadsheets

A re you downright afraid of spreadsheets? Does the idea of building a
budget with charts and all sorts of fancy graphics send you running for
the safety of the hall closet? Well, good MacBook owner, Apple has once again
taken something that everyone else considers super-complex and turned it
into something that normal human beings can use! (Much as Apple did with
video editing, songwriting, and Web site creation — heck, is there any type of
software that Apple designers can’t make intuitive and easy to use?)

In this chapter, I get to demonstrate how Numbers can help you organize
data, analyze important financial decisions, and yes, even maintain a house-
hold budget! You’ll soon see why the Numbers spreadsheet program is spe-
cifically designed with the home Mac owner in mind.

Before You Launch Numbers . . .

Just in case you're not familiar with applications like Numbers and Microsoft
Excel — and the documents they create — let me provide you with a little
background information.
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A spreadsheet organizes and calculates numbers by using a grid system of
rows and columns. The intersection of each row and column is a cell, and
cells can hold either text or numeric values (along with calculations that are
usually linked to the contents of surrounding cells).

Spreadsheets are wonderful tools for making decisions and comparisons
because they let you “plug in” different numbers — such as interest rates or
your monthly insurance premium — and instantly see the results. Some of
my favorite spreadsheets that I use regularly include

v Car and mortgage loan comparisons

v A college planner

1 My household budget (not that [ pay any attention to it)

Creating a New Numbers Document

As does Pages, the desktop publishing application that’s included in iWork
’09, Numbers ships with a selection of templates that you can modify quickly
to create a new spreadsheet. (For example, after a few modifications, you can
easily use the Budget, Loan Comparison, and Mortgage templates to create
your own spreadsheets.)

To create a spreadsheet project file, follow these steps:
1. Open your Applications folder and double-click the iWork ’09 folder
to display its contents.
2. Double-click the Numbers icon.
Numbers displays the Template Chooser window you see in Figure 19-1.
3. Click the type of document you want to create in the list to the left.

The document thumbnails on the right are updated with templates that
match your choice.

4. Click the template that most closely matches your needs.

5. Click Choose to open a new document using the template you
selected.
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Figure 19-1:
Hey, these
templates

aren’t
frightening
atall!
|

Opening an Existing Spreadsheet File

If a Numbers document appears in a Finder window, you can just double-click
the Document icon to open it; Numbers automatically loads and displays the
spreadsheet. However, it’s equally easy to open a Numbers document from
within the program. Follow these steps:

1. Double-click the Numbers icon to run the program.
2. Press 38+0 to display the Open dialog.

3. Click the desired drive in the Devices list at the left of the dialog and
then click folders and subfolders until you’ve located the desired
Numbers document.

\4
<« If you're unsure of where the document is, click in the Search box at the

top of the Open dialog box and type in a portion of the document name,
or even a word or two of text it contains.

4. Double-click the spreadsheet to load it.
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Save

A\

If you want to open a spreadsheet you've been working on over the last few
days, choose Filer>Open Recent to display Numbers documents that you’'ve
worked with recently.

Those Spreadsheets!

If you're not a huge fan of retyping data, I always recommend that you save
your spreadsheets often (just in case of a power failure or a co-worker’s mis-
take). Follow these steps to save your spreadsheet to your hard drive:

1. Press 38+8S.

If you're saving a document that hasn’t yet been saved, the Save As
sheet appears.

2. Type a filename for your new spreadsheet.
3. Click the Where pop-up menu and choose a location to save the file.

This allows you to select common locations, such as your desktop,
Documents folder, or Home folder.

If the location you want isn’t listed in the Where pop-up menu, you can
also click the down-arrow button next to the Save As text box to display
the full Save As dialog. Click the desired drive in the Devices list at the
left of the dialog and then click folders and subfolders until you reach
the desired location. You can also create a new folder in the full Save As
dialog.

4. Click Save.

After you've saved the file the first time, you can simply press 38+S in the
future, and your changes are saved.

Exploring the Numbers Window

Apple has done a great job of minimizing the complexity of the Numbers
window. Figure 19-2 illustrates these major points of interest:

1~ Sheets list: Because a Numbers project can contain multiple spread-
sheets, they’re displayed in the Sheets list at the left of the window. To
switch between spreadsheets in a project, click the top-level headings
(each of which has a spreadsheet icon).
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Figure 19-2:
The
Numbers
window
struts its
stuff.
|

+* Sheet canvas: Numbers displays the rows and columns of your spread-
sheet in this section of the window; you enter and edit cell values within
the sheet canvas.

v Toolbar: The Numbers toolbar keeps the most common commands you
use within easy reach.

+ Formula Box: You use the Formula Box to enter formulas into a cell,
allowing Numbers to automatically perform calculations based on the
contents of other cells.

v+ Format Bar: Located directly under the toolbar, the Format Bar displays
editing controls for the object that’s currently selected. (If you enter
an equal sign into the Formula Box, the Format Bar changes into the
Formula Bar. No, I'm not making this up.) My goodness, this is starting to
sound like that classic movie about the chocolate tycoon and those kids!

Format Bar

Sheets list Formula Box Sheet canvas Toolbar
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Navigate and Select Cells
in a Spreadsheet

You can use the scroll bars to move around in your spreadsheet, but when
you enter data into cells, moving your fingers from the keyboard is a hassle.
For this reason, Numbers has various movement shortcut keys that you can
use to navigate, and I list them in Table 19-1. After you commit these keys to
memory, your productivity shoots straight to the top.

Table 19-1 Movement Shortcut Keys in Numbers
Key or Key Combination Where the Cursor Moves
Left arrow (<) One cell to the left
Right arrow (—) One cell to the right
Up arrow (T) One cell up
Down arrow ({) One cell down
Home To the beginning of the active worksheet
End To the end of the active worksheet
Page Down Down one screen
Page Up Up one screen
Return One cell down (also works within a selection)
Tab One cell to the right (also works within
a selection)
Shift+Enter One cell up (also works within a selection)
Shift+Tab One cell to the left (also works within
a selection)

You can use the trackpad to select cells in a spreadsheet:

v To select a single cell, click it.

v To select a range of multiple adjacent cells, click a cell at any corner of
the range you want and then drag in the direction you want.

v To select a column of cells, click the alphabetic heading button at the
top of the column.

v To select a row of cells, click the numeric heading button on the far left
side of the row.
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Entering and Editing Data
in a Spreadsheet

After you navigate to the cell in which you want to enter data, you're ready to
type your data. Follow these steps to enter That Important Stuff:

1. Either click the cell or press the spacebar.

A cursor appears, indicating that the cell is ready to hold any data you
type.
\‘\gN\BEI? 2. Type in your data.
Q
&

Spreadsheets can use both numbers and text within a cell — either type
of information is considered data in the Spreadsheet World.

3. To edit data, click within the cell that contains the data to select it and
then click the cell again to display the insertion cursor. Drag the inser-
tion cursor across the characters to highlight them and then type the
replacement data.

4. To simply delete characters, highlight the characters and press Delete.

5. When you’re ready to move on, press Return (to save the data and
move one cell down) or press Tab (to save the data and move one cell
to the right).

Selecting the Right Number Format

After your data has been entered into a cell, row, or column, you still might
need to format it before it appears correctly. Numbers gives you a healthy
selection of formatting possibilities. Number formatting determines how a cell
displays a number, such as a dollar amount, a percentage, or a date.

<P Characters and formatting rules, such as decimal places, commas, and dollar
and percentage notation, are included in number formatting. So, if your
spreadsheet contains units of currency, such as dollars, format it as such.
Then all you need to do is type the numbers, and the currency formatting is
applied automatically.

To specify a number format, follow these steps:

1. Select the cells, rows, or columns you want to format.

2. Click the Inspector toolbar button.
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3. Click the Cells Inspector button in the Inspector toolbar to display the
settings you see in Figure 19-3.

4. Click the Cell Format pop-up menu and click the type of formatting
you want to apply.

Figure 19-3:
You can
format the
data you've
entered
from the
Inspector.
|

Aligning Cell Text Just So

You can also change the alignment of text in the selected cells. (The default align-
ment for text is flush left, and for numeric data, flush right.) Follow these steps:
1. Select the cells, rows, or columns you want to format.

See “Navigate and Select Cells in a Spreadsheet,” earlier in this chapter,
for tips on selecting stuff.

2. Click the Inspector toolbar button.

3. Click the Text Inspector button in the Inspector toolbar to display the
settings you see in Figure 19-4.

4. Click the corresponding alignment button to choose the type of for-
matting you want to apply.

You can choose left, right, center, justified, and text left and numbers
right. Text can also be aligned at the top, center, or bottom of a cell.
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Figure 19-4:
Using the
Inspector to
change text
alignment
within a cell.
|
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You can also select the cells you want to align and click the appropriate align-
ment button in the Format Bar.

Do you need to set apart the contents of some cells? For example, you might
need to create text headings for some columns and rows or to highlight the
totals in a spreadsheet. To change the formatting of the data displayed within
selected cells, select the cells, rows, or columns you want to format and then
click the Font Family, Font Size, or Font Color buttons on the Format Bar.

Format with Shading

Shading the contents of a cell, row, or column is helpful when your spread-
sheet contains subtotals or logical divisions. Follow these steps to shade
cells, rows, or columns:
1. Select the cells, rows, or columns you want to format.
2. Click the Inspector toolbar button.
3. Click the Graphic Inspector button in the Inspector toolbar.
Numbers displays the settings you see in Figure 19-5.

4. Click the Fill pop-up menu to select a shading option.
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|
Figure 19-5:
Adding
shading
and colors
to cells,
rows, and
columns
is easyin
Numbers.
|
5. Click the color box to select a color for your shading.
Numbers displays a color picker (also shown in Figure 19-5).
6. Click to select a color.
7. After you achieve the right effect, click the Close button in the color
picker.
3 8. Click the Inspector’s Close button to return to your spreadsheet.

The Fill function is also available on the Format Bar.

Insert and Delete Rows and Columns

What’s that? You forgot to add a row and now you’re three pages into your
data entry? No problem. You can easily add or delete rows and columns.
First, select the row or column that you want to delete or that you want to
insert a row or column next to, and do one of the following:

v For a row: Right-click and choose Add Row Above, Add Row Below, or
Delete Row from the shortcut menu that appears.

v For a column: Right-click and choose Add Columns Before, Add
Columns After, or Delete Column from the shortcut menu that appears.
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You can also insert rows and columns using the Table menu.

The Formula Is Your Friend

Sorry, but it’s time to talk about formulas. These equations calculate values
based on the contents of cells you specify in your spreadsheet. For example,
if you designate cell Al (the cell in column A at row 1) to hold your yearly
salary and cell B1 to hold the number 12, you can divide the contents of cell
Al by cell B1 (to calculate your monthly salary) by typing this formula into
any other cell:

=A1/B1
By the way, formulas in Numbers always start with an equal sign (=).

“So what'’s the big deal, Mark? Why not use a calculator?” Sure, but maybe
you want to calculate your weekly salary. Rather than grab a pencil and
paper, you can simply change the contents of cell B1 to 52, and — boom! —
the spreadsheet is updated to display your weekly salary.

That’s a simple example, of course, but it demonstrates the basis of using for-
mulas (and the reason that spreadsheets are often used to predict trends and
forecast budgets). It’s the “what if?” tool of choice for everyone who works
with numeric data.

To add a simple formula within your spreadsheet, follow these steps:

1. Select the cell that will hold the result of your calculation.
2. Click inside the Formula Box and type = (the equal sign).

The Formula Box appears to the right of the Sheets heading, directly
under the Button bar (refer to Figure 19-2). Note that the Format Bar
changes to show a set of formula controls (a.k.a. the Formula Bar).

3. Click the Function Browser button, which bears the fx label. (It
appears next to the red Cancel button on the Formula Bar.)

4. In the window that appears, as shown in Figure 19-6, click the desired
formula and click Insert Function to add it to the Formula Box.

5. Click an argument button in the formula and click the cell that
contains the corresponding data.

Numbers automatically adds the cell you indicated to the formula.
Repeat this for each argument in the formula.

6. When you’re finished, click the Accept button to add the formula to
the cell.
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Figure 19-6:
If you have
to use
formulas,

at least
Numbers
can enter
them for
you.
|

That’s it! Your formula is now ready to work behind the scenes, doing math

" for you so that the correct numbers appear in the cell you specified.
h\

To display all the formulas that you've added to a sheet, click the Formula List
button in the toolbar.

Adding Visual Punch with a Chart

Sometimes you just have to see something to believe it — hence the ability
to use the data you add to a spreadsheet to generate a professional-looking
chart! Follow these steps to create a chart:

<P 1. Select the adjacent cells you want to chart by dragging.

To choose individual cells that aren’t adjacent, hold down the 88 key as
you click.

2. Click the Charts button on the Numbers toolbar. The Charts button
bears the symbol of a bar graph.

Numbers displays a thumbnail menu.
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3. Click the thumbnail for the chart type you want.

Numbers inserts the chart as an object within your spreadsheet so that
you can move the chart. You can drag using the handles that appear on
the outside of the object box to resize your chart. Figure 19-7 illustrates
the 3-D chart I generated with just a couple of clicks.

\3
P Click the Inspector toolbar button and switch to the Chart Inspector
dialog, where you can change the colors and add (or remove) the chart
title and legend.
4. To change the default title, click the title box once to select it; click it
again to edit the text.
After you’'ve added your chart to the sheet, it appears in the Sheets list, as
shown in Figure 19-7. To edit the chart at any time, just click the correspond-
ing entry in the Sheets list.
|
Figure 19-7:
My finished
chart looks
like some-
one with
talent drew
it for me!
|
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Chapter 20

Building Presentations
with Keynote

In This Chapter
Creating a new presentation
Adding slides
Using selection boxes
Entering and editing text
Formatting text
Adding presenter’s notes
Inserting media and shapes
Running a slideshow

Printing slides and notes

t seems like only yesterday that I was giving business presentations with

a clunky overhead projector and black-and-white acetate transparencies.
Fancy color gradients and animation were unheard of, and the only sound
my presentations made was the droning of the projector’s fan. [ might as well
have been using tree bark and chalk.

Thank goodness those days are gone forever, because cutting-edge presen-
tation software like Keynote makes slide creation easy and — believe it or
not — fun! This is the application that Steve Jobs once used for his Macworld
keynotes every year, and there’s so much visual candy available that you’ll
never need to shout to wake your audience again.

In this chapter, | demonstrate how simple it is to build a stunning Keynote
presentation, and how to start and control your slide display from your
MacBook’s keyboard (or even your iPhone or iPod touch). Heck, you can
even print your slides and notes so that your audience can keep a copy of
your brilliant work!
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Creating a New Keynote Project

As do the other applications in the iWork ’09 suite, Keynote begins the docu-
ment creation process with a Template Chooser window. To create a new
presentation project, follow these steps:

1. Double-click your hard drive icon and click the Applications entry in
the Finder window sidebar. Double-click the iWork folder to open it.

\3
P If presentations are your bread and butter, allow the iWork installation
program to add a Keynote icon to your Dock. Your clicking finger will
thank you.
2. Double-click the Keynote icon.
The Template Chooser window that you see in Figure 20-1 appears.
(I have to say that these are probably the most stunning visual building
blocks I've ever seen in a presentation application.)
|
Figure 20-1:
Selecting
atemplate
from the
Template
Chooser
window.
|
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3. Click the Slide Size pop-up menu at the bottom of the screen to select
the resolution for your completed slides.

Although you don’t necessarily need to select an exact match for your

laptop’s screen resolution, it’s a good idea to select the closest value to
the maximum resolution of your projector. (If someone else is providing
the projector, the default value of 1024 x 768 is a good standard to use.)

4. Click the template that most closely matches your needs.

5. Click Choose to open a new document by using the template you
selected.

Opening a Keynote Presentation

A\\S

If an existing Keynote presentation file is visible in a Finder window, you can
double-click the document icon to open the project. If Keynote is already run-
ning, however, follow these steps to load a project:

1. Press 8+0 to display the Open dialog.

2. Click the desired drive in the Devices list at the left of the dialog; then
click folders and subfolders until you’ve located the Keynote project.

You can also use the Search box at the top of the Open dialog to locate
the document by name or by some of the text it contains.

3. Double-click the filename to load it.

If you want to open a Keynote document that you've edited in the recent past,
things get even easier! Just choose File>Open Recent and you can open the
document with a single click from the submenu that appears. (Note that the
Template Chooser window has both Open Recent and Open Existing File but-
tons as well.)

Saving VYour Presentation

When you’re done working on a Keynote presentation (or if you'd simply like
to safeguard your work in a world of power failures), follow these steps:
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1. Press 38+8S.

If you're saving a document that hasn’t yet been saved, the familiar Save
As sheet appears.

2. Type a filename for your new document.

3. Click the Where pop-up menu and choose a location to save the
document.

To select a location not on the Where pop-up menu, click the button
with the down arrow symbol to expand the sheet. You can also create
a new folder from the expanded sheet.

4. Click Save.

Putting Keynote to Work

3

Ready for the 5-cent tour of the Keynote window? Launch the application
and create or load a project, and you’ll see the tourist attractions shown in
Figure 20-2:

v~ Slides list: Use this thumbnail list of all the slides in your project to help
you navigate quickly. Click a thumbnail to switch instantly to that slide.

The Slides list can also display your project in outline format, allowing
you to check all your discussion points. (This is a great way to ferret out
any “holes” in your presentation’s flow.) While in outline mode, you can
still jump directly to any slide by clicking the slide’s title in the outline.
To display the outline, choose View=>Outline. You can switch back to
the default Navigator Slides list by choosing Viewr>Navigator.

v Layout pane: Your slide appears in its entirety in this pane. You can add
elements and edit the content of the slide from the Layout pane.

v Toolbar: As does the toolbars in Pages and Numbers, Keynote’s toolbar
makes it easy to find the most common controls you’ll use while design-
ing and editing your slides. Clicking an icon in the toolbar performs an
action, just as selecting a menu item does.

+” Notes pane: If you decide to add notes to one or more slides (either for
your own use or to print as additional information for your audience),
choose Views>Show Presenter Notes to open the Notes pane. This text
box appears under the Layout pane.

+* Format Bar: Keynote displays this button strip underneath the Keynote
toolbar, allowing you to format selected text, paragraphs, and lists on
the fly.
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Layout pane Toolbar

Ll_l

Figure 20-2:
The Keynote
window is
dominated
by the
Layout

pane.
|

Slides list Notes pane Format Bar

Adding Slides

Sure, Keynote creates a single Title slide when you first create a project, but
not many presentations are complete with just a single slide! To add more
slides to your project, use one of these methods:

v Click the New button on the Keynote toolbar.

v Choose Slide>New Slide.

v Press 38+Shift+N.

v Right-click (or Control-click) in the Slides list and choose New Slide from

the menu.

Keynote adds the new slide to your Slides list and automatically switches to
the new slide in the Layout pane.
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Need a slide that’s similar to an existing slide you've already designed? Right-
click the existing slide and choose Duplicate to create a new slide just like it.
(Consider it cloning without the science.)

To move slides to different positions in the Slides list (and therefore a dif-
ferent order in your Keynote slideshow), drag each slide thumbnail to the
desired spot in the list.

Working with Text and Graphics Boxes

3
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éQ‘
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You’ve probably noticed that all the text within your first Title slide appears
within boxes. Keynote uses boxes to manipulate text and graphics. You can
resize a box (and its contents) by clicking and dragging one of the handles
that appear around the edges of the box. (Your cursor changes into a double-
sided arrow when you'’re “in the zone.”) The side-selection handles drag only
that edge of the frame, whereas the corner-selection handles resize both
adjoining edges of the selection frame.

To keep the proportions of the box constrained, hold down Shift while drag-
ging the corner handles.

Boxes make it easy to move text and graphics together (as a single unit) to
another location within the Layout pane. Click in the center of the box and
drag the box to the desired spot; Keynote displays alignment lines to help
you align the box with other elements around it (or with regular divisions of
the slide, like horizontal center). As you can see in Figure 20-3, I'm moving a
box on the slide to a new location, and Keynote has supplied alignment lines
to help me place it correctly.

To select text or graphics within a box, double-click the box.
If you're resizing a photo in a box, don’t forget to hold down the Shift key as
you drag the frame. That way, Keynote preserves the aspect ratio of the image

so that the vertical and horizontal proportions remain fixed. You can also flip
images horizontally or vertically from the Arrange menu.
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Figure 20-3:
Keynote
provides

alignment
lines as you
move hoxes.
|

Adding and Editing Slide Text

As with Pages and Numbers, which also use boxes for text layout, Keynote
allows you to add or edit text with ease. For example, double-click in a box
with the text Double-click to edit, and the placeholder text disappears,
leaving the field ready to accept new text. Any new text you type appears at
the blinking cursor within the box.

To edit existing text in your Keynote document, click using the bar-shaped
cursor to select just the right spot in the text, and drag the insertion cursor
across the characters to highlight them. Type the replacement text, and
Keynote obligingly replaces the text that was there with the text you type.

If you want to delete existing text, click and drag across the characters to
highlight them; then press Delete. You can also delete an entire box and
all its contents: Right-click (or Control-click) the offending box and choose
Delete from the menu that appears.

When the contents of a box are just right and you’re finished entering or edit-

ing text, click anywhere outside the box to hide it from view. You can always
click the text again to display the box later.
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Formatting Slide Text
for the Perfect Look

Keynote doesn’t restrict you to the default fonts for the theme you chose.
It’s easy to format the text in your slides — you can choose a different font
family, font color, text alignment, and text attributes such as bold and italics
on the fly, whenever you like.

Select the desired text by double-clicking a box and then dragging the text
cursor to highlight the characters. Now apply your formatting using one of
these two methods:

v+ The Format Bar: The font controls on the Format Bar work just as the
controls on the toolbar do: Either click a font control to display a pop-up
menu or click a button to immediately perform an action. Clicking the
Font Size pop-up menu, for example, displays a range of sizes for the
selected text. A single click on the B (bold) button adds the bold attri-
bute to the highlighted characters.

v The Format menu: The controls on the Format menu generally mirror
those on the Format Bar. To change the alignment from the Format
menu, click Format and hover the cursor over the Text menu item. To
change text attributes, click Format and hover your cursor over the Font
menu.

Using Presenter’s Notes in Your Project

A\

As I mention earlier, you can type text notes in the Notes pane — I use

them for displaying alternate topic points while presenting my slideshow.
However, you can also print the notes for a project along with the slides, so
presenter’s notes are also great for including reminders and To Do points for
your audience in handouts.

To type your notes, just click within the Notes pane; if it’s hidden, choose
Viewr>Show Presenter Notes. When you're done adding notes, click in the
Slides list or the Layout pane to return to editing mode.

To display your notes while practicing, use Keynote’s Rehearsal feature. Click

Play and choose Rehearse Slideshow, and you can scroll through the notes
while the slideshow runs. (More on slideshows in a second.)
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Every Good Presentation Needs Media

Adding audio, photos, and movies to a slide is drag-and-drop easy in Keynote!
Simply drag an image, audio, or movie file from a Finder window and place it
at the spot you want within your document.

You can also use the Media Browser — click the Media button on the tool-

bar and click the Audio, Photos, or Movies button to select the desired type.
Keynote displays the contents of your various media collections — such as
your iPhoto and iTunes libraries. You can also navigate to the file’s location

on your hard drive or type in a filename in the Search box at the bottom of the
browser. When you’ve found the file you want to add, drag it to the spot where
you want it in the document. Figure 20-4 illustrates the Media Browser in action.

Figure 20-4:
It's not just
photos —
you can add
audio and
movie clips
to a slide,
too!
|

Adding a Background Shape

Text often stands out on a slide when it sits on top of a background shape.
To add a shape (such as a rectangle or circle) as a background for your text,
follow these steps:
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1. Click the insertion cursor in the location you want.

2. Click the Shapes button on the Keynote toolbar and choose a shape.
The shape appears in your document.

3. Click the center of the shape and drag it to a new spot.
Like image boxes, shapes can be resized or moved.

4. When the shape is properly positioned and sized, select it and choose
Arrange=>Send to Back.

Creating Vour Keynote Slideshow

3

The heart of a Keynote presentation is the slideshow that you build from the
slides you've created. A Keynote slideshow is typically presented as a full-
screen presentation, with slides appearing in linear order as they are sorted
in the Slides list.

In its simplest form, you can always run a slideshow from a Keynote proj-
ect by clicking the Play button in the toolbar or by choosing Play=>Play
Slideshow from the menu. You can advance to the next slide by tapping the
trackpad, or by pressing the right bracket key, which looks like this: ].

Of course, other controls are available besides just the ones that advance
to the next slide! Table 20-1 illustrates the shortcuts you’ll use most often
during a slideshow.

Keynote offers a number of settings that you can tweak to fine-tune your slide-
show. To display these settings, choose Keynoter>Preferences and click the
Slideshow button in the Preferences window.

Table 20-1 Keynote Slideshow Shortcut Keys

Key or Key Combination Action

] (right bracket) Next slide

P Previous slide

Home Jump to first slide

End Jump to last slide

C Show or hide the pointer

(number) Jump to the corresponding slide in the Slides list
U Scroll notes up

D Scroll notes down

www.it-ebooks.info


http://www.it-ebooks.info/

Chapter 20: Building Presentations with Keynote 34 ’

Key or Key Combination Action

N Show current slide number

H Hide slideshow and display last application used
(the presentation appears as a minimized icon in
the Dock)

B Pause slideshow and display a black screen
(press any key to resume the slideshow)

Esc Quit

<P If you have an iPhone or iPod touch handy and you’ve installed the Apple

Keynote Remote application on your device, display the Preferences window
and click the Remote button to link your iPhone or iPod touch to your
MacBook and Keynote. Now you can use your handheld device as a remote
and use it during your slideshow!

Printing Your Slides and Notes

Okay, I'll be honest: I don’t always print handouts for every presentation I
give, just because some of the slideshows I run are short introductions to
hands-on demonstrations. However, if you're presenting a lengthy slideshow
with plenty of information that you’d like your audience to remember, noth-
ing beats handouts that include scaled-down images of your slides (and,
optionally, your presenter’s notes).

You're not limited to just paper, though! You can also use Keynote to create
an electronic PDF-format document instead of a printed handout, which your
audience members can download from your Web site. Or, if you’re an educa-
tor with access to an interactive whiteboard (such as the SMARTBoard), you
can use this new technology with Keynote.

To print your slides and notes, follow these steps:

1. Within Keynote, choose File=>Print.

Keynote displays the Print sheet you see in Figure 20-5. (Note that some
printer-specific features may be different on your screen.)

2. Click the desired format for printing your slides and notes.

e To print each slide on a separate page at full size, click Individual
Slides.

e To print each slide on a separate page with the presenter’s notes
for that slide, click Slides with Notes.
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e To print the contents of your Slides list in Outline view, click
Outline.

e To print a handout with multiple slides per page (and, optionally,
with presenter’s notes), click Handout. Click the Slides per Page
pop-up menu to specify the number of slides that Keynote should
print on each page.

3. Select the pages to print.
¢ To print the entire document, select All.

¢ To print a range of selected slides, select the From radio button
and enter the starting and ending pages.

4. Select or deselect specific options from the Options column.

You can include elements such as the date, borders around each slide,
and the slide number as part of each page of the hardcopy.

5. Click the Print button to send the job to your printer.

Figure 20-5:
Keynote
offers a

wide range

of printing
options for
your slides
and notes.
|
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Part VI

Necessary Evils:
Troubleshooting,
Upgrading, Maintaining

The 5th Wave By Rich Tennant
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“Well, whoever stole my passwords was sure
clever., Fspecially since none of my veminders
are missing.”
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In this part . . .

N o computer is completely trouble-free — and if your
MacBook, MacBook Air, or MacBook Pro starts

acting strangely, the troubleshooting tips you find in this
part can help you get your favorite machine back to
normal. I also provide you with all the guidance you need
to maintain your MacBook properly as well as step-by-step
instructions for upgrading your laptop with goodies such
as additional RAM and external storage devices.
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When Good Mac Laptops Go Bad

In This Chapter
Avoiding the blame (righteously)

Putting basic troubleshooting precepts to work
Using Mark’s Troubleshooting Tree
Getting help

wish you weren’t reading this chapter.

Because you are, I can only surmise that you're having trouble with your
MacBook, and that it needs fixing. (The other possibility — that you just like
reading about solving computer problems — is more attractive, but much
more problematic.)

Consider this chapter a crash course in the logical puzzle that is computer
troubleshooting: namely, the art of finding out What Needs Fixing. You also
see what you can do when you just plain can’t fix the problem by yourself.

Oh, and you’re going to encounter a lot of Tips and Mark’s Maxims in this
chapter — all of them learned the hard way, so | recommend committing
them to memory on the spot!

Repeat after Me: Ves, ] Am a Tech!

Anyone can troubleshoot. Put these common troubleshooting myths to rest:

1~ It takes a college degree in computer science to troubleshoot. Tell that
to my troubleshooting kids. They’ll think it’s a hoot because they have
Apple computers of their own in the classroom. You can follow all the
steps in this chapter without any special training.

+* I'm to blame. Ever heard of viruses? Failing hardware? Buggy software?
Any of those things can be causing the problem. It’s Mark’s Maxim time:

Don’t beat yourself up! Your laptop can be fixed.™
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+ I need to buy expensive utility software. Nope. You can certainly
invest in a commercial testing and repair utility if you like. My favorite is
TechTool Pro from Micromat (www.micromat .com), but a third-party
utility isn’t a requirement for troubleshooting. (I would, however, con-
sider an antivirus application as a must-have, and you should have one
already. Hint, hint.)

1~ There’s no hope if I can’t fix it. Sure, parts fail and computers crash, but
your Apple Service Center can repair just about any problem. And (ahem)
if you backed up your laptop (like [ preach throughout this book), you’ll
keep that important data (even if a new hard drive is in your future).

v~ It takes forever. Wait until you read the Number One Rule in the next
section; the first step takes but 30 seconds and often solves the prob-
lem. Naturally, not all problems can be fixed so quickly, but if you follow
the procedures in this chapter, you should fix your laptop (or at least
know that the problem requires outside help) in a single afternoon.

With those myths banished for good, you can get down to business and start
feeling better soon.

Step-by-Step Laptop Troubleshooting

In the following sections, [ walk you through my Should-Be-Patented
Troubleshooting Tree as well as the Snow Leopard built-in troubleshooting
application, Disk Utility. I also introduce you to a number of keystrokes that
can make your MacBook jump through hoops.

The Number One Rule: Reboot!

Yep, it sounds silly, but the fact is that rebooting your MacBook can often
solve a number of problems. If you're encountering these types of strange
behavior with your laptop, a reboot might be all you need to heal:

v Intermittent problems communicating over a network

v A garbled screen, strange colors, or screwed-up fonts

v The Swirling Beach Ball of Doom that won’t go away after several minutes

v An application that locks up

v An external device that seems to disappear or can’t be opened
To put it succinctly, here’s a modest Mark’s Maxim:

Always try a reboot before beginning to worry. Always.™

www.it-ebooks.info


http://www.it-ebooks.info/

Chapter 21: When Good Mac Laptops Go Bad 34 7

Why is rebooting so darned effective?

Rebooting fixes problems because it resets time, which can even affect a laptop running on
everything. Your network connection, for exam-  an AC adapter. Such interruptions in constant
ple, might be acting up or have timed out, and juice might not bother you or me (or your less-
rebooting restores it. Rebooting also fixes prob- intelligent toaster), but they can play tricks on
lems due to brownouts or those notorious AC  your laptop that rebooting can fix.

power flickerings that we all notice from time to

QQ,N\BER
<
< If you're in the middle of a program, try to save all your open documents
before you reboot. That might not be possible, but try to save what you can.

If you need to force a locked application (one that’s not responding) to quit
so that you can reboot, follow these steps to squash that locked application:
1. Click the Apple (%) menu and choose Force Quit.

The dialog that you see in Figure 21-1 appears on your screen.

Figure 21-1:
Force a
recalcitrant
application
to take off.
|

2. Click the offending application, and then click the Force Quit button.

When you get everything to quit, you should be able to click the Apple menu
and choose Shut Down (not Restart) without a problem.

If your MacBook simply won’t shut down (or you can’t get the offending
application to quit), do what must be done:

1. Press and hold your laptop’s Power button until it shuts itself off.

You have to wait about five seconds for your MacBook to turn itself off.
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2. Wait about ten seconds.

3. Press the Power button again to restart the computer.

After everything is back up, check whether the problem is still apparent. If
you use your laptop for an hour or two and the problem doesn’t reoccur, you
likely fixed it!

Special keys that can come in handy

A number of keys have special powers over your MacBook. No, I'm not kid-
ding! These keys affect how your road warrior starts up, and they can really
come in handy while troubleshooting.

Using Safe Boot mode

You can use Safe Boot mode to force Snow Leopard to run a directory check
of your boot hard drive and disable any Login Items that might be interfering
with Snow Leopard. Use the Shut Down menu item from the Apple (%) menu
to completely turn off your laptop, press the Power button to restart the com-
puter, and then press and hold down the Shift key immediately after you hear

the startup tone. After Snow Leopard completely boots, restart your MacBook
again (this time without the Shift key) to return to normal operation.

Startup keys

Table 21-1 provides the lowdown on startup keys. Hold the indicated key
down either when you push your Power button or immediately after the screen
blanks during a restart. (As I just mentioned, the Shift key is the exception; it
should be pressed and held down after you hear the startup tone.)

Table 21-1 Startup Keys and Their Tricks

Key Effect on Your MacBook

C Boots from the CD or DVD that's loaded in your optical
drive (if you have one)

Media Eject Ejects the CD or DVD in your optical drive (if you have one)

Option Displays a system boot menu, allowing you to choose any
bootable operating system on your laptop

Shift Prevents your Login Items from running; runs a directory
check
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Key Effect on Your MacBook

T Starts your MacBook in FireWire Target Disk mode
(except for the MacBook and MacBook Air, which have
no FireWire port)

8+V Shows Mac 0S X Console messages
8+S Starts your Mac in Single User mode
88+0ption+P+R Resets Parameter RAM (PRAM)

Some of the keys/combinations in Table 21-1 might never be necessary for
your machine, but you might be instructed to use them by an Apple techni-
cian. I'll warrant that you’ll use at least the C startup key fairly often.

All hail Disk Utility, the
troubleshooter’s friend

Snow Leopard’s Disk Utility is a handy tool for troubleshooting and repairing
your hard drive. You can find it in the Utilities folder within your Applications
folder.

Fire up Disk Utility and click the First Aid tab to open the rather powerful-
looking window shown in Figure 21-2.

Danger, Will Robinson!

Many Disk Utility functions can actually wipe »~ Partitioning and erasing drives
your hard drives clean of datainstead of repair-
ing them! These advanced functions aren’t
likely to help you with troubleshooting a prob- . Restoring files from disk images
lem with your existing volumes anyway.

v~ Setting up RAID arrays

Remember: Don't use these Disk Utility func-
tions unless an Apple technician tells you to
use them:
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Figure 21-2:
The physi-
cian of hard
drives —
Snow
Leopard’s
Disk Utility.
|

In the left column of the Disk Utility window, you can see

v The physical hard drives in your system (the actual hardware)
v The volumes (the data stored on the hard drives)

You can always tell a volume because it’s indented underneath the phys-
ical drive entry.

v Any CD or DVD loaded on your MacBook

1 USB or FireWire external drives

For example, in Figure 21-2, I have one hard drive (the 320.07GB entry) and
one FireWire 800 external drive (the 500.11GB entry). The hard drive has
two volumes (Wolfgang and Mother), and the external drive has one volume
(Rocstor).

The information at the bottom of the Disk Utility window contains the speci-
fications of the selected drive or volume — things like capacity, free space,
and the number of files and folders for a volume, or connection type and total
capacity for a drive.

Repairing disk permissions

Because Snow Leopard is built on a UNIX base, lots of permissions can apply
to the files on your drive — that is, who can open (or read or change) every
application, folder, and document on your hard drive. Unfortunately, these
permissions are often messed up by wayward applications or power glitches,
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Figure 21-3:
A suc-
cessful

run, using

Repair Disk

Permissions.

|

or application installers that do a subpar job of cleaning up after themselves.
And if the permissions on a file are changed, applications often lock up or
refuse to run altogether.

[ recommend repairing your disk permissions with Disk Utility once weekly.
Figure 21-3 shows a permissions repair sweep on my internal hard drive’s
volume.

Use these steps to repair permissions on your MacBook’s hard drive:

1. Make sure that you're logged in with an admin account.
Chapter 10 shows you how to log in as an admin user.

. Save and close any open documents.

. Double-click the Disk Utility icon in the Utilities folder.

. Click the volume that you want to check.

G e W N

. Click the Repair Disk Permissions button.

I don’t worry about verifying. If something’s wrong, you end up clicking
Repair Disk Permissions anyway. Just click Repair Disk Permissions; if
nothing pops up, that’s fine.

6. To finish the process, always reboot after repairing permissions.

This shows you whether a problem has been corrected!
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Should I reinstall Mac 0S X?

This question seems to get a lot of attention on
Mac-related Internet discussion boards and
Usenet newsgroups — and the answer is a
definitive perhaps. (I know. That's really helpful.)

Here's the explanation. You shouldn’t lose a
single byte of data by reinstalling Mac 0S X, so
it's definitely okay to try it. However, reinstalling
Snow Leopard isnt a universal balm that fixes
all software errors because the problem that
you're encountering might be due to a buggy
application, a hard drive that's going critical, or

a video card with faulty memory modules. If the
trouble you're having is due to a corrupted Mac
0S X System folder, reinstalling Snow Leopard
might or might not fix the problem.

Therefore, the debate rages on. | would cer-
tainly follow the MacBook Troubleshooting
Tree all the way to the end before | would
even consider reinstalling Snow Leopard, and
| would recommend contacting an Apple sup-
port technician via the Apple Web site before
you take this step.

Repairing disks

Disk Utility can check the format and health of both hard drives and volumes
with Verify Disk — and, if the problem can be corrected, fix any error by

using Repair Disk.

Using Disk Utility to repair your hard drive carries a couple of caveats:

+* You can’t repair the boot disk or the boot volume. This actually makes
sense because you're using that disk and volume right now.

To verify or repair your boot hard drive, you need to boot from your
Mac OS X installation disc by using the C startup key. (Refer to Table
21-1 for keys that come in handy.) After your laptop boots from the Mac
OS X installation disc, choose the Utilities menu and click Disk Utility.

You should be able to select your boot hard drive or volume, and the
Verify Disk and Repair Disk buttons should be enabled.

+» You can’t repair CDs and DVDs. CDs and DVDs are read-only media and

thus can’t be repaired (at least by Disk Utility).

If your MacBook is having trouble reading a CD or DVD, wipe the disc
with a soft cloth to remove dust, oil, and fingerprints. Should that fail,
invest in a disc-cleaning contrivance of some sort.

If you need to verify and repair a disk or volume, follow these steps:

1. If you need to repair your boot drive and volume, save all your open
documents and reboot from either an external drive or your Mac OS

X Installation disc.

2. Double-click the Disk Utility icon in the Utilities folder.
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3. In the list at the left side of the Disk Utility window, click the disk or
volume that you want to check.

4. Click the Repair Disk button.

5. If changes were made (or if you had to boot from a disc or external
drive), reboot after repairing the disk or volume.

Mark’s MacBook Troubleshooting Tree

As the hip-hop artists say, “All right, kick it.” And that’s just what my
MacBook Troubleshooting Tree is here for. If rebooting your laptop hasn’t
solved the problem, follow these steps in order (until either the solution is
found or you run out of steps — more on that in the next section).

Step 1: Investigate recent changes

This is a simple step that many novice Mac owners forget. Simply retrace
your steps and consider what changes you made recently to your system.
Here are the most common culprits:

v Did you just finish installing a new application? Try uninstalling it by
removing the application directory and any support files that it might
have added to your system. (And keep your applications current with
the most recent patches and updates from the developer’s Web site.)

From time to time, an application’s preference file — which stores all
the custom settings you make — can become corrupted. Although the
application itself is okay, it might act strangely or refuse to launch. To
check your preference files for signs of corruption, try scanning your
applications with Preferential Treatment, a freeware AppleScript utility
by Jonathan Nathan, available from his Web site at www. jonn8.com/
html/pt.html. (Preferential Treatment can flag any dicey preference
files, setting them up for a quick trip to the Trash.)

v Did you just apply an update or a patch to an application? Uninstall
the application and reinstall it without applying the patch. If your
MacBook suddenly works again, check the developer’s Web site or con-
tact its technical support department to report the problem.

v Did you just update Snow Leopard by using Software Update?
Updating Mac OS X can introduce problems within your applications
that depend on specific routines and system files. Contact the developer
of the application and look for updated patches that bring your software
in line with the Snow Leopard updates. (And use Software Update in
automatic mode to check for Mac OS X updates at least once weekly.)

v Did you just make a change within System Preferences? Return
the options that you changed to their original settings; then consult
Chapter 6 for information on what might have gone wrong. (If the setting

www.it-ebooks.info


http://www.it-ebooks.info/

354 Part VI: Necessary Evils: Troubleshooting, Upgrading, Maintaining

a\\J

in question isn’t in Chapter 6, consider searching Snow Leopard’s online
Help or the Apple support Web site for more clues.)

v Did you just connect (or reconnect) an external device? Try unplugging
the device and then rebooting to see whether the problem disappears.
Remember that many peripherals need software drivers to run — and
without those drivers installed, they don’t work correctly. Check the
device’s manual or visit the company’s Web site to search for software
that you might need.

If you didn’t make any significant changes to your system before you encoun-
tered the problem, proceed to the next step.

Step 2: Run Disk Utility

The section “Repairing disk permissions,” earlier in this chapter, shows how
to complete this task on your Snow Leopard boot drive.

If you're experiencing hard drive problems, consider booting from your Mac
OS X Installation DVD to run a full-blown Repair Disk checkup on your boot
volume.

Step 3: Check your cables

Cables work themselves loose, and they fail from time to time. Check all your
cables to your external devices — make sure that they’re snug — and verify
that everything’s plugged in and turned on. (Oh, and don’t forget to check for
crimps in your cables or even Fluffy’s teeth marks.)

If a FireWire or USB device acts up, swap cables around to find whether you
have a bad one. A faulty cable can leave you pulling your hair out in no time.

Step 4: Check your Trash

Check the contents of your Trash to see whether you recently deleted files
or folders by accident. Click the Trash icon on the Dock once to display the
contents. If something’s been deleted by mistake, drag it back to its original
folder and try running the application again.

[ know this one from personal experience. A slight miscalculation while
selecting files to delete made an application freeze every time I launched it.

Step 5: Check your Internet and network connections

Now that always-on DSL and cable modem connections to the Internet are the
norm, don’t forget an obvious problem: Your laptop can’t reach the Internet
because your ISP is down, or your network is no longer working!
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A quick visual check of your DSL or cable modem can usually indicate
whether a connection problem exists between your modem and your ISP. For
example, my modem has a very informative activity light that I always glance
at first. However, if your laptop is connected to the Internet through a larger
home or office network and you can’t check the modem visually, you can
check your Internet connection by pinging www. apple. com:

. Open your Utilities folder (inside your Applications folder).
. Double-click Network Utility.
. Click the Ping button.

. Enter www.apple.com in the Address box.
. Click Ping.

G A W N e

You should see successful ping messages. If you don’t get a successful
ping and you can still reach other computers on your network, your
cable/DSL modem or your ISP is likely experiencing problems. If you
can’t reach your network at all, the problem lies in your network hard-
ware or configuration.

Step 6: Think virus

If you made it to this point, it’s time to run a full virus scan — and make sure
that your antivirus application has the latest updated data files, too. My anti-
virus application of choice is Virus Barrier X6 from Intego (www. intego.
com). If you haven’t invested in a commercial antivirus application, I can also
recommend the excellent freeware ClamXav (http: //clamxav.com).

If a virus is detected and your antivirus application can’t remove it, try quar-
antining it instead. This basically disables the virus-ridden application and
prevents it from infecting other files.

Step 7: Disable your Login Items

Mac OS X might encounter problems with applications that you’ve marked as
Login Items within System Preferences. In this step, [ show you how to iden-
tify login problems and how to fix ’em.

Checking for problems

It’s time to use another nifty startup key (refer to Table 21-1). This time, hold
down Shift after you hear the startup tone.

This trick disables your account’s Login Items, which are run automatically
every time you log in to your MacBook. If one of these Login Items is to
blame, your laptop will simply encounter trouble every time you log in.
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Finding the Login Item that’s causing trouble

If your laptop works fine with your Login Items disabled, follow this proce-
dure for each item in the Login Items list:

1. Open System Preferences, click Accounts, and then click the Login
Items button.

2. Delete the item from the list; then reboot normally.

You can delete the selected item by clicking the Delete button, which
bears a minus sign.

When your MacBook starts up normally with Login Items enabled, you
discovered the perpetrator. You'll likely need to delete that application
and reinstall it. (Don’t forget to add each of the working Login Items back
to the Login Items list!)

Step 8: Turn off your screen saver

This is a long shot, but it isn’t unheard of to discover that a faulty, bug-ridden
screen saver has locked up your MacBook. (If you aren’t running one of the
Apple-supplied screen savers and your computer never wakes up from Sleep
mode or hangs while displaying the screen saver, you found your prime
suspect.)

Reboot your MacBook (if necessary), open System Preferences, click Desktop
& Screen Saver, and then click the Screen Saver button. Then do one of the
following:

v Switch to an Apple screen saver.

v Drag the Start slider to Never.

If this fixes the problem, you can typically remove the screensaver by deleting
the offending saver in the Screen Savers folder inside your Mac OS X Library
folder (as well as the Library folder inside your Home folder). If you can’t find
the screensaver, try typing the saver name in the Spotlight search box.

Step 9: Run System Profiler

Ouch. You reached Step 9, and you still haven’t uncovered the culprit. At this
point, you narrowed the possibilities to a serious problem, like bad hardware
or corrupted files in your Mac OS X System folder. Fortunately, Snow Leopard
provides System Profiler, which displays real-time information on the hard-
ware in your system. Click the Apple menu and choose About This Mac; then
click More Info. Click each one of the Hardware categories in turn, double-
checking to make sure that everything looks okay.
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QQ,N\BEH You don’t have to understand all the technical hieroglyphics. If a Hardware
& category doesn’t return what you expect or displays an error message,
though, that’s suspicious. (If your MacBook doesn’t have a specific type of
hardware onboard — including an optical drive or Fibre Channel hardware —
you won'’t get information from those categories.)

Diagnostics shows whether your MacBook passed the Power On self-test.

Okay, 1 Kicked It, and
It Still Won't Work

Don’t worry, friendly reader. Just because you’ve reached the end of my
MacBook tree doesn’t mean you're out of luck. In the following sections, I dis-
cuss the online help available on the Apple Web site as well as local help in
your own town.

Apple Help Online

If you haven't visited the Apple MacBook Support site yet, run — don’t walk —
to www.apple.com/support/macbook, where you can find
1 The latest patches, updates, and how-to tutorials for the MacBook line
+ MacBook and Mac OS X discussion boards, moderated by Apple

v Tools for ordering spare parts, checking on your remaining warranty
coverage, and searching the Apple Knowledge Base

v Do-it-yourself instructions (PDF files) that you can follow to repair or
upgrade your MacBook

Local service, at your service

In case you need to take in your MacBook for service, an Apple Store or
Apple Authorized Service Provider is probably in your area. To find the clos-
est service, launch Safari and visit

www .apple.com/buy/locator/service
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That’s the Find Service page on the Apple Web site. You can search by city and
state or zip code. The results are complete with the provider’s mailing address,
Web site address, telephone number, and even a map of the location!

Always call your Apple service provider before you lug your (albeit light-
weight) laptop all the way to the shop. Make sure that you know your
MacBook’s serial number (which you can display in System Profiler) and
which version of Mac OS X you're using.
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Chapter 22

Adding New Stuff to Your Laptop

In This Chapter
Adding memory

Upgrading your hard drive
Adding USB and FireWire devices
Reviewing what add-ons are available

N o laptop is an island.” Somebody famous wrote that, I'm sure.

Without getting too philosophical — or invoking the all-powerful Internet yet
again — the old saying really does make sense. All computer owners usually
add at least one peripheral (external device), such as a printer, a joystick, an
iPod, a backup drive, or a scanner. I talk about the ports on your MacBook in
Chapter 1. Those holes aren’t there to just add visual interest to the sides of
your treasured laptop. Therefore, I cover your ports (and what you can plug
into them) in detail in this chapter.

Ah, but what about the stuff inside your road warrior? That’s where things
get both interesting and scary at the same time. In this chapter, I describe
what you can add to the innards of your computer as well as how to get
inside there if you work up the courage to go exploring.

More Memory Will Help

Hey, wait a second. No however stuck on the end? You mean for once, there’s
no exception? Aren’t all computers different? Hard as it is to believe, just
keep in mind this Mark’s Maxim:

More memory helps.™

Period. End of statement. No matter what type of computer you own, how old
it is, or what operating system you use, adding more memory to your system
(to the maximum it supports) significantly improves the performance of your
operating system (and practically every application that you run).
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Memory maximizes the power of your computer. The more memory you have,
the less data your laptop has to temporarily store on its hard drive. Without
getting into virtual memory and other techno-gunk, just consider that extra
memory as extra elbowroom for your applications and your documents.
Believe me, both Mac OS X and Windows XP/Vista/7 efficiently make use of
every kilobyte of memory that you can provide.

MacBook Air owners, [ have good and bad news: The good news is that your
laptop is already maxed out at 2GB of memory, and the bad news is that you
can’t add any more. Your ultrathin Air is a sealed unit — literally — and you
must visit your local Apple hardware technician if your laptop’s memory
malfunctions and needs replacing. (The same is true for your Air’s battery.)
Therefore, you can skip the rest of this section!

Figuring out how much memory you have

Tg see how much memory you have in your computer, click the Apple menu
(%), choose About This Mac, click More Info, and click the Memory heading.

At the time of this writing, your MacBook or MacBook Pro has sockets for two
DDR3 SDRAM memory modules. (Don’t fret over what all the abbreviations
mean. Rest assured that this memory type is fast.) These modules are available
with up to 4GB of memory, so you can install as much as 4GB of total memory
in your MacBook, and up to 8GB of total memory in your MacBook Pro.

How you plan memory upgrades depends on how much memory you want.
Most MacBook owners simply opt to install the maximum amount of memory
possible, so if your 2GB MacBook uses the two default 1GB modules supplied
by Apple, you can add up to 2GB of RAM by replacing the existing memory
modules with two 2GB memory modules. At the time of this writing, a 2GB
memory module should set you back less than $100.

[ should note that the default 2GB of memory is tolerable for running applica-
tions from the iLife and iWork suites as well as any of the applications bundled
with Snow Leopard. With that said, of course, these applications will run sig-
nificantly faster with 4GB instead!

If your primary applications include video editing, game playing, or image edit-
ing, you can use all the memory your laptop can hold.

Although the MacBook Pro comes with a minimum of 4GB, the process is gen-
erally the same — you'’ll install two 4GB modules to bring your laptop to a full
8GB. The exception to the RAM upgrade circus is the MacBook Air, which is a
sealed unit — you can’t upgrade your RAM.
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Climbing inside your Mac laptop

This section on laptop upgrades is short for a
reason: Laptops simply aren’t meant to be dis-
assembled. As | mention several times in this
book, internal expansion in your MacBook or
MacBook Pro is severely limited. Basically, you
can add extra memory and swap out your hard
drive. Adding memory is easy, but swapping out
your hard drive requires more work and con-
siderable preparation. And, as | also mention
earlier in this book, you can’t make any internal
modifications to your MacBook Air, which is
a sealed unit. (Breaking in will likely void your
warranty.)

Therefore, | always recommend that you seek
professional servicing when you need to repair
your laptop. For example, if your laptop’s LCD

screen is cracked or broken, do not try to fix it
yourself! Sure, you might see a number of used
LCD panels on eBay, but these parts aren't
designed to be easily swapped out, like a desk-
top computer’s video card. Besides, if you make
a mistake when trying to fix something deep in
the bowels of your laptop, you might end up
causing more damage than you repair.

The moral of the story? Let your local Apple
dealer’s service technicians perform major
surgery on your laptop, and buy an AppleCare
Protection Plan that can cover your laptop like
a blanket for up to three years!

Read more about swapping out drives in the
upcoming section, “Gotta have internal.”

Unfortunately, Apple’s prices for adding RAM are, well, outrageous (as in,
“Boy, Howdy, I can’t afford that!”) Therefore, I can heartily recommend any
one of these online sources that cater to Mac owners:

» MacMall: www.macmall.com

v CDW: www.cdw.com/content/brands/apple/default.aspx

1 Newegg: www . newegg . com

Installing memory modules

I’'m happy to report that adding extra memory to your system is one of the
easiest internal upgrades that you can perform. Therefore, | recommend that
you add memory yourself unless you simply don’t want to mess with your
MacBook’s internal organs. As I mention earlier, of course, your local Apple
service specialist will be happy to install new RAM modules for you (for a

price).
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To add memory modules to a MacBook or MacBook Pro, follow these steps:

1. Get ready to operate.

a. Spread a clean towel on a stable work surface, such as your kitchen
table.

The towel helps protect your screen from scratches.

b. Find a Phillips screwdriver.
c. Shut down your laptop and wait at least ten minutes for it to cool down.
d. Unplug all cables from the computer.

2. Close the computer and flip it over on top of the towel.

3. Ground thyself!

Check out the nearby “Let’s get grounded!” sidebar.
4. Remove the battery.

Slide both of the release latches up to pop out the battery (shown in
Figure 22-1) and then lift it out.

|
Figure 22-1:
Slide the
release
latches to
access the
battery.
|
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5. Remove the two screws holding the memory door closed.

Place the two screws in a handy plastic bowl for safekeeping. Tah-dah!
That wasn’t much of a challenge, was it? Here’s your chance to gaze with
rapt fascination at a portion of the bare innards of your favorite computer.

6. Locate the memory modules in your Mac’s svelte chassis.

Figure 22-2 illustrates their position.

|
Figure 22-2:
The two
Mac laptop
memory
slots are
right here.
|

7. If you’re replacing an existing memory module, remove it.

To remove a memory module, gently spread the two tabs at the ends
of the socket apart (as shown in Figure 22-3) and then lift and slide the
module away from the socket.

|
Figure 22-3:
Remove

a memory
module

like a pro.
|
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|
Figure 22-4:
Prepare to
install the
new mod-
ule.
|

|
Figure 22-5:
Press the
new RAM
module into
place until it
locks.
|

Save the old module in the static-free packaging that held the new
module. Your old RAM (which you can now sell on eBay) will be pro-
tected from static electricity.

8. Position the new module in the socket.

a. Line up the module’s gold connectors toward the socket, at a
25-degree angle.

b. Line up the notch in the module with the matching spacer in the socket.

See what I mean in Figure 22-4.

Correctly Incorrectly
inserted inserted

9. Press gently (but firmly) on both ends of the module until the mod-
ule’s tabs click into place on both ends of the socket.

Figure 22-5 shows the direction you should press on the module.

10. Replace the memory door and battery.

To replace the memory door and battery, just reverse the steps at the
beginning of this list. (Rather like changing the oil in my Dad’s 1970 Ford
pickup truck.)

Congratulations! You’'ve done it — you’re now a MacBook memory guru! To
verify that all is well with your road warrior, boot the computer, click the
Apple menu, and choose About This Mac. Your laptop should report the
additional memory.
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Let's get grounded!

Follow one cardinal rule when the unguarded
insides of any computer are in easy reach:
Always ground yourself before you touch
anything! Your body can carry enough static
electricity to damage the circuitry and chips
that make up the brains of your MacBook, and
touching those parts without grounding your-
self is an invitation for disaster.

Grounding yourself is easy to do: Just touch
a metal surface for a few seconds before you
dig in. After you ground yourself, you can then

safely handle both the internal components of
your laptop and any new hardware components
that you might be installing (such as memory
modules or a hard drive).

If you walk anywhere in the room — hunting
for a screwdriver, perhaps, or taking a sip of
liquid reinforcement that you've stashed a
comfortable distance away — you must ground
yourself again before you get back to work.
Remember: You can pick up a static charge by
simply walking. Go figure.

Considering a Hard Drive Upgrade?

Asking whether you can upgrade your hard drive is a trick question. Yes,
you certainly can upgrade your hard drive. But before you start cruisin’ the
Internet for a 1TB monster, though, I have two suggestions:

v+ Don’t upgrade your internal hard drive yourself.

v Be sure you really need a hard drive upgrade.

And, all in all, Apple’s pretty generous when configuring hard drive storage
for its base systems — current models run with anywhere from a 120GB to a

500GB drive.

Most folks simply don’t need more than 120GB or 250GB of hard drive space
(even with Windows loaded in a separate partition for use with Boot Camp,
which [ discuss in Chapter 2). You're likely to find that you still have plenty
of elbowroom on your hard drive for a typical family’s needs unless you're

heavily into

v Digital video (DV)
v Cutting-edge video games
v Tons of digital audio

<P If you're short on hard drive space, clean up your existing hard drive by delet-
ing all the crud you don’t need, such as game and application demos, duplicate
or “work” copies of images and documents, archived files you downloaded from
the Internet, and the contents of your Trash. You can read how in Chapter 23.
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If you decide that you do need to upgrade your MacBook’s internal drive, I
strongly recommend that you don’t install your new hard drive yourself. Call
on the services of an Apple technician to upgrade your drive!

Consider your external options

If you do need additional hard drive space, | recommend using an exter-

nal drive! Use a high-speed FireWire or USB port to connect a second hard
drive the quick and easy way. (If your MacBook model isn’t equipped with a
FireWire port, you can concentrate on USB.)

Most of today’s FireWire and USB peripherals don’t even require the driver
software that Mac old-timers remember with such hatred. You simply plug
in a FireWire or USB device, and it works. You can move your external drive
between different Macs with a minimum of fuss and bother.

An external hard drive can do anything that your internal hard drive can do.
You can boot from it, for example, or install a different version of Mac OS X
(great for beta testers like me). External optical drives work just the same as
internal models; Apple sells an external USB SuperDrive optical drive for the
MacBook Air for about $100.

Apple’s Time Capsule unit is an external hard drive with a difference: It stores
the huge Time Machine backup files created by the Macs running Snow
Leopard on your network, and it uses a wireless connection to transfer datal!
(In fact, if you're thinking of adding a wireless base station to your wired net-
work, your Time Capsule actually acts as a full AirPort Extreme Base Station,
complete with USB port for connecting a USB printer.) At the time of this writ-
ing, Time Capsule is available with either a 1TB ($299) or 2TB ($499) drive.

Here’s one problem with external drives: Data transfers more slowly this way
than via an internal drive (even with a FireWire 800 connection). That’s why
most Mac owners use their external drives for storing lesser-used documents
and applications, or for Time Machine backups. Their favorite applications
and often-used documents are housed on the faster internal drive.

Figure 22-6 illustrates a popular external hard drive that offers FireWire 400,
FireWire 800, and USB 2.0 connections: the Airhawk A9, from Rocstor (www .
rocstor.com, about $170 online). I carry this drive with me in my laptop
bag, because it’s not much larger than an iPhone and doesn’t even require
a separate power supply — yet the A9 provides 500GB of quiet external
storage, making it a great choice for a Time Machine backup that travels
with you! The drive is preformatted for Mac OS X, and it couldn’t be easier
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to use (just connect the drive to your MacBook, and it’s ready to use). If
you install Snow Leopard on the A9, you can also boot directly from the
external drive.

|
Figure 22-6:
The Rocstor
Airhawk A9
offers three
different
connec-
tions to your
MacBook.
|

Putting a port to work

A MacBook can carry up to three kinds of high-speed ports, any of which is a
good match for connecting any external device.

Uss 2.0

The USB standard is popular because it’s just as common in the PC world as
in the Mac world. (Most PCs don’t have a FireWire port.) Your laptop carries
at least one USB 2.0 port on the side of the case. Hardware manufacturers can
make one USB device that works on both types of computers.

s&mBEn [ heartily recommend that you avoid using any USB 1.1 devices (except, per-

Y haps, a USB 1.1 keyboard or mouse). USB 1.1 is very slow compared with the
USB 2.0 standard, although you can connect a USB 1.1 device to a USB 2.0 port
with no problem. You should buy only USB 2.0 external hard drives, CD/DVD
recorders, or flash drives. 'Nuff said.

FireWive 400

The original FireWire (also called IEEE 1394) is the best port for most digital
video camcorders. Use your FireWire port for connecting external devices to
MBER your older Mac laptop.

X\

Y
Current MacBook models no longer include a FireWire 400 port, but they were
standard equipment on most older MacBooks.
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The MacBook Pro’s mystery slot

If you're wondering what that larger slot is
for on the left side of your 17-inch MacBook
Pro, you'll be pleased to hear that it's called
an ExpressCard/34 slot. Why the glee? Well,
some of the premium external devices for your
laptop can use the ExpressCard/34 slot, which
is like a drive-through window that allows the
fastest possible data transfer rates to and from
your computer. For example, the fastest exter-
nal eSATA hard drives available these days

can be connected to your MacBook Pro via an
ExpressCard/34 adapter!

Although ExpressCard/34 hardware is gen-
erally more expensive than FireWire or USB
hardware, the higher price may be justified by
the speed increase — before you invest in an
external device, do a little research and see
whether the mystery slot can speed things up.

$V~
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FireWive 800

A FireWire 800 drive offers much better performance than either a FireWire
400 or a USB 2.0 drive, and today’s FireWire 800 drives are getting cheaper
every day. MacBook Pro laptops proudly sport a FireWire 800 port on the

side; MacBook and MacBook Air computers don’t carry a FireWire 800 port.

The physical FireWire 800 connector is shaped differently than the FireWire
400 port, so don’t try to force the wrong connector into the wrong port!

Connecting an external drive

With FireWire or USB, you can install an external hard drive without opening
your laptop’s case. With your MacBook turned on, follow these steps:

1. Connect the FireWire or USB cable betwixt the drive and your

computer.

2. Plug the external drive into a convenient surge protector or uninter-
ruptible power supply (if necessary).

Note that some devices (like the Airhawk A9 external drive) are bus-
powered, meaning that they don’t need a separate power supply. These
devices draw their power directly from the port.

3. Switch on the external drive.

4. If the drive is unformatted (or formatted for use in Windows), parti-
tion and format the external drive.

The drive comes with instructions or software for you to do this. (Don’t
worry; your external drive comes from the factory completely empty,
and you won’t damage anything by formatting it.) Partitioning divides
the new drive into one (or more) volumes, each of which is displayed as
a separate hard drive in Snow Leopard.
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If the drive comes preformatted for use with a Windows PC, [ strongly
suggest reformatting it for use with Mac OS X — this will result in faster
performance and more efficient use of space.

After the drive is formatted and partitioned, it immediately appears on the
Desktop. Shazam!

Gotta have internal

If you decide that you have to upgrade your existing internal hard drive — or
if your internal drive fails and needs to be replaced — you should always take
your MacBook to an authorized Apple service center and allow the techs there
to sell you a drive and make the swap. Here are four darned good reasons why:

v Warranty: You're very likely to void your laptop’s warranty by attempt-
ing a drive upgrade yourself.

v Selection: If you're worried about choosing the proper drive, your
friendly neighborhood Apple technician can order the right type and
size of drive for you.

v Difficulty: Swapping a hard drive in your Mac laptop isn’t anywhere as
easy as adding RAM modules (although the hard drive is much easier to
reach on the MacBook than it is on the MacBook Pro).

v Backup: That very same Apple service technician can back up all the
data on your existing drive, format the new drive, and move all your
data to its new mansion, so you won’t lose a single document. That will
save you time and possible angst.

To those who truly won’t be satisfied with their lives until they upgrade an
internal drive in a MacBook: Yes, I'm sure you can find a magazine article that
purports to show you how. Even better, 've seen many how-to articles on the
Web that can lead you down a rosy path to a hard drive upgrade. Here’s my
take on those savvy instructions: You're walking into a field of land mines with
someone else’s map, so you had better have complete faith in your tech skills.
(And a darn good backup.)

A List of Dreamy Laptop Add-Ons

The USB and FireWire toys I cover in the following sections might add a cord
or two to your collection at the side of your road warrior, but they're well
worth the investment. And they can really revolutionize how you look at
technologies, such as television, digital audio, and computer gaming.
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Game controllers

If you're ready to take a shot at the enemies — whether they be Nazi soldiers,
chittering aliens, or the latest jet fighters — you’ll likely find your keyboard
and mouse somewhat lacking. (And if that enemy happens to be a friend of
yours playing across the Internet, you’ll be ruthlessly mocked while you're
fumbling for the right key combination.) Instead, either pick up a USB joystick
(for flying games) or a gamepad (for arcade and first-person shooting games)!

Uideo controllers

For armchair directors, specialized USB digital video controllers make edit-
ing easier. The ShuttleXpress from Contour Design (www.contourdesign.
com) provides a five-button jog control that can be configured to match any
DV editor. For $60, you get the same type of editing controller as dedicated
video-editing stations costing several thousand dollars.

Audio hardware

Ready to put GarageBand to the test with your favorite version of Chopsticks?
You'll need a USB piano keyboard, and I recommend the KeyRig 49 from
M-Audio (www.m-audio.com), which retails for a mere $130. It provides 49
keys and uses a USB connection.

Another neat audio favorite of mine is the USB-powered radio SHARK 2 from
Griffin Technology (www.griffintechnology.com), which allows you to
add AM/FM radio to your laptop, complete with recording capability, a pause
feature, and scheduled recording, all for $50.
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In This Chapter

Cleaning unnecessary stuff off your hard drive

Backing up your data with Time Machine
Fixing permission errors

Automating tasks in Snow Leopard
Updating Mac OS X automatically

N othing runs better than a well-oiled machine, and your laptop is no
exception. With a little Snow Leopard maintenance, you can ensure
that your MacBook is performing as efficiently as possible (which translates
into longer battery life).

In this chapter, | demonstrate how you can make good use of every byte of
storage space provided by your hard drive, as well as how to back up and
restore that hard drive to an external drive, using Time Machine. Your hard
drive also benefits from a periodic scan for permission errors.

Snow Leopard’s Automator application is a great housekeeping tool. It allows
your laptop to perform tasks automatically that used to require your atten-
tion. I show you how you can create Automator applications and set them up
to run by themselves. (It sounds a little spooky, but you’ll have a ball!)

And it’s important to never forget about updating Mac OS X itself. But then
again, if you configure Software Update to run automatically, you can live life

free and easy, watching your favorite soaps and eating ice cream (or yogurt —
your pick).

Cleaning Unseemly Data Deposits

Criminy! Where does all this stuff come from? Suddenly that spacious 500GB
hard drive has 19GB left, and you start feeling pinched.
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Before you consider buying a new internal or external hard drive (which you
can read about in Chapter 22), take the smart step: “Sweep” your hard drive
clean of unnecessary and space-hogging software and temporary files.

Getting dirty (Or, cleaning
things the manual way )

If you're willing to dig into your data a little, you have no reason to buy addi-
tional software to help you clean up your hard drive. All you really need is
the willpower to announce, “I simply don’t need this application any longer.”
(And, sometimes, that’s tougher than it might seem.)

Unnecessary files and unneeded folders
Consider all the stuff that you probably don’t really need:

v Game demos and shareware that you no longer play (or even remember)

v Movie trailers and other QuickTime video files that have long since
passed into obscurity

v Temporary files that you created and promptly forgot
v Log files that chronicle application installations and errors
v~ Stufflt archives that you downloaded and no longer covet

v iTunes music that no longer appeals to your ear
How hard is it to clean this stuff off your drive? Easier than you might think!

» You can easily delete files.

» You can get rid of at least the lion’s share of any application (often the
whole application) by deleting its application folder that was created
during the installation process.

Removing an application or file from your hard drive is usually two simple steps:

1. Display the file or application folder in a Finder window.
2. Delete the file or folder with one of these steps:

¢ Drag the icon to the Trash.

¢ Press 8+Delete.

¢ Right-click the icon and choose Move to Trash.

e Select the icon and click the Delete button on the Finder toolbar (if
you added one).
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Figure 23-1:
Mine your
hard drive

for addi-
tional files
to delete.
|

Truly, no big whoop.

Don’t forget to actually empty the Trash, or you’ll wonder why you aren’t
regaining any hard drive space. (Snow Leopard works hard to store the con-
tents of the Trash until you manually delete it, just in case you want to unde-
lete something.) To get rid of that stuff permanently and reclaim the space,
follow these steps:

1. Click the Trash icon on the Dock and hold down the mouse button —
or right-click — until the pop-up menu appears.
2. Choose Empty Trash.

Associated files in other folders

Some applications install files in different locations across your hard drive.
(Applications in this category include Microsoft Office and Photoshop.)
How can you clear out these “orphan” files after you delete the application
folder?

The process is a little more involved than deleting a single folder, but it’s still
no big whoop. Here’s the procedure:
1. Click the Search text box in a Finder window.
You can read more about Search and Finder windows in Chapter 7.
2. Type the name of the application in the Search text box.
3. Click the File Name button in the Search button bar that appears.

Figure 23-1 shows a typical search. I want to remove Toast Titanium, so
I'm searching for every file with the word toast in its name.
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4. Decide which of these files belong to the to-be-deleted application.

Be sure that the files you choose to delete are part of the deleted appli-
cation. For example, a text file with the name Instructions on Making a
Perfect Piece of Toast might not be part of Toast Titanium.

Many associated files either
¢ Have the same icon as the parent application
¢ Are in the Preferences, Caches, or Application Support folders

5. In the Search Results window, click the associated file(s) that you
want to delete and just drag them to the Trash.

Don’t empty the Trash immediately after you delete these files. Wait a
few hours or a day. That way, if you realize that you deleted a file that
you truly need, you can easily restore it from the Trash.

Using a commercial cleanup tool

If you’d rather use a commercial application to help you clean up your hard
drive, a number of them are available, but most are shareware and perform
only one task. For example, Tidy Up! 2 from Hyperbolic Software (www . hyper
bolicsoftware.com) finds only duplicate files on your hard drive, match-
ing by criteria such as filename, size, and extension. It’s a good tool at $30.

For a truly comprehensive cleanup utility, I recommend Spring Cleaning Deluxe,
from Smith Micro Software (http://my.smithmicro.com), the same com-
pany that produces the archiving utility Stufflt. Spring Cleaning is a bargain
at $50, because not much crud squeaks by the application’s search routines,
including duplicates, orphan preference files, and log files. Spring Cleaning
can even help automate the steps that I cover in the preceding section.

Backing Up Your Treasure

Do it. 'm not going to lecture you about backing up your hard drive . . . well,
perhaps just for a moment. Imagine what it feels like to lose everything —
names, numbers, letters, reports, presentations, saved games, photographs,
and music. Then ask yourself, “Self, isn’t all that irreplaceable stuff worth just
a couple of hours every month?” Time for a Mark’s Maxim:

Back up your hard drive. On a regular basis.™

You can back up your files either by saving them to external media or by
using Snow Leopard’s awesome Time Machine feature.
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Saving files

The simplest method of backing up files is simply to copy the files and fold-
ers to an external hard drive or a CD or DVD. Nothing fancy, but it works.

Backing up to an external hard drive
If you use an external hard drive with your MacBook, you can easily drag

backup files to it from your internal hard drive. Follow these steps:
1. Open separate Finder windows for
¢ The external hard drive
® The internal hard drive

2. Select the desired files that you want to back up from your internal
drive.

3. Drag the selected files to the external drive window.

For my backups, I prefer an extra level of protection against data loss — a
RAID array drive like the Dock Il from Ci Design (www. istoragepro.com, as
shown in Figure 23-2). RAID stands for Redundant Array of Independent Disks,
and it allows the same files and folders to be mirrored across multiple drives.

Figure 23-2:
ARAID
drive offers
the best
backup
insurance

of all!
|

In essence, a RAID drive actually saves two copies of your data rather than
just one. If one of the disks in your RAID drive fails, the other still contains
your stuff. (For this reason, RAID external drives typically cost significantly
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more than a single-drive unit, and they’re somewhat larger and heavier. The
2TB Dock Il is around $340, while the 4TB model checks in at $570.) With four
types of connections (FireWire 400, FireWire 800, USB 2.0, and eSATA), the
Dock Il is an ideal portable Time Machine drive for your most critical data
while you're on the road, maintaining your MacBook backup even in the face
of hardware failure!

Backing up to CD and DVD

You can burn backup files to a recordable CD or DVD. Owners of the MacBook
Air will need to use an external SuperDrive or third-party recorder, however.

Burning backups from the Finder
To use the Finder’s Burn feature with a CD or DVD, follow these steps:

1. Load a blank disc into your MacBook’s optical drive.

If you're using the default settings in the CDs & DVDs pane in System
Preferences, a dialog asks you for a disc name.

2. Drag the files and folders that you want to back up into the disc’s
Finder window.

They can be organized any way you like. Don’t forget that the total
amount of data shouldn’t exceed 700MB on a CD. You should also stick
within 4GB or so (on a standard recordable DVD) or 8GB (on a dual-layer
recordable DVD). You can see how much free space remains on the disc
at the bottom of the disc’s Finder window.

3. Click File, and then choose Burn Disc from the menu.

You can also click the Burn button on the Recordable DVD bar — it
appears at the top of the disc’s Finder window.

4. Choose the fastest recording speed possible.
5. Click Burn.

Burning backups from other recording applications

If you've invested in Toast Titanium from Roxio (www.roxio.com) or
another CD/DVD recording application, you can create a new disc layout
to burn your backup disc. (Think of a layout as a “road map” that indicates
which files and folders Toast should store on the backup.)

Putting things right with Time Machine

If you enable backups via Snow Leopard’s Time Machine feature, you can
literally move backward through the contents of your MacBook’s hard drive,
selecting and restoring all sorts of data. Files and folders are ridiculously
easy to restore — and | mean easier than any restore you’ve ever performed,
no matter what the operating system or backup program. Time Machine can
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even handle such deleted items as Address Book entries or photos you sent
to the Trash from iPhoto!

Because Time Machine should be an important and integral part of every Mac
owner’s existence, the Time Machine icon is included on the Dock. (Apple is
not messing around!)

Apple’s Time Capsule device is designed as a wireless storage drive for your
Time Machine backup files. If you're interested in a single Time Machine
backup location for multiple Macs across your wireless network, Time
Capsule is a great addition to your home or office. Note, however, that the
Time Capsule drive isn’t meant to be mobile, so while you're on the road, you
still need an external drive to safeguard your data.

Before you can use Time Machine, it must be enabled within the Time
Machine pane in System Preferences. [ cover the Time Machine configuration
settings (and how to turn the feature on) in more detail in Chapter 6.

Here’s how you can turn back time, step by step, to restore a file that you
deleted or replaced in a folder:

1. Open the folder that contained the file you want to restore.

2. In a separate window, open your Applications folder and launch the
Time Machine application, or click the Time Machine icon on the Dock
(which bears a rather funky clock with a counterclockwise arrow).

The oh-so-ultra-cool Time Machine background appears behind your
folder, complete with its own set of buttons at the bottom of the screen
(as shown in Figure 23-3). On the right, you see a timeline that corre-
sponds to the different days and months included in the backups that
Snow Leopard has made.

3. Click within the timeline to jump directly to a date (displaying the
folder’s contents on that date).

Alternatively, use the Forward and Back arrows at the right to move
through the folder’s contents through time. (You should see the faces
of Windows users when you “riffle” through your folders to locate some-
thing you deleted several weeks ago!)

The backup date of the items you’re viewing appears in the button bar
at the bottom of the screen.

4. After you locate the file you want to restore, click it to select it.
5. Click the Restore button at the right side of the Time Machine button bar.
If you want to restore all the contents of the folder, click the Restore All

button instead.

Time Machine returns you to the Finder, with the newly restored file now
appearing in the folder. Out-standing!
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Figure 23-3:
Yes, Time
Machine
really

does look
like this!
|

Timeline

For robust backup and restore protection, Time Machine has everything that
a typical Mac owner at home is likely to ever need. Therefore, a very easy
Mark’s Maxim to predict:

Connect an external hard drive and turn on Time Machine. Do it now. Don’t
make a humongous mistake.™

Maintaining Hard Drive Health

Shifty-eyed, sneaky, irritating little problems can bother your hard drive: per-
missions errors. Incorrect disk and file permissions can

1 Make your MacBook lock up
v Make applications act screwy (or refuse to run at all)

v Cause weird behavior within a Finder window or System Preferences

To keep Snow Leopard running at its best, [ recommend that you fix permis-
sions errors at least once per week.
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To fix any permissions errors on your system, follow these steps:

1. Open a Finder window, click Applications, and then click Utilities.
2. Double-click the Disk Utility icon.

3. Click the volume at the left (which in this case is a named partition,
like Macintosh HD, which appears under your physical hard drive)
that you want to check.

4. Click the Repair Disk Permissions button.

Disk Utility does the rest and then displays a message about whatever it
has to fix. (When will someone invent a car with a Repair Me button?)

Automating Those Mundane Chores

One popular feature in Snow Leopard — Automator — has generated a lot of
excitement. You use Automator (as shown in Figure 23-4) to create applica-
tions with a “relative” of AppleScript called AppleEvents. (In case you're not
familiar with AppleScript, it’s the simple programming language that you can
use to automate tasks and applications within Snow Leopard.)

Library list Run button

L

Figure 23-4:
Automator
is a dream
come true

for those
who hate
repetitive
tasks.
|

Actions Workflow window
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Of course, that might sound daunting — akin to single-handedly building
your own nuclear submarine over a long weekend — but Automator is actu-
ally easy to use. Heck, you might find it downright fun/

You can also create workflows, which are sequential (and repeatable) opera-
tions that are performed on the same files or data, and then your Automator
application can automatically launch whatever applications are necessary to
get the job done.

Here’s a great example: You work with a service bureau that sends you a CD
every week with new product shots for your company’s marketing department.
Unfortunately, these images are flat-out huge — taken with a 12-megapixel
camera — and they’re always in the wrong orientation. Before you move them
to the Marketing folder on your server, you have to laboriously resize each
image and rotate it, and then save the smaller version.

With help from Automator, though, you can build a custom application that
automatically reads each image in the folder, resizes it, rotates it, and even
generates a thumbnail image or prints the image, and then moves the mas-
saged images to the proper folder. You’d normally have to manually launch
Preview to perform the image operations and then use a Finder window to
move the new files to the right location. But now, with Automator, a single
double-click of your custom application icon does the trick.

You find Automator in your Applications folder. Currently, Automator can
handle specific tasks within about 30 or 40 applications (including the
Finder), but both Apple and third-party developers are busy adding new
Automator task support to all sorts of new and existing applications.

To create a simple application with Automator, launch the application and
follow these steps:

1. Select Application and click Choose.

2. Click the desired item in the Library list.

Automator displays the actions available for the item you select. Some
of these items are media files, while others include Address Book con-
tacts, files and folders in the Finder, PDF documents, and even Apple
Mail messages.

3. Drag the desired action from the Library window to the workflow
window.

4. Modify any specific settings provided for the action you chose.
5. Repeat Steps 1 through 3 to complete the workflow.
6. Click Run (in the upper right) to test your script.

Use sample files while you're fine-tuning your application lest you acci-
dentally do something deleterious to an original (and irreplaceable) file!
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7. When the application is working as you like, press 3+Shift+S to save it.
8. In the Save dialog that appears, type a name for your new application.

9. Click the Where pop-up menu and specify a location where the file
should be saved.

10. Click the File Format pop-up menu and choose Application.
11. Click Save.

Your new Automator application icon includes the Automator robot
standing on a document. Why, most normal human beings would now
call you a programmer, so make sure that you're inscrutable from now
on! If you're going to use your new Automator application often, don’t
forget that you can make it more convenient to use by dragging the
application icon to your Dock or to your Desktop.

N To find all the actions of a certain type within the Library list, click in the

Search box at the top of the Library window and type in a keyword, such as

save or burn. You don’t even need to press Return!

If your Automator application should run every time you log in — for exam-
ple, an application to track your time on a project — follow these steps to set
it up as a Login Item:

. Open System Preferences.

. Display the Accounts pane.

. Click the Login Items button.

. Click the plus button at the bottom of the list.

. Navigate to the location of your new Automator application.
. Click Add.

Now your Automator application is really automatic. Watch your signifi-
cant other gape in amazement as your MacBook begins to work without
you touching the keyboard! (If you’ve added the application icon to your
Dock, you can also simply right-click the icon and choose Open at Login
from the right-click menu that appears. Either way, your MacBook gets
the message.)

S U1 AW N -

Updating Mac 0S X Automatically

I prefer my MacBook to take care of cleaning up after itself as much as pos-
sible, so updating Snow Leopard should be automatic as well. In Mac OS X
Snow Leopard, operating system updates are performed by the Software
Update application.
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3
Software Update uses the Internet, so you need an Internet connection to
shake hands with the Apple server and download any updates.

Software Update can be found in two convenient spots:

»* The Apple menu: Click the Apple menu (%) and then choose Software
Update, which displays the Update dialog and alerts you to anything
new that’s available.

v System Preferences: Click the Software Update icon to display the
Software Update pane.

If you take the System Preferences route, you can set Software Update to
check for updates automatically:

a. Select the Check for Updates check box to enable it.
3 b. Choose the time period from the Check for Updates pop-up menu.

Software Update covers every Apple application, so I usually check once
daily just to make sure that that [ don’t miss anything.

If something needs to be updated, the program alerts you, either auto-
matically downloading the update(s) or displaying a dialog letting you
know what you can update (depending on the settings you choose in the
System Preferences Software Update pane).

You can even check for updates immediately from System Preferences. That,
dear reader, is just plain thoughtful design.
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The 5th Wave By Rich Tennant
BRHTENNANT

“Well, here’s your problem. You only have half
the ram ygou need.”
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In this part . . .

h, what book in the For Dummies series is truly

complete without its Part of Tens? Here you find lots
of this author’s raw opinions: my best tips for Mac laptop
Road Warriors as well as my infamous “Top Ten Things to
Avoid Like the Plague.”
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Top Ten Laptop Rules to Follow

In This Chapter

Protect your laptop while you're in transit
Pack that MacBook with RAM

Track your Mac with a hidden beacon
Encrypt your MacBook Home folder

Save energy by disabling wireless hardware
Use a surge protector

Back up your laptop

A h, the sedentary life of a desktop Mac — it sits there, like a bump on
a log, comfortable and immobile. As long as you have a stable surface
and an uninterrupted power supply, your iMac, Mac mini, or Mac Pro is a

happy puppy.

But you, good reader, are mobile! Whether you’re on campus or attending a
convention, your Mac laptop is rarely running in the same spot, so it’s sus-
ceptible to all sorts of road warrior pitfalls. In this chapter, [ remind you of
ten of the most important rules that every laptop owner should follow to pre-
vent chaos and carnage while traveling.

Keep Vour Laptop in a Bag

Sure, using a laptop case or bag sounds like common sense — but MacBooks
are so doggone sexy that you'd be surprised how many people carry them
around without any protection at all. These Mac owners hear phrases like
“aluminum unibody” and “Sudden Motion Sensor hard drive protection” and
figure that their laptop can tackle a construction site, a college campus, or a
hotel room with impunity.
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Part of that is indeed true. Mac laptops are some of the toughest laptops ever
made, but they’re not immune to bumps, scratches, and the (I hope) rare fall.
But if you carry your MacBook from place to place without any protection,
it'll soon look like a boxer after a bad fight.

If you're like me, you're proud that your computers remain in pristine condi-
tion, so use a laptop bag or case that offers ample padding and a convenient
shoulder strap or carry handle. (My laptop bag even converts to a backpack,
and it includes plenty of extra space for power supplies, discs, and all the
assorted hoo-hah that you know you need to carry with you.) Spend an extra
$30 on a laptop bag, and your $1,000 computer can weather the worst the
world can dish out.

Many folks think that a traditional laptop bag draws too much attention —
and to some extent, | agree. (That’s one reason why no one totes an obvious
15-x-7 bag with a hardware manufacturer’s logo emblazoned on the side
these days.) If you’re a member of this group, consider a well-padded laptop
sleeve that allows you to carry your MacBook in your backpack or briefcase,
like the BookBook cover I describe in Chapter 1 — the laptop always goes in
on top of those heavy books, of course. Remember, though, that the padding
is the important thing — without that extra cushion, you might as well just
toss your unprotected laptop in with the rest of your books and must-have
equipment.

Maximize Your RAM

Like any other computer running Windows or Mac OS X, your MacBook will
benefit from all the system RAM (memory) that you can squeeze onto it.
(Chapter 22 describes how to add memory and the benefits of extra RAM.)
However, additional memory is even more effective with a laptop because
your Mac laptop’s internal hard drive runs more slowly than the correspond-
ing internal hard drive in a full-size desktop Mac. Therefore, the virtual
memory functionality built into Snow Leopard (which I also describe in
Chapter 22) will be even slower for your laptop, resulting in mediocre perfor-
mance during memory-intensive tasks such as video and image editing.

With a full complement of RAM, your laptop’s performance will rival the per-
formance of a desktop computer with the same processor — and you’ll be
using it on the go!

As I also mention in Chapter 22, MacBook Air owners need not worry about
upgrading their system RAM. The current Air models come from Apple
already packed with the maximum amount of RAM they can carry (2GB), and
you can’t upgrade (or even reach) the memory modules in your Air.
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Install a Tracker Application

The unthinkable happens: Your laptop is stolen while you’re on vacation or
on a business trip, and you know that the chances that it will be returned are
next to nil. You've resigned yourself to replacing it (and all your data). But
wait! What if I told you that you might just receive an e-mail message on your
desktop computer that tells you the Internet (IP) address of the thief or per-
haps even the telephone number he or she is using?

If this scenario sounds a little like a James Bond movie, you'll be surprised
to discover that several tracker applications are available for Snow Leopard
that can run invisibly on your laptop. A tracker application can turn your
MacBook into a transmitting beacon, broadcasting its current location and
all the Internet information it can get to you — allowing you to alert police
and apprehend the crook (who might be in the middle of creating an iPhoto
library).

For example, LoJack for Laptops from Absolute Software (www.xtool.com)
invisibly sends a signal to the company’s security center each time your
laptop is connected to the Internet or a telephone line. LoJack for Laptops
Standard edition costs about $40 per year, which is pocket change for a cor-
porate Road Warrior or design professional who depends on both the laptop
and the irreplaceable data it contains.

Keepest Thy Home Folder Encrypted

In Chapter 6, I discuss a number of System Preferences panes. The Security
pane is particularly important to laptop users because it allows you to
encrypt your Snow Leopard Home folder. Encryption prevents just about
anyone from accessing (or even identifying) any of the files you've stored in
your Home folder. The robust encryption provided by Snow Leopard will cer-
tainly stymie just about anyone but the NSA and FBI. (I won’t even go there.)

In System Preferences, click Security, click the FileVault button, and then
click Set Master Password to create a backup password that can unlock your
Home folder, just in case. (Your login account password is your primary
password.) Select Turn On FileVault, and Snow Leopard takes care of auto-
matically encrypting and unencrypting files as necessary.

MBER To take full advantage of an encrypted Home folder, you need the proper login
mode (as I discuss in Chapter 10). Think about this possible security back

door: From the Accounts pane, you've set your laptop to automatically log you
in every time you boot your MacBook. This is the very definition of Not Secure
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because your login account password automatically bypasses the FileVault
encryption! Therefore, make sure that you actually have to log in fo access your
account. For the full scoop, see Chapter 10.

Brand Vour MacBook

Put your brand on your laptop! Whether with an engraving tool on the bottom
of the machine (my personal favorite) or a permanent metal tag, your MacBook
deserves some sort of identifying information. After all, most of the people

in the world are honest, and you might not need that tracking software that I
mention earlier in this chapter. You might have left your laptop by accident,
and someone would like to return it to you. (Don’t forget to offer a reward!)

Some laptop owners want to include their name and address and other con-
tact information, while other Road Warriors might feel more comfortable
with just their name and e-mail address. Whatever you choose, branding your
laptop is as important as backing it up.

Disable Your Wireless

NG/

Funny how we don’t think about it, but wireless communications take juice,
and that power comes straight from your laptop’s battery! Because your Mac
laptop comes with a built-in AirPort Express card and built-in Bluetooth hard-
ware, you're constantly broadcasting — sending and receiving, or at least
trying to exchange data with others.

And therein lies the rub: If you're not connected to a wireless network or a
Bluetooth device, you're wasting your precious battery power. That’s why
Snow Leopard gives you the ability to turn off your wireless Ethernet and
Bluetooth hardware to save energy. And when you're sitting in a crowded
auditorium without access to an AC socket or a wireless network, the energy
savings you reap when you disable your wireless hardware can be significant.

In fact, you might have to disable your wireless connectivity in situations
where cellphones are not allowed, such as on an airplane flight or in certain
areas of a hospital. And, because I'm a security-conscious kind of guy, I always
disable my wireless hardware whenever I'm not using it (even if I am in range
of a wireless network). Call me overly careful, but none of my shared files have
ever been sucked out of my MacBook without my permission!

To turn off your wireless Ethernet from the Snow Leopard Finder menu, click
the AirPort status icon and choose Turn Airport Off from the menu. To turn
off your Bluetooth hardware from the Finder menu, click the Bluetooth icon
and choose Turn Bluetooth Off.
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Bring a Surge Protector with Vou

I'll be honest: [ usually am not a huge supporter of surge protectors because
[ think they do only half the job. That job is protecting both your hardware
and your data . . . and, as you probably know, a surge protector doesn’t pro-
vide backup power in case of a brownout or total loss of power like a UPS
(uninterruptible power supply) can.

Of course, many locales around the world offer a less-than-perfect power
grid, which translates into a sudden loss of power — usually at exactly

the wrong moment. (Think Great American Novel Takes a Nosedive.) Your
MacBook is smart enough to immediately switch from AC current to its bat-
tery in case of a power failure. So why am I suggesting a surge protector for
your laptop, especially seeing as how it adds bulk and weight to your laptop
bag or luggage?

v The risk of a power spike: A surge protector is good protection from a
massive power spike, such as an overload or a lightning strike.

1 Extra sockets on tap: Don’t forget that you might need several more AC
sockets for external devices, such as a hard drive, projector, and por-
table printer. A surge protector can provide the extra power, even when
your host can’t.

<MBER
S

& Naturally, if you're traveling to a country with different AC standards (and dif-

ferent socket configurations), invest in an AC plug adapter that’s compatible
with the standard used at your destination.

Use Power-Saving Features

Apple allows you considerable control over how fast your CPU can run,
which is a real boon to power-hungry laptop owners. In System Preferences,
click Energy Saver to display the Settings For and Optimization list boxes.

If you’re running your laptop while connected to an AC outlet, click the Settings
For pop-up menu and click Power Adapter; then click the Optimization pop-up
menu and choose the Better Performance setting. This setting provides the
best performance your laptop’s processor can provide — all your applications
will run their fastest — but it also uses the most electricity.

If your laptop is running on battery power and you need to conserve as much
power as possible, click the Settings For pop-up menu and click Battery; then
choose Better Battery Life from the Optimization pop-up menu. Now you’re
squeezing the maximum amount of computing time out of your remaining
battery power. (Your laptop also runs much cooler.)
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Use an External Keyboard and Mouse

Does your laptop remain at your home, dorm room, or office for long periods
of time? If so, | recommend that you invest in an external keyboard and an
external mouse for two very good reasons:

v Adding external input devices helps lower the wear and tear on your lap-
top’s keyboard and trackpad.

v External input devices are generally more comfortable and convenient
to use than those offered by your MacBook, especially for gaming.

If price is no obstacle, a wireless keyboard and mouse allow you far more
freedom of movement, but a standard USB keyboard and mouse do just as
fine a job and cost less.

In fact, you can have two external keyboards if you like: one to work with
your laptop while you're running Snow Leopard (which has all the keys
unique to an Apple keyboard) and one to use when you're running Windows
(with those gnarly Windows-specific keys). Techno-suave.

Not Again! What Is It with
VYou and Backing Up?

Yes, it’s one of the Top Ten Laptop Rules as well. I'm not kidding: If you
think you don’t need to back up on a regular basis, you will eventually

lose every byte of data you have. Period. It’s only a matter of time. Even if
you have incredible luck and don’t do something you regret with a Finder
window, your MacBook is just a machine, and it will wear out in the long run.
(Especially with the mobile life of a Road Warrior, with all the bumps and
bruises of travel.) That’s why hard drive manufacturers list MTBF — Mean
Time Between Failures — figures for their hard drives.

Backing up your hard drive isn’t difficult and doesn’t take long. Chapter 23
explains everything you need to know. And after you finish your first full
backup, drop me a line at mark@mlcbooks. com with the subject I've Got
Laptop Peace of Mind! We can celebrate together!
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Ten Things to Avoid
Like the Plague

In This Chapter
Dodging USB 1.1 storage devices
Shunning e-mail and Web phishing expeditions
Skirting those strange-sized discs
Keeping liquids at arm’s length
Banishing outdated disk utilities
Eschewing pirated software
Steering clear of the root/System Administrator account
Sidestepping unsecured public wireless networks
Spurning refurbished hardware
Expelling dust and dirt

f you've read other books that I've written in the For Dummies series, you

might recognize the title of this chapter — it’s a favorite Part of Tens sub-
ject of mine. I don’t like to see any computer owner fall prey to pitfalls. Some
are minor (such as not keeping your laptop clean), and others are downright
catastrophic (such as providing valuable information over the Internet to
persons unknown).

All these potential mistakes, however, share one thing in common: They’re
easy to prevent with a little common sense — that is, as long as you’re aware
of them. And that’s my job. In this chapter, I fill in what you need to know.
Consider these pages as experience gained easily!
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USB 1.1 Storage Devices

Man, that is the very definition of sluggish. Let’s see, what could I be talking
about? Oh, yes . .. only a creaking USB 1.1 external device such as a hard
drive or CD-ROM drive could be as slow as a turtle on narcotics.

Unfortunately, you still find countless examples of USB 1.1 storage hardware
hanging around. eBay is stuffed to the gills with USB 1.1 hard drives, and your
family and friends will certainly want to bestow that old 4x CD-RW drive to
you as a gift. (This is one that you should politely refuse immediately, just
like your Aunt Harriet’s fruitcake.) These drives were considered cool in the
early days of the colorful iMac G3, when USB was a new technology. Today, a
USB 1.1 hard drive is simply a slow-as-maple-syrup-in-January embarrassment.

[ do admit that plenty of great USB 1.1 devices are still around these days,
such as joysticks, keyboards, mice, and other controllers, along with print-
ers and scanners that work just fine with slower transfer rates. However, if
a peripheral’s job is to store or move data quickly — including hard drives,
network connections, CD-ROM drives, and USB flash drives — give a USB 1.1
connection a wide berth, opting instead for a USB 2.0 or FireWire device.

Phishing Operations

Phishing is no phun. No, that’s not a misspelling. In Internet lingo, phishing
refers to an attempt by unsavory characters to illegally obtain your personal
information. If that sounds like an invitation to identity theft, it is — and
thousands of sites have defrauded individuals like you and me (along with
banks and credit card companies) out of billions of dollars. Unfortunately,
the phishing industry has been growing like a weed, and more innocent folks
are being ripped off every day. (The low-life running phishing operations are
pond scum . . . and I'm being polite here because this will appear in print.)

A phishing scam works like this: You get an e-mail purporting to be from a
major company or business, such as eBay, a government agency, or a major
credit card company. The message looks genuine, with all the proper graph-
ics and company information, but it warns you that you have to “update”
your login or financial information to keep it current, or that you have to
“validate” your information every so often — and even provides you with a
convenient link to an official-looking Web page. After you enter your oh-so-
personal information on that bogus page, it’s piped directly to the bad guys,
and they’re off to the races.
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Here’s a Mark’s Maxim that every Internet user should take to heart:

No legitimate company or agency will ever solicit your personal informa-
tion through an e-mail message!™

Never respond to these messages. If you smell something phishy, open your
Web browser and visit the company’s site (the real one) directly. Then con-
tact the company’s customer support personnel. They’ll certainly want to
know about the phishing expedition, and you can help by providing them with
the e-mail and Web addresses used in the scam.

In fact, sending any valuable financial information through unencrypted e-mail —
even to those whom you know and trust — is a bad idea. E-mail messages can
be intercepted or read from any e-mail server that stores your messages.

Oddly Shaped Optical Discs

Your Mac laptop’s optical drive is a marvel of precision — and it’s doggone
svelte to boot. Every current Apple laptop model (including the external
drive available for the MacBook Air) features the latest optical drives, which
don’t require silly trays. Just slide your CD or DVD inside the drive, and it
smoothly disappears from sight. Press the Eject key or drag the disc icon on
your desktop to the Trash, and the disc appears like magic. No need to give
the loading and ejecting procedures a second thought, right?

Well, good reader, that’s true — but only if you're loading a standard 1.2mm-
thick, 120mm round CD or DVD into your drive! Notice that I didn’t say

+* An 80mm mini-disc: Yes, they’re cute. Yes, all sorts of devices use them
these days, from DV camcorders to digital cameras. But, no, they’re not
supported by many slot-loading drives, so there’s a good chance one
will refuse to eject.

v A credit-card or triangular-shaped disc: Friends, these discs just aren’t
natural! Of course, that’s part of their pizzazz for advertisers, who give
them away in scads. A square disc works in a tray-loading drive, but a
slot drive will likely get indigestion and refuse to eject it.

v A super-thick disc: Sure, a tray DVD drive can likely accept a disc with
a thick, printed paper label, but if that disc is more than 1.5mm thick,
it can actually damage your laptop’s slot-loading drive. Consider these
words: “Marge, it’s stuck in there!” Now imagine how you would feel if
you were the one saying that.
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All three of these oddly shaped discs share one thing in common: The damage
you may cause by attempting to use one in your MacBook is not covered under
your Apple warranty. A weighty statement indeed.

If you do need to read or record a nonstandard disc size, [ recommend that
you pick up a USB external tray-loading drive, which can easily handle any size
disc you toss at it.

Submerged Keyboards

Do you really want a submerged keyboard? Your answer should be an
unequivocal, “No!” And that’s why everyone should make it a rule to keep all
beverages well out of range of keyboards, trackpads, and external devices,
such as speakers and mice — especially when kids or cats are in close prox-
imity to your laptop.

If a soda spill comes in contact with your MacBook, you’re likely to be vis-
ited with intermittent keyboard problems (or, in the worst-case scenario, a
short in your laptop’s motherboard). Suffice it to say that 12 inches of open
space can make the difference between a simple cleanup and an expensive
replacement!

Antiquated Utility Software

It’s the upgrade game, and everyone’s gotta play. If you're using Mac OS X
Snow Leopard, you must upgrade your older utility programs — such as an
older copy of TechTool Pro from Micromat (www.micromat .com) that sup-
ports only Mac OS X Leopard. I know that you spent good money on ’em, but
these older disk utility applications can do more damage than good to a hard
drive under Mac OS X Snow Leopard. Of course, utility software designed for
earlier versions of Mac OS X (such as Panther and Jaguar) should be strictly
avoided!

A number of things change when Apple makes the leap to a new version of
Mac OS X, including subtle changes to disk formats, memory management in
applications, and the support provided for different types of hard drives and
optical drives. If you use an older utility application, you could find yourself
with corrupted data. Sometimes a complete operating system reinstall is
necessary. (In fact, most utilities now refuse to run if they don’t recognize the
version of Mac OS X you’re running.)
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Now that you’re using Mac OS X Snow Leopard, make sure that you diagnose
and repair disk and file errors by using only a utility application specifically
designed to run in Snow Leopard. Your laptop’s hard drive will definitely
thank you.

Software Piracy

This one’s a no-brainer: Don’t endorse software piracy. Remember, Apple’s
overall market share among worldwide computer users currently weighs in at
around 10 percent. Software developers know this, and they have to expect
(and receive) a return on their investment, or they’re going to find something
more lucrative to do with their time. As a shareware author, I can attest to
this firsthand.

Pirated software seems attractive — the price is right, no doubt about it —
but if you use an application without buying it, you’re cheating the developer,
who will eventually find Macintosh programming no longer worth the time
and trouble. Believe me, a MacBook is a great machine, and Snow Leopard is
a great operating system, but the sexiest laptop and the best hardware won'’t
make up for an absence of good applications.

Pay for what you use, and everyone benefits.

The Forbidden Account

You might never have encountered the root, or System Administrator, account
in Mac OS X — and that’s always A Good Thing. Note that I'm not talking
about a standard Administrator (or Admin) account here. Every Mac needs at
least one Admin account (in fact, it might be the only visible account on your
computer), and any Standard user account can be toggled between Standard
and Admin status with no trouble at all.

The root account, though, is a different beast altogether, and that’s why it’s
disabled by default. All UNIX systems have a root account. Snow Leopard is
based on a UNIX foundation, so it has one, too. Anyone logging in with the
root account can do anything on your system, including deleting or modify-
ing files in the System folder (which no other account can normally access).
Believe me, deliberately formatting your hard drive is about the only thing
worse than screwing up the files in your System folder.
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Luckily, no one can access the root/System Administrator account by acci-
dent. In fact, you can’t assign the root account through System Preferences;
you have to use the Directory Utility application located in your Utilities
folder. Unless an Apple support technician tells you to enable and use it, you
should promptly forget that the root account even exists.

Unsecured Wireless Connections
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Okay, I like free Internet access as much as the next technology author — it’s
cool, it’s convenient, and public-access wireless networks are popping up all
over the world. Heck, New Orleans has almost finished upgrading to citywide
free wireless Internet access, which is perfect for checking your e-mail while
you're catching beads or listening to jazz. More and more cities are certain to
follow in the near future.

However, just because something is free doesn’t mean that it’s safe.
(Impromptu and overly trusting bungee jumpers, take note.) Unfortunately,
the free public wireless access you're likely to encounter is not secure.
Anyone can join, and the information you send and receive can be inter-
cepted by any hacker worthy of the name. A public network uses no WEP or
WPA key, so no encryption is involved, and therefore you have no guarantee
that your private e-mail, your company’s financial spreadsheets, and your
Great American Novel aren’t being intercepted while you're uploading and
downloading them in the airport.

If you must use your laptop on an unsecured public network, make sure that
the connection itself is secure instead. For example, don’t check your e-mail
by using a Web browser unless your ISP or e-mail service offers an encrypted
SSL (Secure Sockets Layer) connection. (Yep, I'm talking again about that
little padlock that appears in Safari, which I discuss in Chapter 8. It’s not just
for ordering things online!) If you need to establish a secure connection with
your home or office network, use an SSL-enabled Virtual Private Network
(VPN) client, which allows you to transfer files and remotely operate a host
computer with bulletproof security. (Visit www . gracion.com and download
a trial copy of DigiTunnel for Mac OS X. The full version sells for about $60.
You'll sleep better at night, Road Warrior.)

Refurbished Hardware

Boy, howdy, do I hate refurbished stuff. Like my single-minded quest to rid
the world of floppy disks, I likewise make it a point to dispel the myth that
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you're actually saving money when you buy a refurbished (or “remanufac-
tured”) piece of hardware. To quote someone famous, “If the deal sounds too
good to be true, it probably is.”

Examine what you get when you buy a refurbished external hard drive. It’s
likely that the drive was returned as defective, of course, and was then sent
back to the factory. There the manufacturer probably performed the most
cursory of repairs (just enough to fix the known problem), perhaps tested
the unit for a few seconds, and then packed it back up again. Legally, retailers
can’t resell the drive as a new item, so they have to cut the price so low that
you’re willing to take the chance.

Before you spend a dime on a bargain that’s remanufactured — 1 can’t get
over that term — make sure that you find out how long a warranty you’ll
receive, if any. Consider that the hardware is likely to have crisscrossed the
country at least once, and that it’s likely to have picked up a few bumps and
bruises during its travels. Also, you have no idea how well the repairs were
tested or how thoroughly everything was inspected.

[ don’t buy refurbished computers or hardware, and most of the tales that
I've heard of folks who do have ended badly. Take my advice: Spend the extra
cash on trouble-free, new hardware that has a full warranty.

Dirty Laptops

\\3

Clean your machine. Every computer (and every piece of computer hard-
ware) appreciates a weekly dusting.

Adding memory to your laptop? Seeing as how you have to open your
MacBook anyway, take advantage of the chance to use that trusty can of com-
pressed air.

On the outside of your laptop, your screen should be cleaned at least once
every two or three days — that is, unless you like peering through a layer

of dust, fingerprints, and smudges. Never spray anything directly on your
screen or your MacBook’s case. I highly recommend using premoistened LCD
cleaning wipes typically used for notebook computers.

Your laptop’s case really doesn’t need a special cleaning agent — in fact, you

shouldn’t use any solvents — but a thorough wipe with a soft cloth should
keep your case in spotless shape.
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Absolute Software’s LoJack
for Laptops, 387
AC outlet, 24, 389
AC plug adapter, 389
ACC files, 198, 200
access code for MobileMe
service, 142
access levels
MobileMe service,
140-141
user accounts, 147
accounts
access levels, 147
Administrator account,
147, 395-396
Migration Assistant, 41-42
MobileMe service,
139-140
user accounts, 147-157
Acrobat PDF format, saving
documents as PDFs, 94
active window, 76
adapters
AC plug adapter, 389
USB Bluetooth adapter,
BC2-BC3
adding
bookmarks, 127, 130-131
loops, 288-293
memory, 359-362, 364
slides, 335-336
storage space to
MobileMe account, 140
text to presentation
slides, 337
tracks, 286-288
users, 148-150
video clips, 254-255,
268-270
Address Book, 29-30

Index

adjusting image properties,
237
Administrator account, 147,
395-396
AIFF files, 198, 200
Airhawk A9 hard drive
(Rocstor), 366-367
AirPort Base Station,
169-170
AirPort Express Base
Station, 169-170, 217
AirPort Extreme Base
Station, 18, 169-170
AirPort Extreme card, 13,
18
AirPort Extreme hardware,
18
album covers, 209
aliases, 67-68
aligning text in cells
(spreadsheets),
324-325
Amazon.com
album covers, 209
cookies, 135
MobileMe subscriptions,
140
AM/FM radio, 370
antivirus applications, 355
Appearance pane (System
Preferences), 104-105
Apple Base Station, 168-169
Apple Knowledge Base, 53
Apple Lossless files,
198, 200
Apple menu, 49, 58
Apple Remote, 15, 188,
190-192
Apple Service Center,
346, 357-358
Apple technical support,
35, 40, 53, 357
Apple TV, 202
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AppleCare Protection Plan,
35, 361
AppleEvents, 379
AppleScript, 379
application icons, 66
Application menu, 49
applications
Address Book, 29-30
aliases, 67-68
antivirus, 355
Automator, 371, 379-381
Boot Camp, 30, 44
Chess, 29
closing, 65
Directory Utility, 396
Disk Utility, 349-354
DVD Player, 29, 191
force quit, 65, 347
Front Row, 28, 188,
190-192
Help system, 53
iLife '09 suite, 28
installing, 353
iWork trial version, 28
keyboard shortcuts, 73
launching, 63-65
locked application, 347
menus, 49
orphan files, 373-374
patches, 353
Photo Booth, 28, 188-190
pirated software, 395
quitting, 63, 65
Software Update, 381-382
switching between
applications, 89-90
tracker, 387
troubleshooting, 353
updating, 353
upgrading, 394-395
Aqua Blue background
(Snow Leopard), 34
Arrange track (GarageBand),
294-295
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arranging windows, 76
audio. See also sound
connecting external
audio, 17
digital audio files,
197-198, 200
Equalizer (iTunes),
210-211
iMovie, 251-252
muting, 72
presentations, 339
recording, 252-253
audio CDs, 198-200, 209-210,
216, 301
Audio Line In jack, 17
Audio Line Out jack, 14
Audio Mute key, 72
audiobooks, 198
author’s Web site, 6
Auto Login, 159
Automator application,
371, 379-381
AVCHD file, 249
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background images,
83, 99-101
background shapes
Keynote presentations,
339-340
Pages documents, 314
backlighting on keyboard,
14, 72
Backup folder (iDisk), 142
backups
CDs, 376
DVDs, 376
external hard drive,
375-376
hard drive, 369, 374-378,
390
iTunes Media Library, 219
RAID array drive, 375
Time Machine, 109-110,
366, 376-378
bad pixels on LCD
screen, 35

bag, 30, 385-386
base station, 168-171
battery
Better Battery Life option,
389
calibrating, 36-37
charging, 15, 35-37
compartment, 15-16
external battery, 37
monitoring battery
level, 36
removing, 362-363
replacing, 364
Belkin’s USB Bluetooth
adapter, BC3
black-and-white images, 237
blank CDs/DVDs, 32
blocking pop-up windows,
137
Bluetooth devices
adapters, BC2
Bluetooth Setup Assistant,
BC3
configuring connections,
BC3-BC4
connecting, 18, BC2-BC8
development history, BC2
internal Bluetooth
hardware, BC2
iSync, BC7-BC8
keyboard, BC5-BC6
mouse, BC5-BC6
printers, 183, BC8
System Preferences,
BC3-BC5
USB Bluetooth adapter,
BC3
Bluetooth File Exchange,
BC4-BC5, BC7
bonus chapter, 6
BookBook case, 30-31
bookmarks, 124, 127,
130-131
Boolean search, 114
Boot Camp, 30, 44
Boot Camp Assistant, 30
boot disk, 352
brightness of display, 36
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BTKey keyboard (Macally),
BC6
built-in keyboard, 12, 14, 28
built-in speakers, 14
burning
CDs, 216-217, 301
DVD movies, 279-280
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C key, 348
cable modem, 174
cable TV, 193
cables, 32, 174, 354
cache, 137
calibrating battery, 36-37
cameras
digital cameras, 221
iSight camera, 12-13,
15, 188-190, 192-193
Caps Lock key, 35
carpal tunnel syndrome, 32
case, 30-31, 385-386
CD-ROM drive, 392
CDs
audio CDs, 198-200,
209-210, 216, 301
backups, 376
blank CDs, 32
burning, 216-217, 301
CD/DVD Sharing feature,
23-24
data CDs, 216
ejecting, 72
MP3 CDs, 216
repairing, 352
CDW Web site, 361
cellphones and iSync,
BC7-BC8
cells (spreadsheets)
aligning text, 324-325
defined, 318
selecting, 322
changing System
Preferences, 353-354
charging battery, 15, 35-36
charts, 328-329
checking spelling, 314-315
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Chess, 29
Ci Design’s Dock II, 375-376
cleaning
keyboard, BC6
laptop, 397
mouse, BC6
cleaning wipes, 31, 397
cleanup utilities for hard
drive, 374
clearing
cache, 137
history, 137
Clipboard, 310
closing
applications, 65
documents, 65
laptop, 27
System Preferences, 97
windows, 75
cloud computing, 139
collating documents, 94
color profile, 99
color saturation of images,
236
columns (spreadsheets)
defined, 318
deleting, 326
inserting, 326
Command key, 72
composing songs
automatic composition,
298
original songs, 284-297
configuring Bluetooth
connections, BC3-BC4
connecting
to Bluetooth devices,
18, BC2-BC8
to external audio, 17
to external devices, 354
to external hard drive, 368
to external video, 17
to iDisk, 143-144
to Internet, 26-27, 29,
354-355
toiPod, 214-215
to a network, 167-176
to printers, 183-186
to scanners, 187

contextual menus, 50, 62
Contour Design’s
ShuttleXpress video
controller, 370
contrast of images, 236
conventions used in this
book, 3
cookies, 135-137
cooling pad, 38
copying items, 70
copying text or graphics,
310
CPU, 17
creating
aliases, 67-68
documents, 305
DVD movies, 264-270
iMovie movies, 244-247
presentations, 332-333
spreadsheets, 318
widgets, 89, 127
cropping
images, 234-235
video clips, 256
Ctrl key, 72
cursor, 60-61
customizing
Desktop, 59, 82-84
Dock, 84-86
cutting text or graphics, 310
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damage
AppleCare Protection
Plan, 35, 361
repairing laptop, 346, 361
shipping damage,
25, 34-35
spills on keyboard, 394
Dashboard, 88-89,
119-120, 127
data CDs/DVDs, 216
DDR3 SDRAM memory
modules, 360
dead pixels on LCD
screen, 35
defragmenting iDisk, 142
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Delete key, 72
deleting
columns (spreadsheets),
326
contents of Safari History
menu, 137
contents of Trash, 86-87
files, 372-374
folders, 372-374
photos, 190
playlists, 206
songs from iTunes Music
Library, 204
user accounts, 152
users, 152
video clips, 255
widgets, 88
Desktop, 46-47, 52,
59, 82-84
Desktop & Screen
Saver pane (System
Preferences), 99-101
DHCP server, 167, 175-176
Dictionary widget, 13, 120
digital audio files, 197-198,
200
digital cameras, 221
digital extraction, 209-210
digital video (DV)
camcorders, 221
DigiTunnel, 396
Directory Utility
application, 396
disabling
Login Items, 355-356
wireless connectivity, 388
disassembling laptop, 361
disc slot, 12, 14
Disk Utility, 349-354
display, 13
Displays pane (System
Preferences), 98-99
Dock, 47-48, 59, 84-86
Dock II (Ci Design), 375-376
Dock pane (System
Preferences), 106-107
documentation, 26
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documents
Acrobat PDF format, 94
background shapes, 314
Clipboard, 310
closing, 65
collating, 94
copying text or graphics,
310
creating, 305
cutting text or graphics,
310
Documents folder (iDisk),
142
e-mailing, 94, 316
exporting, 316
faxing, 94
force quit, 65
formatting, 311
graphics, 309
Home folder, 79-82
icons, 66
iWeb, 316
metadata, 113
opening, 64-65, 306-307
photos, 312-314
printing, 92-94, 315
saving, 307
sharing, 315-316
spell check, 314-315
tables, 311-312
templates, 305-306
text boxes, 309
downloading files, 131-132
drag and drop, 52
drop zones, 269
DSL modem, 174
duplicating, 71, 336
DV (digital video)
camcorders, 221
DV file, 249
DV Widescreen file, 249
DVD authoring, 261
DVD drive, 23
DVD movies
adding video, 268-270
aspect ratio, 270
burning, 279-280

creating, 264-270
dimensions, 272
drop zones, 269
Front Row application,
191, 193
menu background,
273-276
movie buttons, 274-275
music, 272-273
opening, 265
previewing, 276-277
recording, 279-280
resolution, 270
slideshows, 270-272
themes, 267-268
titles, 274
TV Safe Area, 270
DVD Player, 29, 191
DVD-R/CD-RW SuperDrive, 18
DVDs
backups, 376
blank DVDs, 32
data DVDs, 216
ejecting, 72
repairing, 352
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editing
images, 234-237
Keynote presentations,
337
Numbers spreadsheets,
323
Pages documents, 308
song information, 208-209
video clips, 255-256
effects
images, 237
Photo Booth, 190
EIDE hard drive, 17
ejecting CD or DVD, 72
Electric Guitar tracks, 287
Elgato Systems’ EyeTV
Hybrid Plus, 193
e-mailing
documents, 94
images, 242
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Pages documents, 316
photos, 190
Web pages, 135
emptying
cache, 137
Trash, 373
encryption, 161-162,
387-388
Energy Saver settings,
36, 105-106, 389
entering data in
spreadsheets, 323
entering text in documents,
308
Equalizer, 210-211
Ethernet cables, 32, 174
Ethernet jack, 24
Ethernet network, 18
Ethernet port, 16, 27
exporting
iMovie movies, 259
Pages documents, 316
Exposé, 89-90
Exposé & Spaces pane
(System Preferences),
101-103
ExpressCard slot, 17
ExpressCard/34 slot, 368
external battery, 37
external devices
AM/FM radio, 370
connecting, 354
defined, 359
game controllers, 370
hard drive, 366-369, 375
keyboard, 25, 390
MIDI instruments, 286, 297
mouse, 390
piano keyboard, 370
speaker systems, 14
USB 1.1 storage devices,
367, 392
video controllers, 370
external iSight camera, 13
EyeTV Hybrid Plus (Elgato
Systems), 193
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Facebook integration with
iPhoto, 242
Faces and Places feature
(iPhoto), 229-231
fan, 38
faxing, 94
file sharing
Bluetooth File Exchange,
BC4-BC5, BC7
iSync, BC7
iTunes, 201, 215-216
iWork.com, 315-316
MobileMe, 142
networks, 164, 179
Pages documents, 315-316
Public folder, 160-161
Shared folder, 160
files
aliases, 67-68
deleting, 372-374
downloading, 131-132
encryption, 161-162,
387-388
icons, 66-67
orphan files, 373-374
FileVault protection,
161-162
filtering Spotlight search
results, 115-116
Finder
Apple menu, 49, 58
Finder window, 58-60
icons, 58-59
keyboard shortcuts, 72-73
menu bar, 58-59
search tools, 118-119
status, 70
firewalls, 180-182
FireWire 800 external hard
drive, 368
FireWire cables, 32
FireWire port, 16, 40,
187, 367
FireWire scanners, 187

fixing
boot disk, 352
disk permissions, 350-351,
378-379
hard drive, 352-353
laptop, 346, 361
Flickr integration with
iPhoto, 242
Flight Tracker widget, 120
folders
deleting, 372-374
encryption, 161-162,
387-388
Home folder, 79-82
iDisk, 142-143
Public folder, 160-161
Shared folder, 160
Smart Folder, 119
force quit, 65, 347
formatting
external hard drive, 368
iDisk, 142
formatting text or numbers
Keynote presentations,
338
Numbers spreadsheets,
323-324
Pages documents, 311
formulas, 327-328
forums, 54
Front Row, 28, 188, 190-192
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G4 processor, 17
game controllers, 370
games
Chess, 29
multiplayer games, 164
GarageBand
Arrange track, 294-295
automatic song
composition, 298-299
composing songs, 284-286
Create a New Track
button, 282-283
Learn to Play lessons, 301
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Loop Browser, 282-283,
288-289
loops, 282, 288-294
Magic GarageBand,
298-299
Media Browser, 282-284
MIDI instruments, 286, 297
Move Back One Measure,
282, 284
Move Forward One
Measure, 282, 284
musical typing keyboard,
286
piano keyboard, 370
Play button, 282, 284
Playhead, 282-283
podcasts, 282, 284-285,
287-288
Return to Beginning
button, 282, 284
ringtones, 299-300
Songwriting project, 286
Timeline, 282-283
Time/Tempo display,
282, 284
Track Info button, 282-283
Track list, 282-283
tracks, 286-287, 295-297
Visual Equalizer window,
296
Volume slider, 282, 284
Genius feature (iTunes),
201, 205, 220
Google
Google box on Safari
toolbar, 126, 128
Google widget, 120
online storage, 139
graphics
Keynote presentations,
336
Pages documents, 309
Griffin Technology’s SHARK
2 radio, 370
grounding yourself,
362, 365
Groups folder (iDisk), 142
groups in MobileMe, 142
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Hamrick Software’s
VueScan, 197
handling, 27-28
hard drive
backup, 369, 374-378, 390
cleanup utilities, 374
deleting files and folders,
372-374
Disk Utility, 349-354
external hard drive,
365-369
fixing, 352-353
formatting, 368
index file, 112
partitioning, 30, 368
permission errors,
350-351, 378-379
repairing, 352-353
standard equipment, 17
system RAM (memory),
386
upgrading, 365-369
USB 1.1 storage devices,
392
warranty, 369
wiping, 349
Hardcopy Cable
Replacement Protocol
(HCRP), BC8
hardware, 66, 396-397
HDV file, 249
headphones, 14, 17
heat, 24, 38
Help system, 53
history (Safari), 132-133,
137
Home folder, 79-82
Home Sharing feature
(iTunes), 216
hot corners, 101
Hyperbolic Software’s Tidy
Up! 2, 374
HyperMac external battery
(Sanho Corporation), 37
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iBook, upgrading from, 13
iChat AV, 15, 192-193
iChat Buddy icon, 190
icons
aliases, 67
application icons, 66
Dock, 84-85
document icons, 66
files, 66-67
Finder, 58-59
hardware icons, 66
photos, 190
Snow Leopard, 48
used in this book, 6-7
identification, 388
iDisk
Backup folder, 142
connecting, 143-144
defragmenting, 142
Disk Space bar graph, 140
Documents folder, 142
file servers, 141
folders, 142-143
formatting, 142
Groups folder, 142
Library folder, 142
mirror, 141
Movies folder, 142
Music folder, 142
opening, 143-144
Pictures folder, 142
Public folder, 142, 144
root folder, 142
setting up, 139, 141
Sites folder, 142
Software folder, 142-143
Windows, 144
iDVD
Add button, 262-263
adding video clips,
268-270
aspect ratio, 270
Burn button, 262, 264
burning DVD movies,
279-280
creating DVD movies,
264-270
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dimensions, 272
drop zones, 269
DVD Map button, 262, 264
Edit Drop Zones button,
262, 264
iMovie moves, 259
Inspector Window,
262-263
Magic iDVD, 278-279
Magic iDVD feature, 266
Media pane, 262-263
Menu display, 262-263
Motion button, 264
music, 272-273
OneStep DVD, 266,
277-278
opening movies, 265
Preview button, 262, 264
previewing DVD movies,
276-277
recording DVD movies,
279-280
resolution, 270
slideshows, 270-272
themes, 267-268
TV Safe Area, 270
iLife '09 suite, 28
illuminated keyboard,
14, 72
Image Capture, 187
images
adjusting image
properties, 237
albums, 225-228
aspect ratio, 235
black-and-white, 237
color saturation, 236
contrast, 236
cropping, 234-235
editing, 234-237
effects, 237
e-mailing, 242
iMovie movies, 250
importing, 224-225, 227
iWeb, 234
Keynote presentations,
336, 339
keywords, 231-233
MobileMe Gallery, 240-241
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organizing, 225-234

Pages documents, 312-314

photo books, 237-239

printing, 234

ratings, 233

red-eye, 236-237

retouching, 237

rotating, 234

sepia tones, 237

slideshows, 240

Smart Album, 226

sorting, 233

straightening, 236

tagging, 229-231

iMovie

adding video clips,
254-255

audio, 251-253

Browser toolbar, 245-246

Camera Import window,
245-246

creating movies, 244-247

deleting video clips, 255

Editing toolbar, 245-246

editing video clips,
255-256

Event pane, 245-246

exporting movies, 259

importing video, 247-249

launching, 244

Media Browser, 259

Monitor, 245-246

music, 251-252

narration for movies, 253

pillarboxing, 245

Playhead, 245-246

Project pane, 245-246

QuickTime movies, 259

reordering video clips,
255

sharing movies, 259

songs, 251-252

sound effects, 251-253

still images, 250

themes, 245

titles, 257-258

transitions, 256-257

iMovie *09 & iDVD 09 For

Dummies (Wiley), 247

importing
data from a PC, 43-44
data from another Mac,
39-43
images, 224-225, 227
video, 247-249
index file of hard drive, 112
inserting
columns (spreadsheets),
326-327
rows (spreadsheets),
326-327
installing
applications, 353
base station, 170-171
memory modules, 361-364
printers, 184-185
scanners, 187
tracker application, 387
Intego’s Virus Barrier X6,
355
Intel processor, 17
interactive whiteboard, 341
internal optical drive, 14
Internet
cloud computing, 139
widgets, 119-120
Internet connection
establishing, 26-27, 29
sharing, 164, 166-167,
178-179
troubleshooting, 354-355
Internet radio, 198, 211-214
Internet routers, 167
invoice, 26
iPhoto
Create button, 222-223
edit mode, 234-237
Enter Full Screen button,
222-223
Facebook integration, 242
Faces and Places feature,
229-231
Flickr integration, 242
Get Info button, 222-223
import mode, 224-225,
227
keywords, 231-233
MobileMe Gallery, 240-241
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organize mode, 225-234
photo books, 237-239
Play Slideshow button,
223
ratings, 233
Search box, 223
slideshows, 240
Smart Album, 226
Source list, 222-223
tagging, 229-231
Thumbnail Resize slider,
223
toolbar buttons, 223
Viewer pane, 223, 233
iPod, 214-215
iPod & iTunes For Dummies
(Wiley), 215
iSight camera
external iSight camera, 13
location of, 12, 15
photos, 188-190
videoconferencing,
15, 192-193
iSync, BC7-BC8
iTunes
ACC files, 198, 200
AIFF files, 198, 200
AirPort Express Base
Station, 217
album covers, 209
Apple Lossless files,
198, 200
Apple TV, 202
audio CDs, 198-200
audiobooks, 198
backups, 219
burning CDs, 216-217
Equalizer, 210-211
Genius feature,
201, 205, 220
Home Sharing feature, 216
iMovie moves, 259
Internet radio, 198,
211-214
iPod, 214-215
iTunes Plus tracks, 198
keyboard shortcuts, 200
movies, 198
MP3 files, 197, 200
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iTunes (continued)
Music Library, 200-204
playlists, 201, 205-206
podcasts, 198, 301
ringtones, 198
ripping audio files,
209-210
sharing files, 201, 215-216
song information, 207-209
Source list, 200-201
video, 198, 204
Visualizer, 217-219
WAV files, 198, 200
iTunes Store, 201, 219-220
iWeb
images, 234
Pages documents, 316
podcasts, 301
iWork trial version, 28
iWork.com, 315-316

o]o

joining
MobileMe service,
140-141
wired Ethernet network,
175-176
wireless network, 171-172
jumping to bookmarks, 130

oK o

keyboard
backlighting, 14, 72
BTKey keyboard
(Macally), BC6
built-in keyboard,
12, 14, 28
Caps Lock key, 35
checking, 35
cleaning, BC6
external keyboard, 25, 390
illumination, 14, 72
musical typing keyboard,
286
piano keyboard, 370
special keys, 72

spills on keyboard, 394
wireless keyboard,
BC5-BC6
Keyboard Illumination
key, 72
keyboard shortcuts
applications, 73
Finder, 72-73
Front Row, 191-192
iTunes, 200
Keynote, 340-341
memorizing, 71
Numbers, 322
System Preferences,
102-103
Keynote
adding slide text, 337
adding slides, 335-336
audio, 339
background shapes,
339-340
creating presentations,
332-333
duplicating slides, 336
editing slide text, 337
Format Bar, 334, 338
formatting slide text, 338
graphics, 336
interactive whiteboard,
341
iPhone/iPod Touch
application, 341
keyboard shortcuts,
340-341
Layout pane, 334-335
Media Browser, 339
moving slides, 336
Notes pane, 334, 338
opening presentations,
333
photos, 336, 339
printing slides and notes,
341-342
Rehearsal feature, 338
saving presentations,
333-334
slide backgrounds,
339-340
Slides list, 334
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slideshows, 340-341
Template Chooser
window, 332-333
text boxes, 336-337
toolbar, 334
video, 339
KeyRig 49 piano keyboard
(M-Audio), 370
keywords
images, 231-233
Spotlight, 112
Knowledge Base, 53

o/ o

LAN party, 164
laptop bag or case, 30-31,
385-386
laptop shelf, 25, 38
laptop sleeve, 30-31, 386
launching
applications, 63-65
Automator, 380
iMovie, 244
Numbers, 317-318
Safari, 123
Time Machine, 377
LCD screen, 12-13, 35
Learn to Play lessons
(GarageBand), 301
Library (iTunes), 200-204
Library folder (iDisk), 142
lighting considerations, 25
locked application, 347
log files, 155
logging in and out, 158-160
Login Items
defined, 153
disabling, 355-356
setting up, 153-154
LoJack for Laptops
(Absolute Software),
387
loops
adding, 288-293
defined, 282
Loop Browser
(GarageBand), 282-283,
288-289
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moving, 292-294
repeating, 292-293
resizing, 292-293
searching, 289-290

ol o

Mac OS X Snow Leopard.
See Snow Leopard
Mac OS X Snow Leopard
All-in-One For Dummies
(Wiley), 51, 176
Mac Usenet newsgroups, 54
Mac user groups, 54
Macally’s BTKey keyboard,
BC6
MacBook Air, 19-21
MacFixIt Web site, 54
MacMall Web site, 361
magazines about Snow
Leopard, 53
Magic GarageBand, 298-299
Magic iDVD, 266, 278-279
Magic Mouse, BC6
Mail application
features, 29
phishing, 392-393
manual, 26
M-Audio’s KeyRig 49 piano
keyboard, 370
Media Eject key, 72, 348
memorizing keyboard
shortcuts, 71
memory, 359-364, 386
menu commands, 49-50
menus
Apple menu, 49, 58
Application menu, 49
contextual menus, 50, 62
right-click menus, 50
metadata, 113
Micromat’s TechTool Pro,
346
MIDI instruments, 286, 297
MIDI port, 297
migrating data
from another Mac, 39-43
from a PC, 43-44
Migration Assistant, 39-43

Mini DisplayPort
connector, 17
minimizing windows, 75
mirror (iDisk), 141
MLC Radio, 213
MobileMe service
access code, 142
access privilege levels,
140-141
account creation, 139-140
adding storage space, 140
benefits of, 139-143
groups, 142
iDisk, 139-144
joining, 140-141
MobileMe Gallery,
240-241, 259
passwords, 141, 144
Public folder, 141
sharing files, 142
subscription fee, 140
synchronizing data, BC7
trial version, 39, 139-140
modifying user accounts,
150-151
monitoring battery level, 36
mouse
cleaning, BC6
external mouse, 390
Magic Mouse, BC6
optical mouse, BC6
wireless mouse, BC5-BC6
mouse pointer, 60-61
mouse shortcuts, 102-103
MOV file, 249
movie tracks, 287, 292
movies
DVD movies, 191,
193, 264-280
iMovie, 244-259
iTunes, 198
Movies folder (iDisk), 142
QuickTime movies, 259
moving
loops, 292-294
slides, 336
windows, 76
moving items, 71
MP3 CDs, 216
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MP3 files, 197, 200
MPEG-2 file, 249
MPEGH file, 249
multiplayer games, 164
Multi-Touch feature, 61, 76
multiuser setup, 145-150
music. See also songs
album covers, 209
audio CDs, 198-200
backups, 219
copyright issues, 215
digital audio files,
197-198, 200
DVD movies, 272-273
Equalizer (iTunes),
210-211
GarageBand, 281-282
Genius feature (iTunes),
201, 205, 220
iMovie, 251-252
Internet radio,
198, 211-214
iPod, 214-215
iTunes Store, 219-220
Music folder (iDisk), 142
Music Library (iTunes),
200-203
playlists, 201, 205-206
ripping audio files,
209-210
song information, 207-209
Visualizer (iTunes),
217-219
musical typing keyboard,
286
muting audio, 72

o\ o

naming
photo albums, 226
songs, 285
narration for movies, 253
navigating spreadsheets,
322
Network Utility, 177
networked printers,
180, 186
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networks
base station, 168-171
benefits of, 163-164
cable modem, 174
connections, 167-175
DHCP server, 167, 175-176
disabling wireless
connectivity, 388
DSL modem, 174
Ethernet cables, 174
file sharing, 164, 179
firewalls, 180-182
Internet connections, 164,
166-167, 178-179
names, 180
Network Utility, 177
pinging, 355
pinging computers,
177-178
security, 165, 180-182, 396
switches, 174
testing, 177-178
troubleshooting, 354-355
USB-to-Ethernet
connector, 173
Virtual Private Network
(VPN), 396
wired network, 164-166
wireless network, 164, 166
Newegg Web site, 361
newsgroups, 54
notes for presentations,
334, 338
Numbers
aligning cell text, 324-325
charts, 328-329
creating spreadsheets,
318
deleting rows/columns, 326
editing spreadsheets, 323
entering data in
spreadsheets, 323
Format Bar, 321
formatting text or
numbers, 324
Formula Box, 321
formulas, 327-328
Function Browser button,
327

inserting rows/columns,
326-327

keyboard shortcuts, 322

launching, 317-318

navigating spreadsheets,
322

number formatting,
323-324

opening spreadsheets,
319-320

saving spreadsheets, 320

shading, 325-326

Sheet canvas, 321

Sheets list, 320

templates, 318-319

toolbar, 321

o () o

OneStep DVD, 266, 277-278
online storage, 139-144
opening
documents, 64-65,
306-307
DVD movies, 265
iDisk, 143-144
Keynote presentations,
333
laptop, 27
spreadsheets, 319-320
System Preferences, 95-96
operating system updates,
381-382
optical drive, 14, 18, 23,
393-394
optical mouse, BC6
optical output, 17
Option key, 72, 348
organizing images, 225-234
orphan files, 373-374
outlets, 24

oo

packing materials, 25-26
Pages
background shapes, 314
Clipboard, 310
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copying text or graphics,
310
creating documents,
305-306
cutting text or graphics,
310
editing documents, 308
e-mailing documents, 316
entering text, 308
exporting documents, 316
Format Bar, 308, 311
formatting documents,
311
graphics, 309
iWeb, 316
Layout pane, 308
opening documents,
306-307
Pages list, 307
photos, 312-314
printing documents, 315
saving documents, 307
sharing documents,
315-316
spell check, 314-315
Styles Drawer, 308
tables, 311-312
templates, 305-306
text boxes, 309
toolbar, 308
Parental Controls,
147, 153-157
partitioning hard drive,
30, 368
parts, 25
passwords
FileVault protection,
161-162
Migration Assistant, 41-42
MobileMe, 141, 144
user accounts, 149, 157
patches, 353
PDAs and iSync, BC7-BC8
performance and memory,
359-360
Perian QuickTime plug-in,
132
peripherals. See external
devices
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permission errors, 350-351,
378-379
personal digital assistants
and iSync, BC7-BC8
personalizing
Desktop, 59, 82-84
Dock, 84-86
phishing, 392-393
phone and iSync, BC7-BC8
photo books, 237-239
Photo Booth, 28, 188-190
photos
adjusting photo
properties, 237
albums, 225-228
aspect ratio, 235
black-and-white, 237
color saturation, 236
contrast, 236
cropping, 234-235
deleting, 190
editing, 234-237
effects, 237
e-mailing, 190, 242
iChat Buddy icon, 190
icons, 190
iMovie movies, 250
importing, 224-225, 227
iSight camera, 188-189
iWeb, 234
Keynote presentations,
336, 339
keywords, 231-233
MobileMe Gallery, 240-241
organizing, 225-234
Pages documents, 312-314
photo books, 237-239
podcasts, 287-288
presentations, 336, 339
printing, 234
ratings, 233
red-eye, 236-237
retouching, 237
rotating, 234
saving, 190
sepia tones, 237
slideshows, 240
Smart Album, 226

sorting, 233
straightening, 236
tagging, 229-231
piano keyboard, 370
Pictures folder (iDisk), 142
pillarboxing, 245
pinging, 177-178, 355
pirated software, 395
playing
audio CDs, 199-200
digital audio files, 200
playlists, 201, 205-206
podcasts
GarageBand, 282, 284-285,
287-288
iTunes, 198, 301
iWeb, 301
photos, 287-288
podcast artwork tracks,
287
sharing, 299-301
pointer, 60-61
pop-up blocking, 137
ports
Ethernet port, 16, 27
FireWire port, 16, 40,
187, 367
MIDI port, 297
USB port, 16, 183
power button, 15, 34
power cable, 15, 26
Power On self-test, 357
power surges, 31, 389
power-saving features,
36, 105-106, 389
presentations
adding slide text, 337
adding slides, 335-336
audio, 339
background shapes,
339-340
creating, 332-333
duplicating slides, 336
editing slide text, 337
formatting slide text, 338
graphics, 336
interactive whiteboard,
341
moving slides, 336
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notes, 334, 338

opening, 333

photos, 336, 339

printing slides and notes,

341-342
rehearsing, 338
saving, 333-334
slide backgrounds,

339-340
slideshows, 340-341
templates, 332-333
text boxes, 336-337
video, 339

previewing DVD movies,
276-277
printers
Bluetooth printers,

183, BC8
connecting, 183-186
installing, 184-185
networked printers,

180, 186
USB printers, 184-186

printing
documents, 92-94
images, 234
Pages documents, 315
presentation slides and

notes, 341-342
Web pages, 128, 135

privacy
Safari, 135-137
Spotlight, 117-118
privilege levels in
MobileMe, 140-141
protecting your MacBook
AppleCare Protection

Plan, 35, 361
cleaning, 397
identification, 388
laptop bag or case,

30-31, 385-386
optical drive, 393-394
surge protector, 31, 389
tracker application, 387

Public folder, 160-161
Public folder (iDisk),
141-142, 144
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o () o
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quarantining viruses, 355
Quick Look feature, 87
QuickTime movies, 259
QuickTime Player, 132
quitting applications, 63, 65

o R o

radio, 370
RAID array drive, 375
RAM (memory), 359-364,
386
ratings for images, 233
real instrument tracks, 287
rearranging
widgets, 88
windows, 76
rebooting, 346-348
recharging, 35
recording
audio, 252-253
DVD movies, 279-280
red-eye in images, 236-237
refurbished hardware,
396-397
registering MacBook, 39-40
rehearsing presentations,
338
reinstalling Snow Leopard,
352
Remote, 15, 188, 190-192
removing. See also deleting
battery, 362-363
memory modules, 363-364
reordering video clips, 255
repairing
boot disk, 352
CDs, 352
disk permissions, 350-351,
378-379
DVDs, 352
hard drive, 352-353
repairing laptop, 346, 361
repeating loops, 292-293
replacing
battery, 364
memory modules, 363

reporting bugs in Safari, 128
resizing

loops, 292-293

windows, 74-75
restoring windows, 76
restraining cable, 32
retouching images, 237
right-click menus, 50
ringtones, 198, 299-300
ripping audio files, 209-210
Rocstor’s Airhawk A9 hard

drive, 366-367

root account, 395-396
root folder (iDisk), 142
rotating

images, 234

video clips, 256
routers, 167
rows (spreadsheets),

318, 326

Roxio’s Toast Titanium, 376
running Windows, 43

oS e

Safari
AutoFill button, 127
Back button, 126
bookmarks, 124, 127,
130-131
Bookmarks bar, 124
clearing cache, 137
Content window, 124
cookies, 135-137
creating Dashboard
widgets, 127
downloading files, 131-132
e-mailing Web pages, 135
Forward button, 126
Google search box,
126, 128
History list, 132-133, 137
Home button, 127, 129
launching, 123
pop-up windows, 137
Print button, 128
printing Web pages,
128, 135
privacy, 135-137
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Reload button, 127
Report Bug button, 128
saving Web pages, 134-135
security, 135-137
setting home page,
128-129
Show Top Sites button,
125
Status bar, 124
Stop button, 127
tabbed browsing, 133-134
toolbar, 123-126
Top Sites, 133
visiting Web sites, 125-126
Zoom button, 127
Safe Boot mode, 348
Sanho Corporation’s
HyperMac external
battery, 37
satellite TV, 193
saving
documents, 307
documents as PDFs, 94
Keynote presentations,
333-334
photos, 190
spreadsheets, 320
System Preferences, 97
Web pages, 134-135
scanners
connecting, 187
FireWire scanners, 187
Image Capture, 187
installing, 187
TWAIN device standard,
187
USB scanners, 187
VueScan, 197
screen, 12-13
screen savers, 99-101, 356
screen wipes, 31, 397
scroll bars, 74-75
SD (Secure Digital) card
slot, 16
search
Boolean search, 114
Finder, 118-119
Google, 126, 128
Google widget, 120
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iPhoto, 223
loops, 289-290
metadata, 113
orphan files, 373-374
Smart Folder, 119
Spotlight, 111-118
System Preferences, 97-98
Secure Digital (SD) card
slot, 16
security
encryption, 387-388
networks, 165, 180-182
Safari, 135-137
Spotlight, 115
wireless network, 172, 396
selecting
cells (spreadsheets), 322
items, 68—-69
sepia tones for images, 237
serial ATA hard drive, 17
serial number, 358
setting up
iDisk, 139, 141
Login Items, 153-154
Snow Leopard, 38-39
user accounts, 147-150
shading in spreadsheets,
325-326
Shared folder, 160
sharing
iMovie movies, 259
podcasts, 299-301
songs, 300
sharing a CD or DVD drive,
23-24
sharing an Internet
connection, 164,
166-167, 178-179
sharing files
Bluetooth File Exchange,
BC4-BC5, BC7
iSync, BC7
iTunes, 201, 215-216
iWork.com, 315-316
MobileMe, 142
networks, 164, 179
Pages documents, 315-316
Public folder, 160-161
Shared folder, 160

Sharing pane (System
Preferences), 107-108
sharing songs, 299
SHARK 2 radio (Griffin
Technology), 370
Shift key, 348
shipping damage, 25, 34-35
shortcuts. See aliases;
keyboard shortcuts
ShuttleXpress video
controller (Contour
Design), 370
Sites folder (iDisk), 142
sleep mode, 35-36
sleeve, 30-31, 386
slides
adding, 335-336
adding text, 337
background shapes,
339-340
duplicating, 336
editing text, 337
formatting text, 338
moving, 336
printing, 341-342
slideshows
iDVD, 270-272
iPhoto, 240
Keynote, 340-341
Smart Album, 226
Smart Folder, 119
smart playlist, 206
SMARTBoard, 341
Smith Micro Software’s
Spring Cleaning
Deluxe, 374
Snow Leopard
Aqua Blue background, 34
Auto Login, 159
Automator application,
371, 379-381
comparison to
Windows, 52
Desktop, 46-47, 52
Disk Utility, 349-350
Dock, 47-48
drag and drop, 52
ease of use, 51
FileVault protection, 161
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Help system, 53

icons, 48

logging in and out,

158-160

magazines, 53

menu commands, 49-50

performance, 50-51

Quick Look feature, 87

reinstalling, 352

reliability, 50

Setup Assistant, 34, 38-39

Software Update, 353,

381-382

updating, 381-382

windows, 50, 52
software

iLife '09 suite, 28

iWork trial version, 28

pirated software, 395

utility software, 346
Software folder (iDisk),

142-143
software instrument tracks,

286-287
Software Update

application,

353, 381-382
solid-state drive, 18, 22
songs. See also music

adding tracks, 286

composing, 284-298

iMovie, 251-252

naming, 285

sharing, 299-300

song information, 207-209

tempo (speed), 285
Songwriting project

(GarageBand), 286
sorting images, 233
sound. See also audio

Audio Line In jack, 17
Audio Line Out jack, 14
built-in speakers, 14
external speakers, 14
muting, 72
recording, 252-253
volume, 72
sound effects, 251-253
Spaces, 91-92, 103
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speakers, 14
spell check, 314-315
spills on keyboard, 394
Spotlight
capabilities, 111-116
filtering search results,
115-116
index file, 112-113
keywords, 112

privacy, 117-118

security, 115

System Preferences,
116-118

SuperDrive, 18, 23
support
Apple technical support,
35, 40, 53, 357
forums, 54
MacFixIt Web site, 54
Usenet newsgroups, 54
user groups, 54
surge protectors, 31, 389
switches, 174
switching between
applications, 89-90
switching from Windows

Top Hit category, 114
spreadsheets

aligning cell text, 324-325

cells, 318

charts, 328-329

columns, 318

creating, 318

defined, 317-318

deleting rows/columns,
326

editing, 323

entering data, 323

formatting text or
numbers, 323-324

formulas, 327-328

inserting rows/columns,
326-327

navigating, 322

number formatting,
323-324

opening, 319-320

rows, 318

saving, 320

selecting cells, 322

shading, 325-326

templates, 318-319

Spring Cleaning Deluxe

(Smith Micro Software),

374
startup keys, 348-349
start-up tone, 34
straightening images, 236
streaming Internet radio,
198, 211-214
subscription fees for
MobileMe, 140

to Mac
migrating data, 43-44
reasons to do it, 51, 139
tricks and tips, 44

synchronizing data

iSync, BC7-BC8
MobileMe, BC7

System Administrator,

147, 395-396

System Preferences

Appearance pane, 104-105
Bluetooth devices,
BC3-BC5
changing, 353-354
closing, 97
color profile, 99
Desktop & Screen Saver
pane, 99-101
Displays pane, 98-99
Dock pane, 106-107
Energy Saver pane,
36, 105-106, 389
Exposé & Spaces pane,
101-103
keyboard shortcuts,
102-103
Login Items, 355
mouse shortcuts, 102-103
opening, 95-96
panels, 96
panes, 96
saving changes, 97
search, 97-98
Sharing pane, 107-108
Spotlight, 116-118
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System Administrator
account, 396

Time Machine pane,
109-110

System Profiler, 356-357
system RAM (memory),

359-364, 386

o e

T key, 349
tables, 311-312
tagging images, 229-231
technical support
Apple technical support,
35, 40, 53
forums, 54
MacFixIt Web site, 54
Usenet newsgroups, 54
user groups, 54
TechTool Pro (Micromat),
346
telephone jack, 24
television, 193, 202
templates
documents, 305-306
presentations, 332-333
spreadsheets, 318-319
testing networks, 177-178
text log files, 155
themes
iDVD, 267-268
iMovie, 245
Tidy Up! 2 (Hyperbolic
Software), 374
tiling background images,
100
Time Capsule, 169-170,
366, 377
Time Machine, 366, 376-378
Time Machine pane (System
Preferences), 109-110
title bar of a window, 75
titles
DVD movies, 274
iMovie movies, 257-258
Toast Titanium (Roxio), 376
tracker application, 387
trackpad, 12, 14, 60-62
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tracks
adding, 286-288
Arrange track, 294-295
defined, 283
Electric Guitar tracks, 287
movie tracks, 287, 292
podcast artwork tracks, 287
real instrument tracks,
287
settings, 295-297
software instrument
tracks, 286-287
Track list (GarageBand),
282-283
transitions in iMovie,
256-257
Trash, 86-88, 354, 372-373
trimming video clips, 256
troubleshooting
Apple Service Center,
346, 357-358
Apple technical support,
357
applications, 353
cables, 354
disabling Login Items,
355-356
Disk Utility, 349-354
Internet connection,
354-355
investigating recent
changes, 353-354
myths, 345-346
network connection,
354-355
Power On self-test, 357
rebooting, 346-348
reinstalling Snow Leopard,
352
Safe Boot mode, 348
screen savers, 356
serial number, 358
startup keys, 348-349
step-by-step, 347-356
System Profiler, 356-357
Trash, 354
utility software, 346
viruses, 355
TV, 193, 202

TV Safe Area (iDVD), 270

TWAIN device standard for
scanners, 187

Twelve South’s BookBook
case, 30-31

olf o

uninterruptible power
supply, 31, 389

UNIX, 51

unpacking, 25

updating
applications, 353
Snow Leopard, 381-382

upgrading
applications, 394-395
hard drive, 365-369
memory, 359-364
older MacBook or

iBook, 13
system RAM (memory),

386

USB 1.1 storage devices,

367, 392

USB Bluetooth adapter,
BC2-BC3
USB cables, 32
USB flash drive, 22
USB port, 16, 183
USB printers, 184-186
USB scanners, 187
USB-to-Ethernet connector,
173
Usenet newsgroups, 54
user accounts
deleting, 152
Login Items, 153-154
modifying, 150-151
Parental Controls,

147, 153-157
passwords, 149, 157
setting up, 147-150

user groups, 54
users
adding, 148-150
deleting, 152
utility software, 346
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video

adding video clips,
254-255, 268, 270

connecting external
video, 17

cropping video clips, 256

deleting video clips, 255

DV (digital video)
camcorders, 221

editing video clips,
255-256

iChat AV, 192-193

importing, 247-249

iTunes, 198, 204

iTunes Store, 219-220

Photo Booth, 190

presentations, 339

Index 4 ’3

reordering video clips,

255

video card, 19

video controllers, 370

videoconferencing,
15, 192-193

viewing song information,
208-209

Virtual Private Network
(VPN), 396

Virus Barrier X6 (Intego),
355

viruses, 355

Visual Equalizer window
(GarageBand), 296

Visualizer (iTunes), 217-219

volume, 72

VueScan scanning
application (Hamrick
Software), 197
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warranty, 369

WAV files, 198, 200

Weather widget, 120

Web pages
e-mailing, 135
printing, 128, 135
saving, 134-135
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WebClip widgets, 89
widescreen aspect ratio of
screen, 13
widgets
creating, 89, 127
defined, 88
deleting, 88
Dictionary, 120
Dictionary widget, 13
Flight Tracker, 120
Google, 120
Internet, 119-120
rearranging, 88
Weather, 120
WebClip widgets, 89
Yellow Pages, 120
Windows
comparison to Snow
Leopard, 52
Desktop, 52
drag and drop, 52
iDisk, 144
migrating data from
Windows, 43-44
running, 43
switching from Windows
to Mac, 51, 139
windows
active window, 76
arranging, 76

closing, 75
defined, 50
minimizing, 75
moving, 76
rearranging, 76
resizing, 74-75
restoring, 76
scroll bars, 74-75
title bar, 75
Windows versus Snow
Leopard, 52
zooming in/out, 75-76
Windows Switchers, 51-52
wiping hard drive, 349
wired network
cable modem, 174
connections, 173-176
defined, 164-165
DHCP server, 167, 175-176
DSL modem, 174
Ethernet cables, 174
switches, 174
USB-to-Ethernet
connector, 173
wireless access, 166
wireless devices
Bluetooth printers,
183, BC8
keyboard, BC5-BC6
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wireless, BC6
wireless Ethernet, 18
wireless network
access from a wired
network, 166
base station, 168-171
connections, 168-173
defined, 164-165
disabling wireless
connectivity, 388
joining, 171-172
security, 172, 396
workflows, 380
wrist rest, 32
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Yellow Pages widget, 120
YouTube, 259
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zooming in/out
Multi-Touch feature,
61, 76
windows, 75-76
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Bonus Chapter

Communicating with That
Bluetooth Guy

In This Chapter

Using Bluetooth for wireless connections
Adding wireless keyboards and mice

Moving data among devices with iSync
Printing over a Bluetooth wireless connection

Tme to talk cordless. Your MacBook is already pretty doggone all-
inclusive because everything that most other computers string together
with cords has been integrated into the laptop’s case, including the monitor,
pointing device, speakers, and video camera. Depending on the connection
options that you choose when you buy your laptop (or what you added
since), the only cord that you absolutely need might be your AC power cord.

For most of us, this introduces an entirely new realm of possibilities . . . and
that results in more questions. Exactly how do other wireless devices
communicate with your MacBook? Can you really share the data on your
laptop with your cellphone?

In this chapter, I describe to you what’s cooking in the world of wireless
devices.  won’t delve into wireless Ethernet networking between your
MacBook and other computers; that’s covered in depth in the confines of
Chapter 11 of MacBook For Dummies, 3rd Edition. I also don’t discuss the
Apple Remote in this chapter; that’s covered in Chapter 12. However, I do
cover the wireless Bluetooth connections that you can make with devices
other than computers.
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Bluetooth: What a Silly Name
for Such Cool Technology

Originally, wireless computer connections were limited to IR (infrared) and
802.11b (the original Wi-Fi specification for wireless Ethernet networks). This
was fine; after all, what were you gonna connect to your Mac laptop besides
other computers? Ah, but progress marches on.

A little Danish history

Enter the explosion in popularity of modern cellphones and personal digital
assistants (PDAs). In 1998, a consortium of big-name cellphone, PDA, and
computer laptop manufacturers decided that their products needed a
method of communicating with each other. This new wireless standard
needed to be inexpensive and consume as little battery power as possible, so
designers decided to keep the operational distance limited to a maximum of
about 30 feet. Plus, the idea was to keep this new wireless system as hassle
free as possible. Everyone agreed that you should simply be able to walk
within range of another device, and the two would link up immediately and
automatically. Thus, Bluetooth was born!

Bluetooth has been incorporated into a range of peripherals and devices,
including

v Cellphones

v Tablet computers like the iPad

v Laptops and many desktops

v Wireless computer peripherals, such as keyboards and mice

v Printers

v Headphones

Is your MacBook Bluetooth-ready?

Weird name aside, you still need to know whether your MacBook is ready for
a Bluetooth connection. At the time of this writing, all Apple laptops come
with internal Bluetooth hardware. If you're using an older Mac laptop without
Bluetooth built in, though, you’re currently out of the Bluetooth loop.

However, you don’t need to pitch your faithful laptop if it doesn’t yet talk to

the “In” crowd! You can add Bluetooth capability to your computer with a
simple USB Bluetooth adapter. The USB Bluetooth adapter from Belkin
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(www . belkin.com) sells online for about $30. It includes automatic data
encryption, which is necessary only if there’s a hacker within about 30 to 60
feet of your computer (although more security is always better in my book).
The adapter can link with up to seven other Bluetooth devices simultaneously.
(Come to think of it, there were a lot of people within 30 feet of my MacBook
Pro during my last LAN party bash. I guess this stuff really is important!)

Snow Leopard and Bluetooth,
together forever

You’d expect a modern, high-tech operating system like Mac OS X to come
with Bluetooth drivers. You'd be right, but Apple goes a step further: Snow
Leopard comes with a System Preferences screen and a utility application to
help you get your laptop connected with the Bluetooth devices that are likely
hanging out in your coat pockets.

Click the System Preferences icon in the Dock. From the Bluetooth pane,
you can

1 Set up new Bluetooth devices: Click the Set Up New Device button to
run the Bluetooth Setup Assistant, which configures Bluetooth devices
for use with Snow Leopard.

Follow the device-specific on-screen instructions to set up a number of
common Bluetooth toys (including keyboards, mice, cellphones, and
printers), or you can work with other types of devices by choosing
Other. Setup Assistant searches for your Bluetooth device and makes
sure that it’s ready to party with your MacBook.

Make sure that your Bluetooth device is in range and discoverable
(available for connections with other Bluetooth devices) before you run
the Bluetooth Setup Assistant. Check your user manual to determine
how to set your Bluetooth device as “discoverable,” and make sure that
you’re about 20 feet away (or less) from your MacBook.

1 Configure Bluetooth connections: Click the Advanced button to create,
remove, enable, or disable your Bluetooth connections, using them as
virtual serial ports (for the simple transfer of data) or virtual modems
(for bidirectional transfers, such as using an Internet connection
through a Bluetooth cellphone).

These openings to the outside world are presented as individual
connections in the Serial Port list, and you can toggle them on and

off individually. You can also specify whether a Bluetooth port is
encrypted. Figure BC-1 shows an active Bluetooth virtual modem that’s
set up to allow my MacBook Pro to sync with my Palm Pilot, using the
Bluetooth-PDA-Sync service.
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Figure BC-1:
You can
add, delete,
enable,

or disable
Bluetooth
ports

from the
Advanced
sheet.
|

3

<\

I recommend that you select the Show Bluetooth Status in the Menu Bar
check box. The Bluetooth menu lets you conserve power by turning off your
Bluetooth hardware until you need it. You can also conveniently toggle your
laptop’s discovery status as well as set up a device or send and browse files.
(You can even see what devices are connected to your Mac with the click of a
menu icon. 'Nuff said.)

If you know you won’t be using Bluetooth devices while you're on the road,
disabling a Bluetooth service on a laptop can help conserve battery power.

The other Bluetooth resource that you can use is the stand-alone application
Bluetooth File Exchange. (Yes, you can call it BFE if you like. | do whenever
possible.) You have to launch BFE the old-fashioned way; it’s located in

your Utilities folder, inside your Applications folder. Much like a traditional
FTP (File Transfer Protocol) application, double-clicking the Bluetooth File
Exchange icon presents you with a file selection dialog, where you choose
the file(s) you want to send to the connected Bluetooth device! You can also
elect to browse the files on a networked Bluetooth device so that you can see
what the owner of that device is offering.

You can also set up your defaults for file exchanges from the Sharing pane
in System Preferences. Click the Sharing icon and then select the Bluetooth
Sharing check box to display the settings shown in Figure BC-2. Here you
can control what Snow Leopard does when you receive files or Personal
Information Manager (PIM) data with BFE. For instance, with these settings,
Snow Leopard can

v Prompt you for permission to receive each file or PIM item.
v Accept all files and PIM items without restriction or prompting.

v Save all incoming files and items to the folder that you specify.
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Figure BC-2:
Configure
file
exchanges
in System
Preferences.
|

v~ Offer only the files and items in the folder that you specify when other
Bluetooth items browse your MacBook.

Personally, I'm all for the defaults in Snow Leopard for file exchanges:

v [ want to know when someone’s sending me something.

v [ want anything I receive to be saved in my Downloads folder.

v If I turn on File Transfer, I want to allow others to browse the contents of
my Public folder.

However, feel free to adjust, enable, and disable to your heart’s content.

Adding Wireless Keyboards
and Mice to Your Laptop

The current crop of Mac laptops arrive at your doorstep in a fully wireless
configuration. Apple throws in an internal Bluetooth adapter and an internal
AirPort Extreme wireless card. Everything’s already included for you.
Therefore, you can indeed work keyboard and mouse magic from across the
room from your laptop, using a wireless keyboard and mouse that you can
buy separately. (Or perhaps you just want a full-size keyboard and external
mouse to use when you’re working from your home or office.)
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A number of wireless Bluetooth keyboard/mouse packages are on the market,
and any one of '’em should work fine with your Mac. In fact, you can buy
Apple’s wireless Bluetooth keyboard and Magic Mouse separately, for a total
of about $150. Other offerings from Logitech and our old buddy Microsoft run
about the same amount, while the excellent BTKey keyboard from Macally is
significantly cheaper at about $70 (www.macally.com).

When shopping for a Bluetooth keyboard/mouse desktop, keep these facts
in mind:

1 Some keyboards are created more than equal. Many of today’s third-
party keyboards are encrusted with extra function buttons that do
everything from opening your e-mail application to searching your
kitchen cabinets for another can of spray cheese.

I like these programmable function keys — they can bring up your
favorite applications with a single keystroke while you're relaxing 20 feet
away — so look for the keyboard that offers the most programmable
keys in your price range.

+” Rodents crave energy. Does the wireless mouse come with its own
recharging stand? If so, that’s a big plus. Depending on how much you
use your laptop, a mouse that runs on standard batteries can go through
a set in as little as a month’s time! (Not surprisingly, many computer
owners use rechargeable batteries in their wireless mice.) In fact, some
wireless mice include an on/off switch to help conserve battery power.

1 Wireless doesn’t always mean Bluetooth. Just because a keyboard or
mouse is wireless doesn’t automatically make it a Bluetooth device.
Plenty of wireless RF (radio frequency) devices are out there, too. These
toys need their own transmitters, which are usually USB-based as well,
so things can get confusing. Therefore, read the box or technical
specifications carefully to make sure that you’'re buying Bluetooth.

v Bluetooth stuff isn’t self-cleaning. Sure, your new wireless keyboard
and mouse can hang out with you on the sofa, but that doesn’t mean
they’re happy sharing your nacho puffs and grape soda. Look for an
optical mouse (which doesn’t use a ball), and check whether a prospective
keyboard can be easily cleaned and maintained before you buy it.

Most Bluetooth devices are controlled through the Bluetooth pane in System
Preferences. However, wireless keyboards and mice are a special case
because they’re monitored through the Bluetooth section of the Keyboard

& Mouse pane. (You can even add a new wireless device from this tab. Geez,
those Apple designers give you a dozen roads to the same spot on the map,
don’t they?)
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Getting Everything in iSync
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No jokes about boy bands, please. iSync is the data transfer and synchronizing
utility application that ships with Snow Leopard, and it works fine with both
wired and wireless Bluetooth connections. The difference between Bluetooth
File Exchange and iSync is a matter of intelligence:

v BFE merely transfers files and dumps them in the folders you specify.

v iSync copies and updates your Address Book, Safari, and iCal information
among devices. iSync compares the information on both your laptop
and your devices and makes sure that they end up the same.

iSync also allows you to synchronize data among multiple computers
and devices by using your MobileMe membership so that the contacts,
bookmarks, and calendar data on your MacBook match, for example,
the data on your Mac Pro. You can control what gets sent from the
MobileMe pane in System Preferences. (For more on MobileMe, visit
Chapter 9 of MacBook For Dummies, 3rd Edition.)

Just because your phone or PDA supports Bluetooth doesn’t mean that iSync
is guaranteed to work. I know a few Mac owners who are still seething over
incompatible devices. For a complete list of the Bluetooth phones, PDAs, and
other devices that work with iSync, visit www.apple.com/isync/devices.
html.

After your supported Bluetooth device is linked to your Mac, follow these
steps to add the new device to iSync and synchronize your data:
1. Click the Finder icon on the Dock.

2. Click Applications in the Finder window Sidebar and double-click
iSync.

3. Press 3+N.

iSync displays the Add Device dialog.
4. Click Scan to display any Bluetooth devices in range.
5. Double-click the device that you want to use.

The window expands to allow you to specify what data is to be synchro-
nized. (Other settings might appear as well, depending on the device.)

6. Select the check boxes for each data type that you want to exchange.

7. Click Sync Devices.
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QNING/ Never disconnect a device while a synchronization is in progress. You risk
& corrupting the data being transferred, or your MacBook could lock up. Wait
until iSync indicates that the synchronization is finished; the application
displays a message when the process is complete.

QNING/ Deleting a calendar event or a contact on either your laptop or the Bluetooth
Yy device deletes that same data from the other machine! For example, if you
decide you no longer need your personal contacts on your Mac at work and
you delete 'em, they’ll be deleted from your PDA when you synchronize. When |
say that iSync creates a mirror image on both sides of the connection, I'm not
lying: Additions appear, and deletions disappear.

The Magic of Wireless Printing

To your Mac laptop, a wireless Bluetooth printer is just another Bluetooth
connection — but to you, it’s the very definition of convenience, especially if
desk space is limited next to your Mac. Just set that paper-producing puppy

up anywhere in the 30-40 foot range, plug it in, set up the printer in Snow
Leopard, and let ’er rip.

<P Not all printer manufacturers produce Bluetooth models that communicate
properly with your Mac. Make sure that the Bluetooth printer you buy
supports HCRP. (Another jawbreaker acronym. This time it stands for
Hardcopy Cable Replacement Protocol.)

You have two options when installing a Bluetooth printer:
v Whenever possible, use the printer manufacturer’s software. A printer

might require a driver that a typical Bluetooth device doesn’t need.

»* You can usually successfully set up a printer via the Bluetooth Setup
Assistant, which you can run from the Bluetooth pane of System
Preferences (as I discuss earlier in the chapter):

a. Make sure that your printer is set as discoverable.

Check your printer manual to determine how to switch your
printer to discoverable mode. This mode allows other Bluetooth
devices within range (including your laptop) to recognize and
make a connection to your printer.

b. Click the Set Up New Device button.
c. Choose to install a printer.
d. Follow the on-screen instructions.
Luckily, after you successfully set up a Bluetooth printer, you can just press

3 +P to open the Print dialog box and choose that printer from the Printer
pop-up menu. No big whoop . . . and that’s the way it should be.
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There’s a Dummies App for This and That

With more than 200 million books in print and over 1,600 unique
titles, Dummies is a global leader in how-to information. Now
you can get the same great Dummies information in an App.With
topics such as Wine, Spanish, Digital Photography, Certification,
and more, you'll have instant access to the topics you need to
know in a format you can trust.

To get information on all our Dummies apps, visit the following:
www.Dummies.com/go/mobile from your computer.

www.Dummies.com/go/iphone/apps from your phone.
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Enjoy music, movies, and photos,
cruise the Web, and even do
some work — from anywhere!

Ready to rock the MacBook way? This handy guide shows
you how to use your MacBook for work and play, turning
you from novice to pro in no time. Learn the basics about
setting up and maintaining your MacBook, work with Mac
0OS® X, discover MobileMe, enjoy the iLife and iWork suites,
and keep your MacBook happy!

* Get started — set up your MacBook, customize your preferences,
organize files and folders, and hook up a printer

* Get to the heart of Mac OS X — navigate around the desktop, get
to know the Dock, find things with Spotlight°, and back up your
system with Time Machine®

* Online action — get your Internet connection and e-mail set up,
browse the Web, and sync up with MobileMe

* Explore the iLife — where photos, movies, music, and your very
own Web site all hang out

* When you’ve gotta work — do it the MacBook way with Pages,
Numbers, and Keynote, the iWork productivity applications

* Need to share? — personalize your MacBook for multiple users,
set up a network, and use an AirPort® base station

* Gotta hand it to you — master the magic of the multi-touch
trackpad

* Maintain your MacBook — find out how to keep your laptop
updated and running smoothly

Mark L. Chambers is an author, tech editor, and unabashed Mac fan. He is
the author of more than 30 computer books including iMac For Dummies,

6th Edition, Mac OS X Snow Leopard All-in-One For Dummies, MacBook
All-in-One For Dummies, and Macs For Seniors For Dummies.
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digital music, photos, and movies
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